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Designing BIRT Information Objects provides information about using Information
Object Designer to create information objects and publish them to an Actuate
BIRT iServer Encyclopedia volume. This manual also describes how to configure
a database type for use with Information Object Designer.

Designing BIRT Information Objects includes the following chapters:

About Designing BIRT Information Objects. This chapter provides an overview
of this guide.

Part 1. Creating information objects using Information Object Designer. This part
explains how to create information objects using Information Object Designer.

Chapter 1. Introducing Information Object Designer. This chapter defines the term
information object and describes the Information Object Designer user
interface.

Chapter 2. Creating projects, data connection definitions, and maps. This chapter
describes how to create a project, data connection definitions, and maps prior
to creating information objects.

Chapter 3. Creating information objects. This chapter describes how to create
information objects.

Chapter 4. Caching information objects. This chapter describes how to cache
information objects to improve performance and reduce the load on
production databases.

Chapter 5. Building and publishing a project. This chapter describes how to build
and publish an information object project to an Actuate BIRT iServer
Encyclopedia volume.

Chapter 6. Actuate SQL reference. This chapter describes the differences between
Actuate SQL and ANSI SQL-92.

About Designing BIRT Information Objects ix
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Part 2. Configuring database types. This part explains how to configure a
database type for use with Information Object Designer.

Chapter 7. Understanding database types. This chapter defines the term database
type, describes the preconfigured database types, and gives an overview of
database type configuration.

Chapter 8. Configuring connection types. This chapter gives the requirements for
JDBC drivers and describes how to configure a connection type.

Chapter 9. Mapping data types. This chapter explains how database data types
are mapped to Actuate SQL data types at design time.

Chapter 10. Mapping functions and operators. This chapter explains how to map
Actuate SQL functions and operators to their database equivalents.

Chapter 11. Mapping literals and clauses. This chapter explains how to map
Actuate SQL string and timestamp literals and GROUP BY and ORDER BY
clauses to their database equivalents.

Chapter 12. Working with collations and byte-based strings. This chapter explains
how to choose Integration service and database collations and how to work
with a database that processes strings by byte.
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Creating information objects using
Information Object Designer






Introducing Information
Object Designer

This chapter contains the following topics:

m About information objects

m  About Information Object Designer

m  About the Information Object Designer environment

m Displaying hidden messages
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About information objects

Like a view in a relational database, an information object is a named SQL query.
An information object can retrieve data using;:

m Database tables and views

Stored procedures

m  ODA data sources, including Web Services and XML

m  Other information objects

An information object can retrieve data from more than one data source.

Report developers use information objects when they access data with BIRT
Designer Professional, Actuate e.Report Designer Professional, or Actuate
e.Spreadsheet Designer. Business users use information objects when they access
data with BIRT Studio or Actuate Query.

About Information Object Designer

Information Object Designer enables you to create information objects. Before
you can create an information object with Information Object Designer, you must:

m Create data connection definitions for the data sources.
m Create maps:
m Create maps to represent database tables and views.

m Create external procedures and maps to represent stored procedures and
ODA data source queries and their result sets.

Do not use the following characters in resource names in Information Object
Designer:

< (less than)

> (greater than)

' (single quote)

" (double quote)

About the Information Object Designer environment

Information Object Designer is built on the Eclipse integrated development
environment. Information Object Designer is available as a standalone product,
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or as the 10 Design perspective in BIRT Designer Professional. For information
about perspectives and other Eclipse features, see the Workbench User Guide in the
online help.

The default IO Design perspective appears as shown in Figure 1-1.

Navigator view

Query definition view

Properties view

N MyPrajsct

& I =] <
Ele Edt NoAste Eroject Window Help
|| -5 & = £/ 10 Desian
5. Navigstor 13 =l 8 | F Propertes 22 | =ial
HIEER IETE T
52 MyFuoiect Propery | value |
1= Dals Sources = Analysis
i B MyDatabase Select Al Analpsic Type s Dimension
Select 4l
i @ _MyDatsbase.ded el o itemeode (=] Display
[ dba.customers.sma ot = . Display Fermat %%
- dboitems.sma orecssiOrderDate £ desaription Display Length % 10
] itemeode hipBiyD ate Display Name %
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Figure 1-1

The default 10 Design perspective

The IO Design perspective displays the following views:

m Navigator view

The Navigator view displays the contents of your projects. A project consists
of data connection definitions, external procedures, maps, information objects,

cache connection definitions, and cache objects.

m  Query definition view
You create the information object’s SQL query, either graphically or textually,
in the query definition view.

m Properties view

The properties view displays the properties of the selected item, for example a
table or column.

Chapter 1, Introducing Information Object Designer
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To toggle the display of properties in categories, choose Show Categories.

m Problems view
The problems view displays error messages from the Actuate BIRT iServer.

m  SQL Preview view
The SQL Preview view displays the information object’s SQL query.

m Data Preview view
The Data Preview view displays map or information object output.

m  Query Profiler view
The Query Profiler view displays the query execution plan.

m iServer Explorer view
The iServer Explorer view displays your iServer profiles.

Displaying hidden messages

In Information Object Designer, many dialogs contain a Do not show this
message again checkbox. For example, Figure 1-2 shows the Reminder message
for the New Maps dialog. If you check the checkbox, the message does not appear
again.

> X

I/_“. Map [.smal files for data source MyDatabase are in the /D ata

b | SourcesMyD atabase/ folder. Double-click a map name o view and edit map

4
— column names. Make sure that the map uses the comect column names before
creating an infarmation object from the map.

¥ Do nat show this message again

Figure 1-2 Reminder message for New Maps dialog

To display the message again, you must remove it from the Hidden Messages list,
shown in Figure 1-3.

How to display a hidden message
1 Choose Window—>Preferences.
2 Choose Hidden Messages.

3 Select the appropriate message. Hover the mouse over the message to display
a description.

4 Choose Remove. Choose OK.
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Figure 1-3 Hidden Messages
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Creating projects,
data connection definitions,
and maps

This chapter contains the following topics:

m Creating an information object project

m  Moving and renaming folders

m Propagating column and parameter renaming and deletion

m Creating a data connection definition

m  Encrypting and decrypting data source connection properties
m Externalizing data source connection properties

m Creating maps

m Displaying information about a project or resource

Chapter 2, Creating projects, data connection definitions, and maps 9



Creating an information object project

An information object project is a container for data connection definitions,
external procedures, maps, information objects, cache connection definitions, and
cache objects. As shown in Figure 2-1, a project folder contains at least two
subfolders:

m Data Sources

The Data Sources folder contains data connection definitions, external
procedures, and maps.

m Information Objects
The Information Objects folder contains information objects.

A project folder can also contain a Cache Sources subfolder, which contains cache
connection definitions and cache objects.

TT. Mawigator £3 =0

<,5:(>v

" Project folder
= DataSources

L2 Information Objects

Figure 2-1 Project folder with Data Sources and Information Objects subfolders

The project folder resides both on your desktop and in an Encyclopedia volume.
The project folder must reside in an Encyclopedia volume because information
object compilation and execution are performed by the iServer Integration
service. To define the connection properties for an Encyclopedia volume, you
create an iServer profile. For information about the Integration service, see
Configuring BIRT iServer.

How to create an information object project
1 Choose File>New~>Project.
2 In New Project—Select a wizard, shown in Figure 2-2, choose Next.
3 In New Project—Information object project:
» In Project name, type the name of the project.

m In Local directory, if you do not want to save the project in the default
directory, deselect Use default location and type or browse to a different
location.

m In Development Location, in iServer profile, choose an iServer profile from
the drop-down list.

If there are no entries in the drop-down list, choose Add to create an
iServer profile.
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-

Select a wizard

Create a new information object project

Cw5
Eclipze Modeling Framework,
f_ormation Obijects

(= Plugin Development
Bl Examples

Figure 2-2 Selecting the Information Object Project wizard

» In Development Location, browse for the appropriate folder or choose Use
Home to place the project folder in the development folder in the user’s
home folder.

In Figure 2-3, the project folder MyProject resides in the development
folder in the user’s home folder, MyHomeFolder.

» In Publish Location, specify the appropriate iServer profile and folder.

Specifying a publish location is optional. The publish location should be
different from the development location.

m  Choose Finish.
The project appears in Navigator.

Lri O] x|

Information object project
Specify where your praject is stored locally and on the Actuate iServer.
tyProject

¥

[CADserstmedie HGworkspacePiaiect

- |
o, | UseHoms

orwseone o e | A
oo TR Brows.|

_<Back | News [[ Fsh ] corcd |

Figure 2-3 Specifying a project’s name, development location, and
publish location
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How to create an iServer profile
1 In New Project—Information object project, choose Add.

2 In New iServer Profile:

» In Profile name, type the name of the iServer profile, for example
MyServerProfile.

m IniServer, type the name or IP address of the computer on which the
Actuate iServer Message Distribution Service is running.

m In Port number, type the number of the port on which the Actuate iServer
Message Distribution Service listens for requests. The port number appears
in the Message distribution port field on the Servers—Properties—Message
Distribution Service page of Configuration Console. The default port
number is 8000.

m In Volume, choose the Encyclopedia volume in which you want to store
information object projects.

m In User name, type your Encyclopedia volume user name. You type this
user name when you log in to Management Console.

m In Password, type your Encyclopedia volume password. You type this
password when you log in to Management Console.
If you select Remember Password, Information Object Designer stores the
password in encrypted format in acserverprofile.xml. You are not required
to provide the password again when you next launch Information Object
Designer. Storing the password in this way may pose a security risk. If you
deselect Remember Password, Information Object Designer stores the
password in memory for the duration of the session. When you next
launch Information Object Designer, you must provide the password again
in order to connect to the iServer. Remember Password is selected by
default.

m Provide values for the following properties if you plan to test information
objects from this project in BIRT Studio. These properties are used to
construct the URL for BIRT Studio:

o Information Console server
Name or IP address of the computer on which Information Console is
installed. If you are using the Information Console that installs with
iServer, this is the same name or IP address that you typed in the
iServer field.

o Information Console port

Number of the port on which Information Console listens for requests.
The port number appears in the Management Console and Information
Console port field on the Simple View page of Configuration Console.
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The default port number is 8900. If Information Console is installed
separately from iServer, the default port number is 8700.

a Context path

The context path for Information Console URLs. The default context
path is /iportal.

Figure 2-4 shows an example of an iServer profile.

= Choose Finish.
The profile appears in iServer Explorer, as shown in Figure 2-5.

& J =] 3

iServer Profile

Specify & profile name and connection properties.

MyServerProfile

Figure 2-4 Specifying an iServer profile

A iserver Explorer £3

= E Servers

B E tuServerPofile
EQ Hame
E-{= MyHomeFolder
: El-Z= MyPraject
H g Tlones
{2 Public
-z Resouces

—— iServer profile

Figure 2-5 The iServer Explorer view, showing an iServer profile

How to change a project’s development location
1 In Navigator, select the project.

2 Choose File>Properties.
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In Properties, select Actuate iServer.
In Development Location, choose Add.

5 Complete the New iServer Profile dialog, as shown in Figure 2-4. Choose
Finish.

6 Browse for the appropriate folder or choose Use Home to place the project
folder in the development folder in the user’s home folder. Choose OK.

In Figure 2-6, the project folder MyProject resides in the development folder in
the user’s home folder, MyHomeFolder.

Development
location

=
Itype Filter et Actuate iServer T T

+ Resource — _—
i Actuate iServer (S =L (Ll

Builders iServer profile: IMyDeveIopmentPlofile j Edi... Add...l

i+ Localization
: Project References Diirectony: |#Home/MyHomeFolder/development/MyPraject Browse... UseHomel

i Aun/Debug Settings
Tazk Fepositary i~ Publizh Location [optional)

Task Tags iBerver profile: | MyPublishProfiie =] Edi.| [add]

slidation
e WTIT et Directary: |x’\nformation Objects/MyProject Browsze

|@:| 0K | Cancel

Figure 2-6 Selecting a different development location for a project

Moving and renaming folders

An information object uses relative paths to reference maps and other
information objects. If you move or rename the Data Sources or Information
Objects folders or their subfolders, make sure the paths used in the information
object are still valid. For example, an information object contains the following
path:

../Data Sources/MyDatabase/dbo.customers.sma

If you change the name of the Data Sources folder to My Data Sources, you must
modify the path used in the information object as follows:

.. /My Data Sources/MyDatabase/dbo.customers.sma

For this reason, it is best to rename the Data Sources folder and its subfolders
before you create information objects.
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Propagating column and parameter renaming and
deletion

By default, when you rename a column or parameter in a source map or
information object, the name change is propagated to any dependent information
objects as long as the column name in the dependent information object is not
modified. Column names that appear in expressions, including computed
column and filter expressions, are also updated. Information Object Designer
does not check for column name duplication in a dependent information object.
When you compile the information object, column name duplication is reported
as an error.

By default, when you delete a column or parameter in a source map or
information object, the deletion is not propagated to dependent information
objects. If you override this behavior, the deletion is propagated to any dependent
information objects as long as the column name in the dependent information
object is not modified. Filters on a deleted column are deleted. Computed
columns and filter expressions that contain the column name are not deleted.

To override the default behavior, choose Window—>Preferences and make the
appropriate selections. Figure 2-7 shows the default settings for column and
parameter renaming and deletion.

- o]
Jtupe fier texs Information Objects - -
(- General
- Ant General gettings for Information Objects
- Data Management D'ata Previews Timeout [seconds]: |3DU
& Help [~ Show categories in graphical editor by default
- Hidden Messages
- Information Objects g el
I ¥ Propagate column and parameter renaming throughout the project
- Install/Lpdate : X ——Default
- Java ™ Propagate column and parameter deletion tiroughout the praject

[

[ .
[~ Flug-in Development propagatlon
[#- Report Design Settlngs
[#- Run/Debug
(- Tasks
[

- Team

d::;}famn FRestore Defaultsl Apply |

Iﬁ} 0K | Cancel |
Figure 2-7 Default propagation settings

Creating a data connection definition

A data connection definition defines the connection properties for a data source.
Connection properties include connection type, security policy, user name, and
password. By default, Information Object Designer creates a subfolder in the
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project’s Data Sources folder to contain a data connection definition file. A data
connection definition file name has a .dcd extension. Data connection definition
file names are not case-sensitive.

For example, if you create a data connection definition for the database
MyDatabase, Information Object Designer creates the folder MyDatabase and the
data connection definition file _MyDatabase.dcd. As shown in Figure 2-8, the file
_MyDatabase.dcd appears in MyDatabase, which Information Object Designer
creates as a subfolder of the project’s Data Sources folder.

5. Mavigator £3 =8

EEE

E@ MpProject
Bl Data Sources
| B MyDatabase
i _MyD atab.
L2 Information Object;

—— Data connection
definition file

Figure 2-8 The Navigator view, showing a new data connection definition file
and its folder
Creating a data connection definition for a database

Information Object Designer uses an ODBC or JDBC driver to connect to a
database. The preconfigured database types are:

s DB2
m Informix
m  MySQL Enterprise
m Oracle
m PostgreSQL
m SQL Server
m Sybase
How to create a data connection definition for a database
1 In Navigator, select the appropriate project.
2 Choose File>New—>Data Connection Definition.
New Data Connection Definition appears.
3 In New Data Connection Definition:
m In Name, type the name of the database.
m In Type, choose a type from the drop-down list.

m In Description, type a description for the database.
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To retrieve the connection property values from the data source connection
configuration file at run time, type the configuration key in Configuration
key.

Figure 2-9 shows an example of creating a data connection definition for a
database.

= I [=] b3
—
Data Connection Definition =5
Create a data connection definition, l
Narne: IMyDatabasa
Type: ISQL Server 2005 ﬂ
Description: Customer data -
-
Configuration key: I
co |

Figure 2-9 Creating a data connection definition for a database

Choose Finish.

The data connection definition file name appears in Navigator, and Data
source connection properties appears. Connection property values stored
in the data source connection configuration file are not displayed.

4 In Data source connection properties:

If you did not provide a configuration key earlier, you may provide one
NOwW.

In Credentials, choose Proxy or Passthrough.

If you choose Proxy, Information Object Designer connects to the database
using the user name and password you specify in Data source connection
properties. If you choose Passthrough, Information Object Designer
connects to the database using the user name and password you specify in
User Information. For information about using proxy and passthrough
security in an Encyclopedia volume, see Managing an Encyclopedia Volume.

If you chose Proxy, type the user name and password for the database user.

In Port, type the number of the port that Information Object Designer uses
to connect to the database server.

Provide values for the remaining properties.
The remaining properties are specific to the connection type.

Figure 2-10 shows an example of specifying the connection properties for a
database data connection definition.
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Data source connection properties

Tope: |S0L Server 2005

Description Customer data 2
||

Configuration key: |

Credentials: I Prozy j

User name: [MyD atabaseUser

Pagsword: [

Server. |MyD atabaseServer

Database: [Classichodels

Port: |1423

Test Connection |

Map tables | Map stored procedures | Create SOL map |

Figure 2-10 Specifying data source connection properties for a database
data connection definition
m  Choose Test Connection to test the connection to the database.

If you chose Passthrough in Credentials, type the database user name and
password in User Information and choose Finish, as shown in Figure 2-11.

= i [=] 3
User information —x
Specify data source connection properties for Myl)zer l

User name: IMyD atabasellzer

Passwaord: I

7 cocs |

Figure 2-11 Providing user information to connect to the database

If Information Object Designer connects to the database, a confirmation
message appears. Choose OK.

m  Choose one of the following:
o Map tables, to create maps of database tables and views
o Map stored procedures, to create a map of a stored procedure result set

o Create SQL map, to create a map of a query written in the database’s
native SQL
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Creating a data connection definition for an ODA data
source

Information Object Designer uses an Open Data Access (ODA) driver to connect
to an ODA data source. The preconfigured ODA data source types are:

BIRT document
Flat file

POJO

Web services
XML

How to create a data connection definition for an ODA data source

1
2
3

In Navigator, select the appropriate project.

Choose File>New—>Data Connection Definition.

In New Data Connection Definition:

In Name, type the name of the ODA data source.
In Type, choose a type from the drop-down list.
In Description, type a description for the ODA data source.

To retrieve the connection property values from the data source connection
configuration file at run time, type the configuration key in Configuration
key.

Figure 2-12 shows an example of creating an ODA data source connection
definition.

& 9 [m] B3
Data Connection Definition P ¢
Create a data connection definition. i

Marne: IMyDDADataSoulca
Type: IFlal File Data Source j
Description Flat file data ii

Configuration key: I

Figure 2-12 Creating an ODA data source connection definition
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m  Choose Finish.
The data connection definition file name appears in Navigator, and Data
source connection properties appears.

4 In Data source connection properties:

m If you did not provide a configuration key earlier, you may provide one
now.
Figure 2-13 shows an example of beginning to specify the connection
properties for an ODA data source connection definition.

Data source connection properties

Tupe: Inrg.echpse. datatools. connectivity. oda. fatfile

Description: Flat file data ;I

Configuration key: |

Data Saurce Properties |
Test Connection |
4 ap tables |

Figure 2-13 Specifying connection properties for an ODA data source
connection definition

m  Choose Data Source Properties.
m In the data source connection properties dialog:
o Provide values for the data source connection properties.

Figure 2-14 shows an example of specifying the properties for a flat file
data source.

> 0[]
Select Folder
Select the folder that containg the flat files
Select folder: IC:\
Select charset: IUTF-B j
Seleot flatile style: [C5v =

¥ Use first line a3 column name indicator
[~ Use second lins as data type indicator

Test Connection
@:l Finish | Cancel |

Figure 2-14 Specifying connection properties for a flat file data source
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[m]

Choose Test Connection to test the connection to the data source.

If Information Object Designer connects to the data source, a
confirmation message appears. Choose OK.

a Choose Finish.

m  Choose Map tables to create a map of an ODA data source query result set.

About connection properties

Table 2-1 lists the preconfigured connection types, connection properties, and a
description of each property.

Table 2-1 Properties for preconfigured connection types
Connection type  Property Description
BIRT Report Report Path to the report document to use as a
Document Data document data source.
Source path
See Using Actuate
BIRT Designer
Professional.
DB2 Collection Similar to schema. Used only with z/OS
and OS/400 operating systems.
Database Name of database.
IANAApp-  For a description of IANAAppCodePage
CodePage values, see “About the
IANAAppCodePage property,” later in
this chapter.
Password A password used to connect to your DB2
database.
Port The port number that is assigned to the
DB2 DRDA listener process on the server
host machine. Specify this port’s numeric
address or its name. If you specify a port
name, the database driver must find this
name in the SERVICES file on the Actuate
BIRT iServer computer. Port is optional.
Server The IP address of the machine where the

catalog tables are stored. Specify the
address using the machine’s numeric
address (for example, 123.456.78.90) or

(continues)
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Table 2-1 Properties for preconfigured connection types (continued)

Connection type

Property

Description

DB2 (continued)

Flat File Data
Source

See BIRT: A Field
Guide.

Informix

Server
(continued)

User name

Folder

Charset
Flatfile style

Database

Host

TANAApp-
CodePage

Password
Port

Service

User name
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specify its name. If you specify a name, the
database driver must find this name in the
HOSTS file on the Actuate BIRT iServer
computer or in a DNS server.

The login ID used to connect to your DB2
database. For DB2 on UNIX, the User
name is your UNIX user ID.

The UNC path for the folder in which the
file resides, for example \\MyComputer
\MyFolder. The folder must reside on a
Windows computer and must be shared.

Character set used to encode the file.

CSV, SSV, PSV, or TSV for a file that uses
comma-separated values, semicolon-
separated values, pipe-separated values,
or tab-separated values, respectively.

Used to filter catalogs. For example, if you
set this property to MyCatalog, the
connection recognizes only those catalogs
whose name begins with MyCatalog. If
you want the connection to recognize all
catalogs, do not provide a value for this
property.

The name of the machine on which the
Informix database resides.

For a description of IANAAppCodePage
values, see “About the
IANAAppCodePage property,” later in
this chapter.

A password.
The port number of the server listener.

The name of the server running the
Informix database.

Your user name as specified on the
Informix server.



Table 2-1 Properties for preconfigured connection types (continued)

Connection type  Property

Description

MySQL Enterprise Database

Password

Port

Server

User name

Oracle Password

Port

Server

Used to filter catalogs. For example, if you
set this property to MyCatalog, the
connection recognizes only those catalogs
whose name begins with MyCatalog. If
you want the connection to recognize all
catalogs, do not provide a value for this
property.

The password for the MySQL Enterprise
login account specified by the User name

property.
Port number (optional).

The network address of the server running
MySQL Enterprise. This is required and
can be an IP address, for example,
199.226.224.34. If your network supports
named servers, you can specify an address
using the server name, for example,
SSserver.

To specify a named instance of MySQL
Enterprise, use the format server_name
\instance_name. If only a server name is
specified with no instance name, the
database driver connects to the server and
uses the default named instance on the
server.

A valid MySQL Enterprise login account.

The password that the database driver
uses to connect to your Oracle database.

Identifies the port number of your Oracle
listener. The default value is 1521. Check

with your database administrator for the

correct number.

Identifies the Oracle server to which you
want to connect. If your network supports
named servers, you can specify a server
name, such as Oracleserver. Otherwise,
specify an IP address, such as
199.226.224.34.

(continues)
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Table 2-1 Properties for preconfigured connection types (continued)

Connection type  Property Description

Oracle (continued)  SID The Oracle System Identifier that refers to
the instance of the Oracle database
software running on the server.

TNSnames  Name of the TNS names file, for example,

file tnsnames.ora. This file must be accessible
from the computer running the Integration
service. Used only when the Server name
property is not set.

TNSserver  Name of the entry in the TNS names file

name that contains the configuration
information describing the database
server. Used only when the Server name
property is not set.

User name The user name that the database driver
uses to connect to your Oracle database.

POJO Data Source Runtime Shared location of custom POJO data set

See Using Actuate ~ Properties classes.

BIRT Designer

Professional.

Design time  Shared location of custom POJO data set

properties classes.

PostgreSQL Database Used to filter catalogs. For example, if you
set this property to MyCatalog, the
connection recognizes only those catalogs
whose name begins with MyCatalog. If
you want the connection to recognize all
catalogs, do not provide a value for this
property.

Password The password for the PostgreSQL login
account specified by the User name
property.

Port Port number (optional).

Server The network address of the server running

PostgreSQL. This is required and can be an
IP address, for example, 199.226.224.34. If
your network supports named servers,
you can specify an address using the
server name, for example, SSserver.

(continues)



Table 2-1 Properties for preconfigured connection types (continued)

Connection type  Property

Description

PostgreSQL Server
(continued) (continued)

User name
SQL Server Database

Password

Port

Server

User name

To specify a named instance of
PostgreSQL, use the format server_name
\instance_name. If only a server name is
specified with no instance name, the
database driver connects to the server and
uses the default named instance on the
server.

A valid PostgreSQL login account.

Used to filter catalogs. For example, if you
set this property to MyCatalog, the
connection recognizes only those catalogs
whose name begins with MyCatalog. If
you want the connection to recognize all
catalogs, do not provide a value for this
property. If you are running multiple
instances of SQL Server, precede the
database name with the instance name, for
example Mylnstance/MyDatabase.

The password for the SQL Server login
account specified by the User name

property.
Port number (optional).

The network address of the server running
SQL Server. This is required and can be an
IP address, for example, 199.226.224.34. If
your network supports named servers,
you can specify an address using the
server name, for example, SSserver.

To specify a named instance of SQL Server,
use the format server_name\instance
_name. If only a server name is specified
with no instance name, the database driver
connects to the server and uses the default
named instance on the server.

A valid SQL Server login account.
(continues)
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Table 2-1

Properties for preconfigured connection types (continued)

Connection type

Property

Description

Sybase

Web Services Data
Source

See BIRT: A Field
Guide.

Charset

Database

IANAApp-
CodePage

Password
Port

Server

User name
WSDL

descriptor

SOAP end
point

Custom
driver class
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The name of a character set. This character
set must be installed on the Sybase server.
The default is the setting on the Sybase
server. For the Integration service to return
Unicode data, this property must be set to
UTFS8. Refer to the Sybase server
documentation for a list of valid character
set names.

Used to filter catalogs. For example, if you
set this property to MyCatalog, the
connection recognizes only those catalogs
whose name begins with MyCatalog. If
you want the connection to recognize all
catalogs, do not provide a value for this
property.

For a description of IANAAppCodePage
values, see “About the
IANAAppCodePage property,” later in
this chapter.

A case-sensitive password.
Port number.

AnIP address, for example, 199.226.224.34.
If your network supports named servers,
you can specify the address using the
server name, for example, Sybaseserver.

The login ID used to connect to your
Sybase database. This ID is case-sensitive.

The path or URL for the Web Services
Description Language file. A well-formed
WSDL file defines the available services
and, typically, the SOAP end point URL.

SOAP end point URL. Omit this value if
the end point is defined in the WSDL file,
or if you are using a custom connection
class that does not require an end point
URL.

The fully qualified class name. Create and
use a custom driver if, for example, the
web service does not provide a WSDL file.



Table 2-1

Properties for preconfigured connection types (continued)

Connection type

Property

Description

Web Services Data
Source (continued)

XML Data Source

See BIRT: A Field
Guide.

Driver class
path

URL of the
XML source

URL of the
XML schema

Encoding for
the XML
source and
schema

A semicolon-separated list of JAR files and
directories to search for the custom driver
class.

The path or URL for the file that contains
XML data.

The path or URL for the file that contains a
description of the XML file’s data structure
(optional).

Encoding for the XML file and schema.
Use the default value, Auto, if you want

the data source to detect the encoding for
the XML file or schema.

About the IANAAppCodePage property

If the database character set is not Unicode and the Actuate BIRT iServer is
running on a UNIX platform, you must set the IANAAppCodePage property. The
value of IANAAppCodePage must match the database character encoding and
the system locale. If you do not set IANAAppCodePage, the database driver
searches for a value in the system information file (odbc.ini), first in the Data
Source section and then in the ODBC section. If the database driver does not find
a value in odbc.ini, it sets IANAAppCodePage to 4 (ISO 8859-1 Latin-1).

Table 2-2 lists values for IANAAppCodePage and the corresponding character

encodings.

Table 2-2 IANAAppCodePage values for character encoding
IANAAppCodePage value Character encoding
3 US_ASCII
4 1SO_8859_1
5 ISO_8859_2
6 ISO_8859_3
7 1SO_8859_4
8 1SO_8859_5
9 ISO_8859_6
10 1SO_8859_7

(continues)
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Table 2-2 IANAAppCodePage values for character encoding (continued)

IANAAppCodePage value Character encoding
11 ISO_8859_8

12 ISO_8859_9

13 ISO_8859_10
16 JIS_Encoding
17 Shift_JIS

18 EUC_JP

30 ISO_646_IRV
36 KS_C_5601

37 ISO_2022_KR
38 EUC_KR

39 ISO_2022_JP
40 1SO_2022_JP_2
57 GB_2312_80
104 1SO_2022_CN
105 ISO_2022_CN_EXT
109 ISO_8859_13
110 1SO_8859_14
111 1SO_8859_15
113 GBK

2004 HP_ROMANS
2009 IBM850

2010 IBM852

2011 IBM437

2013 IBM862

2024 Windows_932
2025 GB2312

2026 Big5

2027 macintosh
2028 IBM037

2030 IBM273

2033 IBM277

28 Designing BIRT Information Objects



Table 2-2 IANAAppCodePage values for character encoding (continued)

IANAAppCodePage value Character encoding
2034 IBM278
2035 IBM280
2037 IBM284
2038 IBM285
2039 IBM290
2040 IBM297
2041 IBM420
2043 IBM424
2044 IBM500
2045 IBM851
2046 IBM855
2047 IBM857
2048 IBM860
2049 IBM861
2050 IBM863
2051 IBM864
2052 IBM865
2053 IBM868
2054 IBM869
2055 IBM870
2056 IBM871
2062 IBM918
2063 IBM1026
2084 KOI8_R
2085 HZ_GB_2312
2086 IBM866
2087 IBM775
2089 IBM00858
2091 IBM01140
2092 IBM01141

(continues)
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Table 2-2 IANAAppCodePage values for character encoding (continued)

IANAAppCodePage value Character encoding
2093 IBM01142

2094 IBM01143

2095 IBM01144

2096 IBM01145

2097 IBM01146

2098 IBM01147

2099 IBM01148

2100 IBM01149

2102 IBM1047

2250 WINDOWS_1250
2251 WINDOWS_1251
2252 WINDOWS_1252
2253 WINDOWS_1253
2254 WINDOWS_1254
2255 WINDOWS_1255
2256 WINDOWS_1256
2257 WINDOWS_1257
2258 WINDOWS_1258
2259 TIS_620

About Informix database connections

Set the DELIMIDENT environment variable to y before starting the Actuate BIRT
iServer.

The Integration service cannot communicate with an Informix database if the
database character set is Unicode.

If the iServer is running on a Windows platform, the computer’s application code
page must match the DB_LOCALE of the Informix server. For example, if the
database character encoding is Japanese (Shift JIS), the application code page of
the computer on which the iServer is running must be Japanese (Shift JIS). In
other words, you must set CLIENT_LOCALE to ja_]JPsjis-s.

If the iServer is running on a UNIX platform, you must provide a value for the
IANAAppCodePage property. If you do not set IANAAppCodePage, the
database driver searches for a value in the system information file (odbc.ini), first
in the Data Source section and then in the ODBC section. If the database driver
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does not find a value in odbc.ini, it sets IANAAppCodePage to 4 (ISO 8859-1
Latin-1).

Specifying a production database schema

You can provide the name of the production database schema in a data
connection definition. Provide the name of the production database schema in the
following cases:

m The development database and the production database are identical except
for the schema name.

m  You plan to use the iServer administrator dashboard reports, so you must
provide the schema name for the PostgreSQL database.

In Schema (optional), type the schema name in the form MyCatalog.MySchema
or browse for the schema. The schema name is applied to maps of database tables
and views at runtime, overriding the schema name stored in the maps.

The schema name is not applied to maps of native SQL queries or to maps of
stored procedure result sets. The schema name in these maps must be edited
manually before you publish the project to the production volume.

Do not provide a schema name if the maps in your project use more than one
database schema.

Encrypting and decrypting data source connection
properties

You can encrypt and decrypt certain data source connection properties, for
example password, using your own encryption and decryption algorithms. You
implement encryption and decryption algorithms using an Eclipse-based OSGi
extensions framework.

Understanding the encryption extension point plug-in

The encryption extension point plug-in is installed with the following products in
the specified locations:

m BIRT Designer Professional in <Actuatell_HOME>\BRDPro\eclipse
\plugins\com.actuate.ais.encryption_<version>

m Information Object Designer in <Actuatell HOME>\IOD\plugins
\com.actuate.ais.encryption_<version>

Do not install Information Object Designer over an existing installation of
Information Object Designer; uninstall the older version of Information Object
Designer first or install Information Object Designer in a different location.
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m Actuate iServer in $Actuatell /iServer/Jar/BIRT/platform/plugins
/com.actuate.ais.encryption_<version>

The directory com.actuate.ais.encryption contains the following items:

m The file plugin.xml

m The file encryption. jar

m The directory schema, which contains the file EncryptionProviderID.exsd

To extend the encryption extension point plug-in, you must implement both the
encrypt and decrypt methods in the IEncryptionProvider interface, shown in
Listing 2-1.

Listing 2-1 The IEncryptionProvider interface

package com.actuate.ais.encryption;

/**
* This interface specifies a couple of functions that need to
* be implemented in any encryption provider implementation
*/

public interface IEncryptionProvider

/**

* Encrypt function that takes in a string value to be
encrypted. The return value is an encrypted text obtained
after applying the implementation specific encryption
algorithm.

@param value
@return

/

public String encrypt (String value) ;

/**

* Decrypt function that takes in an encrypted text string.

* %k kX F Ok

* The return value is the plain text obtained after applying
* the implementation decryption algorithm.

*

* @param value

* @return

*/

public String decrypt (String value) ;

}

The extension JAR file must be installed in one of the following locations:

m  <Actuatell_HOME>\BRDPro\eclipse\plugins if you are using the IO design
perspective in BIRT Designer Professional
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m  <Actuatell_HOME>\IOD\plugins if you are using the standalone
Information Object Designer that installs with e.Report Designer Professional

The extension JAR file must also be installed in $Actuatell/iServer/Jar/BIRT
/platform/plugins on the Actuate iServer platform.

The rest of this topic uses Information Object Designer to refer to both the 10
design perspective in BIRT Designer Professional and standalone Information
Object Designer.

When Information Object Designer is launched, it detects the encryption
extension point plug-in. This plug-in is used for all connection types, for example
Oracle and DB2. When the data modeler enters connection property values such
as username, password, host name, and port on the Data source connection
properties page, Information Object Designer determines if the property is tagged
as masked. If so, the value entered for that property is passed to the encrypt
method. The encrypt method returns the String value you programmed it to
return, and this return value is stored in the connection definition (.dcd) file. The
encrypt method is called only when the value of a masked property is modified.
When an information object is executed in Information Object Designer or on
iServer, the connection properties that are tagged as masked are read from the
DCD file and passed to the decrypt method. The decrypt method returns the
String value you programmed it to return.

You can have the encrypt method return an encrypted version of the string that a
data modeler enters on the Data source connection properties page. This
encrypted value is then stored in the DCD file and passed to the decrypt method
when an information object is executed.

You can also program the encrypt and decrypt methods to implement lookup
mechanisms to retrieve the actual property values, such as the username and
password, from an external LDAP source. The values that the data modeler enters
on the Data source connection properties page serve as tokens to identify the
actual values. This approach can handle multiple data sources.

For example, the encrypt method can simply return any string value the data
modeler provides without modification, and this token is stored in the DCD file.
So, if a data modeler enters the password for an Oracle connection definition as
Password_OracleDevelopment, the encrypt method returns
Password_OracleDevelopment, and Password_OracleDevelopment is stored in
the DCD file. When the decrypt method receives Password_OracleDevelopment,
the decrypt method logic uses this token to query an external data source or to
search a local encrypted file to retrieve the actual password.

Extending the encryption extension point plug-in

To extend the encryption extension point plug-in, you must perform the
following tasks:

m  Make the encryption extension point plug-in available to Eclipse.
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Create a plug-in project.

Include any required JAR files in the plug-in JAR file.
Select an extension point.

Create the plug-in class.

Implement both the encrypt and decrypt methods in the IEncryptionProvider
interface.

Package the plug-in.
Deploy the plug-in.

Set the Type attribute for the appropriate connection parameters to masked.

Detailed instructions for each task are provided in the following topics.

How to make the encryption extension point plug-in available to Eclipse

Copy com.actuate.ais.encryption_<version> from one of the locations where it
resides to eclipse\plugins.

How to create a plug-in project

1
2
3

In Eclipse, choose File-~New~>Project.
In New Project—Select a wizard, select Plug-in Project. Choose Next.

In New Plug-in Project—Plug-in Project, in Project name, type the name of the
project, as shown in Figure 2-15. Choose Next.
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Plug-in FProject

Create a new plug-in project

Project name: . My Encryption Impl

Use default location
ChAndrew\work\projectsh_eclipse\birtll_workspace\My Enc| Browse
Project Settings
[V] Create a Java project
Sourcefolder:  =rc
Output folder:  bin

Target Platform
This plug-in is targeted to run with:

@ Eclipse version:

(@ an 0SGi framework: | Equinox

Working sets
[] Add project to working sets

@ TN e
Figure 2-15 Typing the name of the project

4 In New Plug-in Project—Content, do the following, as shown in Figure 2-16.
Then, choose Finish.

m InID, type the name of the identifier for the plug-in and the package name
for the encryption provider class.

m In Version, type the version number for the code.
» In Name (optional), type a descriptive name for the plug-in.
m In Provider (optional), type the name of the extension’s provider.

m  Select Generate an activator, a Java class that controls the plug-in’s life
cycle.

m In Activator, type the full name of the Activator class. The package for the
class should be the same as for ID.

m  Deselect This plug-in will make contributions to the UL
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Content EJJ_ :

Enter the data required to generate the plug-in. i'

Properties

I com.example.myencryptionextension

Version: 100

Mame: My AIS Encryption Extension

Provider: My company name

Execution Environment: | JavaSE-1.6 v] | Environments...
Options

[7] Generate an activator, a Java class that controls the plug-in's life cycle

Activator:  com.example.myencryptionextension.Activator

= This plug-in will make contributions to the UI
Enable API Analysis

Rich Client Application

Would you like to create a rich client application? ) ¥es @ Np

| < Back ” Next = I | Einish ] | Cancel |

Figure 2-16 New Plug-in Project—Content
5 Confirm that you want to display the plug-in perspective.
How to include required JAR files in the plug-in JAR file
1 In the plug-in perspective, choose Dependencies.
2 In Required Plug-ins, choose Add.

3 In Plug-in Selection, select com.actuate.ais.encryption (version), as shown in
Figure 2-17. Choose OK.

If com.actuate.ais.encryption is not visible, type encryption in Select a Plug-in
to filter the list.

Select a Plug-in: -

encryption
Matching items:

Ediom.acty ate.ais.encryption (11.0.0.v20100926);

com.actuate.ais.encryption

@  —r— e

Figure 2-17 Specifying the required plug-in

com.actuate.ais.encryption appears in Required Plug-ins, as shown in
Figure 2-18.
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Required Plug-ins |

a®

Specify the list of plug-ins required for the operation of this plug-in.

P - -

sk=iorg.eclipse.core.runtime Add...

?iD\Cng acfuate ais.encryption (11.0.0)
- — — Remove

D

Total: 2

-
3
-g o

Figure 2-18 Required Plug-ins
How to select an extension point
1 Choose Extensions.
2 In All Extensions, choose Add.

3 In New Extension—Extension Point Selection—Extension Points, select

com.actuate.ais.encryption.EncryptionProviderlID, as shown in Figure 2-19.
Choose Finish.

Extension Point Selection

-
Create a new EncryptienProvider extension, lJJ

Extension Points | Extension Wizards

Extension Point filter:

={icom.actuate.ais.encryption.EncryptionProviderID;

={l org.eclipse.core.contenttype.contentTypes
= org.eclipse.core.runtime.adapters

= arg.eclipse.coreruntime.applications

=i org.eclipse.core.runtime.cententTypes

= org.eclipse.core.runtime.preferences

=i erg.eclipse.coreruntime.products

= org.eclipse.equinox.preferences.preferences

[¥] Show only extension points from the required plug-ins

Extension Point Description: EncryptionProvider

This extension point helps define a way for customers to use their own custom built
encryption algorithm for encrypting/decrypting connection parameters that are marked
for encryption

Available templates for encryptionprovidern:

IC?EI = Back Next = [ Finish ] [ Cancel ]

Figure 2-19 Selecting com.actuate.ais.encryption.EncryptionProviderID
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4 In All Extensions, expand the
com.actuate.ais.encryption.EncryptionProviderID node and select the child
entry, as shown in Figure 2-20.

All Extensions e =

Define extensions for this plug-in in the following section.

type filter text

= com.actuateais.encryption.EncryptionProviderID
[¥] com.examplemyencryptionextension.EncryptionEx

| n 3

Figure 2-20 Selecting the child entry

5 In Extension Element Details, modify the id, name, and class as shown in
Figure 2-21.

Note the name of the Java class, EncryptionProvider.

Extension Element Details

Set the properties of "EncryptionExtension”. Required fields are dencted by

id*: com.example.myencryptionextension.EncryptionExtension

name®:  com.example.myencryptionextension.EncryptionExtension

class™  .example.myencryptionextension.EncryptionProvider

Figure 2-21 Setting the properties of the extension element

6 Choose File>Save to save the plugin.xml file.

How to create the plug-in class

1 In Extension Element Details, choose the underlined class link to create the
plug-in class.

2 OnJava Class, shown in Figure 2-22, check that the class name matches the
name you provided in Extension Element Details. Choose Finish.
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Java Class j— i
Create a new Java class.

Source folder: com.example.myencryptionextension/src Browse...
Package: com.example.myencryptionextension Browse...

["]Enclosing type: Browse...
Mame: EncryptionProvider
Modifiers: @ public () default private protected
1E 34 ]| static
Interfaces: @ com.actuate.ais.encryptionEncryptionProvider Add...
Remove
Which method stubs would you like to create?
ublic static void main(String[] args)
onstructors from superclass
nherited abstract methods
Do you want to add comments? (Configure templates and default value here
[ Generate comments
e
'?,’ [ Finish ] | Cancel ]

Figure 2-22 Checking the class name

Eclipse creates a stub class, shown in Figure 2-23, that contains the encrypt
and decrypt methods.

-ﬂ} com.example.myencryptionextension [J] EncryptionProviderjava %

package coOl.example.myvencrvptionextension;
import com.actuate.ais.encryption.IEncryptionProvider:

public class EncryptionProvider implements IEncryptionProvider {

£ public String decrypt(String argl) {

i [/ TODC -generated method stub

%

-2 public S5tring encrypt (String argld) {

-l J/ TODD A
return null;

generated method stub

Figure 2-23 Stub class
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How to implement the encrypt and decrypt methods

The code in Listing 2-2 implements AES 128-bit encryption. Test the encryption
and decryption code in Eclipse. The Activator class, created by Eclipse, must exist
in the plug-in.

Listing 2-2 Implementing the encrypt and decrypt methods

package com.example.myencryptionextension;

import javax.crypto.Cipher;

import javax.crypto.spec.SecretKeySpec;

import sun.misc.BASE64Decoder;

import sun.misc.BASE64Encoder;

import com.actuate.ais.encryption.IEncryptionProvider;

public class EncryptionProvider implements IEncryptionProvider {

private final byte[] key = {—OX6A, 0x6D, 0x49, -0x05, 0x79,
0x38, 0x48, -0x0C, Ox6A, 0x19, 0x46, O0Oxl1lE, -0x09, -0x5E,
-0x2F, 0x17};

private Cipher getCipher (int mode) {

Cipher cipher = null;

SecretKeySpec keyspec = new SecretKeySpec (key, "AES") ;

try {
cipher = Cipher.getInstance ("AES/ECB/PKCS5Padding") ;
cipher.init (mode, keyspec) ;

} catch (Exception ex) {}

return cipher;

}

@Override
public String decrypt (String encryptedString) {

String decryptedString = null;

try {
if (encryptedString == null) return null;
if ("".equals (encryptedString)) return "";

byte[] encryptedBytes = new
BASE64Decoder () .decodeBuffer (encryptedString) ;
Cipher cipher = getCipher (Cipher.DECRYPT MODE) ;
byte[] raw = cipher.doFinal (encryptedBytes) ;
decryptedString = new String(raw) ;
} catch (Exception ex) {}

return decryptedString;
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@Override
public String encrypt (String plainText) {

String encryptedString = null;

try {
if (plainText == null) return null;
if ("".equals(plainText)) return "";

Cipher cipher = getCipher (Cipher.ENCRYPT MODE) ;
byte[] raw = cipher.doFinal (plainText.getBytes()) ;
encryptedString = new BASE64Encoder () .encode (raw) ;

} catch (Exception ex) {}

return encryptedString;

}

How to package the plug-in
1 Open plugin.xml.

2 Choose Overview.

3 In Exporting, shown in Figure 2-24, choose Export Wizard.

Exporting

To package and export the plug-in:
1. Organize the plug-in using the Drganize Manifests Wizard

2. Externalize the strings within the plug-in using the Externalize Strings
Wizard

3. Specify what needs to be packaged in the deployable plug-in on the
Build Configuration page

4, Exportthe plug-inin a format suitable for deployment using the
Export Wizard

Figure 2-24 Choosing Export Wizard

4 In Destination, type or browse to the directory in which to save the plug-in
library, as shown in Figure 2-25. Choose Finish. The plug-in is packaged in a
JAR file in /plugins in the directory you specify.
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Deployable plug-ins and fragments mﬂ:}__
Export the selected projects into a form suitable for deploying in an Eclipse product o ]
P
HAvailable Plug-ins and Fragments:
[¥] == com.example.myencryptionextension (1.0.0) Select All
Deselect All
Working Set...
1 of 1 selected.
QEStiﬂﬂtiUﬂ| gptionsl JAR Signing
@ Directory:
c\projects\myencryptionextension hd Browse...
() Archive file:
Browse...
() Install into host. Repository:
Browse...
e
@ [ Finish ][ Cancel |

Figure 2-25 Specifying the directory in which to save the plug-in library

How to deploy the plug-in

1 Place the plug-in JAR file in $Actuatell/iServer/Jar/BIRT /platform/plugins.
If you are using an iServer cluster, repeat this step for each iServer in the
cluster.

2 Do one of the following:

m If you are using the IO design perspective in BIRT Designer Professional,
place the plug-in JAR file in <Actuatell_HOME>\BRDPro\eclipse
\plugins.

m If you are using standalone Information Object Designer, place the plug-in
JAR file in <Actuatell_HOME>\IOD\plugins.
3 Restart iServer and BIRT Designer Professional or Information Object
Designer for the plug-in to take effect.
How to set the Type attribute to masked

Set the Type attribute for an encrypted connection property to masked in the
appropriate ConnectionParam element in $AC_SERVER_HOME/etc
/intsrvrsources.xml or PAC_SERVER_HOME/ etc/data_integration
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/datasources.xml. For example, in the following code, the Type attribute for the
password property is set to masked:

<ConnectionParams>
<ConnectionParam Name="username"
Display="User name"
Type="string">
</ConnectionParam>
<ConnectionParam Name="password"
Display="Password"
Type="masked" >
</ConnectionParams>

</ConnectionParams>

Troubleshooting an encryption extension

Plug-in loading errors are logged in the Information Object Designer log file. To
display the log file, do one of the following:

m If you are using the IO design perspective in BIRT Designer Professional,
choose Help>About Actuate BIRT Designer Professional>Installation
Details>Configuration>View Error Log.

m If you are using standalone Information Object Designer, choose Help>About
Information Object Designer--Installation Details->Configuration->-View
Error Log.

On the Actuate iServer platform, plug-in loading errors are logged in $Actuatell
\Jar\BIRT \ platform\configuration on Windows platforms and in $Actuatell
/iServer /jar/BIRT /platform/configuration on UNIX platforms.

Alternatively, decorate the Activator.start() and Activator.stop() methods with
System.out statements to ensure that the plug-in is loaded. When the plug-in is
loaded, debug statements appear on the console.

Externalizing data source connection properties

You can externalize data source connection properties rather than embed them in
the data connection definition (.dcd) file. If you externalize data source
connection properties, you can move an information object project from one
environment to another, for example, from a development environment to a test
environment, without modifying the .dcd file. There are two ways to externalize
data source connection properties:

m Passthrough security
To enable passthrough security:
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m  Set the .dcd file’s Credentials property to Passthrough.

m  Using Management Console, set the data source connection properties.

For more information about setting data source connection properties
using passthrough security, see Managing an Encyclopedia Volume.

m The data source connection configuration file

Data source connection property values specified using passthrough security take
precedence over data source connection property values in the data source
connection configuration file. ODA connections do not support passthrough
security.

About the data source connection configuration file

You can use the iServer data source connection configuration file to externalize
data source connection properties. This file is also used by Actuate Basic report
executables and Actuate Analytics cube profiles. A set of connection properties
appears in a ConnectOptions element in the configuration file’s Runtime element,
for example:

<Runtime>

<ConnectOptions Type="My DB2 Connection'>
<Property PropName="server">My DB2 Server</Propertys>
<Property PropName="database">My DB2 Database</Propertys>
<Property PropName="username">My DB2 User</Propertys>
<Property PropName="password"sMy DB2 Password</Propertys>
<Property PropName="port">50000</Property>
<Property PropName="appcodepage">3</Property>
</ConnectOptions>

</Runtime>

The password is not encrypted.

You can create an entry for a new data source connection or add connection
properties to an existing entry. For information about creating a ConnectOptions
element, see one of the following topics:

m Externalizing connection properties for a preconfigured connection type
m Externalizing connection properties for other connection types
m Externalizing connection properties for an ODA connection type

In each case, you must first locate the file in which the connection properties are
configured.

The configuration key specified in the .dcd file must match the Type attribute for
the ConnectOptions element. In Figure 2-26, the configuration key matches the
Type attribute in the ConnectOptions element above.
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To locate the data source connection configuration file, check the setting of
Configuration file for database connections and search path using Management
Console. For more information about this configuration variable, see Configuring
BIRT iServer.

Externalizing connection properties for a
preconfigured connection type

The connection properties for the following connection types are preconfigured in
the file PAC_SERVER_HOME/ etc/intsrvrsources.xml:

s DB2

m Informix

m  MySQL Enterprise
m Oracle

m PostgreSQL

m SQL Server

m Sybase
= =T
Data Connection Definition R
Create a data connection definition. =
Mame: IMy_DEZ_Database
Type: |REEE =l
Description: ﬂ
Configuiation key: |My_DEZ_Connection —Configuration key
must match Type
attribute
(7 Cancel

Figure 2-26 Selecting a configuration key

For example, the connection properties for the DB2 connection type are:
m server

m database

m username

m password
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m  port
m appcodepage
The connection properties are configured as follows:

<ConnectionType Name="DB2">

<ConnectionParams>
<ConnectionParam Name="server"
Display="Server"
Type="string"
ValueIsCaseSensitive="false" />
<ConnectionParam Name="database"
Display="Database"Type="string"
ValueIsCaseSensitive="false" />
<ConnectionParam Name="username"
Display="User name"
Type="string" />
<ConnectionParam Name="password"
Display="Password"
Type="masked" />
<ConnectionParam Name="port"
Display="Port"
Type="integer"
Optional="true"
DefaultValue="50000" />
<ConnectionParam Name="appcodepage"
Display="IANAAppCodePage"
Type="integer"
Optional="true"
Defaultvalue="" />
</ConnectionParams>
</ConnectionType>

To externalize the connection properties for a DB2 connection, add a
ConnectOptions element to the data source connection configuration file’s
Runtime element, for example:

<Runtime>

<ConnectOptions Type="My DB2 Connection"s>
<Property PropName="server">My DB2 Server</Propertys>
<Property PropName="database">My DB2 Database</Propertys
<Property PropName="username">My DB2 User</Propertys>
<Property PropName="password">My DB2 Password</Propertys

46 Designing BIRT Information Objects



<Property PropName="port">50000</Property>
<Property PropName="appcodepage">3</Propertys>
</ConnectOptions>

</Runtime>

The property names listed in the ConnectOptions element must match the
connection parameter names listed in the ConnectionParams element in
intsrvrsources.xml. The match is case-sensitive.

Externalizing connection properties for other
connection types

In addition to the preconfigured connection types in intsrvrsources.xml, you can

configure the connection properties for other connection types in the file
$AC_SERVER_HOME/ etc/data_integration/datasources.xml, for example:

<ConnectionType Name="My Database">
<ConnectionParams>
<ConnectionParam Name="database"
Display="Database"
Type="string"
ValueIsCaseSensitive="false" />
<ConnectionParam Name="username"
Display="User name"
Type="string" />
<ConnectionParam Name="password"
Display="Password"
Type="masked" />
</ConnectionParams>
</ConnectionType>

To externalize the connection properties for a connection of this type, add a
ConnectOptions element to the data source connection configuration file’s
Runtime element, for example:

<Runtime>

<ConnectOptions Type="My Database Connection"s>
<Property PropName="database">My Database</Property>
<Property PropName="username">My Database User</Propertys>
<Property PropName="password'">My Database Password
</Property>
</ConnectOptions>

</Runtime>
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The property names listed in the ConnectOptions element must match the
connection parameter names listed in the ConnectionParams element in
datasources.xml. The match is case-sensitive.

Externalizing connection properties for an ODA
connection type

The connection properties for an ODA connection type are configured in the
plugin.xml file for the appropriate Eclipse plug-in. For example, the connection
properties for the XML connection type are configured in the plugin.xml file
bundled in org.eclipse.birt.report.data.oda.xml_xxxx.jar. This JAR file is located
in $Actuatell /Jar/BIRT /platform/plugins. To extract plugin.xml, type:

jar xvf org.eclipse.birt.report.data.oda.xml xxxx.jar plugin.xml
The JDK must be in your path.

The connection properties for the XML connection type, FILELIST and
SCHEMAFILELIST, are configured as follows:

<propertiess>
<propertyGroup
defaultDisplayName="Connection Properties"
name="connectionProperties">
<property
type="string"
defaultDisplayName="%datasource.property.xmlFile"
canInherit="true"
name="FILELIST"/>
<property
type="string"
defaultDisplayName="%datasource.property.schemaFile"
canInherit="true"
name="SCHEMAFILELIST" />
</propertyGroup>
</properties>

To externalize the connection properties for an XML connection, add a
ConnectOptions element to the data source connection configuration file’s
Runtime element, for example:

<Runtime>
<ConnectOptions Type="My XML Connection"s>
<Property PropName="FILELIST">My XML File</Propertys
<Property PropName="SCHEMAFILELIST">My XML Schema</Propertys>

</ConnectOptions>

</Runtime>
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The property names listed in the ConnectOptions element must match the
property names listed in the properties element in plugin.xml. The match is
case-sensitive.

Creating maps
A map represents one of the following:
m A database table
m A database view
m A query written in the database’s native SQL
m A result set from a stored procedure
m A result set from an ODA data source query
A map file name has an .sma extension. Map file names are not case-sensitive.

You can create column categories for maps of database tables and views. For
other map types, build an information object from the map using the graphical
information object editor and create column categories for the information object.

Creating a map of a database table or view

When you create a map of a database table or view, Information Object Designer
places the map file in the same folder as the data connection definition (.dcd) file
for the database. For example, Figure 2-27 shows that if you create a map of the
table MyTable in the database MyDatabase, Information Object Designer places
the file MyTable.sma in the folder MyDatabase.

T Mavigator 23 =0

B

E-52 MyPraject
- Data Souices
<= MyDatabaze
@ _MyDastabase.dcd
H % by T able. sma
~[#= Information Objects

—— Map file

Figure 2-27 Location of a map file for a database table or view
How to create a map of a database table or view
1 In Navigator, select the appropriate project.
2 Choose File>New>Map.
3 In New Maps—Data Source:
m Select the appropriate data source.

m  Select Create maps by selecting database tables, as shown in Figure 2-28.
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= S

Data Source Ef

Select a data zource for the maps.

Data sources:

+ Create maps by selecting database tables
€~ Create maps by selecting stored procedures

" Create a map by entering the native query string

(7] < Back I Mest > I Einish | Cancel |
Figure 2-28 Creating a map by selecting database tables
Choose Next.

4 In New Maps—Maps:
m In Catalog, select the appropriate catalog.
m In Filter:

o To display tables and views from a particular schema, type the first few
characters of the schema name in Schema name prefix, for example,
dbo. Do not append an asterisk, for example, dbo*. This filter is
case-sensitive.

o To display only tables and views whose names begin with a particular
string, type the string in Table/View name prefix, for example, ac. Do
not append an asterisk, for example, ac*. This filter is case-sensitive.

o Select Show tables only, Show views only, or Show all.
a Choose Apply filter.

= Move the appropriate tables and views from Available to Selected, as
shown in Figure 2-29.

Choose Finish.
A reminder appears. Choose OK.

The map file names appear in Navigator. If you created only one map, Output
Columns appears.
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Maps — j
Aipply a fiker to display tables and views. Then select tables and views to create rL
maps

Diata zaurce tyDatabase
Catalog: IAcTestDB_austr j
Available Selected
E‘ﬂ;:l AcTestDB_austr = i dbo. custamers
=85 dbo N | 5 dho.orders
|: # hcSpecialChar @ %dbo.items
|: AcTestDatatppes
|: Ac_Mull_Datatypes B |
|: Autojoinl
|: Avtojoin
|: Create
|: acDatal ypes
-] aclongNVARCHAR < |
|: aclongy/ archar
-] case <« |
’_ custormers ol
4 I I »
r Filter
Schema name prefis: dbo & Show tables only
TableView name prefis: I € Show views only
Apply filter | " Show all

%) <Back | wess || Ensh | Cancel |
Figure 2-29 Selecting tables

5 If you created more than one map, double-click the first map file name in
Navigator to display Output Columns.

6 In Output Columns:

m  Deselect the columns you want to exclude from the map.

m Torename a column, type the new name in Name.

Decide on column names before you build an information object from the
map. Changing a column name after you build an information object
results in a compiler error in the information object.

m Tocreate a filter on a column, set the column’s Filter property to Predefined
and choose Prompt editor to specify the filter’s prompt properties.
Figure 2-30 shows Output Columns and the location of the Prompt editor
button for the first column.

To define other column properties, select the column and define the
properties in Properties.

To create column categories, choose Column Categories.

m To change the order of the columns, use Move up and Move down.
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Output Columns
Specify output columng: Shaw map properties
| Source column | Name | Data lypel Prompt Ed\lU[I

custD custD Integer —— Choose Prompt
contact_last cantact_last “Yarchar é editor to Specify
coantact_first cantact_first Yarchar .
customM ame custornM ame Varchar prompt propertles
phone phane Varchar

address address Varchar ;I

city city Vachar

state state Varchar ok =l

postalcode postalcode Varchar Lk

creditrank creditrank Varchar Lk

purchaseFrequency | purchaseFrequency  Varchar L

purchazelolume purchaseWolume Varchar Lk

repll repll Integer [k

Figure 2-30 Columns created by selecting database tables

7 Repeat the previous two steps for the remaining maps, if any.

Updating a map of a database table or view
In a database, a table or view can change in the following ways:
m A column is renamed.

m A column’s data type changes.

m A column is added to the table or view.

m A column is dropped from the table or view.

Information Object Designer can detect these changes and update the map of the
table or view. You can update a single map, or update several maps at once.

Map column name and data type changes are propagated to dependent
information objects if the information object column uses the default name. If the
name change would result in a duplicate information object column name, a
suffix is added, for example creditLimit_1. A column name is updated in the
following tabs in the graphical information object editor if it does not appear in
an expression:

m  Columns

m  Column Categories
m Joins

m Filters

m  Group By

A column name in an expression, for example SUM(quantityOrdered *
priceEach), is not updated. If the information object column name has been
modified, changes are not propagated.
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A column that is added to a map is also added to dependent information objects
as a source column. The column is not added to the information object’s SELECT
clause. In other words, the column appears in the upper pane of the graphical
information object editor, but it is unchecked.

A column that is dropped from a map is not dropped from dependent
information objects by default. You must indicate that the column should be
dropped. Because this action cannot be undone, back up the project before
proceeding.

Map changes are also propagated to dependent cache objects.

How to update a map
1 In Navigator, right-click the map file name and choose Update Map.
2 In Database Changes:

m To display the data type for a dropped or added column, hover the cursor
over the column name in Dropped Columns or Added Columns.

m  For renamed columns, drag the old column name from Dropped Columns
to Old Column Name. Then drag the new column name from Added
Columns to New Column Name. For columns whose data type has
changed, the Old Column Name may be the same as the New Column
Name. To remove a renamed column pair, choose Remove.

In Figure 2-31, the name of the customerID column has changed to
customerNumber. The data type of the creditLimit column has changed
from Decimal to Double.

= o/

Select the columns that have been renamed far AMyProject/Data Sources/MpD atabasze/dbo. Customers.sma

Dropped Columng: Added Colunins:

I creditH ank salesH epE mplayesMumber
¥ Propagate diopped column changes to dependent filss

Fienamed Columns:

0ld Colurmn Mame | Mew Calumn Mame |
customer| D customertumber
creditLimit creditLimit

Remove |

A renamed column appears ag a dropped column uging the old name and an added column using the new name. Ta
indicate that a column has been renamed, diag a Dropped Column from it list into the table under Old Column Mame.
Then drag the comesponding Added Column fram its list into the table under Mew Calumn Mame. This will allow 100
to update the project with the renamed column corectly.

'@:‘ < Back | Mext > | Finizh I Cancel |

Figure 2-31 Map column changes

m  To remove dropped columns from dependent information objects, select
Propagate dropped column changes to dependent files. If the warning
shown in Figure 2-32 appears, choose OK.
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Figure 2-32 Dropped column propagation warning
= Choose Next.

3 Because these changes cannot be undone, review them carefully. If the changes
are acceptable, choose Finish. If not, choose Back and make the necessary
corrections. Figure 2-33 shows a summary of changes for the Customers map
and its dependent information object, MyInformationObject.

-

A description of all the changes that will be made ta this project iz available below. These changes cannot
be undone after the operation completes.

]

| cBock | tewr [ Fosh | Concol |

Figure 2-33 Summary of changes for Customers and MylnformationObject

How to update several maps at once

1 In Navigator, right-click the folder that contains the maps or any of its parent
folders and choose Update Maps.

2 In Database Changes, select the maps to update, as shown in Figure 2-34. To
select all the maps in a folder, select the folder. To have Information Object
Designer automatically detect which maps need updating, choose Auto
Detect. The Auto Detect operation may take a few moments. Choose Next.
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- =

Select the Skas to remap. Use the auto detect button to avtomatically determine which Skas need to be remapped.

E-E = MyDatabase
| @j dbo.Customers.sma
O dbo Emplayees sma
-0 & dbo.Offices.sma
| E'lg dbo.OrderD etails sma
O Eﬂ dbo.Orders.sma
a ?ﬂ dbo.Payments.sma
-0 @j dbo. Products. sma

Auta Detect

(?) < Back | Mext > | Finigh | Cancel |

'

Figure 2-34 Selecting maps to update

3 For each map that needs updating, make the necessary changes and choose
Next.

4 Review your changes carefully. If they are acceptable, choose Finish.

Creating a map of a native SQL query

You can map a query written in the database’s native SQL. When writing the
query, observe the following rules:

m  Write the query using only the database’s native SQL; do not use Actuate SQL
functions or syntax.

m Do not include an ORDER BY clause in the query. Including an ORDER BY
clause adversely affects the performance of information objects built from the
map.

m  Use unnamed parameters. An unnamed parameter is represented by a
question mark (?). Do not use named parameters, for example :BeginDate.

If the query uses a parameter, it may be necessary to cast the parameter to the
appropriate data type. For example, if the query queries an Oracle database, you
must use the CAST or RPAD functions to ensure that the data type and length for
a string parameter match the data type and length for the corresponding column
if the column is of type CHAR or NCHAR. For example, in the following queries
the category column is of type CHAR(12):

SELECT orderID FROM items WHERE category
CHAR(12) )

CAST ( ? AS

SELECT orderID FROM items WHERE category

RPAD ( 2, 12 )

How to create a map of a native SQL query
1 In Navigator, select the appropriate project.
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2 Choose File>New>Map.
3 In Data Source:
m Select the appropriate data source.

m  Select Create a map by entering the native query string, as shown in
Figure 2-35.

Choose Next. Map appears.

Data Source

Select a data zource for the maps.

Figure 2-35 Creating a map by entering a native query string

4 Type a map name, as shown in Figure 2-36.

Map
Create & new map resource

MySOLap

Figure 2-36 Specifying a map name
Choose Finish.
The map file name appears in Navigator.
5 In the textual query editor:
» In the upper pane, type or paste the native SQL query.

m In the lower pane, choose Describe Query.
The query’s output columns appear.

m To rename a column, type the new name in Output column.
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Decide on column names before you build an information object from this
map. Changing a column name after you build an information object
results in a compiler error in the information object.

m If necessary, choose the correct data type from the Data type drop-down
list.
The Actuate SQL data type must be compatible with the native SQL data
type.

m To create a filter on a column, set the column’s Filter property to Predefined

and specify the filter’s prompt properties. Figure 2-37 shows Columns and
the location of the Prompt editor button for the first column.

3 _MyDatabase.ded ‘ % dbo.customers. sma [%MySQLMap.sma B2
SELECT AcTestDE,dbo,customers, custonmiame ;I

FROM AcTestDB. dbo, customers
WHERE AcTestDE. dbo.custormers. creditrank LIKE ?

g of

Columns

Describe Buery Shaw map properties

| Source name' Output column | Data typal Prampt editor
customMame  customMame  Varchar Y Choose Prompt

editor to specify
prompt properties

ColumnsJ Parameters |

Figure 2-37 A native SQL query and corresponding Columns page

To define other column properties, select the column and define the
properties in Properties.

m  Choose Parameters.
The query’s parameters appear.

m Torename a parameter, type the new name in Parameter.

Information Object Designer assigns a default name to a parameter based
on its position in the query, for example, param_1.

m If necessary, choose the correct data type from the Data type drop-down
list.
The Actuate SQL data type must be compatible with the native SQL data

type.
m In Default value, type the parameter’s default value.
Do not create an expression.

m To specify the parameter’s prompt properties, choose Prompt editor.
Figure 2-38 shows Parameters and the location of the Prompt editor button
for the first parameter.
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To define other parameter properties, select the parameter and define the
properties in Properties.

3 _MyDatabase.ded ‘ % dbo.customers. sma [% Myp50LMap.sma & L

SELECT AcTestDE,dbo.customers, customiame ;I
FROM AcTestDE. dbo,customers

WHERE AcTestDE. dbo.custormers. creditrank LIKE ? _lj
A v

Parameters

Describe Buery |
F‘ositionl Parameter | Data typel Default valuel Prrompt editor
’ 1

parar_ 1 Warchar A Lk —— Choose Prompt
editor to specify
prompt properties

Columres [ F‘arameters]

Figure 2-38 A native SQL query and corresponding Parameters page

Creating a map of a stored procedure result set

When you create a map of a stored procedure result set, Information Object
Designer creates a subfolder in the folder that contains the data connection
definition (.dcd) file for the database. The subfolder contains an .epr file as well as
the .sma file. The .epr file specifies:

m The statement that calls the stored procedure

m The stored procedure’s input and input/output parameter values and data
types
m The stored procedure’s output parameters

The stored procedure’s input and input/output parameters are associated with
the result set map. In other words, when you build an information object from the
result set map, these parameters are source parameters. The parameter values
provided by a result set map user must yield the same result set metadata as the
parameter values you provide when you create the map. In other words, the
result set map must have the same columns and data types at run time as it does
at design time.

The names of the subfolder and the .epr file are derived from the name of the
stored procedure. For example, you are working with a stored procedure called
MyStoredProcedure in a database called MyDatabase. As shown in Figure 2-39, if
you create a map of a result set called MyResultSet, Information Object Designer
places the files MyResultSet.sma and _MyStoredProcedure.epr in a subfolder of
MyDatabase called MyStoredProcedure.

If you create another result set map for MyStoredProcedure, Information Object
Designer creates a subfolder called MyStoredProcedure_1 and an .epr file called
_MyStoredProcedure_1.epr. If you create a third result set map for
MyStoredProcedure, Information Object Designer creates a subfolder called
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MyStoredProcedure_2 and an .epr file called _MyStoredProcedure_2.epr, and
SO on.

T3 Mavigator 2@] ‘ =5 7 ==

E@ MyPraject

B2 Data Sources

: B MyDatahase

== MyStoredProcedure
& _MyStoredProcedure epr
L MyResultSet sma

— .epr file
— Map file

@ _MuDatabase.ded
(22 Information Dbjscts

Figure 2-39 Location of the .epr file and map file for a stored procedure

Information Object Designer does not distinguish between stored procedures that
have the same name but different parameters (overloaded stored procedures).
DB2 and Informix databases support overloaded stored procedures. To work
with overloaded stored procedures, rename each stored procedure so that it has a
unique name. If you cannot rename a stored procedure, create another stored
procedure with a unique name that calls this stored procedure.

If you are working with a stored procedure in a Sybase database that has an
output parameter, change the output parameter to an input/output parameter
and provide a dummy value in Parameters For Stored Procedure.

How to create a map of a stored procedure result set
1 In Navigator, select the appropriate project.
2 Choose File~New>Map.
3 In Data Source:
m Select the appropriate data source.

m  Select Create maps by selecting stored procedures, as shown in Figure 2-40.

Data Source < :
Select a data source for the maps. l’

Data sources:

" Create maps by selecting database tables
% Create maps by selecting stored procedures

€~ Create a map by entering the native query string

(7 <Back [ Mets | Eesh | Cancel |
Figure 2-40 Creating a map by selecting a stored procedure
Choose Next.
4 In Maps:

m In Catalog, select the appropriate catalog.
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= In Filter:

o To display stored procedures from a particular schema, type the first
few characters of the schema name in Schema name prefix, for example,
dbo. Do not append an asterisk, for example, dbo*. This filter is
case-sensitive.

[

To display only stored procedures whose names begin with a particular
string, type the string in Stored procedure name prefix, for example, ac.
Do not append an asterisk, for example, ac*. This filter is case-sensitive.

o Choose Apply filter.

m  Move the appropriate stored procedure name from Available to Selected.
Parameters For Stored Procedure appears.

®» In Parameters For Stored Procedure:

o In Statement, shown in Figure 2-41, correct the syntax if it is incorrect.

If you are using a configurable database type, check your JDBC driver
documentation for the correct syntax.

Statement:

I{ 7 =cal EIITESTDE.dbo. 5P_CUSTOMERS_ORDERS:1(?. 71

Figure 2-41 Correcting the syntax

In Parameters, for the stored procedure’s input and input/output
parameters:

[m]

o If necessary, choose the correct data type for each parameter from
the Data type drop-down list. The Actuate SQL data type must be
compatible with the native SQL data type.

[

If necessary, choose the correct parameter mode for each parameter
from the Parameter mode drop-down list.

o Type the values, as shown in Figure 2-42.

Choose OK. The name of the stored procedure appears in Selected, as
shown in Figure 2-43.

llﬂame . Data Type Parameter Mode Walle
@RETURN_VALLE IInlegel j IDutpul j
@Cry IVarchar j IInpul j |NYEI
@TOTAL_ORDERS Ilntegel j ||npu, j |1

Figure 2-42 Specifying parameter values for a stored procedure
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Maps

Apply a fiker to display stored procedures. Then select stored pracedures ta create maps.

ENTESTDE

B33 ENTESTDB
-8 dho
{ ¥ ACSP_SALESDETAILT
{3} SP_CUSTOMER
{} SP_CUSTOMERS_ORDERS
{>
{} dt_checkoutobject_u;1

Figure 2-43 Result of specifying input parameters for a stored procedure
Choose Next.
5 InMaps:

= Move the appropriate result set from Available to Selected.
Result Set Name appears.

m In Name, type the name of the result set, as shown in Figure 2-44.

=
fAuR esultS et

_ ok | ool |

Figure 2-44 Naming the stored procedure’s result set

Choose OK. The result set name appears in Selected. The result set
columns appear in Data column preview, as shown in Figure 2-45.

Choose Finish. A reminder appears. Choose OK.

The .epr and .sma file names appear in Navigator.
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Maps

Select and name a map to use as the result set.

Resultgetl

CREDITRANE.
PURCHASEFREQUEMCY
FURCHASEYOLUME
REFID

Figure 2-45 Viewing the list of result set columns
6 In Output Columns:

m Torename a column, type the new name in Name.

Decide on column names before you build an information object from this
map. Changing a column name after you build an information object
results in a compiler error in the information object.

m If necessary, choose the correct data type from the Data type drop-down
list.
The Actuate SQL data type must be compatible with the native SQL data
type.

m To create a filter on a column, set the column’s Filter property to Predefined
and choose Prompt editor to specify the filter’s prompt properties.

Figure 2-46 shows Output Columns and the location of the Prompt editor
button for the first column.

To define other column properties, select the column and define the
properties in Properties.
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Output Columns
Specify output columng: Shaw map properties
| Source column | Name | Data lypel Prompt Ed\lU[I
custD cugtlD Integer k) ——Choose PI’Ompt
contact_lrast contacl_:tast :arc:ar é editor to Specify
contact_first contact_first archar .
customM ame custornM ame Varchar prompt propel‘tles
phone phane Varchar
address address Varchar
city city Vachar
state state Varchar ok
postalcode poztalcode Varchar Lk
creditrank creditrank Varchar Lk
purchaseFrequency | purchaseFrequency  Varchar L
purchazelolume purchaseWolume Varchar Lk
repll repll Integer [k

Figure 2-46 Columns created by the selected result set of a stored
procedure

How to modify an .epr file for a stored procedure
1 In Navigator, double-click the appropriate .epr file.

2 In General:

m  In Query text, correct the syntax if it is incorrect.

If you are using a configurable database type, check your JDBC driver
documentation for the correct syntax.

m In Description, type a description for the stored procedure, as shown in
Figure 2-47.

General

Cluery text
7= cal EITESTDE dbo 6F_CUSTOMERS_ORDERSAD, 7

L]

Drescription:

Customers and orders

|
|

Figure 2-47 Providing a description of a stored procedure
3 Choose Parameters.
The stored procedure’s parameters appear.

4 In Parameters:

m Torename a parameter, type the new name in Parameter.

Information Object Designer assigns a default name to a parameter based
on its position in the statement, for example param_1.

m If necessary, choose the correct Actuate SQL data type from the Data type
drop-down list.
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The Actuate SQL data type must be compatible with the native SQL data

type.

m In Default value, type the parameter’s default value.
Do not create an expression. You cannot type a default value for an output

parameter.

m To specify the parameter’s prompt properties, choose Prompt editor.
Figure 2-48 shows the Parameters pane and the location of the Prompt
editor button for the first column.

Parameters

Parameter | Diata type | Diefault value | Prrompt editor

param_0 Integer

param_1 Warchar MY T N ——Choose Prompt
param_2 Integer 1 53 editor to specify

prompt properties

Figure 2-48 Specifying prompt properties for a stored procedure’s

parameters

To define other parameter properties, select the parameter and define the
properties in Properties.

Creating a map of an ODA data source query result
set

When you create a map of an ODA data source query result set, Information
Object Designer creates a subfolder in the folder that contains the data connection
definition (.dcd) file for the ODA data source. The subfolder contains an .epr file
as well as the .sma file. The .epr file specifies:

m The ODA data source query
m The query’s input and input/output parameter values and data types
m  The query’s output parameters

The result set map represents the first result set returned by the ODA data source
query. The query’s input and input/output parameters are associated with the
result set map. In other words, when you build an information object from the
result set map, these parameters are source parameters. The parameter values
provided by a result set map user must yield the same result set metadata as the
parameter values you provide when you create the map. In other words, the
result set map must have the same columns and data types at run time as it does
at design time.

The names of the subfolder and the .epr file are derived from the name you
provide for the query. For example, you are working with an ODA data source
called MyODADataSource. As shown in Figure 2-49, if you create a map of a
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query result set called MyResultSet, Information Object Designer places the files
MyResultSet.sma and _MyODADataSourceQuery.epr in a subfolder of
MyODADataSource called MyODADataSourceQuery.

TT. Mavigatar E@l | — ]

E]ﬁ tyProject
B2 Data Sources
| B MyDDADataSouice
= tyODAD ataS aurcelluery

% MyResultSet. sma
L B _Mu0DAD ataSouee. dod
o Information Objects

~I{Gh _MyODADataS aurceQuen.epr 7 .€PI file

— Map file

Figure 2-49 Location of the .epr file and map file for an ODA data source

How to create a map of an ODA data source query result set

1 In Data source connection properties, choose Map tables.

2 In Maps:

m In Name, type a name for the ODA data source query.

m In Type, select a data set type from the drop-down list, as shown in

Figure 2-50.

Choose Next. The ODA data source query builder appears. For example,
for a flat file data source, Select Columns appears.

=4
Maps

Select a name and a type for this map

=10] x|

e

Name IM_!,ID DAD ata5 ourceluery

Type IF\at File Data Set

kd

(7 < Back I Mest > I Finish

Cancel |

Figure 2-50 Selecting a data set type for a map on an ODA data source

3 In the ODA data source query builder, build a query. The procedure for
building a query varies by the type of ODA data source. For flat file data
sources, you select columns, as shown in Figure 2-51.

Choose Finish. A reminder appears. Choose OK.

The .epr and .sma file names appear in Navigator.

4 In Output Columns:

m Torename a column, type the new name in Name.
Decide on column names before you build an information object from this
map. Changing a column name after you build an information object
results in a compiler error in the information object.
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Select Columns

Select the file and the columns for the data set

REFID

Figure 2-51

RANEK

CR RANE

ASEFREQL... | PURCHASEFREQU...

IREFID

ASEVOLUME | PURCHASEVOLUME

Selecting columns from a flat file data source

m To create a filter on a column, set the column’s Filter property to Predefined
and choose Prompt editor to specify the filter’s prompt properties.
Figure 2-52 shows the Output Columns pane for a map using an ODA data

source.

Output Columns

Specify output colurns:

|
|
w
1

)
contact_last contach_last Vachar
contact_first contactfirgt Varchar ok
cuztomM ame cugtom ame Varchar Lk
phone phone Varchar Rk
addresz address Varchar Lk
city city Varchar Lk
state state Varchar Lk
postalcode postalcode Varchar
creditrank creditrank. Varchar
purchaseFrequency | purchaseFiequency | Varchar
purchazelolume purchaset/olume Varchar ok
1eplD 1eplD Integer [

Figure 2-52

——Choose Prompt

editor to specify
prompt properties

Viewing the output columns for a map using an ODA data

source

To define other column properties, select the column and define the
properties in Properties.

How to modify an .epr file for an ODA data source query

1 In Navigator, double-click the appropriate .epr file.

2 In General:
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m  To modify the query in Query text, choose Query Builder.

m In Description, type a description for the query.

Figure 2-53 shows General with a description of the query and the Query
Builder button.

Choose Query Builder
/to modify the query
A

General

Query text:

select"CUSTID", "CONTACT_LAST", "COMNTACT_FIRST", "CUSTOMNAME", "PHONE", " ;I
ADDRESS' "CITY", STATE "POSTALCODE ", "CREDITRANK", PUHEHASEFHEGUENCY" "
PURCHASEYOLUME", "REPID" fram CUSTOMERS. csv : {'CLSTID" "CUSTID" STRING "
COMNTACT_LAST", CDNTACT LAST" STRING"CONTACT_FIRST","CONTACT_FIRST" STRING."
CUSTDMNAME CUSTDMNAME  STRING:PHONE" "PHOME" 5TRING: ADDHESS "ADDRESS

" STRIMG"CITY" "CITY" STHING STATE""STATE" STRINGPOSTALCODE", F‘DSTALCDDE
STRING:'CREDITRANK" "CREDITRANK" STRING PUHCHASEFHEQUENEY
PUHCHASEFHEQUENC‘(‘ STRING"PURCHASEYOLUME" "PURCHASEYVOLUME" STRING."
REFID""REFID" STRING}

Diescription:

A flat file query ;I

| |
Figure 2-53 Choosing Query Builder to modify the query

3 Choose Parameters.
The query’s parameters appear.
4 In Parameters:

m To rename a parameter, type the new name in Parameter.

Information Object Designer assigns a default name to a parameter based
on its position in the query, for example param_1.

m If necessary, choose the correct data type from the Data type drop-down
list.

m In Default value, type the parameter’s default value.

Do not create an expression. You cannot type a default value for an output
parameter.

m To specify the parameter’s prompt properties, choose Prompt editor.
Figure 2-54 shows the Parameters pane for a map using an ODA data
source.

To define other parameter properties, select the parameter and define the
properties in Properties.

5 Choose Data Set Properties.

The data set properties appear, if the data set has any. Figure 2-55 shows the
Data Set Properties pane.
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Parameters

Farameter | Diata type | Default value | Prompt editor

patam 0 integer
paran_1 Warchar MY T A5 ——Choose Prompt
param_2 Integer 1 |53 editor to specify

prompt properties

Figure 2-54 Specifying prompt properties for an ODA data source query’s
parameters
Data Set Properties
| Froperty | Walue |

Figure 2-55 Data Set Properties pane
6 In Value, type values for the data set properties.

Displaying information about a project or resource

You can display information about a project or resource. Make sure the project is
open and that it compiles without error. To display information about a project,
select the project in Navigator and choose Project>Show Detail. To display
information about a data connection definition, map, or information object, select
the appropriate resource in Navigator and choose Project>Show Detail.

You can display a list of information objects that are built from a map or
information object by selecting the map or information object in Navigator and
choosing Project>Show Dependents. You can display a list of maps or
information objects from which an information object is built by selecting the
information object in Navigator and choosing Project>Show Sources.
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Creating
information objects

This chapter contains the following topics:

Creating an information object

Creating a graphical information object query
Creating a textual information object

Displaying and testing information object output
Displaying a data source query

Understanding query execution plan operators
Storing a query plan with an information object

Localizing an information object

Chapter 3, Creating information objects
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Creating an information object

You build an information object from maps or other information objects.
Information Object Designer places an information object file in the project’s
Information Objects folder, as shown in Figure 3-1. An information object file
name has an .iob extension. Information object file names are not case-sensitive.

T Mavigator 23 =0

B

E@ MyPraject
(= Data Souices
EI@ Information Objects
e8] 11yl nformationDbject.iob

—— Information object file

Figure 3-1 Default location of an information object file
How to create an information object
1 In Navigator, select the appropriate project.
2 Choose File>New~>Information Object.
New Information Object appears.
3 In Name, type a name for the information object, as shown in Figure 3-2.

Do not use a name that contains only numbers, for example, 123.

& 8 =] 3
Information Object

Specify the name and location for a new information object ,D

Mame: IMyInlnrmatlnnDh\ect

Local directony
& Default

" Other Iz’MyProiect#Informahon Objects Brnwse...l

™ Editin SOL text editor

o |

Figure 3-2 Specifying the name and location of a new information object

4 In Local directory, accept the default or choose Other and type or browse to a
folder.

5 To type or paste an Actuate SQL query instead of creating it graphically, select
Edit in SQL text editor.

6 Choose Finish.
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The information object file name appears in Navigator, and the graphical
information object editor appears.

7 Specify the query for the information object graphically, or using the SQL text
editor.

Creating a graphical information object query

In the graphical information object editor, perform the following tasks:
m  Choose maps and information objects

m  Specify output columns

m Specify column categories

m Specify joins

m Specify filters

m  Specify the GROUP BY clause

m  Specify the HAVING clause

m Specify parameters

Using the Expression Builder

Many of the steps to create an information object query involve specifying a
column or an expression.

When designing a query, you can use Actuate SQL expressions to specify filters or
joins, create aggregate data, and so on. For example, you can type expressions,
such as officelD = 101 to specify that the data returned by the query must have
101 in the officeIlD column.

You can type these expressions in either the graphical editor or the textual editor.
In the textual editor, you type the expressions as part of the SQL SELECT
statement. In the graphical query editor, you can type the expressions or use the
Expression Builder to develop expressions.

Expression Builder helps you create expressions by providing a graphical
interface with selections for the available parts of an expression. In Expression
Builder, you can build the expressions graphically by selecting constants,
operators, functions, column names and so on from a list.

You can use the Expression Builder to create Actuate SQL expressions on the
following tabs in the graphical information object editor:

m Columns

m Joins
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m Filters
m Having
m Parameters

Figure 3-3 shows Expression Builder. You can drag items from the left pane to the
right pane or insert items by choosing the appropriate icon. If you select a
function in the left pane, the function signature appears in the bottom pane.

Function signature

= |of x|
Create an expression by dragging columns into the builder, choosi/4 operators, and typing values.
+| = | ' | @ | _I - | » | « | <>|AN|:I DF!lNDTlLIKEl [ | ] |CounliSurr{Ma»e|Min|Aug| ?|
Eb Constants K_ast{dbo_custorZrs.custlD AS WARCHAR(ZO) ;I
Eb Conditions
- Operators
Functions
== Mumetic
= String
[ Sustem
[FH~[= InformaticA Objects LI
CAST[E=pression» AS DataType ¥ ;I
CAST[Expression# AS WARCHARN)] n = length (INTEGER] ;l
oK I Cancel |
Figure 3-3 Using Expression Builder to create expressions

Choosing maps and information objects

The first step in specifying the query for an information object is to choose the
maps and information objects used by the query.
How to choose maps and information objects

1 In Navigator, expand the project node and folders to see the maps and
information objects.

2 Drag the appropriate maps or information objects from Navigator to the
upper pane of the graphical information object editor. The columns available
in each map or information object appear, as shown in Figure 3-4.
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EEEEE [T
W Select &) Select &l Select &l
custD orderlD itemcode
contact_lagt farecastOrderD ate description
contact_first shipByD ate
customMame forecastShipDate
phane status
address izsue arderlDl
city azkByDate
state custlD
postalcode category
creditrank.
purchaseFrequency
purchaseWolume
replDr
Figure 3-4 Columns available in each selected map or information object

How to open a source map or information object in an editor

If a project contains a large number of maps and information objects, it may be
difficult to locate an information object’s sources in Navigator. Instead, you can
open a source map or information object directly from the graphical information
object editor by clicking the button in the source’s upper right corner, as shown in
Figure 3-5.

liiasionabeet N S| — Click here to open

] Select Al source in editor
cuztomemumber
customertlame
cantactLastN ame
contactFirsth ame

phone

addressLinel
addressLine2

city

state

postalCode

country

zalesR epEmployest umber
creditLimit

Figure 3-5 Opening a source information object in an editor

Defining output columns

To define the output columns for an information object, use the Columns page.
For example, you can create the following SQL fragment:

SELECT ename AS employee, (salary * 12) AS annual comp
FROM Employees

How to define output columns

1 In the graphical information object editor, choose Columns.
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2 In the upper pane, select the columns that you want to include and deselect
the columns that you want to exclude from the query. To select all columns,
select Select All at the top of the listing for that map or information object. By
default, all columns in an information object are included in the query. The
columns that you select appear in Columns.

3 In Columns:

m To return only distinct rows, select Distinct values only. Some queries
return duplicate rows. In a group of duplicate rows, each selected column
contains the same value for all the rows in the group. If you want the query
to return only one row for each group of duplicate rows, select Distinct
values only. This setting affects only rows in which all column values
match. The query still returns rows in which only some of the column
values match. If the Analysis Type property is set to Dimension or
Attribute for all columns in an information object, the DISTINCT keyword
is automatically included in the query generated in BIRT Studio when the
information object is used as a data source.

m To change a column alias, type the new alias in Name. Decide on column
aliases before you build another information object from this information
object. Changing a column alias after you build a dependent information
object results in a compiler error in the dependent information object. If a
column alias contains a special character, such as a period (.) or a space,
enclose the alias in double quotation marks (). Do not use column aliases
that are identical except for case. For example, do not use both status and
STATUS as column aliases.

| m To enter an expression, select the source column, and type the expression
or choose Ellipsis, as shown in Figure 3-6. Choosing Ellipsis opens the
Expression Builder.

Choose Ellipsis to
create an expression

Columns

Specify output colurns: [ Distinct values anly
Prompt editor_ &
Cus WIS > || customerumber L Choose Prompt
dbo_Customers. customerame customerName L editor to Specify
dbo_Customers. contaciLastN ame cUnlacthaslName 23 prompt properties
dbo_Customers.contactFistName | contactFirstName
dbo_Customers. phone phone Lk LI
dbo_Customers. addrezsLinel addrezsLinel Lk -
dbo_Customers. addressLine2 addressLine2 Lk LI
dbo_Custamers. city city Lk
dbo_Custamers. state state A3
Idbo_CustDmers.postaICode postalCode | [, _ILI
4 3

Remove | Femove Al | Localization |

Figure 3-6 Defining output columns
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m To create a filter on a column, set the column’s Filter property to
Predefined, and choose prompt editor to specify the filter’s prompt
properties.

m To change the order of the columns, use the up and down arrows. If the
information object uses column categories, you must reorder the columns
in Column Categories.

4 To define column properties, such as the display name, select the column in
Columns, and define the properties in Properties.
How to delete output columns

To delete an output column, select the column in Columns, and choose Remove.
To delete all output columns, choose Remove All.

Creating and displaying column categories

If an information object has a large number of output columns, it is difficult for a
user to locate a particular column. To help the user locate columns, you can
organize them into categories. For example, for an information object that returns
customer data, you can create a Customer address category that contains the
columns StreetAddress, City, State, and PostalCode.

Creating column categories

Use the Column Categories page to create column categories. In Figure 3-7,
Column Categories lists a category with two columns.

How to create a column category or subcategory

1 In the graphical information object editor, choose Column Categories.

2 On Column Categories, right-click the Root node or a category name and
choose Create.

3 On New Category, type the category or subcategory name and press Enter.
You can provide a description for the category or subcategory in the Properties
view.

4 Drag-and-drop columns into the category or subcategory. Figure 3-7 shows
the result of creating a Contact name category and moving the contact_first
and contact_last columns into the category.
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Column Categories

-E5 contact_first
-E contact_last
-] custD

-] custamb ame
] phone

-[E] addiess

] ciy

] state

-[E] postalcode
-] creditiank

-[E] purchaseFrequency
-[E] purchasevolume
=] replD

-] orderlD

£ forecastOrderD ate
=] shipByD ate
-] forecastShipDate
-] status

] issue

-] askByDate
=] custiD_1

£ categon

Figure 3-7 Result of moving two columns into a new category

How to rename, move, or remove a category or subcategory

Table 3-1 explains how to work with categories, subcategories, and columns on
Column Categories.

Table 3-1 Using Column Categories

To perform this task... = Do the following...

Rename a category or Right-click the category or subcategory name and
subcategory choose Rename.

Move a category or Drag-and-drop the category or subcategory in the
subcategory target location.

Remove a category or Right-click the category or subcategory name and
subcategory choose Remove>Category only.

Remove a category or Right-click the category or subcategory name and
subcategory and its choose Remove>Category and subcategories.
subcategories

Remove all categories Right-click the Root node and choose

and subcategories Remove>Category and subcategories.

Move a column Drag-and-drop the column in the target location.

Reordering columns in Column Categories also
reorders the columns in Columns.
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Displaying column categories

The column categories that you create for an information object appear in
Information Object Designer, Information Object Query Builder, and BIRT
Studio. Column categories do not appear in Actuate Query.

In Information Object Designer, column categories appear in the Navigator view
and the Expression Builder. Column categories do not appear in the upper pane
of the graphical information object editor. To display column categories in the
upper pane of the graphical information object editor, select Toggle categories
view in the upper right corner of the information object, as shown in Figure 3-8.
The information object on the left does not display column categories. The
information object on the right displays the Customer address category.

Click here to display
column categories

i Select Al
EIBA (E) Custorner address

i Select &l
addrezsLinel
addressLine2
city

state

poztalCode
country
customeumber
customemame

contactLasth ame
cantactFirst ame

phane

zalesR epEmployest umber

creditLimit

Figure 3-8

Listomert ame

ortactasth ame
ontactirsth ame

If you want column categories to display by default, choose

Information object with and without categories displayed

Window>Preferences and select Show categories in graphical editor by default in
Preferences—Information Objects, as shown in Figure 3-9.

Select to show categories
in graphical information
object editor by default

= (=
Itype filter tewt

(- General

Data M anagement
Help

nformation Objects
natall/Update

Informatic/ Objects - - -

Genera)4ettings for Information Dbjects

D&/4 Preview Timeout [seconds): IBDD

v Show categories in graphical editor by default

Restare Defaults | Apply |

Figure 3-9 Preferences—Information Objects
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Column categories do not appear in the Expression Builder or the upper pane of
the graphical information object editor for the information object in which they
are defined. Column categories appear for information objects built from this
source information object, in other words, for its dependent information objects.

In the Information Object Query Builder, column categories appear in iServer
Explorer, the upper pane of Query Design, and the Expression Builder.

In BIRT Studio, column categories appear in the Available Data pane.

Categories that do not contain columns appear in the Navigator view in
Information Object Designer, but not in the Information Object Query Builder or
BIRT Studio.

Setting column properties

You set most column properties in the Properties view. You set default values for
analytics properties in the Define Default Column Analytics wizard.

Setting column properties in the Properties view

Table 3-2 lists column properties visible in the Properties view and a description

of each property.
Table 3-2 Column properties visible in the Properties view
Column property Canset?  Description
Aggregate Type Yes, in Default aggregate function for a column in
Define a dashboard or BIRT Studio summary table,
Default for example SUM.
Column
Analytics
wizard
Category Path No Path for column category and
subcategories.
Conceal Value Notused Not used.
Data Type No Actuate SQL data type. If the data type is
unknown, choose the Compile IO button.
Default Value Yes, in Default value for a predefined filter on the
Prompt column in Actuate Query or a dynamic
Editor filter on the column in Information Object
Query Builder.
Description Yes Description of the column that appears
when the column is selected in Actuate
Query.
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Table 3-2 Column properties visible in the Properties view (continued)

Column property Canset?  Description

Description Key Yes Key for Description property in localization
properties file.

Display Control Yes, in Control type for a predefined filter on this

Type Prompt column in Actuate Query or a dynamic

Editor filter on this column in Information Object
Query Builder. The available values are:
text box, read-only drop-down list, editable
drop-down list, or radio buttons.

Display Format Yes Format to apply to column values in BIRT
Studio or Actuate Query output. To specify
the display format, use an Actuate Basic
format pattern or format keyword, such as
Short date.

Display Length Yes Number of characters to allow for display
of column values in report output.

Display Name Yes Display name for the column in BIRT
Studio or Actuate Query. If the column is a
group key, this property value is the group
label in Actuate Query output.

Display Name Key  Yes Key for Display Name property in
localization properties file.

Do Not Prompt Notused  Not used.

Expression Yes,onthe Expression for a computed field.

Columns

tab

Filter Yes To create a predefined filter on the column
in Actuate Query or a dynamic filter on the
column in Information Object Query
Builder, set to Predefined. To enable a user
to create a custom filter on this column in
Actuate Query or a dynamic filter on this
column in Information Object Query
Builder, set to Optional. To prevent filtering
on this column, set to Disabled.

Has Null Yes If column contains NULLs, set to True.
Otherwise, set to False.

Heading Yes The heading for the column in BIRT Studio

or Actuate Query output.
(continues)
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Table 3-2 Column properties visible in the Properties view (continued)
Column property Can set? Description
Heading Key Yes Key for Heading property in localization
properties file.
Help Text Yes Balloon help for the column in BIRT Studio
or Actuate Query.
Help Text Key Yes Key for Help Text property in localization
properties file.
Horizontal Yes Horizontal alignment of column values in
Alignment BIRT Studio or Actuate Query output. The
available values are: left, right, or center.
Indexed No Indicates whether the column is indexed in
the data source. True indicates that the
column is indexed. False indicates that it is
not indexed.
Name Yes,onthe The alias for the column in the information
Columns  object query.
tab
Required Notused  Not used.
Text Format Yes The text format in Actuate Query output.
The available values are: plain, HTML, or
RTF. This property is used only for columns
that have the VARCHAR data type.
Word Wrap Yes To display text on multiple lines in BIRT

Studio (with fixed width layout preference)
or Actuate Query output if the length of the
text exceeds the width of the column, set to
True. To truncate the text, set to False. This
property is used only for columns that have
the VARCHAR data type, and it is enforced
only in the detail frame. It is not enforced in
before and after frames.

Setting default values for analytics properties

You can use an information object as a data source in a summary table in a

dashboard or a BIRT Studio report. To create a summary table, users select a
table’s auto-summarize feature, then select the data set column or columns whose
data to group and aggregate. Because the grouping and aggregating are
performed automatically, you must set default values for the analytics properties
for each column. The analytics properties provide the appropriate context for
these tasks. For example, it makes sense to group sales data by region or product

80 Designing BIRT Information Objects



line, but not by revenue. Conversely, it makes sense to aggregate revenue values,
but not region or product line values.

To provide the appropriate information to generate a summary table, set each
column’s analysis type property to one of the following values:

m Dimension

The dimension analysis type supports the grouping of data in the column. For
example, to display revenue by region, set the region column as a dimension.

m Attribute

An attribute describes the items associated with a dimension. For a product
dimension, for example, attributes might include color, size, and price. When
you set a column as an attribute, you must also specify the dimension column
of which it is an attribute. The summary table cannot group data in an
attribute column.

m  Measure
The measure analysis type supports the aggregation of values in the column.

For example, to calculate revenue totals, set the revenue column as a measure.
The summary table cannot group data in a measure column.

If you do not set default values for the analysis type property, the following
default values are used:

m If the column contains numeric values or the data type is unknown, the
default is measure.

m If the column contains data of type TIMESTAMP, the default is dimension.

m If the column contains data of type VARCHAR or BOOLEAN, the default is
attribute.

m If the column is a primary key, a foreign key, or an indexed column in the
database, the default is Dimension regardless of the column’s data type.

Often, these default values do not provide usable data for a summary table, so
you should assign an analysis type for every column in an information object. The
problems with the default values are:

m  Most columns whose data users want to group, such as region and product
line, are of string type. The default analysis type for these columns is attribute,
but data in attribute columns cannot be grouped.

m The default analysis type for columns that contain numeric values is measure.
In some cases, however, users want to group on numeric values. For example,
for a report that shows order numbers and order totals, users want to group
on order number, but data in measure columns cannot be grouped.

If analysis type is set to Dimension or Attribute for all columns in an information
object, the DISTINCT keyword is included in the query generated in BIRT Studio
when the information object is used as a data source.
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Use the Define Default Column Analytics wizard to specify default values for the
following analytics properties for information object columns:

m For each output column, specify the analysis type: dimension, measure, or
attribute.

m For each attribute column, specify the dimension of which it is an attribute.
m For each measure column, specify the aggregate function.

How to specify default values for analytics properties

1 Open the information object or map in the graphical or textual editor.

2 Choose Columns or Output Columns.

3 Choose Default Analytics, as shown in Figure 3-10.

Default Analytics
button
Columns
Specify output columns: [ Distinct values only
| Source column or expression | Name | Default 2/alysis Type I P.I -
CLASSICMODELS_Customers.cust... | customerMumber DimerAion Q{)
CLASSICMODELS_Customers.cust... | customerMName Apfbute Q’p
CLASSICMODELS_Customers.con... | contactiastMame ‘Attribute ik
CLASSICMODELS_Customers.con... | contactFirstiame Attribute ik
CLASSICMODELS_Customers.phone | phone Attribute ik
CLASSICMODELS_Customers.add... | addressline1 Attribute ik ;I
CLASSICMODELS_Customers.add... | addressline2 Attribute ik
CLASSICMODELS_Customers.city | dity Attribute i =
CLASSICMODELS_Customers.state | state Attribute %
CLASSICMODELS_Customers.pas... | postalCode Attribute \*
CLASSICMODELS_Customers.cou... | country Attribute Q’p
CLASSICMODELS_Customers.sale... | salesPZpEmployeshumber Measure ik
CLASSICMODELS_Customers, cre... | cryditLimit Measure &=
Hemaoie | Remove All | Lacalization | Default Analytics |

Figure 3-10 Default Analytics button in Columns

4 In the first page of the Define Default Column Analytics wizard, specify the
analysis type for each column, as shown in Figure 3-11. Choose Next.
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(= - |of x|
Use this wizard to define analytics properties for output columns. For each output column choose whether itis a dimension,
attribute, or measure.
I Column Name | Data Type | Analysis Type |
customerMumber Integer Dimension
customerName Varchar Attribute
contactlasthName varchar Attribute
contactFirsthame varchar Attribute
phone Warchar Attribute
addressLine1 Varchar Attribute
addressLine2 Varchar Attribute
city Varchar Attribute
state Varchar Attribute
postalCode Varchar Attribute
country Varchar Attribute
salesRepEmployeeMumber Integer Dimension
creditl imit Double Measure
orderMumber Integer Dimension
orderDate Timestamp Dimension
requiredDate Timestamp Dimension
shippedDate Timestamp Dimension
status Varchar Attribute
comments varchar Attribute
customerhNumber_1 Integer Dimension
@ = Back | Next > | Finish I Cancel |

Figure 3-11 Specifying the analysis type for information object columns

5 In the second page of the Define Default Column Analytics wizard, specify the
dimension with which an attribute is associated, as shown in Figure 3-12.
Choose Next.

= JSi[=] £

Link attributes to correspanding dimension columns{optional).

[ attribute | attribute Of |
customerName customerNumber

contactiasthame

contactFirstName

phone

addressLine1

addressLine2

ity customerMumber
state customerhbumber
postalCode

country customerMumber
status

comments

® < Back | Next > | Finish I Cancel |

Figure 3-12 Specifying the dimensions with which attributes are associated
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6 In the third page of the Define Default Column Analytics wizard, specify the
aggregate function for measure columns, as shown in Figure 3-13. You can
choose a function from the drop-down list or type the name of a function.

Choose Finish.
= =
Agsign each measure a default aggregate function.
Measure | Data Type | Default Aggregate Function |
creditlimit Double MAX
(?) <back | wei- |[ Ansh || caneal

Figure 3-13 Specifying the aggregate function for creditLimit

About column property inheritance

When you build an information object, its output columns inherit property values
from the parent maps or information objects. For example, if you use an
information object called IO1 to build another information object called 102, 102’s
output columns inherit property values from the corresponding columns in IO1.
If a column property value in IO1 changes, the change is propagated to 102. For
example, if the horizontal alignment for IO1.column01 changes from left to right
and column(1 is an output column in 102, the horizontal alignment for
I02.column(1 also changes from left to right. Changes to a map or information
object’s Name property are not propagated, however. In Figure 3-14, many of the
column’s property values are inherited from the parent map.

E Poperties 23] ’E b ¥ =0
Property | Walue |:|
= Display

Category Path !
Display Format %
Display Length % 10

Display Name
Heading
Help Text Y
Horizartal Alignment %y, left ——Horizontal alignment
Teut Fomat Ay, Plain iai :
Word o o Fale of s inherited from the
parent map
Figure 3-14 Inheritance of property values

If you change a property value for an output column, that property value is no
longer inherited from the parent map or information object. For example, if you
change the horizontal alignment for I02.column01 to center and the horizontal
alignment for IO1.column01 later changes to left, the change is not propagated to
102.column01. In Figure 3-15, the column’s horizontal alignment is not inherited
from the parent map.
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E Poperties 23] ’E b ¥ =0

Property | Walue |:|
= Display
Category Path !
Display Format %
Display Length % 10

Display Name %
o

Heading

Help Text Y

Haorizantal Alignment Q#D center — HOriZOntal alignment
Teut Fomat Ay, Plain H H :

i o Fase - is not inherited from

the parent map

Figure 3-15 Changing property value inheritance

Choosing Reset for the appropriate property in Properties, as shown in

Figure 3-16, or in the Prompt editor resets the property’s value to the inherited
value. Any future changes to the property’s value in the parent map or
information object are propagated.

) [::-c7°C

Property | Walue |A
= Dizplay
Category Path !

Display Format Y
Display Length 10
Display Mame Y
Heading

Help Text %

Hurizontal Alignment %2050 =I5 ——Choose Reset
Text Format 9y, Plain

it o Fase = toresetvalue to

inherited value
Figure 3-16 Resetting a property’s value

Values for the following column properties are inherited from the parent map or
information object unless the values in the parent map or information object are
blank:

m  Description

m Display Name
m Heading

m  Help Text

If the values in the parent map or information object are blank, the inheritance
rules for these properties are as follows:

m If you do not set the Display Name property, the Display Name property takes
the value of the column’s Name property.

m If you do not set the Heading property, the Heading property takes the value
of the column’s Display Name property.

m If you do not set the Description property, the Description property takes the
value of the column’s Heading property.
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m If you do not set the Help Text property, the Help Text property takes the value
of the column’s Description property.

In other words, if you do not set any of these properties and the values in the
parent map or information object are blank, they all take the value of the column’s
Name property. In this case, propagation of these properties occurs at run time.

Creating a filter for use in queries on an information
object

A predefined filter restricts the data returned by a query built from an
information object. Set a column’s Filter property to Predefined to create a
predefined filter on the column. Actuate Query lists this filter as a predefined
filter that users can set. In report designers, the filter is listed as a dynamic filter in
Information Object Query Builder and becomes an ad hoc parameter in the report
design. For more information about Actuate Query, see Working with Actuate
Query. For more information about Information Object Query Builder, see Using
Actuate BIRT Designer Professional or Using Information Object Query Builder.

Use the Prompt editor to specify the filter’s display control type, list of values,
and default value. You create a list of values by specifying the values or by typing
an Actuate SQL query that retrieves the values. You can specify the filter values as
well as the values displayed to the user. If you type a query, the query must meet
the following requirements:

m  The query must retrieve one or two columns from an information object or
map, for example:

SELECT DISTINCT custID, customName
FROM "MyInformationObject.iob"
ORDER BY 2

The first column contains the filter values and must be of string data type. The
second column contains the values displayed to the user. The information
object or map must reside in the same volume as the IOB from which the user
launches Actuate Query. If you use a relative path to reference the information
object or map, Actuate Query interprets the path as relative to the IOB from
which the user launches Actuate Query. If the information object or map
defines a parameter, you must provide a value for the parameter, for example:

SELECT DISTINCT custID, customName
FROM "MyInformationObject.iob" ['CA']
ORDER BY 2

m The query must not contain a WITH clause.

The filter values are interpreted as QBE expressions. Certain characters, for
example, the comma (,) and the pipe sign (| ), are interpreted as operators in a
QBE expression. For example, the QBE expression:

16M x 1 Dynamic Ram, 3.3 volts
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is interpreted as:

WHERE description LIKE 'l16M x 1 Dynamic Ram%'
OR description LIKE '3.3 volts%'

If you want these characters to be interpreted literally, enclose the strings in four
single quotation marks (") as shown in the following Actuate SQL queries:

m To match a string exactly:

SELECT '''' || description || '''"'
FROM "MyInformationObject.iob"

m To match a string using the LIKE operator:

SELECT '''' || description || '%'"'
FROM "MyInformationObject.iob"

| | is the concatenation operator.

The values returned by the query appear when a user specifies a value for the ad
hoc parameter in Actuate Query. The values do not appear, however, when a
report developer specifies a value for the ad hoc parameter when running a
report in a report designer.

For more information about QBE expressions, see Using Information Console.
How to create a filter for use in queries on an information object

1 Select the appropriate column in Columns.

2 In Properties, set Filter to Predefined.

3 In the row for that filter, choose Prompt editor.

4 On Prompt editor, complete the following tasks:

m In Show as, select the display control type. The choices available and
appearance of the page depend on the display control type you select.

m If you use a display control type other than Text box, you can specify a list
of values for the user to choose by typing the values and, optionally, the
display names, as shown in Figure 3-17. Alternatively, you can select from
a list of database values by choosing Select Values.
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Select from a list
of database
California values

Massachussetts
Mew ork

Type values and
display names

Figure 3-17 Typing values and display names for a filter

To create an Actuate SQL query that retrieves the values, select Dynamic list of
values, as shown in Figure 3-18, and do one of the following:

m  Type the query.

= Choose Generate Query.

Choosing Generate Query creates a query that retrieves the distinct values
from the column for which you are creating a filter, as well as display
names. If the information object used in the query has parameters, you
must provide parameter values.

m In Default value, specify the default value. The default value can be a QBE
expression.

If you select Combo box (editable), Dynamic list of values, and Auto suggest, a
drop-down list appears after the information object user types the number of
characters specified in Start Auto suggest after N character(s). The list contains
values that begin with the characters the user typed. For example, if the user
typed 'Atel and N=4, the list contains the value 'Atelier graphique'. In this
case, the query that retrieves the values must select two columns, a value
column and a display name column.

Choose OK.
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Select Dynamic
list of values

JiE

| Atelier graphique

SELECT DISTINCT ''''||customerName||'''', CA3T ({''''||customerl

Choose
Generate
Query

Figure 3-18 Creating an Actuate SQL query to generate values for a filter

Specifying a join

To define the joins for an information object, use the Joins page. For example, you
can create the following SQL fragment:

FROM Customers INNER JOIN Orders ON (Customers.custID =
Orders.custID)
About joins

A join specifies how to combine data from two maps or information objects. The
maps or information objects do not have to be based on the same data source. A
join consists of one or more conditions that must all be true. In the resulting SQL
SELECT statement, join conditions are linked with AND.

A join can consist of multiple conditions in the following form:
columnA = columnB

A join can have only one condition that uses an operator other than equality (=)
or an expression, for example:

columnA < columnB

Information Object Designer does not support right outer joins or full outer joins.
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How to define a join condition
1 In the graphical information object editor, choose Joins.

2 In the upper pane, drag the join column from the first information object or
map, and drop it on the join column in the second information object or map.

The upper pane shows the join condition, like the one in Figure 3-19, and the
join columns and operator are listed in the lower pane.

Equality operator

I T/
v Selact Al SeleAAl

custll AerlD
contack_last I A forecastOrderDate
contact_first shipByD ate
customMame forecastShipD ate
phone status

address issue

city askByD ate

state custlD

postalcode categary
creditrank,

purchazeFrequency

purchaze¥olume

replD

Figure 3-19 Joined columns from two information objects or maps
3 In the lower pane, select the row that describes the new join condition.

If necessary, select a different join condition operator from the drop-down list.
By default, Information Object Designer uses the equality operator (=) to relate
two columns.

[ 5 Tochange acolumn name to an expression, select the column name, and type
the expression, or choose Ellipsis to display the expression builder, as shown
in Figure 3-20.

If the join has a condition that uses an operator other than equality (=) or an
expression, the upper pane marks the join line with the symbol that appears in
Figure 3-21.

6 If the join consists of more than one condition, repeat this procedure for the
other conditions.

7 Choose one of the following join types:
s Innerjoin
m Left outer join

8 Optimize the join.
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Choose Ellipsis to
create an expression

Select a join
condition operator

Joins

Select joir: Idbn_custnmers <> dbo_orders j Newl Deletel
Select join typer | Inner Join -

Diefine jain using columne and expressions,

I dbo_customers j OrArator | dbo_orders |

dbo_c gt D hd | = dba_orders.custD

Figure 3-20 Defining a join

Join uses an operator other than
equality (=) or an expression

doowones [T oot
Select All Select Al

custlD arderlD
contack_last forecastOrderD ate
contact_first shipBuD ate
customMame forecastShipDate
phone statuz

address issue

city askByDate

state custlD

postalcode categary
creditrank,

purchazeFrequency

purchaze¥olume

replly

Figure 3-21 A join condition that uses an expression or an operator other than
equality

How to delete a join condition

To delete a join condition, select the join condition in the upper pane of the
graphical information object editor and press Delete.

Optimizing joins

You can improve a query’s performance by optimizing the joins. To optimize a
join, use the CARDINALITY and OPTIONAL keywords in the Actuate SQL
query. To optimize a join, you can specify the cardinality of the join. Specifying
the cardinality of the join adds the CARDINALITY keyword to the Actuate SQL
query.

You can also specify whether a table in a join is optional. Specifying that an

information object is optional adds the OPTIONAL keyword to the Actuate SQL
query. If you indicate that a table is optional and none of its columns appear in
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the query created by a report developer or business user (except in a join
condition), the table is dropped from the optimized query.

If the maps or information objects are based on different data sources, there are
two additional ways to optimize a join:

m Use ajoin algorithm.
m  Use map and join column properties.

Figure 3-22 shows how to specify the cardinality of an information object or map
in a join, whether an information object is optional, and how to specify a join
algorithm in Joins.

Specify relationship:  For each value in dbo_CUSTOMERS. the number of values in dba_ORDERS is: ID of mare ﬂ T (A:pArl):l‘lglsNALlTY
For each value in dbo_ORDERS, the number of values indbo_CUSTOMERS & [1 =] keyword
Specify join algarithm: lm — Speciﬁes jOin
Specify quer timming bt dbo_CUSTOMERS <> dbo_ORDERS algorithm
Optional | cd _App“es
OPTIONAL
keyword

Figure 3-22 Optimizing a join

Using join algorithms

When you join maps or information objects that are built from different data
sources, the Actuate SQL compiler chooses a join algorithm. If you have a good
understanding of the size and distribution of the data, however, you can specify
the join algorithm. Choosing the correct join algorithm can significantly reduce
information object query execution time. Actuate SQL supports three join
algorithms:

m Dependent

m Merge

m Nested Loop

When you join maps or information objects that are built from the same data
source, specifying a join algorithm has no effect. The join is processed by the data
source.

About dependent joins

A dependent join is processed in the following way:

m The left side of the join statement is executed, retrieving all the results. The
results are then processed one at a time (pipelined).

m For each left side result, the right side of the join is executed, parameterized by
the values provided by the current left side row.
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A dependent join is advantageous when the cardinality of the left side is small,
and the selectivity of the join criteria is both high and can be delegated to the data
source. When the cardinality of the left side is high, a dependent join is relatively
slow because it repeatedly executes the right side of the join.

Dependent joins can be used for any join criteria, although only join expressions
that can be delegated to the right side’s data source result in improved selectivity
performance.

About merge joins
A merge join is processed in the following way:

m The left side of the join statement is executed, retrieving all the results sorted
by the left side data source. The results are then processed one at a time
(pipelined).

m The right side of the join statement is executed, retrieving all the results sorted
by the right side data source. The results are then processed one at a time
(pipelined).

A merge join can only be used with an equijoin. A merge join has much lower
memory requirements than a nested loop join and can be much faster. A merge
join is especially efficient if the data sources sort the rows.

About nested loop joins
A nested loop join is processed in the following way:

m The left side of the join statement is executed, retrieving all the results. The
results are then processed one at a time (pipelined).

m The right side of the join statement is executed. The results are materialized in
memory. For each row on the left side, the materialized results are scanned to
find matches for the join criteria.

A nested loop join is advantageous when the cardinality of the right side is small.
A nested loop join performs well when the join expression cannot be delegated to
the data source. A nested loop join can be used for any join criteria, not just an
equijoin.

A nested loop join is a poor choice when the cardinality of the right side is large
or unknown, because it may encounter memory limitations. Increasing the
memory available to the Integration service removes this limitation. The
Integration service parameter Max memory per query specifies the maximum
amount of memory to use for an Integration service query. For more information
about this parameter, see Configuring BIRT iServer.
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How to specify a join algorithm

In Joins, select the appropriate join and choose one of the following from the
Specify join algorithm drop-down list shown in Figure 3-23:

m  Dependent
m Merge
m  Nested loop

Specify join algorithm: IDefauIt j
Default
Jependent

Nested Loap

Figure 3-23 Specifying the join algorithm

Improving the selectivity of a join

When you join maps that are based on different data sources, you can optimize
the join by providing values for map and join column properties. Providing
values for these properties improves the selectivity of the join. You should
provide values for:

m The maps’ Cardinality property
Cardinality specifies the number of rows returned by the map, or gives an
approximation based on the possible parameter values.

m The following join column properties:

m Distinct Values Count
Distinct Values Count specifies the number of distinct column values.

m  Max Value
Max Value specifies the maximum column value.

= Min Value
Min Value specifies the minimum column value.

Max Value and Min Value are not used for columns of character data type.
When providing values for Max Value and Min Value, use the appropriate
format. For example, if the column is of type TIMESTAMP, Max Value must be
in the following format:

TIMESTAMP '2001-02-03 12:11:10'

You should also provide values for these properties for a column used in a
WHERE clause.

How to provide a value for the Cardinality property

1 In Navigator, double-click one of the maps in the join.
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2 On Output Columns, choose Show map properties, as shown in Figure 3-24.

Choose Show map
properties

Output Columns

Specify output colurns: I Show map properties

| Source column | Name | Data type' Prormpt ed\torl
custlD custlD Integer Lk
contact_last contact_last “Yarchar
contact_first contact_first archar
cuztomM arme cuztomM ame Warchar
phone phane Yarchar
address address Warchar
city city “archar
state state “archar
postalcode poztalcode “Yarchar
creditrank. creditrank. Varchar
purchazeFrequency | purchazeFrequency | Yarchar
purchazelolume purchazel/olume “Yarchar
repll repll Integer

=

EEEEEEEEEEEERE
LS rsrs e rare e rera s

Figure 3-24 Choosing Show map properties
3 In Properties, type a value for Cardinality.
4 Repeat this procedure for the other map.

How to provide values for join column properties

1 In Output Columns, select the join column.
2 In Properties, type values for:

m Distinct Values Count

m  Max Value

m  Min Value

3 Repeat this procedure for the join column in the other map.

Creating a Cartesian join

By default, an information object user cannot create a query with two information
objects, for example a Customers information object and an Orders information
object, without explicitly joining the information objects. The absence of an
explicit join is called a Cartesian join. Cartesian joins can consume database
resources and return very large result sets. In some cases, however, it is acceptable
to create a Cartesian join. For example, a map of a single-row system information
table does not have to be joined to another map or information object. If it is
acceptable for a map or information object to be used in a Cartesian join, set
Allow this Source to be used in Cartesian Joins to True. To display this property
for a map, choose Show map properties as shown in Figure 3-24. To display this
property for an information object, click in the white space in the upper pane of
the query editor as shown in Figure 3-63.
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Filtering data

If an information object returns more data rows than you need, you can restrict
the number of data rows by using a filter. For example, rather than list all
customer sales, you can create a filter to select only the sales data for a particular
week or only the sales data for a particular region.

Filtering data helps you work effectively with large amounts of data. It enables
you to find the necessary pieces of information to answer specific business
questions, such as which sales representatives generated the top ten sales
accounts, which products generated the highest profit in the last quarter, which
customers have not made a purchase in the past 90 days, and so on.

Filtering data can also have a positive effect on processing speed. Limiting the
number of data rows can reduce the load on the databases because the
information object does not need to return all the rows every time it is run.

Creating a filter condition

When you create a filter, you define a condition that specifies which data rows to
return. A filter condition is an If expression that must evaluate to true in order for
a data row to be returned. For example:

If the order total is greater than 10000
If the sales office is San Francisco
If the order date is between 4/1/2008 and 6/30/2008

Filter conditions are appended to the information object’s WHERE clause, for
example:

WHERE OrderTotal > 10000 AND SalesOffice LIKE 'San Francisco%' AND
OrderDate BETWEEN TIMESTAMP '2008-04-01 00:00:00' AND TIMESTAMP
'2008-06-30 00:00:00"

Figure 3-25 shows an example of a condition defined in Filter Conditions.

The column to The comparison The value to
evaluate operator compare to

Filter by: Walue:

[CLASSICMODELS_Customers.creditLimit [+ | J > =] [roooo | J Select Yalus
Coct_|

Figure 3-25 Filter Conditions displaying a filter condition

As Figure 3-25 shows, Filter Conditions helps you define the condition by
breaking it down into the following parts:

m The column to evaluate, such as credit limit.
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m The comparison operator that specifies the type of comparison test, such as >

(greater than).

m  The value to which all values in the column are compared, such as 10000.

Table 3-3 lists the operators you can use when you create expressions for filter

conditions.
Table 3-3 Operators in filter condition expressions
Operator Use to Example
BETWEEN Test if a column value is between  Profit BETWEEN 1000 AND 2000
two specified values.
= (Equal to) Test if a column value is equal toa  CreditLimit = 100000
specified value.
> (Greater Test if a column value is greater Total > 5000
than) than a specified value.

>= (Greater
than or equal
to)

IN

ISNOT NULL

ISNULL
< (Less than)

<= (Less than
or equal to)

LIKE

NOT
BETWEEN

<> (Not equal
to)

NOT IN

NOT LIKE

Test if a column value is greater
than or equal to a specified value.

Test if a column value is in the
specified set of values.

Test if a column value is not a null
value. A null value means that no
value is supplied.

Test if a column value is a null
value.

Test if a column value is less than a
specified value.

Test if a column value is less than
or equal to a specified value.

Test if a column value matches a
string pattern.

Test if a column value is not
between two specified values.

Test if a column value is not equal
to a specified value.

Test if a column value is not in the
specified set of values.

Test if a column value does not
match a string pattern.

Total >= 5000

Country IN ('USA’, 'Canada’, 'Mexico')

CreditLimit IS NOT NULL

CreditLimit IS NULL

Total < 5000

Total <= 5000

ProductName LIKE 'Ford%'

Profit NOT BETWEEN 1000 AND 2000
CreditLimit <> 100000

Country NOT IN ('USA’, 'Canada’,

'Mexico')
ProductName NOT LIKE 'Ford%'
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How to create a filter condition

1
2
3

In the graphical information object editor, choose Filters.

In Filters, choose New.

In Filter Conditions, in Filter by, do one of the following:

Select a column from the drop-down list. The drop-down list contains the
non-aggregate columns that you defined on the Columns page. To create a
filter for an aggregate column, use the Having page.

Type an expression.

Choose Ellipsis to create an expression.

Select the comparison test, or operator, to apply to the selected column or
expression. Depending on the operator you select, Filter Conditions displays
one or two additional fields, or a completed filter condition.

If you selected an operator that requires a comparison value, specify the value
in one of the following ways:

Type the value or expression.

If you selected a column in Filter by, choose Select Value to select from a list
of values. Figure 3-26 shows the selection of Boston from a list of possible
sales office values.

=i B3
Filter tewt: I

The choices above reprezent a preview of values from the database. Enter a
filter walue ta refine the results based on a prefis match.

Add Cancel |

Figure 3-26 Select Value showing the list of values in the selected column

Select one or more values.

Select a parameter or column from the drop-down list. You create
parameters on the Parameters page.

Choose Ellipsis to create an expression.
Figure 3-27 shows the completed filter condition.
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Filker by: Walue:

[CLASSICMODELS_Dffices.city | J JukE x| [Boston =l J Select Value
coce_|

Figure 3-27 Filter Conditions displaying a completed filter condition

Choose OK. The filter condition appears in Filters as shown in Figure 3-28.

Filters

Column filters:

CLASSICMODELS Offices. city LIKE 'Boston’’

Edit | Deletel
jl dnd | ar | Nat |
1 e B

Figure 3-28 Filters page displaying a filter condition

6 Display the Actuate SQL query. Verify that the filter condition is appended to
the WHERE clause and that the syntax is correct, for example:

WHERE SalesOffice LIKE 'Boston%'
How to create a filter condition using Actuate SQL
1 In the graphical information object editor, choose Filters.
2 In Filters, complete the following tasks:

m Click in the text box.

m  Type the filter condition using Actuate SQL, as shown in Figure 3-29.If a
table or column identifier contains a special character, such as a space,
enclose the identifier in double quotation marks (").

Add the fallowing Actuate SOL expression to the WHERE clause:
dbo_customers. creditrank. LIKE A% ;l

E

Figure 3-29 Using Actuate SQL to create a filter condition

Selecting multiple values for a filter condition

So far, the filter examples specify one comparison value. Sometimes you need to
view more data, for example, sales details for several sales offices, not for only
one office. To select more than one comparison value, select the IN operator,
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choose Select Values, then select the values. To select multiple values, press Ctrl as
you select each value. To select contiguous values, select the first value, press
Shift, and select the last value. This action selects the first and last values and all
the values in between.

Figure 3-30 shows the selection of London and Paris from a list of sales office
values.

& X
Filker by: Yalues:
|ELASSICMDDELS_thcas.city =l J ||N =] [tondor Add
Edit
Remave

Select Values

Figure 3-30 Filter Conditions showing the selection of multiple comparison values

Excluding data

You use comparison operators, such as = (equal to), > (greater than), or < (less
than), to evaluate the filter condition to determine which data to include.
Sometimes it is more efficient to specify a condition that excludes a small set of
data. For example, you need sales data for all countries except USA. Instead of
selecting all the available countries and listing them in the filter condition, simply
use the NOT LIKE operator. Similarly, use NOT BETWEEN to exclude data in a
specific range, and <> (not equal to) to exclude data that equals a particular value.

For example, the following filter condition excludes orders with amounts
between 1000 and 5000:

OrderAmount NOT BETWEEN 1000 AND 5000

The filter condition in the next example excludes products with codes that start
with MS:

ProductCode NOT LIKE 'MS%'

Filtering empty or blank values

Sometimes, rows display nothing for a particular column. For example, suppose a
customer database table contains an e-mail field. Some customers, however, do
not supply an e-mail address. In this case, the e-mail field might contain an empty
value or a blank value. An empty value, also called a null value, means no value
is supplied. A blank value is entered as " (two single quotes without spaces) in the
database table field. Blank values apply to string fields only. Null values apply to
all data types.

You can create a filter to exclude data rows where a particular column has null or
blank values. You use different operators to filter null and blank values.
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When filtering to exclude null values, use the IS NOT NULL operator. If you want
to view only rows that have null values in a particular column, use IS NULL. For
example, the following filter condition excludes customer data where the e-mail
column contains null values:

email IS NOT NULL

The following filter condition displays only rows where the e-mail column
contains null values:

email IS NULL

When filtering blank values, use the NOT LIKE operator with " (two single
quotes without spaces) as the operand. For example, to exclude rows with blank
values in an e-mail column, specify the following filter condition:

email NOT LIKE ''

Conversely, to display only rows where the e-mail column contains blank values,
create the following condition:

email LIKE ''

In a report, you cannot distinguish between an empty value and a blank value in
a string column. Both appear as missing values. If you want to filter all missing
values whether they are null or blank, specify both filter conditions as follows:

email IS NOT NULL AND email NOT LIKE ''

Specifying a date as a comparison value

When you create a filter condition that compares the date-and-time values in a
column to a specific date, the date value you supply must be in the following
format regardless of your locale:

TIMESTAMP '2008-04-01 12:34:56'"

Do not use locale-dependent formats such as 4/1/2008.

Specifying a number as a comparison value

When you create a filter condition that compares the numeric values in a column
to a specific number, use a period (.) as the decimal separator regardless of your
locale, for example:

123456.78

Do not use a comma (,).

Comparing to a string pattern

For a column that contains string data, you can create a filter condition that
compares each value to a string pattern instead of to a specific value. For
example, to display only customers whose names start with M, use the LIKE
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operator and specify the string pattern, M%, as shown in the following filter
condition:

Customer LIKE 'M%'

You can also use the % character to ensure that the string pattern in the filter
condition matches the string in the column even if the string in the column has
trailing spaces. For example, use the filter condition:

Country LIKE 'USA%'

instead of the filter condition:

Country = 'USA'

The filter condition Country LIKE 'USA%' matches the following values:

'USA'
'USA !
'USA !

The filter condition Country = 'USA' matches only one value:
'USA'
You can use the following special characters in a string pattern:

m % matches zero or more characters. For example, %ace% matches any value
that contains the string ace, such as Ace Corporation, Facebook, Kennedy
Space Center, and MySpace.

m _ matches exactly one character. For example, t_n matches tan, ten, tin, and
ton. It does not match teen or tn.

To match the percent sign (%) or the underscore character (_) in a string, precede
those characters with a backslash character (\). For example, to match S_10, use
the following string pattern:

S\_10
To match 50%, use the following string pattern:

50\%

Comparing to a value in another column

Use a filter condition to compare the values in one column with the values of
another column. For example, in a report that displays products, sale prices, and
MSRP (Manufacturer Suggested Retail Price), you can create a filter condition to
compare the sale price and MSRP of each product, and display only rows where
the sale price is greater than MSRP.

How to compare to a value in another column

1 In the graphical information object editor, choose Filters.
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In Filters, choose New.
In Filter Conditions, in Filter by, select a column from the drop-down list.

Select the comparison test, or operator, to apply to the selected column.

a & WODN

In Value, select a column from the drop-down list.

Figure 3-31 shows an example of a filter condition that compares the values in
the priceEach column with the values in the MSRP column.

=i x|

Filter by: Walue:

ICLASSIEIMDDELS_DrderDelails.pncaEacI | J |> =l |CLASSICMDDELS_Pmducls.MSHP =l Select Value
Ok | Cancel |

Figure 3-31 Comparing the values in priceEach with the values in MSRP
Choose OK.

Using an expression in a filter condition

An expression is any combination of Actuate SQL constants, operators, functions,
and information object columns. When you create a filter condition, you can use
an expression in Filter by, Value, or both. You create an expression in the
Expression Builder.

For example, in an information object that returns customer and order data, you
want to see which orders shipped less than three days before the customer
required them. You can use the DATEDIFF function to calculate the difference
between the ship date and the required date:

DATEDIFF('d', shippedDate, requiredDate) < 3
Figure 3-32 shows this condition in Filter Conditions.

Expression —Click to open Expression Builder

Filter by: Walue:

[Datedif{d, CLASSICMODELS_Orders. shi x| J < 1 E = J © 7
8 | Cancel |

Figure 3-32 Filter Conditions with expression in Filter by

In an information object that returns order data, you want to see which orders
were placed today. You can use the CURRENT_DATE function to return today’s
date:

orderDate = CURRENT DATE( )

Figure 3-33 shows this condition in Filter Conditions.
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—Expression

Filker by: Walue:
|ELASSICMDDELS_Drders.orderDate =l J |= | ICurrent_data[]

Figure 3-33 Filter Conditions with expression in Value

In an information object that returns employee data, you want the information
object to return only data for the user who is currently logged in to the
Encyclopedia volume. You can use the LEFT function and the concatenation
operator (| |) to construct the employee’s user name, and the CURRENT_USER
function to return the name of the user who is currently logged in:

LEFT (firstName, 1) || lastName = CURRENT USER( )

Figure 3-34 shows this condition in Filter Conditions.

Expressions
Filker by: Walue:
ILelt[CLASSICMDDELS_Emponees.f\rstNajJ |= j ICurrent_user[] ] SelectValue

0K | Cancel |

Figure 3-34 Filter Conditions with expressions in Filter by and Value

Creating multiple filter conditions

When you create a filter, you can define one or more filter conditions. Each
condition you add narrows the scope of data further. For example, you can create
a filter that returns rows where the customer’s credit rank is either A or B and
whose open orders total between $250,000 and $500,000. Each condition adds
complexity to the filter. Design and test filters with multiple conditions carefully.
If you create too many filter conditions, the information object returns no data.

Adding a condition

You use the Filters page, shown in Figure 3-28, to create one or more filter
conditions. To create a filter condition, you choose New and complete the Filter
Conditions dialog, shown in Figure 3-27. When you create multiple filter
conditions, Information Object Designer precedes the second and subsequent
conditions with the logical operator AND, for example:

SalesOffice LIKE 'San Francisco%' AND
ProductLine LIKE 'Vintage Cars%'
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This filter returns only data rows that meet both conditions. Sometimes, you want
to create a filter to return data rows when either condition is true, or you want to
create a more complex filter. To accomplish either task, use the buttons on the
right side of the Filters page, shown in Figure 3-35.

If you create more than two filter conditions and you use different logical
operators, you can use the parentheses buttons to group conditions to determine
the order in which they are evaluated. Display the information object output to
verify the results.

Filters Filter conditions

Calurnn filkers:

DELS_Offices. city LI Tancisco’’
CMODELS ProductLines. uciLine LIKE “intage Cars’

Edit | De\etel
ﬂ And| ar | Not |—Logical operators

ﬁl (_"l )_"l )_‘Fl — Parentheses

Figure 3-35 Filters page displaying two conditions
Selecting a logical operator

As you add each filter condition, the logical operator AND is inserted between
each filter condition. You can change the operator to OR. The AND operator
means both filter conditions must be true for a data row to be included in the
information object output. The OR operator means only one condition has to be
true for a data row to be included. You can also add the NOT operator to either
the AND or OR operators to exclude a small set of data.

For example, the following filter conditions return only sales data for classic car
items sold by the San Francisco office:

SalesOffice LIKE 'San Francisco%' AND
ProductLine LIKE 'Classic Cars%'

The following filter conditions return all sales data for the San Francisco and
Boston offices:

SalesOffice LIKE 'San Francisco%' OR SalesOffice LIKE 'Boston%'

The following filter conditions return sales data for all product lines, except
classic cars, sold by the San Francisco office:

SalesOffice LIKE 'San Francisco%' AND
NOT (Product Line LIKE 'Classic Cars%')

Specifying the evaluation order

Information Object Designer evaluates filter conditions in the order in which they
appear. You can change the order by selecting a filter condition in Filters, shown
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in Figure 3-28, and moving it up or down using the arrow buttons. Filter
conditions that you type in the Actuate SQL text box, shown in Figure 3-29, are
preceded by AND and are evaluated last.

If you define more than two conditions, you can use parentheses to group
conditions. For example, A AND B OR C is evaluated in that order, so A and B
must be true or C must be true for a data row to be included. In A AND (B OR C),
B OR C is evaluated first, so A must be true and B or C must be true for a data row

to be included.

To illustrate the difference a pair of parentheses makes, compare the following
examples.

The following filter contains three conditions and none of the conditions are
grouped:

Country IN ('Australia', 'France', 'USA') AND

SalesRepNumber = 1370 OR CreditLimit >= 100000

Figure 3-36 shows the first 10 data rows returned by the information object.
Although the filter specifies the countries Australia, France, and USA and sales
rep 1370, the data rows display data for other countries and sales reps. Without
any grouped conditions, the filter includes rows that meet either conditions 1 and
2 or just condition 3.

|= ¢ Problems | SOL Preview [ Data Preview &8 l“‘[g Cuery F'rnhler| @ [=N=p RS |
Show |50 rows at a time
"'Customer name" | Country | S ales Iep number” | “Credit limit'! =
satkelier graphique France 1370 21000.0
Austialian Collectors, Co. | Australia 1611 117300.0
La Rochelle Gifts France 1370 118200.0 —
Mini Gifts Distributars Lid. | LISA 1165 210500.0
Land of Toys Inc. USA 1323 114500.0
Euro+ Shopping Channel | Spain 1370 227600.0
Saveley & Henriot, Co France 1337 123300.0
Dragon Souveniers, Ltd Singapore 1621 103800.0
Muzcle Maching Inc LISA 1286 138500.0
Diecast Classics Inc US4 1216 100600.0 LI
Row(z] 1- 30

Figure 3-36 Results of a complex filter without parentheses grouping

The following filter contains the same three conditions, but this time the second
and third conditions are grouped:

Country IN ('Australia', 'France',K 'USA') AND
(SalesRepNumber = 1370 OR CreditLimit >= 100000)

Figure 3-37 shows the first 10 data rows returned by the information object. The
Country IN ('Australia’, 'France', 'USA') condition must be true, then either the
SalesRepNumber = 1370 condition or the CreditLimit >= 100000 condition is true.
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H F‘rnblems| SOL Preview | Data Preview &3 |‘:“‘[E ey F‘roliler| @ == |
Show |50 rows at a lime
"'"Customer hame' | Country | "Sales rep humber”! | "Credit limit” -
itelier graphique France 1370 21000.0
Australian Collectors, Co Australia 1611 117300.0
La Rochels Gifts France 1370 118200.0
Mini Gifts Distributors Ltd, | US4, 1165 210500.0
Land of Tays Inc. USA, 1323 114900.0 [
Saveley & Henriot, Co France 1337 123500.0
Muzcle Maching Inc LSa 1286 138500.0
Diecast Classics Inc LISA 1216 100600.0
Daedalus Designs Imports | France 1370 82900.0
bdini Caravy France 1370 53800.0 LI
FRow(z)1-18

Figure 3-37 Results of a complex filter with parentheses grouping

Changing a condition

You can change any of the conditions in Filters.

How to change a filter condition

1 In Filters, shown in Figure 3-28, select the filter condition. Choose Edit.

2 In Filter Conditions, shown in Figure 3-27, modify the condition by changing
the values in Filter by, Condition, or Value. Choose OK.

Deleting a condition

To delete a filter condition, in Filters, select the condition. Then, choose Delete.
Verify that the remaining filter conditions still make sense.

Prompting for filter values

You can use a parameter to prompt an information object user for a filter value. A
parameter enables an information object user to restrict the data rows returned by
the information object without having to modify the WHERE clause. For
example, for an information object that returns sales data by sales office, instead
of creating a filter that returns data for a specific office, you can create a parameter
called param_SalesOffice to prompt the user to select an office. The WHERE
clause is modified as follows:

WHERE SalesOffice LIKE :param SalesOffice

You create parameters and define their prompt properties on the Parameters
page. Prompt properties include the parameter’s default value, a list of values for
the user to choose from, and whether the parameter is required or optional.
Parameters appear in the Value drop-down list in Filter Conditions with a :
(colon) preceding the parameter name, as shown in Figure 3-38.
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Parameter name
preceded by a colon

Filter by: Walue:
|CLASSICMDDELS_thces.cily =] J |LIKE | I.param_SaIestfice | J Eeliect Valle!

oK | Cancel |

Figure 3-38 Filter Conditions with a parameter in the Value field

Do not use a parameter in a filter condition with the IN operator, for example:
Country IN :param_ Country

Actuate SQL parameters can only accept a single value, but the IN operator takes
multiple values. Instead, do one of the following for the appropriate column, for
example the Country column:

m Create a predefined filter. The predefined filter becomes a dynamic filter in the
Information Object Query Builder.

m Create a dynamic filter in the Information Object Query Builder.

m Create a report parameter using the Any Of operator in BIRT Studio.

Grouping data

A GROUP BY clause groups data by column value. For example, consider the
following information object:

SELECT orderNumber
FROM OrderDetails

The first 10 data rows returned by this information object are as follows:

orderNumber
10100
10100
10100
10100
10101
10101
10101
10101
10102
10102

Each order number appears more than once. For example, order number 10100
appears four times. If you add a GROUP BY clause to the information object, you
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can group the data by order number so that each order number appears only
once:

SELECT orderNumber
FROM OrderDetails
GROUP BY orderNumber

The first 10 data rows returned by this information object are as follows:

orderNumber
10100
10101
10102
10103
10104
10105
10106
10107
10108
10109

Typically, you use a GROUP BY clause to perform an aggregation. For example,
the following information object returns order numbers and order totals. The
Total column is an aggregate column. An aggregate column is a computed
column that uses an aggregate function such as AVG, COUNT, MAX, MIN, or
SUM.

SELECT orderNumber, (SUM(quantityOrdered * priceEach)) AS Total
FROM OrderDetails
GROUP BY orderNumber

Figure 3-42 shows the first 10 data rows returned by the information object. The
data is grouped by order number and the total for each order appears.

Creating a GROUP BY clause

By default, Information Object Designer creates a GROUP BY clause
automatically. If you prefer, you can create a GROUP BY clause manually.

Creating a GROUP BY clause automatically

When an information object’s SELECT clause includes an aggregate column and
one or more non-aggregate columns, the non-aggregate columns must appear in
the GROUP BY clause. If the non-aggregate columns do not appear in the
GROUP BY clause, Information Object Designer displays an error message. For
example, consider the following information object:

SELECT orderNumber, (SUM(quantityOrdered * priceEach)) AS Total
FROM OrderDetails
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When you attempt to compile the information object, the error message shown in
Figure 3-39 appears in the Problems view.

- =0 x|

\ An operation on the Actuate iServer failed.
= Reason

Line 2, Column 32 The column reference "quantityOrdered” iz invald because
itis contained in an aggregate function and there is no GROUP BY clause.
Sum(CLASSICMODELS_DrderDetails. quantityOrdered *
CLASSICMDDELS_PrderDetails.priceEach] JAS Total

Details »»

Figure 3-39 Information object requires a GROUP BY clause

To avoid this problem, Information Object Designer automatically creates a
GROUP BY clause:

SELECT orderNumber, (SUM(quantityOrdered * priceEach)) AS Total
FROM OrderDetails
GROUP BY orderNumber

If more than one column appears in the GROUP BY clause, you can change the
order of the columns using the up and down arrows in Group By, as shown in
Figure 3-40.

Group By

Select columns to group:

Available Selected
Zl <Computed: arderMumber
Sl <Outputs productCode
& =
Hl = — Up and
down arrows

| Show all Fiemave Al |

Figure 3-40 Changing the order of GROUP BY columns

Creating a GROUP BY clause manually

If automatic grouping does not generate the desired SQL query, create the
GROUP BY clause manually. Create the GROUP BY clause manually if you want
to group on a column that does not appear in the SELECT clause, for example:

SELECT (SUM(quantityOrdered * priceEach)) AS Total
FROM OrderDetails
GROUP BY orderNumber

110 Designing BIRT Information Objects



How to create a GROUP BY clause manually
1 In the graphical information object editor, choose Group By.
2 In Group By, deselect Use Automatic Grouping.

3 In Available, expand the Computed and Output nodes to view the available
columns.

By default, Information Object Designer displays only output columns and
non-aggregate computed fields. To group on a column that is not an output
column, choose Show all.

4 In Available, select the appropriate column, and choose Select. This action
moves the column name to Selected, as shown in Figure 3-41.

Repeat the previous step for each GROUP BY column.

6 To change the order of the GROUP BY columns, select a column in Selected,
and use the up or down arrow.

Group By

Select columnsz to group,

Available Selected

Bl <Computed: CLASSICMODELS_QOrderDetails. orderNurnber
By <Output

B [ CLa5SICMODELS_OrderDe

=1 CLASSICMODELS_Orde

E CLASSICMODELS_Drde

E CLASSICMODELS_Orde _>| ;I
E CLASSICMODELS_Orde ﬂ j
N i

¥ Show all Remove Al

Figure 3-41 Selecting a GROUP BY column

Removing a column from the GROUP BY clause

By default, Information Object Designer removes GROUP BY columns
automatically. If you disable automatic grouping, you must remove GROUP BY
columns manually.

Removing a GROUP BY column automatically

Information Object Designer automatically removes a column from the GROUP
BY clause when:

m  You remove the column from the SELECT clause.
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For example, consider the following information object:

SELECT orderNumber, productCode, (SUM(quantityOrdered *
priceEach)) AS Total

FROM OrderDetails

GROUP BY orderNumber, productCode

You remove the productCode column from the SELECT clause. Information
Object Designer automatically removes productCode from the GROUP BY
clause:

SELECT orderNumber, (SUM(quantityOrdered * priceEach)) AS Total
FROM OrderDetails
GROUP BY orderNumber

m  You manually add a column to the GROUP BY clause that does not appear in
the SELECT clause and then enable automatic grouping.

For example, consider the following information object:

SELECT orderNumber, (SUM(quantityOrdered * priceEach)) AS Total
FROM OrderDetails
GROUP BY orderNumber, productCode

The productCode column appears in the GROUP BY clause but not in the
SELECT clause. You enable automatic grouping. Information Object Designer
automatically removes productCode from the GROUP BY clause:

SELECT orderNumber, (SUM(quantityOrdered * priceEach)) AS Total
FROM OrderDetails
GROUP BY orderNumber

Information Object Designer automatically removes the GROUP BY clause when:
= You remove all aggregate columns from the SELECT clause.
For example, consider the following information object:

SELECT orderNumber, (SUM(quantityOrdered * priceEach)) AS Total
FROM OrderDetails
GROUP BY orderNumber

You remove the aggregate column SUM(quantityOrdered * priceEach) from
the SELECT clause. Information Object Designer automatically removes the
GROUP BY clause:

SELECT orderNumber
FROM OrderDetails

= You remove all non-aggregate columns from the SELECT clause.
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For example, consider the following information object:

SELECT orderNumber, (SUM(quantityOrdered * priceEach)) AS Total
FROM OrderDetails
GROUP BY orderNumber

You remove the orderNumber column from the SELECT clause. Information
Object Designer automatically removes the GROUP BY clause:

SELECT (SUM(quantityOrdered * priceEach)) AS Total
FROM OrderDetails
Removing a GROUP BY column manually
If you disable automatic grouping, you must remove GROUP BY columns
manually.
How to remove a GROUP BY column manually
1 In the graphical information object editor, choose Group By.
2 In Group By, complete one of the following tasks:
= Select the column in Selected, and choose Deselect.

m  Toremove all Group By columns, choose Remove All.

Filtering on an aggregate column

If an information object includes a GROUP BY clause, you can restrict the data
rows the information object returns by adding a HAVING clause. The HAVING
clause places a filter condition on one or more aggregate columns. An aggregate
column is a computed column that uses an aggregate function such as AVG,
COUNT, MAX, MIN, or SUM, for example SUM(quantityOrdered * priceEach).

For example, the following information object returns order numbers and order
totals. The Total column is an aggregate column. The data is grouped by order
number and no filter condition is placed on the Total column.

SELECT orderNumber, (SUM(quantityOrdered * priceEach)) AS Total
FROM OrderDetails
GROUP BY orderNumber

Figure 3-42 shows the first 10 data rows returned by the information object.

You can add a HAVING clause to this information object to place a filter condition
on the Total column. The following information object returns only rows for
which the order total is greater than or equal to 50000:

SELECT orderNumber, (SUM(quantityOrdered * priceEach)) AS Total
FROM OrderDetails

GROUP BY orderNumber

HAVING SUM(quantityOrdered * priceEach) >= 50000
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|2 Pioblems | SGL Preview [ Data Preview &3 WD‘E Gueny Prufilar| @ o et U
ShowIED Tows at a time
orderMumber | Tatal | -
10100 1022383 i
10101 105439.01 -
10102 5434.78
10103 50218.950000000004
10104 40206.2
10105 £3959.20993393333
10106 52151.61000000001
10107 22292.620000000003
10108 51001.219999999954
10109 2583314 =l
Row(z] 1 - 50

Figure 3-42 Data rows returned by information object with GROUP BY clause
Figure 3-43 shows the first 10 data rows returned by the information object.

The procedures for creating filter conditions for aggregate columns are identical
to the procedures for creating filter conditions for other columns, except that you
use the Having page instead of the Filters page. Filter conditions that you create
using the Filters page are evaluated before filter conditions that you create using
the Having page. In other words, filter conditions in the WHERE clause are
applied before filter conditions in the HAVING clause.

|2 Pioblems | S0L Preview [ Data Preview &3 WD"E Cuery Profilar| @ L= |
ShowISU rows at a time
orderMumber | Tatal | -
10103 B218.950000000004 ¢
10105 53959.20933333333
10106 52151.61000000001 [
10108 51001.219999399954
10122 H0824.659939933336
10126 57131.92
10127 58641.35
10135 BAE01. 840000000004
10142 5E052.56000000001
10145 5034274 =l
Fow(s] 1 - 36

Figure 3-43 Data rows returned by information object with GROUP BY and
HAVING clauses

Defining parameters

An Actuate SQL parameter is a variable that is used in an information object. The
information object user provides a value for this variable in BIRT Studio, Actuate
Query, a report designer, or Information Object Designer.

For example, the following Actuate SQL query uses the parameters lastname and
firstname in the WHERE clause:

WITH ( lastname VARCHAR, firstname VARCHAR )
SELECT lname, fname, address, city, state, zip
FROM customerstable

WHERE (lname = :lastname) AND (fname = :firstname)

If an Actuate SQL query defines a parameter in a WITH clause but does not use
the parameter, the query does not return any rows if no value is provided for the
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parameter when the report runs. For example, the following query does not
return any rows if no values are provided for the lastname and firstname
parameters when the report runs:

WITH ( lastname VARCHAR, firstname VARCHAR )
SELECT lname, fname, address, city, state, zip
FROM customerstable

How to define a parameter
1 In the graphical information object editor, choose Parameters.
2 In Parameters, click the top empty line, and complete the following tasks:

m In Parameter, type the name of the parameter. If a parameter name contains
a special character, such as a period (.) or a space, enclose the name in
double quotation marks ().

m In Data type, select a data type from the drop-down list.
m In Default value, type the default value:

o If Default value is a string, enclose the string in single quotation marks,
as shown in the following example:

'New York City'

[

If Default value is a timestamp, it must be of the following form:
TIMESTAMP '2001-02-03 12:11:10'

o If Default value is a number, use a period (.) as the decimal separator, as
shown in the following example:

123456.78
NULL is not a valid parameter value. You cannot use a QBE expression.
E m To change the order of the parameters, use the up or down arrow.
|

To use the Prompt editor to specify the parameter’s prompt properties,
choose Prompt editor, as shown in Figure 3-44.

m To define other parameter properties, such as display name, select the
parameter in Parameters, and define the properties in Properties.

How to delete a parameter
1 In the graphical information object editor, choose Parameters.
2 In Parameters, complete one of the following tasks:

m To delete an individual parameter, select the parameter, and choose
Remove.

m To delete all parameters, choose Remove All.
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Parameters

Create a parameter by specifying a name, data type, and default value:
I Parameter I Data type | Default value I Prompt editor
S R I ———— Choose Prompt
editor to specify
prompt properties

= =

Remove | Femove Al | Localization |

Figure 3-44 Choosing Prompt editor to specify a parameter’s prompt properties

Specifying a parameter’s prompt properties

Use the Prompt editor to specify a parameter prompt’s properties, including
display control type, list of values, and default value. You can specify the
parameter values and, if desired, a corresponding set of display values that the
users choose. You create a list of values by typing the values or by typing an
Actuate SQL query that retrieves the values.

The query must meet the following requirements:

m  The query must retrieve one or two columns from an information object or
map, as shown in the following example:

SELECT DISTINCT custID, customName
FROM "MyInformationObject.iob"
ORDER BY 2

The first column contains the parameter values. The second column contains
the values that are displayed to the user. The information object or map must
reside in the same volume as the IOB from which the user launches Actuate
Query. If you use a relative path to reference the information object or map,
Actuate Query interprets the path as relative to the IOB from which the user
launches Actuate Query. If the information object or map defines a parameter,
you must provide a value for the parameter, as shown in the following
example:

SELECT DISTINCT custID, customName
FROM "MyInformationObject.iob" ['CA']
ORDER BY 2

m The first column’s data type must match the parameter’s data type.

m  The query must not contain a WITH clause.
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Information Object Designer does not validate the query. The values returned by
the query appear when a user specifies a value for the parameter in Actuate
Query or BIRT Studio. The values do not appear, however, when you specify a
value for the parameter in Information Object Designer or when a report
developer specifies a value for the parameter in a report designer.

How to specify a parameter prompt’s properties
1 Locate the appropriate parameter in Parameters and choose Prompt editor.

2 On the Prompt editor, in Show as, select the method of prompting the user, as
shown in Figure 3-45. If you use a type of display other than a text box, you
can specify a list of values for the user to choose.

Show az

 Text hox

% Drop-down list [read anly)
€~ Combo box (editable)

" Radio buttons

Figure 3-45 Selecting the method of prompting the user

You can create a list of values by typing the values and, optionally, the display
names, as shown in Figure 3-46. If you do not provide display names, the
values are displayed to the user.

You can create an Actuate SQL query that retrieves the values or both the
values and the corresponding display names. If the query has two columns,
the values in the second column are used as the display names. To use a query
to create the list of values, select Dynamic list of values, as shown in

Figure 3-47, and type the query.

If you select Combo box (editable), Dynamic list of values, and Auto suggest, a
drop-down list appears after the information object user types the number of
characters specified in Start Auto suggest after N character(s). The list contains
values that begin with the characters the user typed. For example, if the user
typed 'Atel and N=4, the list contains the value 'Atelier graphique'. In this
case, the query that retrieves the values must select two columns, a value
column and a display name column.

3 In Default value, you specify the default value.
You also can specify values for the following additional properties:
m  Conceal value
®= Do not prompt
m  Required
When you finish specifying the property values for the prompt, choose OK.
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and display
names

Figure 3-46 Typing a list of values and display names
Select
Dynamic list
of values
SELECT DISTINCT custID, customiame TypeActuate
FROM "MyInformationOhject.iob™
ORDER EBY 2 SQL query

Figure 3-47 Specifying an Actuate SQL query to provide a dynamic list of
values
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Setting parameter properties

Table 3-4 lists parameter properties and provides a description of each property.

Table 3-4 Parameter properties
Parameter property Can set? Description
Conceal Value Yes, in the  Visibility of the value that the user
Prompt provides for this parameter. To conceal the
editor value, set to True. To display the value, set
to False. This parameter property applies
only to parameters with the varchar data
type and the text box display type.
Data Type Yes, on the Parameter’s data type.
Parameters
tab
Default Value Yes, in the = Parameter’s default value. If a parameter
Prompt does not have a default value, and the
editor Required property is set to False, the
parameter takes one of the following
values if the user does not provide a value:
m 0 if the parameter is of type decimal,
double, or integer.
m  Empty string if the parameter is in the
varchar data type.
m Current date and time if the parameter
is in the timestamp data type.
Description Notused  Not used.
Description Key Notused  Not used.
Display Control Yes, in the  Control type for the parameter. The options
Type Prompt are text box, read-only drop-down list,
editor editable drop-down list, or radio buttons.
Display Format Notused  Not used.
Display Length Notused  Not used.
Display Name Yes Parameter prompt in BIRT Studio or
Actuate Query.
Display Name Key  Yes Key for Display Name property in
localization properties file.
Do Not Prompt Yes, in the  Visibility of the parameter to the user. To
Prompt hide the parameter, set to True. To display
editor the parameter, set to False.

(continues)
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Table 3-4 Parameter properties (continued)

Parameter property Can set? Description
Heading Notused  Not used.
Heading Key Notused  Not used.
Help Text Notused  Not used.
Help Text Key Notused  Not used.
Horizontal Notused  Not used.
Alignment
Name Yes, on the Parameter name.
Parameters
tab
Parameter Mode Yes Setting for parameters in stored procedures

and ODA data source queries to specify the
input or output type of the parameter. The
options are Input, Output,
InputAndOutput, or ReturnValue.
ReturnValue is used only for stored
procedures and is equivalent to Output.

Required Yes, in the  Indicator of whether the parameter is
Prompt required. To require a value for this
editor parameter, set to True. Otherwise, set to

False.
Size Yes The size of the parameter if the parameter

data type is varchar. Otherwise, not used.
Must be set if size is greater than 1300.

Setting source parameters

A source parameter is a parameter that is defined in a map or information object
from which you are building another information object.

You can set a source parameter to one of the following types of values:
m A single scalar value
m A local parameter in the information object that you are creating

You cannot set a source parameter to a column reference, such as
ORDERS.ORDERID, or an Actuate SQL expression.

When you set a source parameter to a local parameter, you can indicate that the
local parameter inherits the values of its prompt properties from the source
parameter. The available prompt properties are Conceal Value, Default Value,
Display Control Type, Do Not Prompt, and Required. If you specify that the local
parameter inherits its prompt property values from the source parameter, and
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prompt property values for the source parameter change, the changes are
propagated to the local parameter. For example, if the display control type for the
source parameter changes from text box to read-only drop-down list, the display
control type for the local parameter also changes from text box to read-only

drop-down list.

If you change a prompt property value for a local parameter, its prompt property

values are no longer inherited from the source parameter. For example, if you

change the display control type for the local parameter to editable drop-down list,
and the display control type for the source parameter later changes to text box,

the change is not propagated to the local parameter. To reinstate inheritance,

choose Reset in the Prompt editor. Choosing Reset returns all property values in

the local parameter to inherited values, and the local parameter inherits any

future changes to property values in the source parameter.

To set source parameters, use the Parameters page. To define a local parameter

and set a source parameter to the local parameter in one step, drag the source

parameter from Source parameter, and drop it in Parameter, as shown in

Figure 3-48.

Parameters

Create a parameter by specifying a name, data type. and default value

Parameter | Data type | Default valus | Prormpt editDrI
paramState Warchar 'Ca) )

|
|

Specify the value for each source plrameter. A source parameter is a parameter defined
in an information object used by this |farmation object. To uge a source parameter az a
local parameter for this information otliect, drag the source parameter to the Parameter
column.

Remove HemuveAIIl Locali)

| Source parameter I Yalue | Feset valuesl
M_l,l\nfurrrlali\:mDIJixacI.|:|aramSlalel :paramState -ﬁ

——F— Choose Reset

toresetvalue to
default value

Figure 3-48 Setting a source parameter for a new, local parameter

How to set a source parameter

1 In the graphical information object editor, choose Parameters.

2 In Parameters, complete the following tasks:

m In Source parameter, select the appropriate parameter.

= In Value, complete one of the following tasks:

o Choose a parameter from the drop-down list. The drop-down list
contains the local parameters for the information object you are

building.
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[m]

Type a value, as shown in Figure 3-49:

o If Value is a string, enclose the string in single quotation marks, as
shown in the following example:

'New York City'

[

If Value is a timestamp, it must be in the following form:
TIMESTAMP '2001-02-03 12:11:10'

o If Value is a number, use a period (.) as the decimal separator, as
shown in the following example:

123456.78
o If Value is a parameter, precede the parameter name with a colon (:).
Specily the value for each source p . & source p izap defined

in an infarmation object used by this information object. To use a source parameter as a
local parameter for this information object. drag the source parameter to the Parameter
calumi,

| Source parameter | Walue | Feset valuesl
MylnfomationObject paramState MY = —— Choose Reset
to reset value to

default value
Figure 3-49 Providing a value for a source parameter

Synchronizing source parameters

You must synchronize source parameters when parameters in a source map or
information object are added, removed, or reordered, or their data types or other
properties change. To synchronize source parameters, choose Compile IO in the
graphical information object editor, as shown in Figure 3-50. Synchronizing
source parameters refreshes the list of source parameters on the Parameters page.

REE

Choose Compile 10
to synchronize

saTIcDmn = source parameters
cu
contact_last
contact_first
custom ame
phone -
address

city

state

postalcode
credirank,
purchaseF requency
purchaseYolume ;I

Define a value for the source parameter:

| Source Parameter | Walue | |

MylnformationObject paramState  'WY"

T
| I 1

Columns | Column Categories | Joins | Filters [ Group By [ Having | Parameters|

Figure 3-50 Synchronizing source parameters
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Creating a textual information object

Use the Actuate SQL text editor if either of the following conditions is true:

m The graphical information object editor does not generate the desired Actuate
SQL query, so you must edit the query. For example, if the query includes OR
or UNION, you must use the Actuate SQL text editor to edit the query.

m  You want to type or paste an Actuate SQL query instead of creating it
graphically.

If you save a query in the Actuate SQL text editor, you cannot modify the query in
the graphical information object editor.

To display the Actuate SQL text editor, complete one of the following tasks:

m In the graphical information object editor, choose SQL editor, as shown in
Figure 3-51.

& |4 |

Choose SQL editor
= —~ to edit the SQL

vk Select Al d

custD q Uel'y

contact_last
contact_first
custom ame
phone I
address

city

state

postalcode
creditrank.
purchaseFequency
purchaseyolume LI

Define a value for the source parameter: =]

| Source Parameter | Walue | |
MylnformationObject paramState  'WY* ﬁ J
=

Columns ‘ Calurn Categories |.Jn|ns ‘ Filkers | Group By | Having | Parametersl

Figure 3-51 Choosing SQL editor to edit an Actuate SQL query
m In SQL Preview, choose Edit SQL.

m  On New Information Object, select Edit in SQL text editor, as shown in
Figure 3-52.

You edit the query in the upper pane of the Actuate SQL text editor. The lower
pane displays output columns or parameters.

When you edit a query in the SQL text editor, do not use table and column aliases
that are identical except for case. For example, do not use both status and STATUS
as column aliases.
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Information Object

Specify the name and location for a new infarmation object.

Mame: [ ditSOLInformationObject

Local director
& Default

€ Other Iz’MyProiect.z‘Information Objects

Browse. . |

V¥ Editin SOL text editor

(7] Cancel

Figure 3-52

The following rules also apply:

Select Edit in
SQL text editor
to type or paste
the query

Choosing to provide the Actuate SQL query in the SQL text editor

m Do not include an ORDER BY clause in the query.

m Paths that do not begin with a forward slash (/) are relative to the IOB file, as

shown in the following example:

../Data Sources/MyDatabase/dbo.customers.sma

m Absolute paths must begin with a forward slash. Using absolute paths is not

recommended.

Figure 3-53 shows the Actuate SQL text editor.

Displaying output columns

In SQL Text Editor—Columns, to display the query’s output columns and the
data type for each column, choose Describe Query, as shown in Figure 3-54.

To create a filter on a column, set the column’s Filter property to Predefined, and
specify the filter’s prompt properties.

To specify other column property values, select the column, and specify the

property values in Properties.
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Edit SQL query

1]

Columns

j=El *ourlrformationObject iob &2

WITH (parsm3tate Varchar)

Describe Query Localization

WHERE dbho_customers.sState = :param3tate

Lo

SELECT dbo_custowers.custID AS custID, dbo_custowmers.contact_last AS contact_last,
dho_customers.contact_first AS contact first, dbo_customers.customlame AS custonlame,
cho_custowers.phone AS phone, dbo_customers.address AS address, dbo_customers.city AS city,
dho_customers.state AS state, dbo_custowers.postalecode AS postaleode, dbo_customers.creditrank AS
creditrank, dbo_customers.purchaseFrequency AS purchaseFrequency, dbo_customers.purchaseVolume AS
purchaseVolume, dbo_customers.replD AS replD

FROM "../Data ZJources/Nylatsbase/dbo.customers.swa” AS dbo_customers

ol

I Output column I Data type I Prompt editor -
rcustlD Irteger i :
contact_last Warchar 53
contact_first Warchar i
customMame Warchar i
phone Warchar 53
address Warchar i
ity Warchar i [
state Warchar 53
postalcode Warchar i
creditrank “Warchar i =l

Columns [ Parameters|

Figure 3-53

Editing the SQL query in the Actuate SQL text editor

Choose Describe Query to display
the query’s output columns

Columns

Describe Queny | Localization |

| Data tppe

contact_last
cantact_first
cuistomb ame
phone

address

city

state

postalcode
creditrank
purchazeF requency
puichazelolume
repll

Integer

Warchar
Warchar
“Warchar
“Warchar
“Warchar
Warchar
Warchar
Warchar
Warchar
Warchar
Warchar
Integer

E [ e e

—— Choose Prompt editor to specify
prompt’s property values

Figure 3-54

Using Describe Query to display the query’s output columns
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Displaying parameters

On SQL Text Editor—Parameters, choose Describe Query to display the query’s
parameters and the data type for each parameter. You can type a default value for
a parameter in Default value, as shown in Figure 3-55.

Choose Describe Query to
display the query’s parameters

Parameters,

Describe Queny | Localization |

| Parameter | Data type | Defalt value | Prompt editorl

paiamState  Warchar g ) ——— Choose Prompt editor to specify
the prompt property values

Figure 3-55 Using Describe Query to display the query’s parameters

You can choose Prompt Editor to set the prompt property values.

Displaying and testing information object output

To preview output, you can display information object output in Data Preview.
You can also test the information object in BIRT Studio.

How to display and test information object output
1 Choose Data Preview.

2 In Data Preview, choose Refresh. As shown in Figure 3-56, Parameter Values
appears if the information object defines parameters.

& 5 [=1 B3

Specify parameter values:

Parameter | Diata type | Walue |
paramState Yarchar M
oK I Cancel |

Figure 3-56 Specifying parameter values

3 On Parameter Values, type the parameter values. A parameter value must be a
single value, not a list of values. When you finish, choose OK, and information
object output appears, as shown in Figure 3-57.
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Refresh

Previous Page
Next Page

Test in BIRT Studio

i F‘roblems| SOL Preview [ fl Data Preview 23 l‘:‘"lg Query Prafiler | @ LRI |
Show |50 Tows at a time —— Page Size list box

custlD I contact_last | contact_first | custorM ame | phaone | city | state &
156 Tam Wai Chung | Advanced Design Corp. 9145556707 | New Rachelle NY

m Hernandez | Maria Advanced Design Ine. 2125568493 | NYC NY

166 Fong Fawai Advanced Solutions Inc. 5185559644 | Albany MY

160 “fung SiuLun CompuE ngineering 5185553342 | Albany NY

168 Chandler Leslie CompuMicraSysterns Carp. 9145559081 | Sneadons Landing | WY

157 Barajaz Joze Computer Engineering 9145557064 | Mew Rachelle NY

128 Awila tdaria Computer MicioSystemns Corp. | 9145568205 | White Plain: MY

158 Cervantes Jogze Dresign Boards Co. 9145557468 | Mew Rochelle MY

115 Thompson | Bill Design Salutions Corp. 2125553675 | NYC NY

159 Thompson | Sue Design Systerns 9145553870 | Mew Rachelle NY

161 Smith Stan E xozoft Corp. 9145667172 | Sneadons Landing | WY =
109 Frick tdichael InfoE ngineering 21255851500 | NYC MY

129 “foung Julie InfaSpecialists 9145557265 | White Plains NY

162 King Pater Signal MicraSystems 5185554154 | Albany NY

104 Kuao Kee SigniS pecialists Corp 2125651957 | NWC MY

11|3 Tu Fwai Technical Design Inc. 21 255I5?81 g8 | NYC NY_Iﬂ
4 »

Figure 3-57 Viewing the information object’s output

4

To test the information object in BIRT Studio, choose the Test in BIRT Studio
icon.

Use the scroll bars to view all columns and displayed rows. Use the Page Size
list box to change the number of rows displayed on each page. Use the Next
Page and Previous Page icons to navigate through the data preview one page
at a time.

Displaying a data source query

When the Actuate SQL compiler compiles an information object, the compiler
creates one query for each data source. The query is written in the data source’s
native query language. You can display the query that is sent to a data source, as
well as the following information about the query:

The number of rows in the query’s output
The amount of time it takes to execute the query in milliseconds

The name and path for the data connection definition file

How to display a data source query and information about the query

1
2

Choose Query Profiler.
In Query Profiler, choose Start.

On Parameter Values, type the parameter values, as shown in Figure 3-58.
Choose OK.
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Specify parameter values:

Parameter | Diata type | Walue |
paramState Yarchar M
oK I Cancel |

Figure 3-58 Providing the parameter values

A schematic representation of the query execution plan appears in the upper
pane of Query Profiler.

4 Select a SQL or ODA node to display the data source query.
The data source query appears in the lower pane, as shown in Figure 3-59.

Select a SQL node to display
the data source query

|2 Problems | 507 Preview | [rata Preview [““E Query Profiler &2 I =8

Slartl Stopl Cancell 100 vl e |

SELECT "AcTestDBE" "dbo" "customers™."custl D", "AcTestDB". "dbo"."customers". "contact_last”, "beTestDB"."dbo”. "customers." ;I
contact_first", "AcTestDB". "dbo" "customers" "custormMame", "AcTestDB". "dba"."customers"."phone", "AcTestDB". "dba". "customers

" Maddress"”, "hcTestDB" "dba" "customers" "city”, "AcTestDB". "dbo™. "customers". "state”, "AcT estDB"."dba". "customers". "postalcode”,
“AcTestDB"” 'dbo"."customers”. "creditrank", "AcT estDE" "dbo™."customers™. "purchazeFrequency”’, "AcT estDB" . "dbo". "customers"."
purchaselolume”, "4cTestDB". 'dbo" "customers™. "repl D", "AcTestDB". "dbo". "orders™. "orderl D", "AcT estDB". "dba™. "orders"."
forecastOrderD ate”, “AcTestDB" "dbo™ "orders”."shipByDate”, "AcTestDB". "dbo™ "orders”."forecastShipDate”, “AcTestDB". "dbo™ "

orders". "status", "AcTestDB" 'dbo"."orders" "izsue’’, "AcTestDB". "dbo". "orders" "askByD ate", "acT estDE" "dbo" "orders". "custl D", "
AcTestDB" "dba' "orders". "categony”, "AcT estDB" "dba" "items". "itemcode, "AcTestDE" "dba". items"."'description”’, "AcT estDE"'dbo

" items" " pricequote’”, "AcTestDB" "dba" Vitemns".'quantity”, "AcTestDB" "dba" “items" 'category”, "AcT estDB" "dbo" “items" "orderl D"
FROM "AcTestDB" "dbo" "customers", "AcTestDB"."dbo'" "orders", "AcT estDB"."dbo" "items"

wWHERE CAST[ "AcTestDE " "dbo". "customers'. "state" AS NYARCHAR[4000] | COLLATE Latin1_General_BIN = 7 AMD UPPER[ CAST(
“AcTestDB". "dbo” "customers™. “credirank” 45 NVARCHAR(4000] ) COLLATE Latinl _General_BIM ] LIKE N'A%' COLLATE Latinl
_General_BIM ESCAPE ‘@2 AWND "AcTestDB"."dbo"."customers". "custl D" = "4cTestDB". "dbo" "orders". "custl D" AND "AcTestDB". "dbo

" orders” "orderl D" = "AcTestDB"."dbo" items". "arder| D"

ORDER BY "AcTestDE""dbo™. "customers™."customMame' ASC =l

Figure 3-59 Displaying the data source query

5 Hover the cursor over the SQL or ODA node to display information about the
query. Figure 3-60 shows an example of the information displayed for a query.

SQL
Input Tuples Exhausted a
Dutput Tuples 157 —— Number of OUtpUt rows
Cumulative Time 12340 —Query execution time
Exhaust Calls 1]
Reset Calls 1]
Pages Allocated 1]
Physical Store MyProject/Data Sources/MyDatabase/_MyDatabaseded —— Connection definition file
Fress F2for focus

Figure 3-60 Display of information about a query
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Understanding query execution plan operators

If an information object retrieves data from only one data source, the query
execution plan consists of a single node: a SQL or ODA node that displays the
query sent to the data source. If an information object retrieves data from more
than one data source, the query execution plan consists of several nodes,
including the following;:

m  One SQL or ODA node for each data source query.
m  Nodes that represent the joins between data source queries.

For example, the query execution plan in Figure 3-61 displays two SQL nodes and
a join node. The SQL nodes represent the native SQL queries that are sent to two
different databases. The join node indicates that the join uses the Nested Loop
join algorithm.

-+ soL

&

HLJain

saL

Figure 3-61 An execution plan for a query using a join of two SQL queries

You can experiment with different join algorithms and determine which one
performs best by doing the following:

m Displaying the execution time for each node.

m Calculating the total execution time for the information object by adding the
execution times for the individual nodes.

Understanding node operators

Node operators process the output of other operators to produce rows.

Augment

Augment adds the result of an expression as a new column to each row in the
target relation.

Box

Box appends a nested relation containing a single row whose columns are a
subset of the columns in the input row. The boxed columns are removed from the
input row. Both the inner and outer relations are projections of the input relation.
In other words, columns can be rearranged.

Chapter 3, Creating information objects 129



CallExecutionUnit

CallExecutionUnit executes the equivalent of a subroutine call. CallExecutionUnit
augments each incoming row with an iterator that iterates over the product of a
dependent execution unit. The dependent execution unit can be parameterized
with data from the input relation or from the calling execution unit. The
parameters are either scalar types or iterators over nested relations.

DependentJoin

DependentJoin joins an input relation with the product of a dependent execution
unit. The dependent execution unit can be parameterized with data from the
input relation or from the calling execution unit. The join itself is unconditional.
Because the dependent execution unit is parameterized, however, the contents of
the dependent relation can be different for every input row. The join is either
nesting or flat:

m Nesting

Each input row is augmented by a single iterator column that contains the
dependent execution unit’s output rows.

m Flat

Each input row is augmented by all the columns of the dependent execution
unit’s output rows.

Dup

Dup creates a second independent iterator over a materialized relation. In effect,
Dup duplicates the relation. The duplicated relation can come from any row in
the target path. It is possible to take a relation that is nested in an outer row and
nest a copy of it into every row in a deeper relation. The output row is a copy of
the input row with the additional iterator on the end.

Materialize

Materialize caches an entire relation, including its descendants in the executor’s
memory. [terators over the relation and its descendants can then be reset
repeatedly. This is necessary if the relation is duplicated or if the relation is to be
aggregated over as well as detailed. Materialize does not change any data.
Materialize simply accumulates rows from its input and does not release the rows
until they are no longer needed. For more information about controlling how a
relation is materialized, see Configuring BIRT iServer.

MergedJoin

MergeJoin performs an equijoin between left and right relations. Both relations
must be ordered by join condition. The join can be nesting or flat:

m Nesting
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Each left-side row is augmented by a single iterator column that contains the
selected right-side rows.

m Flat

Each left-side row is augmented by all the columns of the selected right-side
rows.

Move

Move copies an iterator. The copied iterator can come from any row in the target
path. It is possible to take a relation that is nested in an outer row and nest a copy
of it into every row in a deeper relation. Unlike Dup, the copied iterator shares
state with the original one. It is illegal to iterate over one iterator in an inner loop
while maintaining the context of the other in an outer loop.

MultiAugment

MultiAugment augments a row with an iterator column. This iterator produces a
relation whose contents are the result of evaluating an expression. One row is
produced for each expression, and then the inner iterator is exhausted until the
outer iterator is advanced again. The operator has the effect of augmenting a row
with a sequence.

Nest

Nest groups adjacent rows that match an equality constraint. The group of rows is
then replaced by a single outer row with a nested relation containing the same
number of rows that were in the group. The columns in the input rows that are
projected into the inner relation are independent of the columns that are
compared to determine grouping.

NestedLoopdJoin

NestedLoop]oin joins two input relations by evaluating an expression for every
pair of rows. NestedLoopJoin materializes the right-side relation and then, for
every left-side row, iterates over all rows in the right-side materialization,
evaluating the expression each time. If the result of the expression is True, the
rows match.

Project

Project reorders or removes columns within a relation.

Select

Select removes rows from the target relation. For every input row, an expression
is evaluated. If the result of the expression is False, the row is rejected. When
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Select is advanced, it advances its input iterator repeatedly until it finds a row
that is accepted. Then it passes that row on.

Sort

Sort sorts a relation using one or more sort keys. The relation is first materialized.

Union

Union combines the rows from two relations without eliminating any duplicates.
The left-side rows are output first, and then the right-side rows.

Understanding leaf operators

Leaf operators produce rows by communicating with a data source.

FakeData

FakeData generates a flat relation using synthesized data. FakeData is used for
testing.

FakeFileData

FakeFileData reproduces a flat relation stored in tab-delimited format in a text
file. FakeFileData is used for testing.

IteratorAsLeaf

IteratorAsLeaf is used in dependent execution units. IteratorAsLeaf takes an
iterator that is specified in the execution unit’s parameter list and treats the
iterator as a leaf operator. IteratorAsLeaf is used when a binary operator, for
example a join, is applied to sibling relations within the same containing relation.
NoOp

NoOp returns an empty relation. NoOp is used by the compiler to represent
queries when the compiler determines that there are no results.

ODA

For more information about the ODA operator, see “Displaying a data source
query,” earlier in this chapter.

SortedOuterUnion

SortedOuterUnion allows multiple SELECT statements to be evaluated by a data
source in a single round-trip.
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SQL

For more information about the SQL operator, see “Displaying a data source
query,” earlier in this chapter.

Storing a query plan with an information object

An information object can be used as a data source in BIRT Studio. The
information object’s query plan is compiled the first time a BIRT Studio user
drags-and-drops a column from the Available Data pane to the report display
area. If the information object is built from a large number of maps or information
objects, the first drag-and-drop operation may take a long time. To avoid this
problem, you can store a precompiled query plan with the information object.

Storing a precompiled query plan with an information object increases the size of
the information object. For this reason, do not store a precompiled query plan
with an information object unless the first drag-and-drop operation in BIRT
Studio is unacceptably slow.

Store a precompiled query plan with an information object when either of the
following conditions is true:

m The information object is built from more than 100 tables consisting of more
than 1000 columns.

m The information object has more than four levels in its hierarchy.

If an information object query’s compile time is very large, it may be advisable to
store a precompiled query plan with the information object.

How to display an information object query’s compile time
1 Choose Query Profiler.
2 In Query Profiler, choose Start.

3 On Parameter Values, type the parameter values, as shown in Figure 3-58.
Choose OK.

A schematic representation of the query execution plan appears in the upper
pane of Query Profiler, as well as Profiler Statistics such as compile time. In
Figure 3-62, Profiler Statistics displays a compile time of three seconds.

Profiler Statistics
Compile Time: 3
Execution Time : 315

Figure 3-62 Profiler Statistics
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Saving an information object’s query plan

To store a query plan with an information object, set the Use Precompiled Query
Plan at runtime property to True and save the information object. The
Precompiled query plan saved on property displays the date and time at which
the query plan is saved.

How to save an information object’s query plan
1 Open the information object in the graphical or textual query editor.
2 Click in the white space in the upper pane of the query editor.
Figure 3-63 shows the upper pane of the graphical information object query

editor.
Cineroen | TN
wESelect &1 Select Al
custlD orderlD
contact_last forecastOrderD ate
contact_first shipByD ate
customMame forecastShipD ate
phone satus
addresz izsue
city askByD ate
state custlD
postalcode category
creditrank,
purchazeFrequency
purchaseVolume —Click in white space
replD

Figure 3-63 Upper pane of the graphical information object editor
3 In Properties, set Use Precompiled Query Plan at runtime to True.

4 Choose File>Save.

Saving query plans for source and dependent
information objects

To store query plans for a source information object and its dependent
information objects, set the Use Precompiled Query Plan at runtime property to
True for each information object and save the information objects. If you modify
the source information object, you can refresh the query plans in one step by
compiling the information objects.

How to refresh the query plans for source and dependent information objects

1 In Navigator, select the source information object.

2 Choose File>Compile IO and dependents.

If any of the information objects are open, the prompt shown in Figure 3-64
appears. Choose Yes.
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This action compiles the |0 and dependents, resolves unknown column data
twpes and synchronizes source parameters. The precompiled gueny plan will be
updated if stared.

I order to perform this action the following files will need to be closed. These
will be reopened after the action is complete :

MyProject/nformation Objects/S ourcel0.iob
MyProject/Information Objects/Dependent! 0.ioh

Lo you wizh to zave any changes and proceed?

es No

Figure 3-64 File close prompt

The Progress dialog appears, as shown in Figure 3-65. To run the compile
operation in the background, choose Run in Background.

B Compile I0 and dependents

‘ir) Compiling the selected IO and its dependents...

[ ahways run in backaround

IRun in Background I [ Cancel I [ Details ==

Figure 3-65 Progress dialog

The progress indicator appears in the lower right corner of the IO design
perspective.

3 To display the Progress view, choose the progress indicator.

The Progress view, shown in Figure 3-66, displays the progress of the compile
operation.

[3_\ Pfob)’ems[ SOL Preview [ Data Presview {E“[‘; Guery Profiler [C Progress &3 S& ¥ =0
a4 Building workspace
]

Compiling AyProject/Information Objects/Dependentl 0.iob

Figure 3-66 Progress view

Deleting an information object’s query plan

To delete an information object’s query plan, set Use Precompiled Query Plan at
runtime to False and save the information object.
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Localizing an information object

If an information object is used in more than one locale, you should provide
translated strings for the following column and parameter properties for each
locale:

m  Description

m Display Name

m Heading

m  Help Text

The translated strings are used when:

m The information object is used as a data source in a report design in BIRT
Studio, e.Report Designer Professional, or e.Spreadsheet Designer.

m A report with an information object data source is viewed in the Viewer or
Interactive Viewer.

For each locale, you create a properties file that contains a key and a translated
string for each column or parameter and property. For example, the following
entries contain keys and French strings for the customerNumber and
customerName columns:

customerNumber DescriptionKey="Numéro de client"
customerNumber DisplayNameKey="Numéro de client"
customerNumber HeadingKey="Numéro de client"
customerNumber HelpTextKey="Numéro de client"
customerName DescriptionKey="Nom du client"
customerName DisplayNameKey="Nom du client"
customerName HeadingKey="Nom du client"
customerName HelpTextKey="Nom du client"

The localization properties file resides in the project’s Localization folder. The
name of the file is constructed from the project name and the locale code. In
Figure 3-67, the Localization folder in the project MyLocalizedProject contains
properties files for Spanish and French. Localization properties files are shared
among all information objects in a project.

5. Mavigator £3 l =04

Eg MyLocalizedProject

= Data Sources

(= Information Objects

B[~ Localization
MyLocalizedProject_es ES.properties
‘ Myl ocalizedProject_fr_FR.properties
- |K] project

Localization properties files

Figure 3-67 Localization properties files
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The locale code consists of a two-letter language code, an underscore, and a two-
letter country code. For example, the locale code for French (France) is fr_FR. Use
the following URL to display a list of languages and the corresponding ISO 639
language codes:

http://ftp.ics.uci.edu/pub/ietf/http/related/iso639.txt

Use the following URL to display a list of countries and the corresponding ISO
3166 country codes:

http://userpage.chemie.fu-berlin.de/diverse/doc/ISO_3166.html

How to localize an information object

1 Open the information object in the graphical or textual information object
editor.

Choose Columns or Parameters.

In Columns or Parameters, select the column or parameter whose properties
you want to localize.

In Figure 3-68, the customerName column is selected in the graphical
information object editor.

4 Choose Localization, as shown in Figure 3-68.

Columns
Specify output colurnns: ™ Distinct values only
| Source columin of expression | Narne -
CLASSICMODELS _Customers.customer umber customerM umber
IDELS il ame
CLASSICMODELS _Customers.contactLastMame cantactLastM ame
CLASSICMODELS _Customess.contactFirsttame contactFirstM ame
CLASSICMODELS_Customers.phone phone
CLASSICMODELS _Customers. addressLinel addrezsLine’ d
CLASSICMODELS_Customers. addressLine2 addressLine?
CLASSICMODELS_Customess.city city j
CLASSICMODELS _Customers. state state
CLASSICMODELS _Customers.postalCade postalCode [—
CLASSICMODELS _Customers.country cauntry
ICLASSICMDDELS_Customels.saIesHepEmployaeNumbar salesHepEmpIDyeeiNumber _Iﬂ
4 »

Hemovel HemoveAIIl LocalizationI Localization button

Figure 3-68 Localization button in Columns

5 In Localization, choose a translation locale from the drop-down list. Choose
OK.

In Figure 3-69, the translation locale is French (France).
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Translation locale is
French (France)

Figure 3-69 Specifying the translation locale
6 In Localization, choose Browse for the appropriate key.

For example, to localize the Display Name property, choose the Browse button
to the right of the Display Name Text Key field.

7 In Select Key, in Quick Add:
1 In Key, type the translation key.
2 In Value, type the translation string.
3 Choose Add.

8 Select the Key-Value pair. Choose OK.

In Figure 3-70, the Key-Value pair customerName_DisplayNameKey-"Nom
du client" appears.

Mom du client

custornerMame_Displayh amek ey Morn du client

(2] ok | Cancel |

Figure 3-70 Creating a Key-Value pair
9 Repeat steps 6 through 8 for the remaining translation keys. Choose OK.

Figure 3-71 shows the translation keys for the customerName column.
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The fallowing properties can be localized:
Display Mame Text Key  [customemame_DisplayN amekey Browse... |m|
Heading Test Key [customeM ame_Headingkey Browse |ﬂ|
Help Text Key |customeMame_HelpTexstk.ey Erowse... |ﬂ|
Desciiption Text Key  [customerMName_D escriptioney ﬂl

ok Cancel

Figure 3-71 Translation keys for customerName

10 Repeat steps 3 through 9 for the remaining columns or parameters.
11 Test the localized information object with the appropriate locale. For example:
1 Log in to Information Console with the French (France) locale.

2 Use the localized information object as a data source in a report design in
BIRT Studio.

3 Verify that the French display name, help text, and heading appear.
How to modify a translation string
1 In Localization, shown in Figure 3-71, choose Browse for the appropriate key.
2 In Select Key, shown in Figure 3-70, select the appropriate Key-Value pair.
3 In Value, modify the translation string. Choose Add.
4 Select the Key-Value pair. Choose OK.
How to modify a translation key
1 In Localization, shown in Figure 3-71, choose Browse for the appropriate key.

2 In Select Key, shown in Figure 3-70, select the appropriate Key-Value pair.
Choose Delete.

3 In Key, modify the translation key. Choose Add.
4 Select the Key-Value pair. Choose OK.

How to disable localization for a column or parameter property

In Localization, shown in Figure 3-71, choose Reset for the appropriate key. The
information object displays the untranslated string for the column or parameter
property, for example Display Name, instead of the translated string.

How to restore localization for a column or parameter property

1 In Localization, shown in Figure 3-71, choose Browse for the appropriate key.
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2 In Select Key, shown in Figure 3-70, select the appropriate Key-Value pair.
Choose OK.

How to change the translation locale

The first time you localize an information object, you specify the translation locale
in the Localization dialog shown in Figure 3-69. If you localize the information
object for another locale, you must specify the translation locale in the Properties
dialog shown in Figure 3-72. To display the Properties dialog, select the project in
Navigator and choose File>Properties.

tupe filter tewt

- Resource

- Actuate iServer S ————Translation locale is
- Bulders Spanish (Spain)
- Project References

un/Debug Settings
- Task Repositony

Figure 3-72 Specifying the translation locale
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Caching information
objects

This chapter contains the following topics:
m About information object caching
m Creating a cache connection definition

m Creating a cache object
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About information object caching

Certain information objects, for example an information object that aggregates
data over a very large number of rows, take a long time to return data rows and
place a heavy load on production databases. You can reduce information object
execution time as well as the load on production databases by caching the
information object. You cache the data rows returned by an information object in
a single table in the cache database. A cache database must be of one of the
following types:

s DB2
m Oracle
m SQL Server

Information object caching is managed by the Actuate BIRT iServer System
Caching service For more information about the Caching service, see Configuring
BIRT iServer.

You cannot cache an information object that has a parameter.
To cache an information object, you perform the following tasks:

m In Information Object Designer, create a cache connection definition. A cache
connection definition defines the connection properties for the cache database.

m In Information Object Designer, create a cache object. A cache object is
associated with a table in the cache database.

m In Management Console, activate the cache object. Activating the cache object
creates a cache table.

m In Management Console, populate the cache table by running a job for the
cache object. You should periodically refresh the data rows in the cache table.

This chapter explains how to perform the first and second tasks. For information
about the third and fourth tasks, see Managing an Encyclopedia Volume.

Creating a cache connection definition

A cache connection definition defines the connection properties for the cache
database. Information Object Designer creates a subfolder in the project’s Cache
Sources folder to contain a cache connection definition file. A cache connection
definition file name has a .dcd extension. Cache connection definition file names
are not case-sensitive.

For example, if you create a cache connection definition for the database
MyCacheDatabase, Information Object Designer creates the folders Cache
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Sources and MyCacheDatabase and the cache connection definition file
_MyCacheDatabase.dcd. As shown in Figure 4-1, the file _MyCacheDatabase.dcd
resides in MyCacheDatabase.

5. Mavigatar 23 =0
LEs =

= @ A yProject
El-l= Cache Sources
‘ (= MyCachelDatabase

‘ L@ _MyCacheDatabas=ded ——— Cache connection
B Data Sources definition file
[H-[= Infarmation Objects
K| .project
Figure 4-1 A cache connection definition file

The procedure for creating a cache connection definition is the same as the
procedure for creating a data connection definition, except that you must also
provide the names of the database catalog and schema in which you want to
create the cache table. The database user you specify for the cache connection
definition must have permissions to create, modify, and delete tables in the
schema.

Creating a cache object

A cache object is associated with a table in the cache database. Information Object
Designer places the cache object file in the same folder as the cache connection
definition (.dcd) file for the cache database. A cache object file name has a .icd
extension. Cache object file names are not case-sensitive.

For example, Figure 4-2 shows that if you create a cache object using the cache
connection definition _MyCacheDatabase.dcd, Information Object Designer
places the file MyCacheObject.icd in the folder MyCacheDatabase.

5. Mavigator £3 =0
|8 &5 [ = =

= @ MyProject
El-l= Cache Sources
‘ E|Eb MyCachelatabase
E _MyCacheDatabase.ded
‘ -8 MyCachebiecticd
[#-[= Data Sources
[H-[= Infarmation Objects
- |X] project

—— Cache object file

Figure 4-2 A cache object file
When you create a cache object, you can specify the following:

m The default name for the cache table and the names of the columns in the
cache table.

m A primary key for the cache table.
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m Indexes for the cache table.

m How to refresh the data rows in the cache table.

Refreshing the data rows in a cache table

When you refresh the data rows in a cache table, you can recreate the cache table
or add only new rows to the cache table. If you choose to recreate the cache table,
you can specify Data Definition Language (DDL) statements that are executed
after the cache table is created. For example, you can use DDL statements to
perform the following tasks:

m Create a foreign key.

m Execute a stored procedure.

m Create a trigger on the cache table.
m Create a check constraint.

m Create a clustered index.

If you choose to add only new rows to the cache table, you must specify an
update column for the cached information object. The update column is typically
of type Integer or Timestamp. The Caching service uses the update column in
either of two ways:

m The Caching service compares the values in the update column to the
maximum value of the corresponding column in the cache table.

m The Caching service compares the values in the update column to a parameter
value.

In either case, rows for which the value of the update column is greater than or
equal to the comparison value are added to the cache table.

For example, you want to cache an information object called
MylInformationObject that lists bank transactions. MyInformationObject contains
the following query. The update column, TransactionlID, contains the transaction
IDs and is of type Integer.

SELECT Transactions.TransactionID, Transactions.Date,
Transactions.Amount
FROM Transactions.iob

If you choose to have the Caching service compare the values in the update
column to the maximum value of the corresponding column in the cache table,
MyCacheTable, the Caching service issues the following query and appends the
rows in the result set to the cache table.

SELECT Transactions.TransactionID, Transactions.Date,
Transactions.Amount
FROM Transactions.iob
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WHERE Transactions.TransactionID
>= MAX( MyCacheTable.TransactionID )

If you choose to have the Caching service compare the values in the update
column to a parameter value, you must create a map or information object similar
to the following information object. This information object must meet the
following requirements:

m The output columns for the information object must have the same data types
as the output columns for the cached information object
(MyInformationObject in this example).

m  The update column data type must match the parameter data type.
m The FROM clause must not refer to cached maps or information objects.

WITH ( MyParameter Integer )

SELECT Transactions.TransactionID, Transactions.Date,
Transactions.Amount

FROM Transactions.iob

WHERE Transactions.TransactionID >= :MyParameter

When the cache job runs, the Caching service passes the value of
MAX( MyCacheTable.TransactionID ) to MyParameter and appends the rows in
the result set to the cache table.

Database-specific limitations

If you are using a DB2 cache database, take note of the following limitations:
m Table name size must not exceed 128 bytes.

m  Column name size must not exceed 30 bytes.

m  Anindex name must be unique within the database.

m  You cannot use a semicolon as a SQL delimiter in a set of DDL statements. As
a result, you cannot type more than one DDL statement in the Post-cache
replacement DDL statements text box, shown in Figure 4-9.

m In a DDL statement, a table name must be of the form

"schema_name"."table_name".
If you are using an Oracle cache database, take note of the following limitations:
m Table and column identifiers must not exceed 30 characters.
m  Anindex name must be unique within the database.

m By default, column names in SQL Server database tables contain double
quotes, for example "ACSPECIAL_CHAR". Oracle databases, however, do not
support column names that contain double quotes. For this reason, you cannot
cache an information object built from SQL Server database tables in an Oracle

Chapter 4, Caching information objects 145



database without removing the double quotes from the column names in the
cache table. If you attempt to do so, an error similar to the following appears:

Executing a SQL statement returned a database error.

[ActuateDD] [Oracle JDBC Driver] [Oracle]ORA-03001: unimplemented
feature

The statement executed was:

CREATE TABLE "CACHEDB GAL"."ACSPECIALCHARS SQL ch" (

"ACSPECIAL_ CHAR" nvarchar2 (20) NULL,
"ACSPECIAL#CHAR" nvarchar2 (20) NULL,
"ACSPECIALSCHAR" nvarchar2 (20) NULL,
"EMBED" "QUOTE" nvarchar2 (5) NULL

)

How to create a cache object
1 Choose File>New~>Cache Object.

2 In Choose a Cache DCD, select the cache connection definition for the
appropriate cache database, as shown in Figure 4-3. Choose Next.

= =10 x|
Choose a Cache DCD

Choose a Cache DCD ta be aszaciated with the cache object

= @ tyProject
El= Cache Sources
‘ EH= MyCacheDatabase

] %= Data Sources
[ Information Objects

(7] < Back I Hext > I Einish | Cancel |
Figure 4-3 Selecting a cache connection definition

3 In Choose an object to cache, select the map or information object you want to
cache, as shown in Figure 4-4. Choose Next.

= _[ofx|

Choose an object to cache

Choosge an 0B or SMA to cache. The cached object cannot be associated with a
cache alieady and cannot have any paiameters.

= @ tuProject
[#-[= Cache Sources
(= Data Sources
= E Infarmation Objects

(7} < Back I Mext » I Einish | Cancel |
Figure 4-4 Selecting an information object
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4 In Choose a name, type a name for the cache object, as shown in Figure 4-5.

Choose Finish.
= IS [=]
Choose a name
Choose a name for the new cache object
Cache object namelMyCaCheDb\ect
< Back | Tewt > | Einizh I Cancel |

Figure 4-5

5 In Columns:

Typing a name for the cache object

In Name, type the names for the columns in the cache table.

Columins

Default table name: [pyCacheT able

Specify colurns:

| Source calumn | Mame | Diata type -

MylnformationDbject. customer... | custamerMurnber Integer

fulnformationDbject. customer... | customerMame Warchar

ylnformationDObject. contactL... | contactLastMame “archar

MylnformationDbject. contactFir... | contactFirstM ame Yarchar

MylnformationDbject. phane phone Yarchar

fulnformationDbject. addressLi.. | addressLinel Warchar

MylnformationDbject. addressLi.. | addressLine2 Yarchar

MylnformationDbject. city city Yarchar

fulnformationD bject. state state Warchar

tulinformationDbject. postalCode | postalCode Warchar

MylnformationDbject. country country Yarchar

MylnformationDbject. salesRep... | salesRepEmployeeumber Integer

fdulnformationD bject. creditLimit creditlimit Double

tdulnformationDbject. orderMum... | ordemumber Integer

MylnformationDbject. orderDate | orderDate Timestamp

MylnformationDbject. requiredD... | requiredD ate Timestamp

fylnformationDbject shippedD shippedD ate Timestamp

tdulnformationD bject. status statug Warchar ]
MylnformationDbject. cormments | comments Yarchar

MylnformationObject. custamer... | customerMumber_1 Integer LI

Figure 4-6

m  Choose Optimization.

6 In Optimization:

m To define a primary key, in Define primary key (optional):
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Specifying cache table and column names

o In Available Columns, select the appropriate column(s).

In Default table name, type the default name for the cache table, as shown
in Figure 4-6. You can override the default when you activate the cache
object using Management Console.
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o Choose > to move the column(s) to Columns in Primary Key, as shown
in Figure 4-7.

Diefine prirmary key [optional]

Available Columng Caolumng in Primary Key

GUBOMEINAME ot customnertiumber
contactLasth ame j
<

contactFirsth ame
phane J
addrezzLine]

addressLinez LI

Figure 4-7 Defining a primary key
m To define an index, in Define table indices (optional):
o Choose Add.
o In New Index, type a name for the index. Choose OK.
o In Available Columns, select the appropriate column(s).

o Choose > to move the column(s) to Columns in Index, as shown in
Figure 4-8.

r Define table indices [optional)

Add
Delete |
Avaiable Columng Calumng in Indes
creditLimit N
<
requiredD ate LI J

Figure 4-8 Defining an index

m  Choose Updates.
7 In Updates:

m In Post-cache replacement DDL statements (optional), type the DDL
statements, as shown in Figure 4-9.

Automatic Cache Replacement
Past-cache replacement DDL statements [optional):

I{? = cal EITESTDE.dbo. 5F_CUSTOMERS_ORDERS 1}

Figure 4-9 Typing DDL statements
m In Update column, choose an update column from the drop-down list.

m  Choose Use column as filter or Use column as parameter into data source.
If you choose Use column as parameter into data source, browse to the
appropriate map or information object, as shown in Figure 4-10.
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Incremental updates
Mew recards will be appended to the table, while existing recards will be unchanged.

Update column | orderMurber j

€ Use column as fiter

% Usze column as parameter into data source

Iz’MyF‘roiect!I nfarmation Objects/Cachelpdatel 0.iob

Figure 4-10 Specifying an incremental update method

You specify automatic cache replacement or incremental cache update when
you schedule the cache job using Management Console.
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Building and
publishing a project
This chapter contains the following topics:
m Building a project

m Propagating column and parameter property values

m Publishing a project
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Building a project

Building a project compiles the resources in the project. By default, Information
Object Designer builds a project whenever you modify and save a resource. If you
disable automatic building, choose Project>Build Project to build a project.

Build error messages appear in Problems, as shown in Figure 5-1. To locate an
error, double-click the error message. To filter the error messages, choose Filters.

Double-click to Choose Filters
locate the error to filter error
messages

[3_ Problems &3 SL Preview| Data Pleviaw‘ ““E Gueny Prufilar| :‘=:i> ¥ =0

2 errore, 0 warnings, [/Afos

Dascriition =

@ Error retrieving column information from the database, MySOLMap.sma Unknown
@ Line 1. Column 22; Every SELECT item column refere MylnformationObject.ioh Line 1. Column 22

Resource Location

Figure 5-1 The Problems view

[ If the description is truncated, select the error message and choose Ellipsis to
display the complete description.

For more information about building a project and filtering error messages, see
the Workbench User Guide in the Information Object Designer online help.

Propagating column and parameter property values

Before you publish a project, make sure the information objects in the project
inherit the correct column and parameter property values by selecting the project
and choosing Project>Propagate Property Values. Propagation of property
values may take several minutes. A map’s or information object’s column order
and category order are not propagated to its dependent information objects.

Propagating column and parameter property values modifies the information
objects in your project. For this reason, you should make a copy of the project
before you perform this operation.

How to make a copy of a project
1 In Navigator, select the project and choose Edit>Copy.
2 Choose Edit>Paste.

The copied project appears in Navigator.

3 Choose an iServer profile for the copied project.
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Publishing a project

When you create an information object project, you must specify a development
location that includes the Encyclopedia volume and the folder in which the
project resides. When you are ready to test or deploy the project, you should
publish the project to a different location. The publish volume can be the same as
the development volume, or you can publish to a different volume. If you publish
to the same volume, the publish folder should be different from the development
folder. If you do not specify a project’s default publish location when you create
the project, you can do so in the project’s Properties dialog.

You can publish a project or individual resources to an Encyclopedia volume.
Data and cache connection definitions (DCDs), external procedures (EPRs), maps
(SMAs), information objects (IOBs), and cache objects (ICDs) are not versioned in
an Encyclopedia volume. When you publish a DCD, EPR, SMA, IOB, or ICD, you
replace the existing file.

How to specify a default publish location for a project

1 In Navigator, select the project.
Choose File>Properties.
In Properties, select Actuate iServer.

In Publish Location, choose Add.

a & ODN

Complete the New iServer Profile dialog, as shown in Figure 2-4. Choose
Finish.

6 Browse for the appropriate folder or accept the default folder, shown in
Directory in Figure 5-2. Choose OK.

Default publish
location

ETE

Itype Filter et Actuate iServer T T

+ Resource — _—
i Actuate iServer (S =L (Ll

Builders iServer profile: IMyDeveIopmentPlofile j Edi... Add...l

i Localization
Praject References Directany: |.-"HDme.-"MyHomeFDIH;rfdevelopment.-"MyProiect Browse... | UseHome |
i Run/Debug Settings

B Task Repasitay i~ Publizh Location [optional)
- Task Tags iServer profile; | MyPublishProfile j Edi... -Add---
i+ Walidation I

L WikiT et Diirectary: |x’\nformation Objects/MyProject Brovise:

|@:| 0K | Cancel

Figure 5-2 Default publish location for a project
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How to publish a project
1 In Navigator, select the project.
2 Choose File>Publish Information Objects.
3 In Publish Information Objects:
1 Select the project, a folder, or individual resources.

2 IniServer profile, select a profile from the drop-down list.

If you specified a default publish location for the project, the iServer profile
and folder appear.

3 In Publish location, browse for the appropriate folder or accept the default
folder, as shown in Figure 5-3.

4 If you want Information Object Designer to remember this location the next
time you publish a project, select Remember this location.

= =1of x|

Publizh falders and files fram a project ta an Encyclopedia volume.

Select project files:

Project: IMyProiecl -

M=

t

Data Sources
= MyDatabase
B _MyDatabase.dod
% dbo.Customers. sma

[ dbo.DrdeDetails. sma
dbo. Orders.zma

(== Information Objects
=Bl MylnformationObject.iob
& YourlnformationObject iob

Specify the Encyclopedia volume and directory.

iServer prafile: IMyPuinshF’rofi\e - Edit | Add
Publizh location: I.-"Information Objects/ Browse... |

™ Remember this location
Version % Replace the |atest version ¥ Copy permissions from |ast version

' Create a new version

(7] Publish Filesl Close |

Figure 5-3 Selecting files to publish

5 Choose Publish Files.
Publishing appears, as shown in Figure 5-4. Messages indicate whether the
selected items are published. If an item is not published, a message gives
the reason.
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@ MyProject/Data Sources/MuDatabase! MuDatabase.ded |
tMyPraject/D ata Sources/MyD atabasze/dbo. Customers. sma
MyProject/Data Sources/MyD atabasze/dbo. OrdeiDetals. sma
MyProject/Data Sources/MyD atabaze/dbo. Orders.zma
MyProject/Information Objects/MylnformationObject.iob

M8 AdyProject/Information Objects owlnformationd bject.iob

Published.
Published.
Published.
Published.
Published.
Published.

Figure 5-4 Publishing messages

4 When publishing is complete, choose OK in Publishing.

5 In Publish Information Objects, choose Close.
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Actuate SQL reference

This chapter contains the following topics:

About Actuate SQL

Differences between Actuate SQL and ANSI SQL-92
Actuate SQL syntax

Data types and data type casting

Functions and operators

Providing query optimization hints

Using pragmas to tune a query

Chapter 6, Actuate SQL reference
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About Actuate SQL

An information object encapsulates an Actuate SQL query. You can create the
Actuate SQL query that defines an information object in Information Object
Designer by typing the Actuate SQL query in the textual query editor or by
specifying the desired query characteristics in the graphical query editor. If you
use the graphical query editor, you can view the resulting Actuate SQL query in
SQL Preview.

If you already have one or more existing information objects, you can access the
information object data by specifying a query on the information object using a
report designer’s Information Object Query Builder. You can create the query on
the information object by typing a Actuate SQL query in the textual query editor
or by specifying the desired query characteristics in a graphical query editor. If
you use the graphical query editor, you can view the resulting Actuate SQL query
in SQL Preview.

A query that defines an information object and a query on an information object
both use Actuate SQL. Actuate SQL is based on the ANSI SQL-92 standard. This
chapter describes the differences between Actuate SQL and ANSI SQL-92. This
chapter also describes the FILTERS statement that you can use when creating a
query from Information Object Query Builder in a report designer.

Differences between Actuate SQL and ANSI SQL-92

Actuate SQL is based on ANSI SQL-92. This section provides an overview of the
differences between Actuate SQL and ANSI SQL-92. This section also provides an
overview of the FILTERS statement that is available from report designers. Report
designers support using the FILTERS statement with Actuate SQL to dynamically
filter SELECT statements.

Limitations compared to ANSI SQL-92
Actuate SQL has the following limitations compared to ANSI SQL-92:
m  Only the SELECT statement is supported.

m Data types are limited to integers, strings, timestamps, floating point numbers,
and decimals.

m Intersection and set difference operations are not available.
UNION and UNION DISTINCT are not supported. UNION ALL is
supported. To obtain the same results as a UNION DISTINCT operation,
perform a UNION ALL operation followed by a SELECT DISTINCT
operation. For example, IO3 performs a UNION ALL operation on 101 and
102:
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SELECT empNo, eName
FROM "IOl.iob" AS IOl
UNION ALL

SELECT empNo, eName
FROM "IO2.iob" AS IO2

To obtain distinct results from 103, create 104, which performs a SELECT
DISTINCT operation on 103:

SELECT DISTINCT empNo, eName
FROM "IO3.iob" AS IO3

m LIKE operator patterns and escape characters must be literal strings,
parameters, or expressions. The LIKE operator does not support column
references, subqueries, or aggregate functions, for example, MAX and AVG.

m Unnamed parameters are not supported.
m Some subqueries are not supported.

m  Not all ANSI SQL-92 functions and operators are available.

Extensions to ANSI SQL-92
Actuate SQL has the following extensions to ANSI SQL-92:

m Parameterized queries with named parameters

A parameterized query starts with a WITH clause that specifies the names and
types of parameters that the query uses. The following example shows using
parameters to specify returning rows where salesTotal is within a range
specified by two parameters:

WITH ( minTotal DECIMAL, maxTotal DECIMAL )

SELECT o.id, o.date

FROM "/sales/orders.sma" o

WHERE o.salesTotal BETWEEN :minTotal AND :maxTotal

A query with a parameterized SELECT statement is typed and is subject to the
same casting rules as a function call, except that parameter declarations
specify the maximum scale, precision, and length of parameter values. All
parameter values are required. A parameter value must be a literal, for
example 'abc’, NULL, a parameter reference, or an Actuate SQL expression. A
parameter value cannot be a column reference, for example
ORDERS.ORDERID.

m Parameterized table, view, and query references
A parameterized table or view reference in a query enables specification of the
query without knowing the table or view until run time. At run time, the
values of the parameters specify the table. In the following example, the table
is specified by the IOB name and the team and position parameters:
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WITH( team VARCHAR, position VARCHAR, minGamesPlayed
INTEGER )

SELECT playername

FROM "/sports/baseball/japan/players.iob" [:team, :position]

WHERE GamesPlayed > :minGamesPlayed

Parameter passing is typed and is subject to the same casting rules as a
function call.

m Scalar subqueries

A scalar subquery is a query that returns a scalar value that is used in a second
query. For example, the following query returns a scalar value:

SELECT SUM (B.Quantity * B.UnitPrice)
FROM "Order Detail.sma" AS B

This second query uses the previous query as a scalar subquery, evaluating the
result of the scalar subquery and checking if the result is greater than 1000:

SELECT CustomerID
FROM "Customers.sma" C
LEFT OUTER JOIN
"Orders.sma" O
ON ( C.CustomerID=0.CustomerID )
WHERE
( SELECT SUM(B.Quantity * B.UnitPrice)
FROM "Order Detail.sma" AS B
) > 1000

m Join control syntax specifying the join algorithm
In Actuate SQL, you can specify the algorithm to use for joins. There are three
join algorithms in Actuate SQL:

m  Dependent join
A dependent join specifies obtaining all the results for the left side of the
join and then using each resulting row to process the right side of the join.
This algorithm is especially efficient when the left side of the join does not
return many rows and the data source of the right side can handle
evaluating the join criteria.

= Nested loop join

A nested loop join specifies obtaining and storing in memory all the results
for the right side of the join. Then, for each row resulting from the left side,
a nested loop join evaluates the right side results for matches to the join
criteria. This algorithm is especially efficient when the right side of the join
does not return many rows and the join expression cannot be delegated to
the data source of the right side.
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m Merge join
A merge join specifies obtaining the results for the right and left sides of the
join and comparing these results row by row. Merge joins are applicable
only for joins where the value on the left must be equal to the value on the
right. This algorithm uses less memory than a nested loop join. This
algorithm is especially efficient if the data sources sort the rows but
presorting is not required.

The following example shows a merge join in a simple SELECT statement:

SELECT customers.custid, customers.customname,
customers.city, salesreps.lastname, salesreps.email

FROM customers MERGE JOIN salesreps

ON customers.repid = salesreps.repid

The following example shows a dependent join in a parameterized SELECT
statement:

WITH ( minRating INTEGER )
SELECT c.name, o.date, o.shippingStatus
FROM
"/uk/customers.sma" c
DEPENDENT JOIN
"/sales/orders.sma" o
ON c.id = o.custId
WHERE c.rating >= :minRating

You can also specify whether the join is an inner join or left outer join. The
following example shows a SELECT statement with a left outer join:

SELECT customers.custid, customers.contact last,
customers.contact first, salesreps.lastﬁéme,
salesreps.firstname

FROM salesreps LEFT OUTER JOIN customers

ON salesreps.firstname = customers.contact_ first

For information about inner and outer joins, see the SQL reference guide for
your database.

Pragmas to alter query semantics
Additional functions

The ability to have ORDER BY items other than SELECT items or aliases, for
example:

SELECT customers.contact first || ' ' ||
customers.contact last
"MOST_VALUED CUSTOMERS"
FROM "/customers.sma" customers
WHERE customers.purchasevolume > 3
ORDER BY customers.purchasevolume DESC
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If an ORDER BY item is not a SELECT item or an alias, it must be a grouping
column if a GROUP BY clause is present. ORDER BY items must be SELECT
items if SELECT DISTINCT is specified.

Use ORDER BY only when creating a query in a report designer. Do not use
ORDER BY when you create an information object in Information Object
Designer.

m The ability to have GROUP BY items that are expressions, for example:

SELECT DATEPART ('yyyy', orders.shipbydate) "YEAR",
DATEPART ('m', orders.shipbydate) "MONTH",
COUNT (*) "NUM_ORDERS"

FROM "/orders.sma" orders

GROUP BY DATEPART ('yyyy', orders.shipbydate),
DATEPART ('m', orders.shipbydate)

To use an expression as a GROUP BY item, the expression must appear as a
SELECT item. Aggregate functions are not allowed in GROUP BY expressions
unless they are outer references from a subquery and the subquery is
contained in the HAVING clause of the parent query. Complex GROUP BY
expressions cannot be used in the HAVING clause of the query.

m The ability to use references to aliases

Database limitations

Because the Integration service delegates many of its operations to the databases,
these operations are affected by database limitations, such as the maximum
precision of decimal types or the treatment of zero-length strings.

FILTERS statement in report designers

In addition to Actuate SQL’s extensions to ANSI SQL-92, report designers
support using a FILTERS statement with Actuate SQL to dynamically filter
SELECT statements. A dynamically filtered SELECT statement enables the user to
specify additional filters in the WHERE clause or HAVING clause when running
a SELECT statement or a parameterized SELECT statement. The FILTERS
statement specifies one or more dynamic filters, their data types, and the
beginning of each filter. The user completes conditions using operators, constants,
and column names:

FILTERS ( filterl Integer 'o.salesRepID' , filter2 Varchar
'o.territory = ')

WITH ( minTotal Decimal, maxTotal Decimal )

SELECT o.1id, o.date

FROM "/sales/orders.sma" o

WHERE o.salesTotal BETWEEN :minTotal AND :maxTotal AND :?filterl
AND :?filter2
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Information Object Designer does not support use of the FILTERS statement.

Actuate SQL syntax

Actuate SQL syntax is similar to SQL-92 syntax. Actuate SQL has additional
syntax for naming tables and columns. Table 6-1 provides a description of the
typographical conventions used in describing Actuate SQL grammar.

Table 6-1 Typographical conventions used in describing Actuate SQL
grammar

Convention Used for...

NORMAL UPPERCASE  Actuate SQL keywords.

ITALICIZED Tokens.

UPPERCASE

| (vertical bar) Separating syntax items. You choose one of the

items.

[ ] (brackets) Optional syntax items. Do not type the brackets.
{ } (braces) Required syntax items. Do not type the braces.
[,...n] Indicating that the preceding item can be repeated n

number of times. The item occurrences are
separated by commas.

[..n] Indicating that the preceding item can be repeated n
number of times. The item occurrences are
separated by blanks.

<label> The name for a block of syntax. This convention is

used to label syntax that can appear in more than
one place within a statement. Each location in which
the block of syntax can appear is shown with the
label enclosed in chevrons, for example <label>.

Table 6-2 lists the tokens used in the Actuate SQL grammar.

Table 6-2 Tokens used in describing the Actuate SQL grammar
Token Definition
IDENTIFIER A sequence of Unicode letters, digits, dollar signs,

and underscores combining characters and
extenders. The first character must be a letter.

(continues)
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Table 6-2 Tokens used in describing the Actuate SQL grammar (continued)

Token Definition

IDENTIFIER (continued) ~ Use double quotes to quote identifiers. To represent
a double quote within a quoted identifier, use two
double quotes. Quoted identifiers can include any
characters except carriage return or new line.

CHAR_LITERAL Any Unicode text between single quotes other than
carriage return or new line. To represent a single
quote, use two single quotes. Multiple consecutive
character literals are concatenated.

DECIMAL_LITERAL An integer literal followed by a decimal point and
an optional integer representing the fractional part.

Syntax: (INTEGER LITERAL .) |
(. INTEGER_LITERAL) | (INTEGER LITERAL.
[INTEGER _LITERAL])

DOUBLE_LITERAL A number of the form 1.2E+3. If the sign is omitted,
the default is positive.

Syntax: ((. INTEGER LITERAL) |
(INTEGER_LITERAL. [INTEGER_LITERAL]))
[(e|E) [-|+] INTEGER LITERAL]

INTEGER_LITERAL One or more consecutive digits.

TIMESTAMP_STRING A literal string that is interpreted as a timestamp
value, such as '2002-03-31 13:56:02.7'. Years are 4
digits. Seconds are 2 digits with an optional fraction
up to 3 digits. All other fields are 2 digits. The space
between the date and time sections is required.

Format: 'yyyy-mm-dd hh:mm:ss.msec’

Actuate SQL grammar

The Actuate SQL grammar contains one statement. The syntax of this statement
is:

[<Pragma>] [..n] [<QueryParameterDeclaration>] <SelectStatement>

Report designers also use a FILTERS statement that incorporates Actuate SQL.
Information Object Designer does not support use of the FILTERS statement. The
syntax for the FILTERS statement is:

<FilterClause> <QueryParameterDeclaration> <SelectStatement>
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Table 6-3 provides the syntax for the grammar parts used in these statements.

Table 6-3 Syntax for the Actuate SQL grammar parts

Grammar part Syntax

AdditiveExpression <MultiplicativeExpression> {(+ | - | )
<MultiplicativeExpression>} [...n]

AdHocParameter :?IDENTIFIER
Use AdHocParameter only in a FILTERS statement, which is
available only from a report designer. AdHocParameter cannot
be used in a WITH clause.

AggrExpression COUNT (([ALL | DISTINCT] <ValueExpression> | *))
| (AVG | MAX | MIN | SUM) ([ALL | DISTINCT]
<ValueExpression>)

AndExpression {<UnaryLogicalExpression>} [AND...n]

CardinalityType 11211+

CaseExpression CASE [<ValueExpression>]
{<WhenClause>} [...n]
[ELSE <ValueExpression>]
END

CastExpression CAST((<ValueExpression> | NULL)
AS <ScalarDataType>)

ColumnAlias IDENTIFIER

CondExpr {<AndExpression>} [OR...n]

ConditionalPrimary (<CondExpr>) | <SimpleCondition> | <AdHocParameter>
Use AdHocParameter only in a FILTERS statement.

DataType <ScalarDataType>

ExplicitinnerOuterType LEFT [OUTER] | INNER

ExplicitJoinType MERGE | NL | DEPENDENT

ExpressionList {<ValueExpression>} [,...n]

FilterClause FILTERS(/IDENTIFIER DataType 'ValueExpression' [,...n])
Use FILTERS only from a report designer.

FromClause {FROM <FromTableReference>} [,...n]

FromTableName IDENTIFIER [(<TableParameters>)] [[AS] IDENTIFIER]
If the identifier is not enclosed in quotes, it is interpreted as a
table. If the identifier is enclosed in quotes, it is interpreted as
an absolute or relative path in the Encyclopedia volume.

FromTableReference <JoinExpression> | (<JoinExpression>) | <FromTableName>

FunctionCallOrColumnRef

IDENTIFIER ( ([<ExpressionList>]) | [. IDENTIFIER] )

(continues)
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Table 6-3

Syntax for the Actuate SQL grammar parts (continued)

Grammar part

Syntax

GroupByClause

HavingClause

JoinCondition

JoinElement

JoinExpression
JoinSpec

Length
MultiplicativeExpression
NamedParameter
OrderByClause

ParameterDeclaration
ParamPlaceholder
Pragma

Precision

PrimaryExpression

QueryParameterDeclaration

RelationalOperator

GROUP BY {<ValueExpression>} [,...n]
ValueExpression can be an expression as long as the
expression also appears as a SELECT item.

HAVING <CondExpr>

ON <CondExpr> [ {CARDINALITY ('<CardinalityType> -
<CardinalityType>")} ]

(<JoinExpression>) | <FromTableName>

<JoinElement> {<JoinSpec><JoinElement> [<JoinCondition>]}
[...n]

[[ [LEFT | RIGHT] OPTIONAL ] <ExplicitinnerOuterType> ]

[ <ExplicitdoinType> ] JOIN

INTEGER_LITERAL

<UnaryExpression> {(* | /) UnaryExpression} [...n]
: IDENTIFIER

ORDER BY {<ValueExpression> (ASC | DESC)? } [,...n]
ValueExpression is not limited to SELECT items or aliases. If
ValueExpression is not a SELECT item or an alias, it must be a
grouping column if a GroupByClause is present.

Use ORDER BY only when creating a query in a report
designer. Do not use ORDER BY when you create an
information object in Information Object Designer.

IDENTIFIER [<AS>] <Data Type>
<NamedParameter>

PRAGMA IDENTIFIER := CHAR_LITERAL
INTEGER_LITERAL

<FunctionCallOrColumnRef>
| <ParamPlaceholder>

| <UnsignedLiteral>

| <AggrExpression>

| (<ValueExpression>)

| <CastExpression>

WITH ({<ParameterDeclaration>} [,...n])
All parameters are required.

=l<>l<l<=I>I>=

166 Designing BIRT Information Objects



Table 6-3 Syntax for the Actuate SQL grammar parts (continued)

Grammar part

Syntax

ScalarDataType

Scale
Selectltem
SelectList

SelectStatement

SelectWithoutFrom
SelectWithoutOrder

SetClause

SignedLiteral

SimpleCondition

VARCHAR [(<Length>)]

| DECIMAL [(<Precision>, <Scale>)]
| INTEGER

| DOUBLE [<Precision>]

| TIMESTAMP

INTEGER_LITERAL
<ValueExpression> [[AS] <ColumnAlias>]
{<Selectltem>} [,...n]

(<SelectWithoutOrder> [<OrderByClause>])
| <SelectWithoutFrom>

SELECT <ValueSelectList>
(

(
SELECT [ALL | DISTINCT] <SelectList>
<FromClause>
[<WhereClause>]
[<GroupByClause>]
[<HavingClause>]
[<SetClause>]
| )
(<SelectWithoutOrder>)

[<SetClause>]

UNION ALL

(<SelectWithoutOrder> | <SelectWithoutFrom> )
CHAR_LITERAL

I[+ | -]INTEGER_LITERAL

I[+ | -]DOUBLE_LITERAL

I[+ | -]DECIMAL_LITERAL

ITIMESTAMP TIMESTAMP_STRING

EXISTS <SubQuery>
| <SubQuery> <RelationalOperator> <ValueExpression>
| <ValueExpression>

(<RelationalOperator>

(
([ ANY | ALL ] <SubQuery>) | <ValueExpression>
)

(continues)
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Table 6-3 Syntax for the Actuate SQL grammar parts (continued)
Grammar part Syntax
SimpleCondition (continued) 1S [NOT] NULL
| [NOT]
(

BETWEEN <ValueExpression> AND <ValueExpression>
| LIKE <ValueExpression> [ESCAPE <ValueExpression>]
I IN <SubQuery>
| IN (ExpressionList)
)

)

The escape character must evaluate to a single character
other than a single quote, a percent sign, or an underscore.

SubQuery (<SelectWithoutOrder> [ OPTION (SINGLE EXEC) ])

TableParameter (<SignedLiteral> | NULL | <ParameterReference> |
<ValueExpression>)

TableParameters <TableParameter> [,...n]

UnaryExpression [+ | -] <PrimaryExpression>

UnaryLogicalExpression

[NOT] <ConditionalPrimary>

UnsignedLiteral CHAR_LITERAL

[INTEGER_LITERAL

IDOUBLE_LITERAL

IDECIMAL_LITERAL

ITIMESTAMP TIMESTAMP_STRING
ValueExpression <AdditiveExpression> | <CaseExpression>
ValueSelectItem <ValueExpression> [[AS] <ColumnAlias>]
ValueSelectList {<ValueSelectitem>} [,...n]
WhenClause WHEN <ValueExpression> THEN <ValueExpression>
WhereClause WHERE <CondExpr>

Using white space characters

White space characters include the space, tab, and new line characters. Multiple
white space characters are not significant outside of literal strings and quoted

identifiers.

Using keywords
The Actuate SQL keywords are shown in the following list:
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= ALL

= AND

= ANY

m AS

m ASC

m AVG

s BETWEEN
s BY

m CARDINALITY

m CASE

m CAST

s COUNT

s DEC

= DECIMAL

s DEPENDENT

m DESC

m DISTINCT
= DOUBLE
m ELSE

m END

m ESCAPE

Actuate SQL keywords are not case-sensitive. To prevent incompatibility with

EXEC
EXISTS
FALSE
FILTERS
FROM
GROUP
HAVING
IN
INNER
INT
INTEGER
IS

JOIN
LEFT
LIKE
MAX
MERGE
MIN
NL
NOT
NULL

ON
OPTION
OPTIONAL
OR

ORDER
OUTER
PRAGMA
PRECISION
RIGHT
SELECT
SINGLE
SUM

THEN
TIMESTAMP
TRUE
UNION
VARCHAR
WHEN
WHERE
WITH

other versions of SQL, do not use SQL-92 keywords. If you use an identifier that
is also a keyword, place double quotes around the identifier.

Using comments

Precede a single-line comment with two hyphens. Enclose a multiline comment

with /*and */.
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Specifying maps and information objects in Actuate
SQL queries

In Information Object Designer, a map or information object name should be
qualified by its relative path in the Encyclopedia volume. The path is relative to
the IOB file. Use forward slashes to separate components of the path, for example:

../Data Sources/MyDatabase/dbo.customers.sma

In a query from a report designer, a map or information object name should be
qualified by its absolute path in the Encyclopedia volume. Use forward slashes to
separate components of the path, for example:

/MyProject/Data Sources/MyDatabase/dbo.customers.sma

Using identifiers in Actuate SQL

Identifiers include table and column names. Actuate SQL identifiers have the
same limitations as standard SQL identifiers. For example, you must enclose an
identifier in double quotes if it contains an illegal character such as a space or if it
is identical to a SQL-92 keyword. Unlike the SQL-92 standard, however, there is
no length limitation on Actuate SQL identifiers. Identifiers can contain Unicode
characters.

Using column aliases in Actuate SQL
When you use column aliases, the following rules apply:

m The column and alias names of the items in the first SELECT statement of a
UNION of statements are definitive.

m  Within the items in a SELECT statement, you can use previously defined
aliases to create expressions, for example:

SELECT coll AS a, col2 AS b, a+b
s  Only SELECT and ORDER BY can use aliases.
m  You cannot use an alias in an aggregate expression, for example, MAX(a).

m  You can use aliases defined in an outer SELECT statement in a nested SELECT
statement.

m  You can use aliases from the items in the first SELECT statement in a set of
UNION statements in the ORDER BY clause of the query.

Specifying parameter values
A parameter value must be one of the following:

m A literal value, for example 'abc’ or 123.
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Examples

m The NULL literal value.
m A parameter reference.

m An expression consisting of literal values, parameter references, and Actuate
SQL functions and operators.

A parameter value cannot include column references, subqueries, or aggregate
functions.

MylInformationObject uses the parameters p1, p2, and p3. The following query
passes the parameter values :p1, -100, and 'abc’ to MyInformationObject. :p1
represents the value of parameter p1 provided by the user. -100 and 'abc’ are
literal values:

WITH ( pl INTEGER, p2 INTEGER, p3 VARCHAR )
SELECT ..
FROM "MyInformationObject.iob" [:pl, -100, 'abc']

MylInformationObject uses the parameter p1. The following query passes the
NULL literal value to MyInformationObject:

WITH ( pl INTEGER )
SELECT ..
FROM "MyInformationObject.iob" [NULL]

MylInformationObject uses the parameter p1. The following query passes the
NULL literal value, cast as integer data type, to MyInformationObject:

WITH ( pl INTEGER )
SELECT ...
FROM "MyInformationObject.iob" [CAST (NULL AS INTEGER)]

MylInformationObject uses the parameter p1. The following query passes the
expression :pl + 10 to MyInformationObject:

WITH ( pl INTEGER )

SELECT ..

FROM "MyInformationObject.iob" [:pl + 10]

MylInformationObject uses the parameters p1 and p2. The following query passes
the parameter reference :p1 and the expression :pl | | :p2 to
MylInformationObject:

WITH ( pl VARCHAR, p2 VARCHAR )

SELECT ..

FROM "MyInformationObject.iob" [:pl, :pl || :p2]

MylInformationObject uses the parameters p1 and p2. The following query passes
two expressions to MyInformationObject:

WITH ( pl INTEGER, p2 INTEGER )
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SELECT ..
FROM "MyInformationObject.iob" [:pl + 10, CASE WHEN :p2 > 100 THEN
100 ELSE 0 END]

Using subqueries in Actuate SQL

Subqueries have the following limitations:

m Subqueries are supported in every clause except the FROM clause.
Specifically:

m Subqueries cannot be used in Actuate SQL parameters or JOIN conditions.

m  Subqueries cannot constitute derived tables.

Derived tables are tables in a FROM clause that are the result of running a
subquery.

m Subqueries must be operands to the operators IN or EXISTS, or operands to a
comparison operator such as =, >, or >=ALL. Only one operand of the
comparison operator can be a subquery, not both.

m  Only single-column subqueries are supported. In other words, each subquery
must have only one SELECT item.

m Subqueries cannot have more than one SELECT statement. In other words, set
operators such as UNION ALL are not allowed in subqueries.

Subqueries can use OPTION (SINGLE EXEC). The SINGLE EXEC option
improves the performance of a query when the query cannot be pushed to the
database. When the SINGLE EXEC option is specified, the non-correlated portion
of the subquery is executed once against the target database, while the correlated
portion is executed within the Integration service.

By default, a subquery from a different database is implemented using a
dependent join. Using the SINGLE EXEC option, a subquery can be executed
using a single dependent query instead of executing one dependent query for
each row of the outer query, for example:

SELECT DISTINCT CUSTOMERS.CUSTID AS "CUSTID",
ORDERS.ORDERID AS "ORDERID"

FROM "../Data Sources/MyDatabase/CUSTOMERS.SMA" CUSTOMERS

INNER JOIN "../Data Sources/MyDatabase/ORDERS.SMA" ORDERS

ON CUSTOMERS.CUSTID = ORDERS.CUSTID

WHERE (SELECT count (ITEMS.PRICEQUOTE)

FROM "../Data Sources/YourDatabase/ITEMS.SMA" ITEMS
WHERE ORDERS.ORDERID = ITEMS.ORDERID
OPTION (SINGLE EXEC) ) < 100

ORDER BY CUSTOMERS.CUSTID, ORDERS.ORDERID
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Using derived tables in Actuate SQL

A derived table is a virtual table that is calculated on the fly from a SELECT
statement. A derived table can be used in a FROM clause, WHERE clause,
HAVING clause, or subquery, for example:

SELECT ColumnO1l
FROM (Derived table)

A derived table can have parameters.

Data types and data type casting

Table 6-4 lists Actuate SQL data types and a description of each data type.

Table 6-4 Actuate SQL data types
Data type Description
String ("VARCHAR") A sequence of Unicode characters. You can specify

a maximum character length for the string. For
example, VARCHAR (30) represents strings with a
maximum length of 30 Unicode characters.

Integer number 32-bit two’s-complement arithmetic numbers.
("INTEGER")

Decimal number Fixed point numbers consisting of up to 100 digits.
("DECIMAL") You can specify a maximum scale and a maximum

precision using the syntax (precision, scale). For
example, DECIMAL (15, 4) represents decimals that
can have up to 15 digits in all and up to 4 digits
after the decimal point.

Floating point number 64-bit IEEE double precision floating point
("DOUBLE") numbers.

Timestamp A combined date and time (hour/minute/second).
("TIMESTAMP")

Facets

The precision, scale, and length associated with a database data type are called
facets. Facets are supported for the corresponding Actuate SQL data type.

An Actuate SQL expression that evaluates to a scalar value has facets. These
facets are determined by the Actuate SQL functions used in the expression and
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the facets on the columns in the expression. You can specify facets for an Actuate
SQL expression by using a cast, for example:

CAST (EXPR AS DECIMAL (38, 8))
CAST (EXPR AS VARCHAR(25))

Parameters in Actuate SQL queries have facets. These facets determine the
maximum precision, scale, and length of parameter values. When no facets are
specified for a parameter or a cast expression, the defaults are used. The default
precision and scale for the Actuate SQL DECIMAL data type are (20, 8). The
default length for the Actuate SQL VARCHAR data type is 50.

If the decimal value passed into a parameter or cast expression is too large for the
precision and scale, an error results. Actuate SQL truncates digits after the
decimal point to force the decimal value to fit within the precision and scale.

If the string or timestamp value passed into a string parameter, or into a cast
expression to VARCHAR, is too large for the string length specified, the string or
timestamp is truncated. If the string value passed into a cast expression to
DECIMAL is too large for the precision and scale specified, an error results.

By default, Actuate SQL has a decimal precision of 38. The decimal precision can
be set to a smaller or larger value up to 100. Results of calculations that exceed
this limit may have their precision and scale truncated. Calculations may also be
limited by the database. The same applies to operations on strings in the
database.

Casting rules
The following casting rules apply:

m Integers can be implicitly cast to decimals and doubles. For implicit casts to
decimals, the resulting decimals have a precision of 10 and a scale of 0.
Integers can be explicitly cast to these types, as well as to strings.

m  Decimals can be implicitly cast to doubles. Decimals can be explicitly cast to
doubles, as well as to integers and strings. Conversion to integer type may
result in rounding or truncation of data.

m  Doubles can be explicitly cast to strings, as well as to integers and decimals.
Conversion to decimal and integer types may result in rounding or truncation
of data.

m Timestamps can be explicitly cast to strings. Casting to other types is not
permitted.

m Strings can be implicitly or explicitly cast to timestamps. For explicit casting,
the strings must be of the form:

yyyy-MM-dd hh:mm:ss.f£ff

Strings can be explicitly cast to integers, decimals, and doubles.
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m Because databases vary in their implementation, casts to strings do not have a
defined format. For example, the same value can be represented as 6E5, 60000,
or 60000.00.

m All types can be implicitly cast to the same type.
Table 6-5 summarizes the casting rules for Actuate SQL data types.

Table 6-5 Casting rules for Actuate SQL types
To To To To To
INTEGER DECIMAL  DOUBLE VARCHAR TIMESTAMP
From Implicit Implicit Implicit Explicit Casting not
INTEGER casting casting casting casting permitted
occurs occurs occurs required
From Explicit Implicit Implicit Explicit Casting not
DECIMAL casting casting casting casting permitted
required occurs occurs required
From Explicit Explicit Implicit Explicit Casting not
DOUBLE casting casting casting casting permitted
required required occurs required
From Explicit Explicit Explicit Implicit Implicit
VARCHAR casting casting casting casting casting occurs
required required required occurs
From Casting not Castingnot  Castingnot  Explicit Implicit
TIMESTAMP  permitted permitted permitted casting casting occurs
required

String comparison and ordering

The Actuate BIRT iServer System Integration service compares and orders strings
according to the Unicode code point value of each character. For example,
Bright-Abbott is sorted before Brightman because the hyphen (-) has a Unicode
value of 45, while lowercase m has a Unicode value of 109. The expression:

'Kirsten' LIKE 'ki%'

evaluates to False because uppercase K is different from lowercase k.

Although string comparison is case-sensitive by default, you can configure the
Integration service to do case-insensitive comparison and ordering.
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Functions and operators

Actuate SQL supports several built-in operators and named functions. Functions
and operators are described in the following topics, grouped by related
functionality.

Comparison operators: =, <>, >=, >, <=, <

Comparison operators are used to compare the value of two expressions,
returning True if the comparison succeeds, and False if it does not. The following
rules apply to the use of comparison operators handled by the Integration service:

m  For numeric data types, the usual rules of arithmetic comparisons apply.

m For string comparisons, the shorter of the two strings is padded with space
characters to equal the length of the longer string before the comparison is
performed, as in SQL-92.

m  Timestamps are compared using chronological order.

m An equality comparison between two floating point numbers does not return
an error.

For information about the Integration service, see Configuring BIRT iServer.
Comparison operations delegated to a remote data source may vary from the
rules for comparison operators handled by the Integration service.

Range test operator: BETWEEN

The BETWEEN operator tests a value to see if it occurs in a given range including
the endpoints. For example, the expression:

col BETWEEN 10 AND 20

evaluates to True if and only if the value of col is at least 10 but no more than 20.
Table 6-6 shows the result type for using BETWEEN for each operand data type.

Table 6-6 Result data types for using BETWEEN with various operand types

First operand type Second operand type = Third operand type Result type
Boolean Boolean Boolean Boolean
Integer Integer Integer Boolean
Decimal Decimal Decimal Boolean
Double Double Double Boolean
Varchar Varchar Varchar Boolean
Timestamp Timestamp Timestamp Boolean
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The BETWEEN operator follows the same rules as the comparison operators.

Comparison operator: IN

The IN operator tests a row or scalar value to see if it occurs in a set of values. For
example, the expression

column IN (1,3,5,7,9)

evaluates to True if and only if the value of columnis 1, 3,5, 7, or 9.

Arithmetic operators: +, -, *, /

These operators implement addition, subtraction, multiplication, and division on
the supported numeric data types. For decimal data types, the result’s precision
and scale are shown in Table 6-7. d1 represents an operand expression with
precision p1 and scale s1, and d2 represents an operand expression with precision
p2 and scale s2. The result’s precision and scale may be truncated due to database
limitations.

Table 6-7 Precision and scale of arithmetic operation results

Operation  Result’s precision Result’s scale

dl +d2 max(sl, s2) + max(pl-sl, p2-s2) + 1 max(sl, s2)

dl-d2 max(sl, s2) + max(pl-sl, p2-s2) + 1 max(sl, s2)

d1* d2 pl+p2+1 sl+s2

dl /d2 pl-sl+s2+max(6,sl+p2+1) max(6, sl +p2 + 1)

Integer arithmetic operations are performed using 32-bit two’s-complement
semantics. Floating point operations are performed according to the IEEE double
precision standard.

These general rules apply to operations handled by the Integration service.
Operations delegated to remote data sources may vary in their semantics. For
information about the Integration service, see Configuring BIRT iServer.

Table 6-8 shows the result type of using arithmetic operators with each operand
type.

Table 6-8 Result data types for using arithmetic operators with various operand
types
Left operand type Right operand type Result type
Integer Integer Integer
Decimal Decimal Decimal
Double Double Double
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Numeric functions

Actuate SQL supports the following numeric functions:
s FLOOR, CEILING, MOD

= ROUND

s POWER

FLOOR, CEILING, MOD

FLOOR returns the largest integer not greater than the argument’s value. The
result is cast to the specified type:

Decimal FLOOR( value Decimal )
Double FLOOR( value Double )

Example The following code:
SELECT FLOOR(123.45), FLOOR(-123.45), FLOOR(0.0)
returns:
123,-124,0

CEILING returns the smallest integer not less than the argument’s value. The
result is cast to the specified type:

Decimal CEILING( value Decimal )
Double CEILING( value Double )

Example The following code:
SELECT CEILING(123.45), CEILING(-123.45), CEILING(0.0)
returns:
124,-123,0
MOD returns the remainder after division of two integers:
Integer MOD( vl Integer, v2 Integer )

Example The following code:

SELECT CUSTOMERS.CUSTID, CUSTOMERS.CUSTOMNAME

FROM "../Data Sources/MyDatabase/CUSTOMERS.SMA" CUSTOMERS
WHERE MOD (CUSTOMERS.CUSTID, 2) =1
returns:

101,Signal Engineering
109, InfoEngineering
111,Advanced Design Inc.
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Example

Example

For decimal data types, the result’s precision and scale for the FLOOR and
CEILING functions are (p + 1, s), where (p, s) are the precision and scale of the
operand.

ROUND

ROUND returns the number closest in value to the first argument, rounding
away from zero. The second argument specifies the precision, with positive
values indicating a position to the right of the decimal point, and negative values
indicating a position to the left of the decimal point. All positions to the right of
the specified position are zero in the result:

Integer ROUND ( value integer, precision integer )
Decimal ROUND( value Decimal, precision integer )
Double ROUND( value Double, precision integer )

The following code:

SELECT ROUND(123.4567, 2), ROUND(123.4567, -1)
returns:

123.46, 120

For decimal data types, the result’s precision and scale are (p + 1, s), where
(p, s) are the precision and scale of the operand.

POWER

POWER raises the left argument (base) to the power of the right argument
(exponent):

Integer POWER( base Integer, exponent Integer )
Decimal POWER( base Decimal, exponent Integer )
Double POWER( base Double, exponent Integer )

The following code:

SELECT CUSTOMERS.CUSTID, POWER (CUSTOMERS.CUSTID, 2)
FROM "../Data Sources/MyDatabase/CUSTOMERS.SMA" CUSTOMERS

returns:

101,10201
102,10404
104,10816

For decimal data types, the result’s precision and scale are (P, s), where P is the
maximum precision in the database or the Integration service, and s is the scale of
the operand.
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Null test operators: IS [NOT] NULL

These operators allow expressions to be tested for NULL values. For example, the
expression:

column IS NULL

evaluates to True if and only if column has the value NULL.

Logical operators: AND, OR, NOT

These operators implement Boolean conjunction, disjunction, and negation,
respectively. AND and OR take two Boolean operands each, while NOT takes a
single operand. All return Boolean values.

For AND and OR, both operands may be evaluated even if one operand is
undefined, particularly in queries against multiple databases. For example, the
clause:

WHERE QUANTITY <> 0 AND TOTALCOST / QUANTITY > 50

may result in an error for rows where QUANTITY = 0.

String functions and operators

Actuate SQL supports the following string functions and operators:
m Case conversion functions: UPPER, LOWER

m Concatenation operator: | |

m Length function: CHAR_LENGTH

m LIKE operator

m Substring functions: LEFT, RIGHT, SUBSTRING

m  Trimming functions: LTRIM, RTRIM, TRIM

m Search function: POSITION

Case conversion functions: UPPER, LOWER

These functions return a string formed by converting the characters in the
argument to uppercase or lowercase respectively, provided the character is
alphabetic:

Varchar UPPER( value Varchar )
Varchar LOWER ( value Varchar )

Examples The following code:

SELECT CUSTOMERS.CUSTID, CUSTOMERS.CUSTOMNAME,
UPPER (CUSTOMERS . CUSTOMNAME )
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FROM "../Data Sources/MyDatabase/CUSTOMERS.SMA" CUSTOMERS
returns:

101,Signal Engineering, SIGNAL ENGINEERING
109, InfoEngineering, INFOENGINEERING
111,Advanced Design Inc.,ADVANCED DESIGN INC.

The following code:

SELECT CUSTOMERS.CUSTID, CUSTOMERS.CUSTOMNAME,
LOWER (CUSTOMERS . CUSTOMNAME)
FROM "../Data Sources/MyDatabase/CUSTOMERS.SMA" CUSTOMERS

returns:

101,Signal Engineering, signal engineering
109, InfoEngineering, infoengineering
111,Advanced Design Inc.,advanced design inc.

Concatenation operator: |l

This operator concatenates two string values, returning a new string that contains
the characters from the left operand followed by the characters from the right
operand.

Length function: CHAR_LENGTH

This function computes the length of a string, returning an integer count of its
characters. Trailing spaces are significant:

Integer CHAR LENGTH( value Varchar )
Example The following code:

SELECT CUSTOMERS.CUSTID, CUSTOMERS.CONTACT FIRST
FROM "../Data Sources/MyDatabase/CUSTOMERS.SMA" CUSTOMERS
WHERE CHAR_LENGTH(CUSTOMERS.CONTACT_FIRST) > 5

returns:

102, Leslie
109,Michael
116, William

LIKE operator
The LIKE operator is used in an expression such as:

column LIKE 'Mar$%'
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In this example, values of column, such as Mary or Martin, satisfy the test because
both start with Mar.

A LIKE operator pattern must be a literal string, for example, 'abc%’, a parameter,
or an expression. The LIKE operator does not support column references,
subqueries, or aggregate expressions. Other examples include:

column LIKE :paramState
column LIKE CURRENT USER( )

The following rules apply:

m Literal pattern characters must match exactly. LIKE is case-sensitive.
m  An underscore character (_) matches any single character.

m A percent character (%) matches zero or more characters.

Escape a literal underscore, percent, or backslash character with a backslash
character (\). Alternatively, use the following syntax:

test string LIKE pattern string ESCAPE escape character

The escape character must obey the same rules as the LIKE operator pattern.

Substring functions: LEFT, RIGHT, SUBSTRING

These functions transform a string by retrieving a subset of its characters.

LEFT and RIGHT return the leftmost or rightmost n characters, respectively. Each
takes the string as the first argument and the number of characters to retrieve as
the second argument:

Varchar LEFT( value Varchar, offset Integer )
Varchar RIGHT ( value Varchar, offset Integer )

Specifying an offset that is less than zero results in an error. If the offset is greater
than the length of the string, these functions return the entire string.

SUBSTRING takes three arguments: the input string, the start position (one-based
offset from the left side), and the number of characters to retrieve. It returns the
substring located at this position:

Varchar SUBSTRING( input Varchar, start Integer, length Integer )
The following actions result in an error:
m Specifying a start position that is less than or equal to zero.
m Specifying a length that is less than zero.
Examples The following code:

SELECT CUSTOMERS.CUSTID, CUSTOMERS.CUSTOMNAME
FROM "../Data Sources/MyDatabase/CUSTOMERS.SMA" CUSTOMERS
WHERE LEFT (CUSTOMERS.CUSTOMNAME, 4) = 'Info'
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returns:

109, InfoEngineering
117, InfoDesign
129, InfoSpecialists

The following code:

SELECT CUSTOMERS.CUSTID, CUSTOMERS.CUSTOMNAME
FROM "../Data Sources/MyDatabase/CUSTOMERS.SMA" CUSTOMERS
WHERE RIGHT (CUSTOMERS.CUSTOMNAME, 5) = 'Corp.'

returns:

104,SigniSpecialists Corp.
115,Design Solutions Corp.
118, Computer Systems Corp.

The following code:

SELECT CUSTOMERS.CUSTID, CUSTOMERS.CUSTOMNAME,
SUBSTRING (CUSTOMERS . CUSTOMNAME, 2, 5)
FROM "../Data Sources/MyDatabase/CUSTOMERS.SMA" CUSTOMERS

returns:

101,Signal Engineering, ignal
102, Technical Specialists Co.,echni
104,SigniSpecialists Corp.,igniSs

Trimming functions: LTRIM, RTRIM, TRIM

These functions strip space characters from a string. LTRIM strips only from the
left side, RTRIM only from the right side, and TRIM from both sides. In all cases
the result value is a string identical to the argument except for the possible
removal of space characters from either side. Other white space characters,
including tabs and newlines, are not removed by these functions:

Varchar LTRIM( value Varchar )
Varchar RTRIM( value Varchar )
Varchar TRIM( value Varchar )

The following code:

SELECT LTRIM(' Title '), 'Author’
returns:

Title ,Author

The following code:
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SELECT RTRIM(' Title '), 'Author’
returns:

Title,Author
The following code:
SELECT TRIM(' Title '), 'Author’
returns:

Title,Author

Search function: POSITION

The POSITION function takes two arguments: a substring and a search string.
The POSITION function returns the position of the substring in the search string
as an integer or as 0 if the substring is not found. If the substring is the empty
string, the POSITION function returns 1. The POSITION function is
case-sensitive:

Integer POSITION( substring Varchar, searchstring Varchar )
Example The following code:
SELECT CUSTOMERS.CUSTID, CUSTOMERS.CUSTOMNAME

FROM "../Data Sources/MyDatabase/CUSTOMERS.SMA" CUSTOMERS
WHERE POSITION('Inc.', CUSTOMERS.CUSTOMNAME) > 0
returns:

106, Technical MicroSystems Inc.
111,Advanced Design Inc.
113, Technical Design Inc.

Timestamp functions

These functions perform operations on timestamp values:
m CURRENT_TIMESTAMP

s CURRENT_DATE

s DATEADD

m DATEDIFF

m DATEPART

m DATESERIAL
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When using these functions, use the control strings listed in Table 6-9 to represent
units of time. The control string used in a function must be a literal string, not an
expression or a parameter.

Table 6-9 Control strings for various units of time
Unit of time Control string
year yyyy
quarter q
month m
day d
day of year y
day of week w
hour h
minute n
second S

CURRENT_TIMESTAMP

CURRENT_TIMESTAMP returns a timestamp value for the current date and
time:

Timestamp CURRENT TIMESTAMP ()
The following code:

SELECT CURRENT TIMESTAMP ()
returns:

2004-10-27 14:49:23.0

CURRENT_DATE

CURRENT_DATE returns a timestamp value for the current date with the time
set to 00:00:00.0:

Timestamp CURRENT DATE ()
The following code:

SELECT CURRENT DATE ()
returns:

2004-10-27 00:00:00.0
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DATEADD

DATEADD takes three arguments: a control string, an integer delta value, and a
timestamp value. It returns a timestamp that applies the delta value to the
specified part of the original timestamp. The operation carries if the sum of the
original field value and the delta is illegal:

Timestamp DATEADD ( control Varchar, delta Integer,
value Timestamp )

Example The following code:

SELECT ORDERS.ORDERID, ORDERS.SHIPBYDATE,
DATEADD ('d', 14, ORDERS.SHIPBYDATE) AS ExpectedDelivery
FROM "../Data Sources/MyDatabase/ORDERS.SMA" ORDERS

returns:

1645,1995-05-22 00:00:00.0,1995-06-05 00:00:00.0
1340,1995-06-03 00:00:00.0,1995-06-17 00:00:00.0
1810,1995-04-12 00:00:00.0,1995-04-26 00:00:00.0

DATEDIFF

DATEDIFF takes three arguments: a control string, a start timestamp, and an end
timestamp. It returns the integer delta between the part of the two timestamps
specified by the control string. Components smaller than the control string are
ignored. Components larger than the control string contribute to the result:

Integer DATEDIFF ( control Varchar, start Timestamp,
end Timestamp )

Examples The following code:

SELECT ORDERS.ORDERID, ORDERS.SHIPBYDATE, ORDERS.FORECASTSHIPDATE,
DATEDIFF('d', ORDERS.SHIPBYDATE, ORDERS.FORECASTSHIPDATE) AS

ShipDateDifference
FROM "../Data Sources/MyDatabase/ORDERS.SMA" ORDERS
returns:

1645,1995-05-22 00:00:00.0,1995-06-02 00:00:00.0,11
1340,1995-06-03 00:00:00.0,1995-06-10 00:00:00.0,7
1810,1995-04-12 00:00:00.0,1995-04-27 00:00:00.0,15

The following expression:

DATEDIFF('d', CAST('2005-12-31 23:59:59.0' AS TIMESTAMP),
CAST('2006-01-01 00:00:00.0' AS TIMESTAMP))

returns 1. The control string d indicates that the difference is in days. The
difference between December 31, 2005 and January 1, 2006 is one day. The hours,
minutes, and seconds components are ignored.
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The following expression:

DATEDIFF('m', CAST('2005-12-31 23:59:59.0' AS TIMESTAMP),
CAST('2006-01-01 00:00:00.0' AS TIMESTAMP))

returns 1. The control string m indicates that the difference is in months. The
difference between December 31, 2005 and January 1, 2006 is one month. The day,
hours, minutes, and seconds components are ignored.

DATEPART

DATEPART takes two arguments: a control string and a timestamp. It returns the
part of the timestamp specified by the control string:

Integer DATEPART( control Varchar, value Timestamp )

The following code:

SELECT ORDERS.ORDERID, ORDERS.SHIPBYDATE

FROM "../Data Sources/MyDatabase/ORDERS.SMA" ORDERS
WHERE DATEPART ('m', ORDERS.SHIPBYDATE) = 5

returns:

1645,1995-05-22 00:00:00.0
1725,1995-05-10 00:00:00.0
1125,1995-05-03 00:00:00.0

DATESERIAL

DATESERIAL has two forms. The first form takes three arguments: a year value,
a month value, and a day value. It returns a timestamp for the date corresponding
to the specified year, month, and day with the time set to 00:00:00.0:

Timestamp DATESERIAL( year Integer, month Integer, day Integer )

The second form of DATESERIAL takes six arguments: values for the year,
month, day, hour, minute, and second. It returns the timestamp for the specified
values:

Timestamp DATESERIAL ( year Integer, month Integer, day Integer,
hour Integer, minute Integer, second Integer )

The following code:

SELECT ORDERS.ORDERID, ORDERS.ASKBYDATE
FROM "../Data Sources/MyDatabase/ORDERS.SMA" ORDERS
WHERE ORDERS.ASKBYDATE >= DATESERIAL (1995, 6, 15, 12, 59, 59)

returns:

1555,1995-06-28 00:00:00.0
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1725,1995-06-23 00:00:00.0
1720,1995-06-17 00:00:00.0

Aggregate functions: COUNT, MIN, MAX, SUM, AVG

These functions aggregate an entire column of values into a single scalar result.
For decimal data types:

m For the MIN, MAX, and AVG functions, the result’s precision and scale are the
same as the precision and scale of the operand.

m For the SUM function, the result’s precision and scale are (P, s), where P is the
maximum precision in the database or the Integration service, and s is the
scale of the operand.

The COUNT function reduces any argument type to a single integer representing
the number of non-NULL items. As in SQL-92, COUNT(*) counts the number of
rows in a table:

Integer COUNT ( column )
Example The following code:

SELECT COUNT (ORDERS.ORDERID) AS NumberOfOrders
FROM "../Data Sources/MyDatabase/ORDERS.SMA" ORDERS

returns:
111

MIN and MAX accept any type and return the minimum or maximum value,
using the same rules that apply to comparison of individual items:

ColumnType MIN( column )
ColumnType MAX( column )

Examples The following code:

SELECT MIN (ITEMS.QUANTITY)

FROM "../Data Sources/MyDatabase/ITEMS.SMA" ITEMS
returns:

2

The following code:

SELECT MAX (ITEMS.QUANTITY)

FROM "../Data Sources/MyDatabase/ITEMS.SMA" ITEMS
returns:

6203
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SUM and AVG can be applied to any of the three numeric types and produce the
sum or average of all the numbers:

ColumnType SUM( column )
ColumnType AVG( column )

Examples The following code:
SELECT SUM (ITEMS.QUANTITY)

FROM "../Data Sources/MyDatabase/ITEMS.SMA" ITEMS
returns:

606177

The following code:

SELECT AVG (ITEMS.QUANTITY)

FROM "../Data Sources/MyDatabase/ITEMS.SMA" ITEMS
returns:

319

System function: CURRENT_USER

CURRENT_USER returns a string containing the user name for the current
Encyclopedia volume user:

Varchar CURRENT USER()

Example The following code:
SELECT CURRENT USER ()
returns:

userl

Providing query optimization hints

A report developer or business user uses an information object to create an
Actuate SQL query. When you create the information object, you can provide
hints that help to optimize the query. Specifically, you can:

m Indicate that a table in a join is optional.
m Specify the cardinality of a join.

For query optimization hints to take effect, you must create join conditions with
the ON clause, not the WHERE clause.
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Indicating that a table in a join is optional

When you create an information object, you indicate that a table in a join is
optional using the OPTIONAL keyword. If you indicate that a table is optional
and none of its columns appear in the query created by a report developer or
business user (except in a join condition), the table is dropped from the optimized

query.
The OPTIONAL keyword has no effect in queries created in the Information
Object Query Builder.

For example, consider the following information object CustomersOrders:

SELECT Customers.custid, Customers.customname,
Customers.contact last, Orders.orderid, Orders.custid,
Orders.amount, Orders.shipbydate

FROM Customers.sma LEFT OPTIONAL INNER JOIN Orders.sma

ON (Customers.custid = Orders.custid)

Now consider the following Actuate SQL query created by a report developer or
business user using CustomersOrders:

SELECT Orders.custid, Orders.orderid, Orders.amount
FROM CustomersOrders.iob
WHERE Orders.amount BETWEEN 10000 and 20000

Because no column from the Customers table appears in the query, and because
the join in CustomersOrders includes the LEFT OPTIONAL keywords, the
Customers table is dropped from the optimized query:

SELECT Orders.custid, Orders.orderid, Orders.amount
FROM Orders.sma
WHERE Orders.amount BETWEEN 10000 and 20000

Now consider another Actuate SQL query created by a report developer or
business user using CustomersOrders:

SELECT Customers.custid, Customers.contact_ last
FROM CustomersOrders.iob
WHERE Customers.city = 'NYC'

No column from the Orders table appears in the query. But because the Orders
table is not optional, it is not dropped from the query:

SELECT Customers.custid, Customers.contact_ last
FROM Customers.sma INNER JOIN Orders.sma

ON (Customers.custid = Orders.custid)

WHERE Customers.city = 'NYC'

If you use the OPTIONAL keyword without the LEFT or RIGHT qualifier, it
applies to both tables in the join.
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The OPTIONAL keyword is ignored when it applies to:

m A table whose columns appear in the query created by a report developer or
business user, for example in the SELECT list or in the ORDER BY, GROUP BY,
HAVING, or WHERE clauses.

m The middle table in an information object, for example:

SELECT Customers.custid, Items.orderid, Items.itemcode,
Items.description

FROM Customers RIGHT OPTIONAL INNER JOIN Orders

ON (Customers.custid = Orders.custid)

LEFT OPTIONAL INNER JOIN Items ON (Orders.orderid =
Items.orderid)

In this information object, Orders is the middle table.

An information object that uses the OPTIONAL keyword cannot be joined to
another information object. Therefore, an Actuate SQL query created by a report
developer or business user cannot include more than one information object if
that information object uses the OPTIONAL keyword.

Using the OPTIONAL keyword with a computed field

Do not define a computed field in an information object that contains the
OPTIONAL keyword. Instead, define the computed field in a lower level
information object.

For example, consider the information object MyInformationObject:

SELECT dbo_ CUSTOMERS.CUSTID AS CUSTID, dbo CUSTOMERS.CONTACT FIRST
AS CONTACT_FIRST, dbo CUSTOMERS.CONTACT LAST AS CONTACT_ LAST,
dbo CUSTOMERS.CITY AS CITY, dbo ORDERS.SHIPBYDATE AS
SHIEBYDATE, dbo_ORDERS.FORECASTEHIPDATE AS FORECASTSHIPDATE,
dbo CUSTOMERS.ADDRESS AS ADDRESS,

( dbo ITEMS.PRICEQUOTE * dbo ITEMS.QUANTITY ) AS Total

FROM "dbo.CUSTOMERS.sma" AS dbo_ CUSTOMERS

OPTIONAL INNER JOIN "dbo.ORDERS.sma" AS dbo ORDERS

ON ( dbo CUSTOMERS.CUSTID=dbo ORDERS.CUSTID )

OPTIONAL INNER JOIN "dbo.ITEMS.sma" AS dbo ITEMS

ON ( dbo_ ORDERS.ORDERID=dbo_ ITEMS.ORDERID )

MyInformationObject defines the computed field Total and also contains the
OPTIONAL keyword.

Now consider the following Actuate SQL query created by a report developer or
business user using MyInformationObject:

SELECT MyInformationObject.CUSTID AS CUSTID,
MyInformationObject.CONTACT FIRST AS CONTACT FIRST,
MyInformationObject.CITY AS CITY,
MyInformationObject.CONTACT LAST AS CONTACT LAST

FROM "MyInformationObject.iob" AS MyInformationObject
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The ORDERS and ITEMS tables are not dropped from the query even though the
OPTIONAL keyword is applied to both tables in MyInformationObject and the
SELECT clause does not contain columns from either table. The tables are not
dropped because in MyInformationObject the columns ITEMS.PRICEQUOTE
and ITEMS.QUANTITY are used in a computation outside the join condition.

To avoid this situation, define the computed field in a lower level information
object such as ITEMS.iob. MyInformationObject then contains the following
query:

SELECT dbo_CUSTOMERS.CUSTID AS CUSTID, dbo_CUSTOMERS.CONTACT FIRST
AS CONTACT_FIRST, dbo_CUSTOMERS.CONTACT LAST AS CONTACT LAST,
dbo_CUSTOMERS.CITY AS CITY, dbo_ ORDERS.SHIPBYDATE AS
SHIPBYDATE, dbo_ORDERS.FORECASTSHIPDATE AS FORECASTSHIPDATE,
dbo_CUSTOMERS . ADDRESS AS ADDRESS, ITEMS.Total AS Total

FROM "dbo.CUSTOMERS.sma" AS dbo_CUSTOMERS

OPTIONAL INNER JOIN "dbo.ORDERS.sma" AS dbo_ ORDERS

ON ( dbo_CUSTOMERS.CUSTID=dbo_ORDERS.CUSTID )

OPTIONAL INNER JOIN "ITEMS.iob" AS ITEMS

ON ( dbo_ORDERS.ORDERID=ITEMS.ORDERID )

Using the OPTIONAL keyword with parentheses ()

You can control the processing of the OPTIONAL keyword with parentheses. For
example, in the following query the tables CUSTOMERS and ORDERS can be
dropped:

SELECT ITEMS.ORDERID, ITEMS.PRICEQUOTE, ITEMS.QUANTITY

FROM "CUSTOMERS.sma" AS CUSTOMERS INNER JOIN "ORDERS.sma" AS
ORDERS ON (CUSTOMERS.CUSTID = ORDERS.CUSTID) LEFT OPTIONAL
INNER JOIN "ITEMS.sma" AS ITEMS ON
(ORDERS.ORDERID = ITEMS.ORDERID)

In the following query, however, only the ORDERS table can be dropped because
the join that includes the LEFT OPTIONAL keywords is enclosed in parentheses:

SELECT ITEMS.ORDERID, ITEMS.PRICEQUOTE, ITEMS.QUANTITY

FROM "CUSTOMERS.sma" AS CUSTOMERS INNER JOIN ("ORDERS.sma" AS
ORDERS LEFT OPTIONAL INNER JOIN "ITEMS.sma" AS ITEMS ON
(ORDERS.ORDERID = ITEMS.ORDERID) ) ON
(CUSTOMERS .CUSTID = ORDERS.CUSTID)

In the following examples, A, B, C, and D are tables.
Consider the following query that includes the RIGHT OPTIONAL keywords:

A RIGHT OPTIONAL JOIN B RIGHT OPTIONAL JOIN C RIGHT OPTIONAL
JOIN D

The Actuate SQL compiler interprets this query as:

((A RIGHT OPTIONAL JOIN B) RIGHT OPTIONAL JOIN C)
RIGHT OPTIONAL JOIN D
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Tables B, C, and D can be dropped from the query.

Consider the following query that includes the LEFT OPTIONAL keywords
without parentheses:

A LEFT OPTIONAL JOIN B LEFT OPTIONAL JOIN C LEFT OPTIONAL
JOIN D

The Actuate SQL compiler interprets this query as:

((A LEFT OPTIONAL JOIN B) LEFT OPTIONAL JOIN C) LEFT OPTIONAL
JOIN D

Tables A, B, and C can be dropped from the query. It is not possible, however, to
drop table C without dropping tables A and B, or to drop table B without
dropping table A, without using parentheses.

Consider the following query that includes the LEFT OPTIONAL keywords with
parentheses:

A LEFT OPTIONAL JOIN (B LEFT OPTIONAL JOIN (C LEFT OPTIONAL
JOIN D))

Table C can be dropped from the query without dropping tables A and B. Table B
can be dropped from the query without dropping table A.

Consider the following query that includes the OPTIONAL keyword without the
LEFT or RIGHT modifier:

A OPTIONAL JOIN B OPTIONAL JOIN C OPTIONAL JOIN D
The Actuate SQL compiler interprets this query as:
((A OPTIONAL JOIN B) OPTIONAL JOIN C) OPTIONAL JOIN D

Any table or set of tables can be dropped from the query.

Using the OPTIONAL keyword with aggregate functions

If a query created by a report developer or business user contains the function
COUNT(*), the OPTIONAL keyword, if it appears in the information object, is
ignored. If a query contains another aggregate function, for example SUM or
COUNT(column), the value returned by the aggregate function depends on
whether the information object includes the OPTIONAL keyword. For example,
consider the following Actuate SQL query created by a report developer or
business user using the CustomersOrders information object:

SELECT COUNT (Customers.custid) AS CustomerCount
FROM CustomersOrders.iob

In the first case, consider the following information object CustomersOrders,
which applies the OPTIONAL keyword to the Orders table:
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SELECT Customers.custid, Customers.customname,
Customers.contact last, Orders.orderid, Orders.custid,
Orders.amount, Orders.shipbydate

FROM Customers.sma RIGHT OPTIONAL INNER JOIN Orders.sma

ON (Customers.custid = Orders.custid)

Because no column from the Orders table appears in the query and because the
join in CustomersOrders includes the RIGHT OPTIONAL keywords, the Orders
table is dropped from the optimized query:

SELECT COUNT (Customers.custid) AS CustomerCount
FROM Customers.sma

In the second case, consider the following information object CustomersOrders,
which does not apply the OPTIONAL keyword to the Orders table:

SELECT Customers.custid, Customers.customname,
Customers.contact last, Orders.orderid, Orders.custid,
Orders.amount, Oraers.shipbydate

FROM Customers.sma INNER JOIN Orders.sma

ON (Customers.custid = Orders.custid)

In this case, the Orders table is not dropped from the query:

SELECT COUNT (Customers.custid) AS CustomerCount
FROM Customers.sma INNER JOIN Orders.sma
ON (Customers.custid = Orders.custid)

The value of CustomerCount depends on whether the OPTIONAL keyword is
applied to the Orders table in the CustomersOrders information object.
Specifying the cardinality of a join

You can specify the right-to-left and left-to-right cardinality of a join. Table 6-10
lists the cardinality types and a description of each type.

Table 6-10 Cardinality types

Cardinality type Description

1 One record in the first table matches one record in the
second table.

? One record in the first table matches zero or one record in
the second table.

* One record in the first table matches zero or more records in
the second table.

+ One record in the first table matches one or more records in

the second table.
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The right-to-left cardinality type is followed by a hyphen (-), and then by the
left-to-right cardinality type. The cardinality type depends on the join column.

For example:

Customers JOIN Orders ON (Customers.custid = Orders.custid)
{CARDINALITY ('1-+')}

indicates that:
m  One record in Orders matches one record in Customers.
m  One record in Customers matches one or more records in Orders:

Customers JOIN Orders ON (Customers.custid = Orders.custid)
{CARDINALITY ('1-*')}

indicates that:
m  One record in Orders matches one record in Customers.
m  One record in Customers matches zero or more records in Orders:

Customers JOIN Orders ON (Customers.custid = Orders.custid)
{CARDINALITY ('*-2')}

indicates that:
m  One record in Orders matches zero or more records in Customers.

m  One record in Customers matches zero or one record in Orders.

Using pragmas to tune a query

If an information object query joins maps or information objects that are based on
different data sources, you may be able to tune the query using the following
pragmas:

m  EnableCBO
m applyIndexing
m  MinRowsForIndexing

These pragmas are described in the following topics.

Disabling cost-based optimization

If you provide values for the map and join column properties, the Actuate SQL
compiler uses these values to do cost-based query optimization. You can disable
cost-based optimization using the pragma EnableCBO.

For example, consider the following query based on SQL Server and Oracle
database tables:
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SELECT
NATION.N NAME,
SUM (LINEITEM.L EXTENDEDPRICE * (1 - LINEITEM.L DISCOUNT))
AS Revenue B B
FROM
"/SQL Server/CUSTOMER.SMA" CUSTOMER,
"/Oracle/ORDERS.SMA" ORDERS,
"/SQL_Server/LINEITEM.SMA" LINEITEM,
"/SQL_Server/SUPPLY.SMA" SUPPLY,
"/Oracle/NATION.SMA" NATION,
"/Oracle/REGION.SMA" REGION
WHERE
CUSTOMER.C_CUSTKEY = ORDERS.O_ CUSTKEY
AND LINEITEM.L ORDERKEY = ORDERS.O ORDERKEY
AND LINEITEM.L SUPPKEY = SUPPLY.S SUPPKEY
AND CUSTOMER.C NATIONKEY = SUPPLY.S NATIONKEY
AND SUPPLY.S NATIONKEY = NATION.N NATIONKEY
AND NATION.N REGIONKEY = REGION.R REGIONKEY
AND REGION.R _NAME = 'ASIA'
AND ORDERS.O_ORDERDATE >= TIMESTAMP '1993-01-01 00:00:00'
AND ORDERS.O_ORDERDATE < TIMESTAMP '1994-01-01 00:00:00"'
GROUP BY
NATION.N NAME

If you provide values for the map and join column properties, part of the query
plan looks similar to Figure 6-1.

: : Merge Lineitem,
NLJoin Project Join SQL Supply
SQL | Customer SQL |Orders
Figure 6-1 Example of part of the query plan for which values for the map and

join column properties have been provided

To disable cost-based optimization for the query, set the pragma EnableCBO to
False:

PRAGMA "EnableCBO" := 'false!’
SELECT
NATION.N NAME,
SUM(LINEITEM.L_EXTENDEDPRICE * (1 - LINEITEM.L_DISCOUNT))
AS Revenue
FROM
"/SQL_Server/CUSTOMER.SMA" CUSTOMER,
" /Oracle/ORDERS.SMA" ORDERS,
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"/SQL Server/LINEITEM.SMA" LINEITEM,
"/SQL Server/SUPPLY.SMA" SUPPLY,
"/Oracle/NATION.SMA" NATION,
"/Oracle/REGION.SMA" REGION

WHERE

Now this part of the query plan looks similar to Figure 6-2.

NLJoin Project NLJoin SQL | Customer
sqL | Lineitem, SQL | Orders
Supply
Figure 6-2 Example of part of a query plan with cost-based optimization
disabled

Disabling cost-based optimization changes the join sequence and the join
algorithm. The Customer and Lineltem, Supply database subqueries switch
positions, and the merge join is replaced with a nested loop join.

If you create a query using an information object for which cost-based
optimization is disabled, cost-based optimization is disabled for the query as
well.

You can disable cost-based optimization for all information object queries by
setting the BIRT iServer configuration variable Enable cost based optimization to
False. For more information about BIRT iServer configuration variables, see
Configuring BIRT iServer.

Disabling indexing

By default, the Actuate SQL compiler creates indexes for rows that are
materialized in memory during query execution, for example the rows returned
when the right side of a nested loop join is executed. You can disable indexing
using the pragma applyIndexing.

For example, to disable indexing for a query, set the pragma applyIndexing to
False:

PRAGMA "applyIndexing" := 'false'
SELECT
NATION.N NAME,
SUM (LINEITEM.L EXTENDEDPRICE * (1 - LINEITEM.L DISCOUNT))
AS Revenue a
FROM
"/SQL Server/CUSTOMER.SMA" CUSTOMER,

Chapter 6, Actuate SQL reference 197



"/Oracle/ORDERS.SMA" ORDERS,
"/SQL Server/LINEITEM.SMA" LINEITEM,
"/SQL_Server/SUPPLY.SMA" SUPPLY,
"/Oracle/NATION.SMA" NATION,
"/Oracle/REGION.SMA" REGION

WHERE

If you create a query using an information object for which indexing is disabled,
indexing is disabled for the query as well.

Specifying a threshold value for indexing

If cost-based optimization is enabled and you provide values for the map and join
column properties, the Actuate SQL compiler creates an index when 100 rows are
materialized in memory during query execution. You can change the number of

materialized rows that triggers indexing using the pragma MinRowsForIndexing.

If cost-based optimization is disabled, or you do not provide values for the map
and join column properties, an index is created for materialized rows if a suitable
column is available.

For example, to change the number of materialized rows that triggers indexing to
1000, set the pragma MinRowsForIndexing to 1000:

PRAGMA "MinRowsForIndexing" := '1000'
SELECT
NATION.N NAME,
SUM (LINEITEM.L EXTENDEDPRICE * (1 - LINEITEM.L DISCOUNT))
AS Revenue a
FROM
"/SQL_Server/CUSTOMER.SMA" CUSTOMER,
"/Oracle/ORDERS.SMA" ORDERS,
"/SQL Server/LINEITEM.SMA" LINEITEM,
"/SQL Server/SUPPLY.SMA" SUPPLY,
"/Oracle/NATION.SMA" NATION,
"/Oracle/REGION.SMA" REGION
WHERE

Specifying the number of materialized rows that triggers indexing for an
information object has no effect on queries that use the information object.

You can specify the number of materialized rows that triggers indexing for all
information object queries by setting the BIRT iServer configuration variable
Minimum rows to trigger creation of an index during materialize operation. For
more information about Actuate iServer configuration variables, see Configuring
BIRT iServer.
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Two

Configuring database types






Understanding database
types

This chapter contains the following topics:
m  About database types

m About preconfigured database types

m About configurable database types

m  Working with XML files
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About database types

A database type refers to a connection type and a mapping. Several
preconfigured database types are available for use with Information Object
Designer. You can also configure your own database types. You choose a database
type when you create a data connection definition, as shown in Figure 7-1.

= =10] x|

Data Connection Definition

Create a data connection definition.

-

Marne: IMyDatabase
Tupe: ISQL Server 2005 =l Database type
Description Customer data ﬂ

Configuration key: I

cos |

Figure 7-1 Choosing the database type for a data connection definition

About connection types

A connection type defines JDBC connection string syntax and connection
parameters, for example user name and password. You provide values for
connection parameters on the Data source connection properties page, as shown
in Figure 7-2.

About mappings

When the Integration service processes an Actuate SQL query, one of the
following occurs:

m The entire query is executed by the database.

m Parts of the query are executed by the database, while other parts of the query
are executed by the Integration service.

m The entire query is executed by the Integration service.
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Data source connection properties
Type: |S0L Server 2005
Descriptiar Customer data =
||
Configuration key: |
Credentialz: I Prosy j
User name: IMyD atabasellzer
Passwaord: | ********
Server. IMyDatabaseSewer
Database: ICIassicMDdEIs
Port: |1423
Test Connection |
Map tables | Map stored procedures | Create SOL map |
Figure 7-2 Providing values for the data source connection properties

Figure 7-3 shows how the Integration service processes an Actuate SQL query
when parts of the query are executed by the database, while other parts of the
query are executed by the Integration service.

Integration Integration
service translates |- e | Thedatabase
service sends the tes th
Actuate SQL query execuéas X e
i uery and returns
query into to the database g yresults
database’s native
SQL
The Integration )
service converts The Integration The Integration
the result setinto [~ service performs | —= service provides
an Actuate SQL any remaining results to the
compliant result operations on the Factory service
set result set

Figure 7-3 Actuate SQL query processing

You optimize performance by having the database execute as much of the query
as possible. Mappings translate Actuate SQL into the database’s native SQL and
ensure that an Actuate SQL query returns the same results for every database
type. For example, a DB2 database and an Oracle database have identical
schemas. You create an Actuate SQL query using maps that represent tables from
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one of these databases. The query returns the same results whether the maps
represent DB2 tables or Oracle tables.

Specifically, a mapping defines how to map Actuate SQL data types to a
database’s native SQL data types. A mapping also defines how to map the
following Actuate SQL constructs to the corresponding native SQL constructs:

m Functions and operators

m Parameters

m Literals

= GROUP BY and ORDER BY clauses

About preconfigured database types

Information Object Designer supports the following preconfigured database
types:

s DB2

m Informix

m  MySQL Enterprise

m Oracle

m PostgreSQL

m SQL Server

m Sybase

The connection type configuration and mappings files for preconfigured database
types are located in the following iServer directory:

$AC_SERVER _HOME/etc

The connection type configuration for preconfigured database types resides in the
file intsrvrsources.xml. Do not modify this file.

The mapping for a preconfigured database type resides in the mappings.xml file
in the directory for that type. For example, Figure 7-4 shows the location of the
mappings.xml file for the SQL Server database type.

The following topics explain how data types for preconfigured database types are
mapped to Actuate SQL data types and vice versa. Some database data types
cannot be mapped to an Actuate SQL data type, for example binary types with
specially defined operations. These topics also discuss special considerations for
each database type.

204 Designing BIRT Information Objects



etc
H- £ data_inteqration
=l Baze_Mappings

o

e [H mappings.xml
- £ DBz

- [ mappings.xml
E-- £ Generic_QDEC

feeo [ mappings.xml
= £ Infarmix

feeo [ mappings.xml
EE MySQL

L [B mappings.xml
- £ Oracle

feeo [ mappings.xml
Bl €1 5L Server

e B mappings.xml —Mappings file for SQL
= £ Sybase_AsE Server database type

- [ mappings.xml
------- [ datasources.ml

o [ intsrursources sl ——Connection type configuration
file for preconfigured database
types
Figure 7-4 Location of the connection type configuration file and mappings files

for preconfigured database types

DB2 data type mapping and issues

The following DB2 functions convert DECIMAL values to the DOUBLE data
type. The corresponding Actuate SQL functions are implemented using these
native functions, and may therefore return slightly inaccurate values, especially
for calculations involving very large or very small numbers:

s POWER ()
= ROUND ()
= FLOOR ()
s CEILING ()

When a numeric type is cast to VARCHAR(n) and n is not large enough to
accommodate the string, Actuate SQL returns an error. DB2, however, truncates
the value without returning an error.

Table 7-1 shows how DB2 data types map to Actuate SQL data types.

Table 7-1 Mapping of DB2 data types to Actuate SQL data types
Compiled to
Actuate SQL  DB2 data
DB2 data type data type type DB2 data type limitations
BIGINT DECIMAL DECIMAL The maximum number of significant digits

(precision) for DB2 DECIMAL is 31.

(continues)
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Table 7-1 Mapping of DB2 data types to Actuate SQL data types (continued)
Compiled to
Actuate SQL. DB2 data
DB2 data type data type type DB2 data type limitations
CHAR VARCHAR VARCHAR  DB2 VARCHAR has a maximum length of
32,672 characters.
DATE TIMESTAMP  DATETIME
DECIMAL DECIMAL DECIMAL The maximum number of significant digits
(precision) for DB2 DECIMAL is 31.
DOUBLE DOUBLE DOUBLE
INTEGER INTEGER INTEGER
REAL DOUBLE DOUBLE
SMALLINT INTEGER INTEGER
TIMESTAMP  TIMESTAMP DATETIME
VARCHAR VARCHAR VARCHAR  DB2 VARCHAR has a maximum length of

32,672 characters.

Informix data type mapping and issues
The NCHAR and NVARCHAR data types are not supported.

If a query contains a CASE statement that returns a string, Informix pads the
string with spaces so that its length matches the length of the longest string in the
CAGSE statement. For example, the following CASE statement returns 'O '

(O followed by two spaces), not 'O'. The string length matches the length of the
longest string in the CASE statement, 'N/A'":

SELECT
CASE ORDERS.status
WHEN 'Open' Then 'O
WHEN 'Closed' Then 'C!'
WHEN 'In Evaluation' Then 'E'
ELSE 'N/A'
END
AS "Short Status", ORDERS.orderid, ORDERS.custid,
ITEMS.quantity
FROM "../Data Sources/MyDatabase/ORDERS.sma" ORDERS
INNER JOIN "../Data Sources/MyDatabase/ITEMS.sma" ITEMS
ON ORDERS.orderid = ITEMS.orderid
WHERE ORDERS.orderid < 1120 OR ORDERS.orderid > 2000
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Table 7-2 shows how Informix data types map to Actuate SQL data types.

Table 7-2 Mapping of Informix data types to Actuate SQL data types
Compiled
Informix Actuate SQL  to Informix
data type data type data type Informix data type limitations
CHAR VARCHAR VARCHAR Informix VARCHAR has a maximum length

of 254 characters.
CHARACTER VARCHAR VARCHAR Informix VARCHAR has a maximum length

VARYING of 254 characters.

DATE TIMESTAMP DATETIME

DATETIME TIMESTAMP DATETIME

DECIMAL DECIMAL DECIMAL  The maximum number of significant digits
(precision) for Informix DECIMAL is 32.

FLOAT DOUBLE FLOAT Informix FLOAT is 4-byte, not 8-byte,

floating point. The maximum number of
significant digits (precision) is 16.

INTS8 DECIMAL DECIMAL  The maximum number of significant digits
(precision) for Informix DECIMAL is 32.

INTEGER INTEGER INTEGER

MONEY DECIMAL DECIMAL  The maximum number of significant digits
(precision) for Informix DECIMAL is 32.

SMALLFLOAT DOUBLE FLOAT Informix FLOAT is 4-byte, not 8-byte,

floating point. The maximum number of
significant digits (precision) is 16.
SMALLINT INTEGER INTEGER

VARCHAR VARCHAR VARCHAR Informix VARCHAR has a maximum length
of 254 characters.

Oracle data type mapping and issues

Oracle treats zero-length VARCHAR?2 and NVARCHAR?2 values as NULL values.
Oracle also treats NULL VARCHAR2 and NVARCHAR?2 values as zero-length
values. For this reason, Oracle queries may return different results than queries
against other databases, for example:

m The CONCAT function, when concatenating a NULL value and a non-NULL
value, returns a non-NULL value because the NULL value is treated as an
empty string.

Chapter 7, Understanding database types 207



m Comparisons with empty strings using the operators =, <, >, and <> never
evaluate to TRUE. For example, the expression:

'Hello' <> '!

does not evaluate to TRUE because Oracle treats " as a NULL value, and any
comparison with NULL evaluates to UNKNOWN, not TRUE.

Actuate SQL uses SQL-92 semantics to perform VARCHAR string comparisons.
In most cases, when a query is pushed to the database, the mappings.xml file
preserves SQL-92 semantics. For Oracle databases, however, using SQL-92
semantics results in poor performance. For this reason, a query that is pushed to
an Oracle database uses Oracle semantics to perform string comparisons. If you
are working solely with Oracle databases, string comparisons yield consistent
results. If you join a table in an Oracle database to a table in a database of another
type, string comparisons may yield inconsistent results because the query pushed
to the other database uses SQL-92 semantics. Moreover, if the query is not pushed
to the database, the Integration service uses SQL-92 semantics. If you want Oracle
databases to use SQL-92 semantics, you must use a different mappings.xml file.
Contact Actuate Support to obtain this file.

Table 7-3 shows how Oracle data types map to Actuate SQL data types. The
letters p and s represent precision and scale.

Table 7-3 Mapping of Oracle data types to Actuate SQL data types
Compiled to
Oracle Actuate SQL  Oracle
data type data type data type Oracle data type limitations
CHAR VARCHAR NVARCHAR2 Oracle NVARCHAR? has a maximum
length of 2000 bytes or characters.
DATE TIMESTAMP DATE Oracle versions earlier than 9i do not
(Oracle 8i) support the TIMESTAMP data type. For
TIMESTAMP  those versions the milliseconds field of
(Oracle 9iand timestamp values is ignored in
later) comparisons and sorting.
FLOAT DOUBLE FLOAT Oracle FLOAT has a maximum precision
of 38 decimal digits.
NCHAR VARCHAR NVARCHAR2 Oracle NVARCHAR? has a maximum
length of 2000 bytes or characters.
NUMBER(p,s) INTEGERif INTEGER Oracle supports only the NUMBER and
s=0 and p<=9 FLOAT data types for internal storage.
DECIMAL if DECIMAL INTEGER and DECIMAL data types are
s<>0 or p>9 provided to support queries written with
standard SQL types.

The maximum number of significant digits
(precision) for Oracle DECIMAL is 38.
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Table 7-3 Mapping of Oracle data types to Actuate SQL data types
Compiled to
Oracle Actuate SQL  Oracle
data type data type data type Oracle data type limitations

NVARCHAR2 VARCHAR NVARCHAR2 Oracle NVARCHAR? has a maximum

TIMESTAMP
VARCHAR?2

length of 2000 bytes or characters.
TIMESTAMP  TIMESTAMP

VARCHAR NVARCHAR2 Oracle NVARCHAR? has a maximum
length of 2000 bytes or characters.

SQL Server data type mapping and issues

The behavior of the Actuate SQL DatePart(), DateAdd(), and DateDiff() functions
sometimes differs from the behavior of the corresponding
Transact-SQL functions.

If you want to use the Actuate collation UNICODE_BIN against a SQL Server
database that uses a collation other than unicode_bin, you must install the
SQL_Latin1_General_Cp850_BIN2 collation. This installation requires HotFix
816039 from Microsoft. For information about HotFix 816039, go to:

http://support.microsoft.com/?1d=816039

Using parameters in a GROUP BY clause may result in a SQL Server database
error. For example, a query of the form:

SELECT CUSTID+? FROM CUSTOMERS
GROUP BY CUSTID+?

results in the following error:

[Microsoft][ODBC SQL Server Driver][SQL Server]Column
'EIITESTDB.dbo.CUSTOMERS.CUSTID' is invalid in the select list because it is
not contained in either an aggregate function or the GROUP BY clause

SQL Server considers the two parameters to be different since they are not named
parameters. The solution is to include a reference to the CUSTID column in the
GROUP BY clause.
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Table 7-4 shows how Transact-SQL data types map to Actuate SQL data types.

Table 7-4 Mapping of Transact-SQL data types to Actuate SQL data types
Compiled to

Transact-SQL Actuate SQL  Transact-SQL

data type data type data type Transact-SQL data type limitations

CHAR VARCHAR NVARCHAR Transact-SQL NVARCHAR has a
maximum length of 4000 characters on
SQL Server.

DATETIME TIMESTAMP  DATETIME Transact-SQL DATETIME stores values
from January 1, 1753. The accuracy of
dates is to one three-hundredths of a
second (3.33 milliseconds).

DECIMAL DECIMAL DECIMAL The maximum number of significant
digits (precision) for Transact-SQL
DECIMAL is 38.

FLOAT DOUBLE FLOAT

INT INTEGER INTEGER

MONEY DECIMAL DECIMAL The maximum number of significant
digits (precision) for Transact-SQL
DECIMAL is 38.

NCHAR VARCHAR NVARCHAR Transact-SQL NVARCHAR has a
maximum length of 4000 characters on
SQL Server.

NVARCHAR VARCHAR NVARCHAR Transact-SQL NVARCHAR has a
maximum length of 4000 characters on
SQL Server.

REAL DOUBLE FLOAT

SMALLDATE TIMESTAMP  DATETIME Transact-SQL DATETIME stores values

TIME from January 1, 1753. The accuracy of
dates is to one three-hundredths of a
second (3.33 milliseconds).

SMALLINT INTEGER INTEGER

SMALLMONEY DECIMAL DECIMAL The maximum number of significant
digits (precision) for Transact-SQL
DECIMAL is 38.

TINYINT INTEGER INTEGER

VARCHAR VARCHAR NVARCHAR Transact-SQL NVARCHAR has a

maximum length of 4000 characters on
SQL Server.
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Sybase data type mapping and issues

Sybase table and column names must not exceed 28 characters.

When using Sybase, an expression in a WHERE clause can contain the power
function and a decimal value with up to five digits in the fractional part of the
value. The following WHERE clause shows this type of expression:

WHERE power (ACNULLDATATYPES.ACDECIMAL, 2) > 1.12345

Do not use expressions in the WHERE clause that have a power function and a
decimal value with six or more digits in the fractional part of the value. For
example, the following WHERE clause causes an error:

WHERE power (ACNULLDATATYPES.ACDECIMAL, 2) > 1.123456

Table 7-5 shows how Sybase data types map to Actuate SQL data types.

Table 7-5 Mapping of Sybase data types to Actuate SQL data types
Compiled to
Actuate SQL  Sybase data

Sybase data type data type type Sybase data type limitations

CHAR VARCHAR NVARCHAR  Sybase NVARCHAR has a
maximum length of 255
characters.

DATETIME TIMESTAMP DATETIME Sybase DATETIME stores values
from January 1, 1753. The accuracy
of dates is to one three-hundredths
of a second (3.33 milliseconds).

DECIMAL DECIMAL DECIMAL The maximum number of
significant digits (precision) for
Sybase DECIMAL is 38.

DOUBLE PRECISION  DOUBLE FLOAT

FLOAT DOUBLE FLOAT

INT INTEGER INTEGER

MONEY DECIMAL DECIMAL The maximum number of
significant digits (precision) for
Transact-SQL DECIMAL is 38.

NCHAR VARCHAR NVARCHAR  Sybase NVARCHAR has a
maximum length of 255
characters.

NVARCHAR VARCHAR NVARCHAR  Sybase NVARCHAR has a
maximum length of 255
characters.

(continues)
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Table 7-5 Mapping of Sybase data types to Actuate SQL data types (continued)
Compiled to
Actuate SQL  Sybase data
Sybase data type data type type Sybase data type limitations
REAL DOUBLE FLOAT

SMALLDATETIME TIMESTAMP DATETIME Sybase DATETIME stores values

from January 1, 1753. The accuracy
of dates is to one three-hundredths
of a second (3.33 milliseconds).

SMALLINT INTEGER INTEGER

SMALLMONEY DECIMAL DECIMAL The maximum number of
significant digits (precision) for
Sybase DECIMAL is 38.

TINYINT INTEGER INTEGER

VARCHAR VARCHAR NVARCHAR  Sybase NVARCHAR has a

maximum length of 255
characters.

About configurable database types

If Information Object Designer does not provide a preconfigured database type
for a database you want to use, you can configure your own database type. The
connection type configuration and mappings files for configurable database types
are located in the following iServer directory:

$AC_SERVER HOME/etc/data_integration
You can use the default mappings file if both of the following statements are true:
m  Your database implementation adheres closely to the SQL-92 standard.

m  Your JDBC driver supports features that mask differences between databases,
such as ODBC escape sequences and Generic SQL type codes.

The default mappings file is located in the Generic_ ODBC directory.

If your database differs significantly from the SQL-92 standard, you must create a
mappings file. For example, the configurable database type MySQL Enterprise 4.1
is installed with Actuate BIRT iServer. Figure 7-5 shows the location of the
connection type configuration file for configurable database types and the
mappings file for MySQL Enterprise.

When you configure a database type, first test your queries with the default
mappings file. If any of your queries fail, you must create a mappings file for the
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database type. The mappings file in the Base_Mappings directory contains the
default mapping as a reference.

B £ ete
B & data_integration
= Baze_Mappings
o [ mappings.xml
- £ DBz
- [ mappings.xml
Bl €1 Generic_ODBC

o

“en [ mappings.xml ——Default
B £ Informix i i
M mappings file
B E My3oL . .
B mappings. ——Mappings file
B E Oracle for Mysol—
...... [ mappings.xml i
Bl £ 5L Server Enterprlse
o B mappings.xml database type

EE Sybase_AsE
o [ mappings.xml
------- [ datasources.xml ——Connection type
o [ intsrvrsources xml Configuration file
for configurable
database types

Figure 7-5 Location of the connection type configuration file and the mappings
file for MySQL Enterprise

How to configure a database type

1 Configure a connection type for the database type using a ConnectionType
element in datasources.xml.

2 Configure the database type using a DatabaseType element in datasources.xml
Do not specify the DataSourceMapping attribute, for example:

<DatabaseTypes>

<DatabaseType Name="MyDatabaseType"
ConnectionType="MyConnectionType" />
</DatabaseTypes>

The Integration service uses the mappings.xml file in the Generic_ODBC
directory.

Restart the Integration service to reload database type configurations.
Test your queries.
If any of your queries fail, go to step 5.

5 Create a directory and a mappings file for the database type in
$AC_SERVER_HOME/etc/data_integration.

Start the mappings file by making a copy of the mappings.xml file in the
Generic_ODBC directory.

6 Modify the DatabaseType element.
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The DataSourceMapping attribute gives the name of the directory in which
the mappings file resides, for example:

<DatabaseTypes>
<DatabaseType Name="MyDatabaseType"
ConnectionType="MyConnectionType"
DataSourceMapping="MyDataSourceMapping" />
</DatabaseTypes>

7 Restart the Integration service to reload database type configurations.

8 Test your queries and modify the mappings file as necessary.

Working with XML files

When you configure a database type, you modify the datasources.xml file and
possibly create a mappings.xml file. When you work with XML, the following
characters require special treatment:

m < (less than)
m > (greater than)
m " (double quotation mark)

Use the codes in Table 7-6 to represent these characters.

Table 7-6 XML codes for special characters
Special character XML code

< &lt;

> &gt;

" &quot;

In the following example, &quot; represents the character ":

<Initializer>
SET SESSION sgl mode=&quot;ANSI QUOTES&quot;
</Initializers>

Alternatively, you can use CDATA to escape an element value. XML parsers do
not interpret the string data inside CDATA. The following example uses < and >
but is acceptable because the element value is enclosed in [[CDATA[]]:

<FunctionMapping FunctionName="NE">
<! [CDATA[ SPO0 <> S$P1 11>
</FunctionMapping>
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Configuring connection
types

This chapter contains the following topics:
m About configuring connection types
m JDBC driver requirements and installation

m  Working with datasources.xml
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About configuring connection types

A connection type defines JDBC connection string syntax and connection
parameters, for example user name and password. You provide values for
connection parameters on the Data source connection properties page, as shown
in Figure 8-1.

Data Source connection properties
Type: JryscL
Description: ;I
E
Configuration key: |
Credentials: IPFUXY j
User name: I sales_user
Password: | [
Fort: | 3306
Service: |
Hest: I dbserver
IANAApPpCodePage: |
Database: | sales
Test Connection
Finishl Map tables | Create SOL map |
Figure 8-1 Providing values for the data source connection properties

To configure a connection type:

m  Confirm that the database has a JDBC driver that meets the requirements
described in this chapter.

m Install the JDBC driver.
m  Modify the datasources.xml file:
m Define the ConnectionType element.

m Define the ConnectionType attribute for the appropriate DatabaseType
elements.
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JDBC driver requirements and installation

When you configure a connection type, you must specify the JDBC driver that the
connection uses. The Integration service uses a JDBC driver to retrieve a list of
database tables, views, or stored procedures when you create maps in
Information Object Designer. For example, Figure 8-2 shows a list of tables in the
Available pane.

= 1ol

Maps f= j
Apply a filker to display tables and views. Then select tables and views to create LL
Maps.

[rata source tuD atabaze
Catalog: IAcTestD B_austr j
Available Selected

E-82 AcTestDB_austr - [ dbe. custamers

282 dbo [ dbe.orders
[ % heSpecialChar @ —>| [ dbeiterns
-] AcT estDatatypes

5] A Null_Datatypes LI

-] Autcicini

-] Autcicin2

-] Create

-] acDataTypes

-] aclongNVARCHAR < |
-] aclongarchar

-] case 2 |
-.[55] customers =
2| | »

r Filter

Schema name prefix: dbo & Show tables only

TableView name prefis: I € Show views only
Apply filter | V¥ Use cached values © Show all

(7] < Back | Hest s | Finish I Cancel |
Figure 8-2 Selecting tables

The Integration service also uses a JDBC driver to execute Actuate SQL queries.

JDBC driver requirements

JDBC drivers must be JDBC 3.0 compatible. Specifically, the function
Driver.jdbcCompliant() must return TRUE, and
DatabaseMetadata.getfDBCMajorVersion() must return at least 3. Because the
iServer compiler is based on Java 1.5, JDBC drivers should be compatible with
JRE version 1.5 or earlier.

The JDBC driver must be able to retrieve a list of tables using the
DataBaseMetaData.getTables() method. Some tables returned by this method
may not be callable by the database user specified in the data connection
definition. Actuate SQL queries that use these tables may fail at query execution

Chapter 8, Configuring connection types 217



time. For Information Object Designer to display only the tables that can be
selected, DataBaseMetaData.allTables AreSelectable() must return TRUE.

The JDBC driver must be able to retrieve a list of stored procedures using the
DataBaseMetaData.getProcedures() method. Some stored procedures returned by
this method may not be callable by the database user specified in the data
connection definition. Actuate SQL queries that use these stored procedures may
fail at query execution time. For Information Object Designer to display only the
callable stored procedures, DataBaseMetaData.allProceduresAreCallable() must
return TRUE.

Installing a JDBC driver

You can store the JDBC driver anywhere in the iServer file system as long as the
iServer user can access it. You specify the absolute path to the driver when you
create the connection type. You can include the driver by name to ensure that no
other driver is loaded.

Working with datasources.xml

To configure a connection type, you must modify datasources.xml.
datasources.xml is located in the following directory:

SAC_SERVER _HOME/etc/data_integration

datasources.xml contains two main elements:

m  ConnectionTypes
ConnectionTypes contains connection type configurations.

m DatabaseTypes
DatabaseTypes associates a connection type and a mapping with a database
type.

Configuring connection types: ConnectionTypes
element

The ConnectionTypes element has one or more child elements called
ConnectionType. Each ConnectionType element specifies how the Integration
service connects to a database. You define a name for each connection type using
the Name attribute.

The ConnectionType element has two child elements:
m JDBCDriver

m ConnectionParams
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Here is an example of a ConnectionTypes element:

<ConnectionTypes>
<ConnectionType Name="MySQL">
<JDBCDriver DriverName="com.mysqgl.jdbc.MySQLDriver">
<ConnectionStrings
jdbc:mysgl:mysqgl://%$server$:$port%;SID=%sid%
</ConnectionString>
<ConnectionProperties>
<Property Name="Username">%username%</Property>
<Property Name="Password">$%$password%</Property>
</ConnectionPropertiess>
<LibraryPaths>
<Location>/home/jsmith/bin/</Location>
<Location>/home/jsmith/mysqgl/bin/</Location>
</LibraryPath>
</JDBCDrivers>
<ConnectionParams>
<ConnectionParam Name="server"
Display="Server"
Type="String"
DefaultValue="end2243"
Optional="true"
ValueIsCaseSensitive="false">
</ConnectionParam>

</ConnectionParams>
</ConnectionType>
</ConnectionTypes>

ConnectionType child element: JDBCDriver

The JDBCDriver element contains information used to create JDBC connections.
This element has one attribute, DriverName, as shown in Table 8-1. The
JDBCDriver element has three child elements, ConnectionString,
ConnectionProperties, and LibraryPath, as shown in Table 8-2.

Table 8-1 Attribute of the JDBCDriver element
Attribute Description Required
DriverName Class name of the JDBC Yes
driver, for example
com.mysql.jdbc.
MySQLDriver.
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Table 8-2 Child elements of the JDBCDriver element

Element Description Required

ConnectionString JDBC connection string Yes
syntax. Do not include
user name and password.

Connection User name and password  Yes

Properties properties.

LibraryPath Paths to search for Yes
libraries used by the

JDBC driver. Use a
separate Location element
for each path.

ConnectionString element
The JDBCDriver element has a ConnectionString child element, for example:

<ConnectionStrings>
DRIVER={MySQL 4.0} ;DB=%database%; PORT=%port%; IP=%server$
</ConnectionStrings>

The ConnectionString element provides a template for the JDBC connection
string. The parameters enclosed in percent signs (%), for example %server%, are
placeholders for the values you type on the Data source connection properties
page, shown in Figure 8-1, when you create a data connection definition. These
values are retrieved from the data connection definition (DCD) file when the
Integration service creates a connection.

You can exclude a portion of a connection string when no value is provided for a
connection parameter by enclosing it in double brackets ([[...]]). In the following
example, to exclude the IANAAppCodePage parameter from the connection
string when the value is left blank, define the ConnectionString element as
follows:

<ConnectionStrings>
DRIVER={MySQL 4.3}; HOST=%server%; PORT=%port$%;
SID=%sid%; [ [IANAAppCodePage : CODEPAGE=%IANAAppCodePage%]]
</ConnectionString>

[[TANAAppCodePage : CODEPAGE=%IANAAppCodePage%]] is not included
in the connection string unless the IANAAppCodePage parameter is set.

To include the following literal characters in a ConnectionString element, precede
the character with a backslash (\):

r \

] 0/0
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ConnectionType child element: CatalogFilter

The CatalogFilter element filters catalogs returned by the JDBC driver when
Information Object Designer displays a list of tables, views, or stored procedures
in the New Maps dialog. By default, all catalogs are returned. Like the template
for the JDBC connection string, the catalog filter can contain placeholders for the
values of connection parameters, for example:

<CatalogFilter>%database%</CatalogFilter>

ConnectionType child element: ConnectionParams

The ConnectionParams element defines the parameters that are used in the
ConnectionString element. The ConnectionParams element has a single child
element, ConnectionParam. Here is an example of a ConnectionParam element
that defines the server parameter:

<ConnectionParam Name="server"
Display="Server"
Type="String"
DefaultValue="end2243"
Optional="true"
ValueIsCaseSensitive="false">

</ConnectionParams>

One ConnectionParam element is required for each parameter. Each
ConnectionParam element has the attributes shown in Table 8-3.

Table 8-3 Attributes of the ConnectionParam element

Default
Attribute Description Required? value

Name Name of the connection Yes
parameter. This attribute is
case-insensitive.

Display Display name that appears ~ Yes
on the Data source
connection properties page
in Information Object
Designer.

(continues)
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Table 8-3 Attributes of the ConnectionParam element (continued)

Default
Attribute Description Required? value

Type Connection parameter type.  Yes
Must be one of the following:

String
Boolean
Integer

Masked (Use for a string
whose value should be
hidden, such as a
password.)

DefaultValue Default value of the No
parameter.

Optional Specifies whether a No True
parameter is optional.

ValuelsCaseSensitive  Specifies whether the No True
parameter value is case-
sensitive. Used when
comparing two DCD files to
see if they are equivalent.

Configuring database types: DatabaseTypes element

The DatabaseTypes element has one or more child elements called DatabaseType.
Each DatabaseType element specifies the connection type and mapping for a
database type. Several database types can use the same connection type, provided
they use similar JDBC drivers, or the same mapping. For example, two different
versions of a MySQL Enterprise database can use the same connection type.

Here is an example of a DatabaseTypes element:

<DatabaseTypes>
<DatabaseType Name="MySQL4"
ConnectionType="MySQL"
DataSourceMapping="MySQL4" />
<DatabaseType Name="Ingres"
ConnectionType="Ingres"
DataSourceMapping="Ingres" />
</DatabaseTypes>
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Each DatabaseType element has the attributes shown in Table 8-4.

Table 8-4 Attributes of the DatabaseType element
Attribute Description Required?
Name Name of the database type. Yes
DisplayName Display name for the database No
type in the New Data Connection
Definition dialog in Information
Object Designer.
ConnectionType Name of the connection typeto  Yes
use with this database type. The
connection type is configured
using the ConnectionType
element.
DataSourceMapping Directory where the No. If not specified,

mappings.xml file is located. This
directory must be in the
$AC_SERVER_HOME/etc
/data_integration directory.

the Integration
service uses the
mappings.xml file
in the
Generic_ODBC
directory.

If you set this
attribute to
No_Mappings, all
operations are
executed by the
Integration service
executor.
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Mapping data types

This chapter contains the following topics:
m  About data type mapping
m  DataTypeMapper element
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About data type mapping

When you create a map of a database table, a database view, or a stored
procedure result set, Information Object Designer assigns an Actuate SQL data
type to each column in the map. For example, Figure 9-1 shows the output

columns for a map of a SQL Server database table and the Actuate SQL data types
for each column.

Output Columns

Specify output columns:

Source column
ORDERID CRDERID
[J| FORECASTORDERDATE FORECASTORDERDATE Timestamp
SHIPBYDATE SHIPEYDATE Timestamp
| FORECASTSHIPDATE FORECASTSHIPDATE Timestamp
STATUS STATUS Yarchar
| 1550E 1550E Varchar
0| askevDAaTE ASKEYDATE Timestamp
O/ custio CUSTID Integer
CATEGORY CATEGORY oobe  ——Actuate SQL
data type
Figure 9-1 Output columns and Actuate SQL data types for a map of a database
table

The Actuate SQL data type for a column is determined as follows:

m The JDBC driver provides the generic SQL data type for the column, for
example INTEGER, FLOAT, VARCHAR, or DATE.

m Based on the generic SQL data type, the Integration service chooses the best
Actuate SQL data type for the column.

For example, in Figure 9-2 a column in a SQL Server database table has FLOAT
data type. The JDBC driver provides the generic SQL data type FLOAT. The
Integration service then chooses the Actuate SQL data type DOUBLE.

SQL Server Generic SQL Actuate SQL

data type: data type: data type:
FLOAT = FLOAT - DOUBLE

Figure 9-2 Mapping a database data type to an Actuate SQL data type
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Table 9-1 lists the generic SQL types supported by the Integration service.

Table 9-1 Generic SQL types supported by the Integration service
Generic SQL Actuate SQL
type Facets Description type
BIT 1-bit integer, with value 1 or 0. INTEGER
TINYINT 8-bit integer. INTEGER
SMALLINT 16-bit integer. INTEGER
INTEGER 32-bit integer. INTEGER
BIGINT 64-bit integer. DECIMAL
FLOAT Size Floating point that can vary between DOUBLE
single and double binary precision,
depending on the value of size.
REAL Floating point (single binary precision). DOUBLE
DOUBLE Floating point (double binary DOUBLE
precision).
NUMERIC Size, decimals  Decimal with scale decimals, and DECIMAL
precision that cannot exceed size.
DECIMAL Size, decimals  Same as NUMERIC. DECIMAL
CHAR Size Fixed-width character, maximum VARCHAR
length is specified by size.
VARCHAR Size Variable-width character, maximum VARCHAR
length is specified by size.
LONG Size Long variable-width character. VARCHAR
VARCHAR Maximum length is specified by size.
The Integration service does not
support strings with a maximum length
of more than 64,000 characters.
DATE Date with no time component. TIMESTAMP
TIMESTAMP Date with time component, with or TIMESTAMP

without fractions-of-a-second field,
containing up to 3 digits.

DataTypeMapper element

If the JDBC driver does not provide a generic SQL data type for a column or the
JDBC driver provides an incorrect data type, use the DataTypeMapper element in
mappings.xml to map the column’s database data type to a generic SQL data
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type. The DataTypeMapper element has one child element, DataTypes. The
DataTypes element has one child element, DataType.

For each database data type you want to map, you define a DataType element.
You should declare all VARCHAR and DECIMAL (or NUMERIC) data types
using the DataType element. If these data types are not declared, the Integration
service uses the ODBC escape sequences to convert these types. The escape
sequences cannot specify the string length, decimal precision, or decimal scale of
the result.

Each DataType element has the attributes shown in Table 9-2.

Table 9-2 Attributes of the DataType element
Attribute Description Required?
Name Name of the database data type, for example FLOAT,  Yes
NUMBER, VARCHAR2.
GenericSQLType  Generic SQL type the data type corresponds to. Yes
MaxSize Maximum size (decimal precision or string length) for ~No, but highly
the database data type. Applies only to CHAR, recommended.
VARCHAR, LONGVARCHAR, NUMERIC, and
DECIMAL types.

MaxSize attribute

For every database type, there is a maximum string length and a maximum
decimal precision (the maximum number of decimal digits in a DECIMAL value).
For example, for SQL Server 2000, NVARCHAR strings cannot exceed 4000
characters. When performing calculations involving strings and decimals, the
Integration service uses these maximum sizes to determine how big the result can
be. Strings and decimal digits may be truncated by the Integration service based
on these maximum values. Also, if the maximum assumed by the Integration
service is too large, the Integration service may create queries that the database
cannot accept.

You should specify the MaxSize attribute for CHAR, VARCHAR,
LONGVARCHAR, NUMERIC and DECIMAL types. Table 9-3 gives the default
values for the MaxSize attribute.

Table 9-3 Default values for the MaxSize attribute
Generic SQL type Default value of MaxSize attribute
CHAR, VARCHAR 255
LONGVARCHAR 64000

NUMERIC, DECIMAL 20
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The following example uses the MaxSize attribute to specify the maximum string
length for the database data type NVARCHAR and the maximum decimal
precision for the database data type DECIMAL:

<DataTypeMapper>
<DataTypes>
<DataType Name="NVARCHAR" GenericSQLType="VARCHAR"
MaxSize="1000" />
<DataType Name="DECIMAL" GenericSQLType="DECIMAL"
MaxSize="32" />
</DataTypes>
</DataTypeMapper >

DataType child element: Aliases

The database may have other names or aliases for a data type. For example, on
SQL Server INT is also called INTEGER. You must define the aliases so that the
Integration service can recognize the data type when the database column uses an
alias. To define aliases, use the Aliases element. The Aliases element has one child
element, Alias. Define each alias using the Alias element.

The following example assumes you have a database that has the following data
types: CHAR, VARCHAR, NVARCHAR, SMALLINT, INT, DECIMAL, FLOAT,
and DATETIME. The Integration service maps all of these to generic SQL data
types except NVARCHAR and FLOAT. For these data types, the Integration
service returns an error such as Type is not supported. The Integration service
returns an error because the JDBC driver does not provide the generic SQL type
for FLOAT or NVARCHAR. You must define a mapping for data types that the
JDBC driver cannot map.

Using your database documentation and the descriptions in Table 9-1, you select
generic SQL types for NVARCHAR and FLOAT. You also define an alias for
FLOAT:

<DataTypeMapper>
<DataTypes>
<DataType Name="NVARCHAR" GenericSQLType="VARCHAR" />
<DataType Name="FLOAT" GenericSQLType="DOUBLE">
<Aliases>
<Alias>DOUBLE</Alias>
</Aliases>
</DataType>
</DataTypes>
</DataTypeMapper >
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Mapping functions and
operators

This chapter contains the following topics:

About mapping functions and operators
Syntax for mapping functions and operators
Using operators in a mapping

Using initialization statements
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About mapping functions and operators

If an Actuate SQL query contains a function, the Integration service must convert
the function into a database function that returns the same results. To convert an
Actuate SQL function to a database function, the Integration service uses function
templates in a mappings.xml file. A function template contains a database
function that is substituted for the Actuate SQL function when the query is sent to
the database. The mappings.xml file in the Base_Mappings directory contains the
default function templates.

If your database is ODBC-compliant and the database function is exactly like an
Actuate SQL function, then the Integration service can perform the mapping for
you using ODBC escape sequences. Relational databases, however, frequently
differ in their implementation of SQL functions. Thus, when you configure a new
database type you must resolve discrepancies in function implementations.

If your database does not support a function used in an Actuate SQL query, then
you cannot map the function. The function must be performed by the Integration
service.

About ODBC escape sequences

ODBC escape sequences are a set of standard patterns that are recognized by both
ODBC and JDBC drivers. The sequences are used for creating SQL statements
that are platform-independent. When sent to a JDBC or ODBC driver, the driver
converts the escape sequences to SQL expressions that are recognized by the
database. An ODBC escape sequence is enclosed in braces and starts with FN,
which stands for function. An ODBC escape sequence has the following pattern:

{FN functionName (parameters) }

For example, the following query sent through a JDBC driver for SQL Server
converts the values from the column Name to uppercase:

SELECT {FN UCASE (Name)} FROM Customers
The JDBC driver translates the expression to:
SELECT UPPER (Name) FROM Customers

The Integration service uses ODBC escape sequences to map functions. However,
not all drivers implement all the ODBC escape sequences. In some cases, a
database has no equivalent of an escape sequence. When a driver does not have
an implementation for an escape sequence, the driver returns an error. When your
driver does not support an escape sequence, you must provide a function
mapping in mappings.xml. Additionally, when the escape sequence
implementation is incompatible with the Actuate SQL specification, you must
also edit mappings.xml.
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The following example demonstrates one possible transformation of an Actuate
SQL query into a database query, in this case SQL Server. The Integration service
reads the mappings.xml file for function mappings but may determine that it can
do some of the query operations more efficiently than the database. Thus, the
query that the Integration service sends to the database may not use all
mappings.

The following Actuate SQL query selects three columns from a single table,
TOPDEALS:

SELECT CUSTID, CUSTOMNAME, FLOOR (AMOUNT) AS AMOUNT
FROM "../TOPDEALS.sma" AS TOPDEALS
WHERE Upper (CUSTOMNAME) LIKE Upper ('DES%')

For the AMOUNT column, you use the FLOOR function to round down the
values returned. In the WHERE clause, you define a filter condition so that the
query only returns customers whose name starts with DES. With the exception of
the FROM clause, which refers to a map file, the query looks like a generic SQL

query.
To translate the query into a database query, the Integration service loads function
templates from the mappings.xml file for the database type. The Integration

service finds mappings for the Actuate SQL functions used in the query, as shown
in the following plan:

Actuate SQL: FLOOR(), ODBC Escape Sequence: {FN FLOOR (SPO) },
SQL Server SQL: FLOOR ()

Actuate SQL: UPPER(),ODBC Escape Sequence: {FN UCASE ($PO)},
SQL Server SQL: Upper ()

The Integration service determines an optimal query execution plan after parsing
the query and assessing the mappings. FLOOR() is not sent to the database.
Instead, the Integration service performs this operation on the returned data. The
following query is sent to the database:

SELECT CUSTID, CUSTOMNAME, AMOUNT
FROM TOPDEALS
WHERE UPPER( CUSTOMNAME ) LIKE Upper ('DES%')

You can see the query sent to the database in the Information Object Designer
Query Profiler.

Once the database returns results, the Integration service uses the data type
mappings you defined in mappings.xml to convert the data in the result set to
Actuate SQL data types. Finally, the Integration service performs any remaining
operations, in this case the FLOOR function, before sending the data to the
Factory service to generate the report.
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Disabling the default mapping for a function

Your database may not support certain SQL-92 functions that are used by default
to implement Actuate SQL functions. You must disable the default mappings for
functions that are not supported. If you disable the mapping for a function, the
Integration service performs the function instead of the database.

For example, some databases do not have an implementation of the POSITION
function. The ODBC driver returns an error when the Integration service issues a
query containing the POSITION function to such a database. To prevent the
Integration service from encountering such errors, you should disable the
mapping for the POSITION function in the mappings.xml file.

Differences between Actuate SQL functions and
database functions

Your database’s implementation of certain SQL functions may differ slightly from
the Actuate SQL implementation of the same functions. For example, the Actuate
SQL function DATEPART (weekday) is used to find the weekday of a date. The
Actuate SQL function DATEPART(weekday) returns 0 for Sunday. On your
database, a similar function WEEKDAY may return 1 for Sunday. The JDBC
driver may hide this from the Integration service, but if it does not, a query would
return incorrect values for the weekday of each date. Thus, you need to edit
mappings.xml to define an appropriate substitute for the Actuate SQL function
DATEPART.

About Generic_ODBC mappings.xml

Most of the elements in the Generic_ODBC mappings.xml are for mapping
functions or operators. Functions and operators are implemented differently on
different databases. Thus, most of your work in configuring a new database type
involves mapping functions and operators. To map a function, you provide a
template that includes a database function that the Integration service uses when
rewriting a query.

The Generic_ODBC mappings.xml file contains the following elements for
mapping functions and operators:

<DataSourceMappingss>
<DataSourceMapper>

<BooleanOpMapper />
<ComparisonOpMapper />
<ArithOpMapper />
<NumericFuncMapper />
<BasicStringFuncMapper />
<SubStringFuncMapper />
<LikeOpMapper />
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<DatePartMapper />
<DateDiffMapper />
<DateAddMapper />
<NullFuncMapper />
<CondFuncMapper />
<MultiRowBoolFuncMapper />
<CastFuncMapper />

</DataSourceMapper >
</DataSourceMappings>

The Generic_ODBC mappings.xml file does not contain examples or the default
templates for mapping Actuate SQL functions and operators. The default
templates are listed in the mappings.xml file in the $AC_SERVER_HOME/etc
/data_integration/Base_Mappings directory. In subsequent topics, you can find
specific examples of how to map functions and operators.

Syntax for mapping functions and operators

Though it is possible to have the Integration service perform all Actuate SQL
operations, it is not recommended. Whenever possible, you should execute
functions and other operations on your database to optimize performance. Since
Actuate SQL supports many common functions, for each Actuate SQL function
there is usually an expression on the database that performs the same operation.

The goal of mapping a function is to specify a database function that provides the
correct result for an Actuate SQL function. Sometimes it is possible to find a
function on a database that behaves exactly like an Actuate SQL function. For
example, Actuate SQL has a SUBSTRING function that takes three operands: $P0
for the string to be evaluated, $P1 for the start position, and $P2 for the number of
characters to retrieve. Your database may have a function called SUBSTR that has
the same syntax and performs the same operation. Therefore, Actuate SQL’s
SUBSTRING ($P0, $P1, $P2) maps to SUBSTR ($P0, $P1, $P2) on the database.

In most cases, however, the mapping is not so straightforward. The syntax of the
database function is usually different from the Actuate SQL syntax. Perhaps the
SUBSTR function on the database does not specify the length of the substring as
the third operand. Instead the SUBSTR function specifies the end position of the
substring. For example, if the substring begins at position 3 and has 10 characters,
the value of the third operand is 12. To map the SUBSTRING function, you must
create an expression using the SUBSTR function that produces the same result, for
example SUBSTR ($P0, $P1, $P1 + $P2 - 1).

The mappings.xml files for preconfigured database types contain many examples
of function mapping. Do not modify the mappings.xml file for a preconfigured
database type.
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Mapping functions and operators: FunctionMapping
element

The Generic_ODBC mappings.xml file contains empty elements for functions and
operators. You customize function mappings by finding the appropriate element,
such as BooleanOpMapper or NumericFuncMapper, and adding a

FunctionMapping child element. The FunctionMapping element contains the
attributes listed in Table 10-1.

Table 10-1 Attributes of the FunctionMapping element

Attribute Description Required?

FunctionName  Name of the Actuate SQL function. Yes.

OperandTypes  Space-separated list of the Actuate No. If the function can have
SQL data types of the operands. The many different operand types
list can consist of the tokens (overloading), then the mapping
BOOLEAN, INTEGER, DECIMAL, applies to all versions of the
DOUBLE, VARCHAR, TIMESTAMP,  function.
and TABLE. For DATEDIFF, DATEADD, and

DATEPART, use the DatePart
attribute instead.

DatePart Used only for DATEDIFF, DATEADD, Yes, for DATEDIFF, DATEADD,
and DATEPART. Specifies the date part and DATEPART. Not required
being mapped. Must be one of: for other functions.
= yyyy (year)

m g (quarter)
= m (month)
n d(day)
m  h (hour)
= n (minute)
m s (second)
m  w (weekday)
m y (day of year)
Disabled Whether the mapping is disabled. If set No. Default is False.

to True, then the expression is not sent
to the database. It is handled by the
Integration service.
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About function templates

You use the syntax shown in Table 10-2 to define function templates.

Table 10-2 Syntax used to define function templates
Syntax Represents
$Pn The (n+1)th operand. $P0 is the first operand, $P1 is the second

operand, $P2 is the third operand, and so on. An operand can be a
literal like 'Hello' or 6. An operand can also be a column on the
database or a parameter.

$R The database data type that the expression returns, for example
CAST $P0 AS $R.
$$ The dollar sign ($).

The Integration service calculates the return data type for a function. You cannot
calculate the return data type manually in a reliable manner. For example, when
mapping the CAST function, do not use CAST ($P0 AS NVARCHAR). Instead,
use CAST ($P0 AS $R). The Integration service determines the correct data type.
When you use the $R syntax, you must explicitly declare the name of the database
data type in the DataTypeMapper element, otherwise the ODBC name, for
example SQL_VARCHAR, is used.

To help you understand how to use function templates, three examples of
customized function mappings are given below.

Example: Mapping the POWER function

When you test your queries, you discover that the default mapping for the
Actuate SQL POWER function returns an error. The Integration service uses the
ODBC escape sequence {FN POWER ($P0, $P1)} as the default mapping.
However, your JDBC driver does not have an implementation for the escape
sequence and thus cannot rewrite the expression. Therefore, you must map the
POWER function.

After checking your database documentation, you determine that the database
has a function called POWER and that it takes two arguments. You compare this
to the Actuate SQL POWER prototypes:

Integer POWER( base Integer, exponent Integer )
Decimal POWER( base Decimal, exponent Integer )
Double POWER( base Double, exponent Integer )

You use the NumericFuncMapper element. Because there is no OperandTypes
attribute, the mapping applies to all versions of the POWER function:
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<NumericFuncMapper>
<FunctionMappings>

<FunctionMapping
FunctionName="POWER"> <!-- The Actuate SQL function -->
POWER ($SPO, $P1l) <!-- The database function -->

</FunctionMapping>
</FunctionMappings>
</NumericFuncMapper>

For another example, refer to the mappings.xml file for Oracle, which requires a
very different mapping for the POWER function. To map POWER, you use the
OperandTypes attribute and define three different mappings:

<NumericFuncMapper>
<FunctionMappings>

<FunctionMapping FunctionName="POWER"
OperandTypes="INTEGER INTEGER">
CAST ( TRUNC (POWER( $PO, SP1 )) AS SR )

</FunctionMapping>

<FunctionMapping FunctionName="POWER"
OperandTypes="DECIMAL INTEGER">
CAST (POWER( $PO, $P1 ) AS S$R)

</FunctionMapping>

<FunctionMapping FunctionName="POWER"
OperandTypes="DOUBLE INTEGER">
POWER ( $SPO, $P1 )

</FunctionMapping>

</FunctionMappings>
</NumericFuncMapper>

Example: Mapping the DATEDIFF function with date part yyyy

The Actuate SQL DATEDIFF function uses a prototype that enables you to
provide a date part such as yyyy. Thus, you can use the same function to do date
subtraction for years, months, days, etc.:

Integer datediff ( datepart Varchar, start Timestamp, end
Timestamp )

When you test your queries you discover there is a problem with the default
mapping for the DATEDIFF function with date part yyyy. The driver is mapping
the DATEDIFF function to the YEARS_BETWEEN function on the database. The
query gives incorrect results because the year is consistently off by one.
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You can resolve the problem using the following mapping:

<DateDiffMappers>
<FunctionMappings>
<FunctionMapping FunctionName="DATEDIFF" DatePart="yyyy">
YEARS BETWEEN ($P0, $P1) - 1
</FunctionMapping>
</FunctionMappings>
</DateDiffMappers>

As another example, DB2 uses the following mapping for the DATEDIFF function
with date part yyyy:

<FunctionMapping FunctionName="DATEDIFF" DatePart="yyyy">
(YEAR( $P1 ) - YEAR ( S$PO ))
</FunctionMapping>

Example: Disabling the POSITION function

You determine that your database does not support the POSITION function.
Therefore, you must disable the mapping of the POSITION function:

<SubStringFuncMapper>
<FunctionMappings>
<FunctionMapping FunctionName="POSITION"
Disabled="true" />
</FunctionMappings>
</SubStringFuncMapper>

Mapping Boolean operators: BooleanOpMapper
element
The BooleanOpMapper element is used for customizing the mappings of the

Boolean operators AND, OR, and NOT. Table 10-3 shows the default templates
for mapping Boolean operators.

Table 10-3 Default templates for mapping Boolean operators

Boolean

operator Operand data types Default template
AND <BOOLEAN>, <BOOLEAN> $P0 AND $P1
OR <BOOLEAN>, <BOOLEAN> $P0 OR $P1

NOT <BOOLEAN> NOT $P0
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Example: Mapping the NOT operator

You determine that the database sometimes returns errors when the argument of
the NOT operator is not enclosed in parentheses. To resolve this problem, you use
the following mapping:

<BooleanOpMapper>
<FunctionMappings>
<FunctionMapping FunctionName="NOT">
NOT ($PO)
</FunctionMapping>
</FunctionMappings>
</BooleanOpMapper>

Mapping comparison operators:
ComparisonOpMapper element
The ComparisonOpMapper element is used for customizing the mappings of the

comparison operators listed in Table 10-4. The table also shows the default
template for each operator.

Table 10-4 Default templates for mapping comparison operators
Comparison Default
operator Operand data types template Remarks
= <INTEGER>, <INTEGER> $P0 = $P1 Use EQ as the
<DECIMAL>, <DECIMAL> FunctionName for =.
> <DOUBLE>, <DOUBLE> $P0 > $P1 Use GT as the
<VARCHAR>, <VARCHAR> FunctionName for >.
< <TIMESTAMP>, <TIMESTAMP> $P0 < $P1 Use LT as the
FunctionName for <.
>= $P0 >= $P1 Use GE as the
FunctionName for >=.
<= $P0 <= $P1 Use LE as the
FunctionName for <=.
<> $P0 <> $P1 Use NE as the

FunctionName for <>.

Example: Mapping the <> operator

You change the mapping of the <> operator for VARCHAR because on your
database the comparison operator for strings is an exclamation point followed by
an equals sign (!=). You use NE as the FunctionName:
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<ComparisonOpMapper>
<FunctionMappings>
<FunctionMapping FunctionName="NE"
OperandTypes="VARCHAR VARCHAR">
$PO != S$SP1
</FunctionMapping>
</FunctionMappings>
</ComparisonOpMapper>

Mapping arithmetic operators: ArithOpMapper
element
The ArithOpMapper element is used for customizing the mappings of the

arithmetic operators listed in Table 10-5. The table also shows the default
template for each operator.

Table 10-5 Default templates for mapping arithmetic operators
Arithmetic Operand data Default
operator types template Remarks
+ <INTEGER>, ($P0 + $P1) Use ADD as the FunctionName
<INTEGER> for +.
- <DOUBLE>,  ($P0 - $P1) Use SUB as the FunctionName
<DOUBLE> for -.
* <DECIMAL>, (¢pg * $P1) Use MULT as the FunctionName
<DECIMAL> for *.
/ <INTEGER>, ($P0 / $P1) Use DIV as the FunctionName
<INTEGER> for /.
<DOUBLE>, ($P0 / $P1)
<DOUBLE>

<DECIMAL>, Generated by
<DECIMAL> thelntegration
service

- <INTEGER> - ($P0) Use NEG as the FunctionName
<DOUBLE> for -.
<DECIMAL>

Example: Mapping the negation operator

You change the mapping of the negation operator because your database uses a
different syntax. You use NEG as the FunctionName:
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<ArithOpMapper>
<FunctionMappings>
<FunctionMapping FunctionName="NEG">
NEGATE ($PO)
</FunctionMapping>
</FunctionMappings>
</ArithOpMapper>

Mapping numeric functions: NumericFuncMapper
element

The NumericFuncMapper element is used for customizing the mappings of the
numeric functions listed in Table 10-6. The table also shows the default template
for each function.

Table 10-6 Default templates for mapping numeric functions

Numeric

function Operand data types Default template

ROUND <DECIMAL>, <INTEGER> {FN ROUND ($P0, $P1)}
<DOUBLE>, <INTEGER>

FLOOR <DECIMAL> {FN FLOOR ($P0)}
<DOUBLE>

CEILING <DECIMAL> {FN CEILING ($P0)}
<DOUBLE>

POWER <INTEGER>, <INTEGER> {FN POWER ($P0, $P1)}
<DECIMAL>, <INTEGER> Generated by the Integration

service

<DOUBLE>, <INTEGER> {FN POWER ($P0, $P1)}

MOD <INTEGER>, <INTEGER> {FN MOD ($P0, $P1)}

Example: Mapping the POWER function

The POWER function with DECIMAL and INTEGER operands does not give
accurate results on your database. To obtain more accurate results, you convert
the second operand to a decimal:

<NumericFuncMappers>
<FunctionMappings>
<FunctionMapping FunctionName="POWER"
OperandTypes="DECIMAL INTEGER">
POWER ($SP0, CAST ($P1 AS DECIMAL (10, 0))
</FunctionMapping>
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</FunctionMappings>
</NumericFuncMapper>

Mapping string functions: BasicStringFuncMapper
element

The BasicStringFuncMapper element is used for customizing the mappings of the
functions listed in Table 10-7. The table also shows the default template for each
function.

Table 10-7 Default templates for mapping string functions

String function Operand data types Default template

CHAR_LENGTH <VARCHAR>, {FN LENGTH ($P0)}
<INTEGER>

UPPER <VARCHAR> {FN UCASE ($P0)}

LOWER <VARCHAR> {FN LCASE ($P0)}

LTRIM <VARCHAR> {FN LTRIM ($P0)}

RTRIM <VARCHAR> {FN RTRIM ($P0)}

CONCAT <VARCHAR>, {FN CONCAT ($P0,
<VARCHAR> $P1)}

Example: Mapping the CHAR_LENGTH function

The Actuate SQL CHAR_LENGTH function returns the length of a string
including trailing spaces. The corresponding database function, however, ignores
trailing spaces. To resolve this discrepancy, the following mapping appends an
underscore (_) to the string, applies the database function LEN, and subtracts one:

<BasicStringFuncMappers>
<FunctionMappings>
<FunctionMapping FunctionName="CHAR LENGTH">
LEN (sPO + ' ') -1
</FunctionMapping>
</FunctionMappings>
</BasicStringFuncMapper>
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Mapping substring functions: SubStringFuncMapper
element
The SubStringFuncMapper element is used for customizing the mappings of the

functions listed in Table 10-8. The table also shows the default template for each
function.

Table 10-8 Default templates for mapping substring functions
Substring
function Operand data types Default template
SUBSTRING  <VARCHAR>, <INTEGER>, <INTEGER> {FN SUBSTRING ($P0, $P1, $P2)}
LEFT <VARCHAR>, <INTEGER> {EN LEFT ($P0, $P1)}
RIGHT <VARCHAR>, <INTEGER> {FN RIGHT ($P0, $P1)}
POSITION <VARCHAR>, <VARCHAR> {FN LOCATE ($P0, $P1)}

Example: Mapping the POSITION function

You must map the POSITION function because your driver does not implement
the escape sequence {FN LOCATE ($P0, $P1)}:

<SubStringFuncMapper>
<FunctionMappings>
<FunctionMapping FunctionName="POSITION">
POSITION ($PO, SP1)
</FunctionMapping>
</FunctionMappings>
</SubStringFuncMapper>

Mapping the LIKE operator: LikeOpMapper element

The LikeOpMapper element is used for customizing the mapping of the LIKE
operator. The default template is $P0 LIKE $P1 ESCAPE '@'. $P1 is the pattern
against which to compare the string $P0. $P0 and $P1 are both of type
VARCHAR.

To map the LIKE operator, do the following:

m Determine whether the database has an equivalent for the LIKE operator. The
database equivalent must be able to support escaping special characters in the
pattern, for example through the ESCAPE clause. If no database equivalent
exists, disable the mapping by setting the Disabled attribute to true.

m Identify the character that the database uses for matching a single character.
For example, standard SQL uses the underscore (_). Set the SingleMatchChar
attribute to this character. If no such character exists, disable the mapping by
setting the Disabled attribute to true.
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m Identify the character that the database uses for matching any number of
characters. For example, standard SQL uses the percent sign (%). Set the
GreedyMatchChar attribute to this character. If no such character exists,
disable the mapping by setting the Disabled attribute to true.

m Determine how special characters are escaped on the database. Typically, you
specify an escape character, for example backslash (\), using an ESCAPE
clause in the LIKE template, for example $P0 LIKE $P1 ESCAPE '\". You then
specify the EscapeTemplate attribute to show how to escape special characters.
For example, \$ indicates that the backslash precedes the special character.

m Identify any additional special characters that the database recognizes within
the pattern. For example, some databases allow pattern matching using the
square bracket syntax [a-z0-9]. In this case, the square brackets must be
escaped whenever the Integration service pushes queries to the database to
ensure that the database interprets these characters as literals.

The attributes used for customizing the LIKE operator mapping are listed in

Table 10-9.
Table 10-9

Attributes for customizing the LIKE operator mapping

Attribute name

Description

Required?

Disabled

SingleMatchChar

GreedyMatchChar

EscapeTemplate

AdditionalSpecialChars

Set to true to disable the
mapping for the LIKE operator.

Character used on the database
to match a single character.

Character used on the database
to match any number of
characters.

Template that shows how to
escape a special character on the
database. In the template, $
stands for the special character,
while $$ stands for the dollar
sign.

Any special characters other
than the single match character
and the greedy match character.
Additional special characters are
listed without spaces.

No. Default is false.

No. Default is underscore (_).
For example, on the database
' rown' matches 'Brown' and
'Crown'.

No. Default is percent sign (%).
For example, on the database
'Hat%' matches 'Hatcher' and
'Hathaway'.

No. Default is @$. By default,
the characters used on the
database for single match and
greedy match are escaped by
prepending an @.

No. Default is at sign (@), the
default escape character.
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Example: Mapping the LIKE operator

Your database has an equivalent for the LIKE operator called MATCH. The
MATCH operator uses the question mark (?) to match a single character and the
asterisk (*) to match any number of characters. The MATCH operator uses square
brackets to escape special characters, for example [? ]:

<LikeOpMapper SingleMatchChar="?"
GreedyMatchChar="*"
EscapeTemplate="[$]"
AdditionalSpecialChars="1[]">
<FunctionMappings>
<FunctionMapping FunctionName="LIKE">
MATCH ($PO, $P1)
</FunctionMapping>
</FunctionMappings>
</LikeOpMappers>

Example: Changing the escape character

Your database supports the LIKE operator but errors occur when you use the at
sign (@) as the escape character, so you use the backslash (\) instead:

<LikeOpMapper
EscapeTemplate="\$"
AdditionalSpecialChars="\">
<FunctionMappings>
<FunctionMapping FunctionName="LIKE">
$PO LIKE $P1 ESCAPE '\'
</FunctionMapping>
</FunctionMappings>
</LikeOpMapper>

Example: Disabling the LIKE operator

Your database has no equivalent for the LIKE operator so you disable the
mapping. Disabling the mapping means that the Integration service processes
LIKE expressions, not the database:

<LikeOpMapper Disabled="true" />

Example: Specifying additional special characters

Your database supports the LIKE operator, but extends it to recognize patterns
such as [a-z0-9]. If the characters open square bracket ([), close square bracket (]),
and hyphen (-) appear in a string, they must be escaped so that the database
interprets them as literals instead of assigning special meaning to them:

<LikeOpMapper AdditionalSpecialChars="@[]-" />
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Mapping DATEPART functions: DatePartMapper
element

DATEPART takes two arguments: a date part and a timestamp. It returns the part
of the timestamp specified by the date part:

Integer datepart( datepart Varchar, value Timestamp )

The DatePartMapper element is used to customize the mappings for the date
parts listed in Table 10-10. The table also shows the default template for each date

part.
Table 10-10 Default templates for mapping date parts with the DATEPART

function
Date part Default template
yyyy (year) {FN YEAR ($P0)}
q (quarter) {FN QUARTER ($P0)}
m (month) {FN MONTH ($P0)}
d (day) {FN DAYOFMONTH ($P0)}
h (hour) {FN HOUR ($P0)}
n (minute) {FN MINUTE ($P0)}
s (second) {FN SECOND ($P0)}
w (day of week) {FN DAYOFWEEK ($P0)}
y (day of year) {FN DAYOFYEAR ($P0)}

Example: Mapping the DATEPART functions

Your database has a different syntax for the DATEPART functions. You define
each part using a mapping:
<DatePartMapper>

<FunctionMappings>
<FunctionMapping FunctionName="DATEPART"
DatePart="yyyy">
TO NUMBER (TO_CHAR ($PO, 'YYYY'))
</FunctionMapping>

<FunctionMapping FunctionName="DATEPART"
DatePart="y">
TO NUMBER (TO_CHAR ($PO, 'DDD'))
</FunctionMapping>
</FunctionMappings>
</DatePartMapper>
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Mapping date subtraction functions: DateDiffMapper
element
DATEDIFF takes three arguments: a date part, a start timestamp, and an end

timestamp. It returns the integer delta between the part of the two timestamps
specified by the date part:

Integer datediff ( datepart Varchar, start Timestamp, end
Timestamp )

The DateDiffMapper element is used to customize the mappings for the date
parts listed in Table 10-11. The table also shows the default template for each date

part.
Table 10-11 Default templates for mapping date parts with the DATEDIFF
function
Date part Default template

FN TIMESTAMPDIFF (SQL_TSI_YEAR, $P0, $P1)}
FN TIMESTAMPDIFF (SQL_TSI_QUARTER, $P0, $P1)}
m (month) FN TIMESTAMPDIFF (SQL_TSI_MONTH, $P0, $P1)}

yyyy (year) {
{
{
d (day) {FN TIMESTAMPDIFF (SQL_TSI_DAY, $P0, $P1)}
{
{
{

q (quarter)

h (hour) FN TIMESTAMPDIFF (SQL_TSI_HOUR, $P0, $P1)}

n (minute) FN TIMESTAMPDIFF (SQL_TSI_MINUTE, $P0, $P1)}
s (second) FN TIMESTAMPDIFF (SQL_TSI_SECOND, $P0, $P1)}
w (day of week)  ({FN TIMESTAMPDIFF (SQL_TSI_DAY, $P0, $P1)} / 7)
y (day of year) {FN TIMESTAMPDIFF (SQL_TSL DAY, $P0, $P1)}

Examples: Mapping the DATEDIFF function with date part yyyy

The following examples show different ways of mapping the DATEDIFF function
with date part yyyy.

Example 1

<FunctionMapping FunctionName="DATEDIFF"
DatePart="yyyy">
(YEAR( $P1 ) - YEAR ( $PO ))
</FunctionMapping>

Example 2

<FunctionMapping FunctionName="DATEDIFF"
DatePart="yyyy">
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CAST (
TO NUMBER( TO_ CHAR( $P1, 'YYYY' ) )

TO _NUMBER( TO CHAR( $PO, 'YYYY' ) )
AS NUMBER (9)
)

</FunctionMapping>

Example 3

<FunctionMapping FunctionName="DATEDIFF"
DatePart="yyyy">
DATEDIFF( year, $PO, SP1l )
</FunctionMapping>

Mapping date addition functions: DateAddMapper
element

DATEADD takes three arguments: a date part, an integer delta value, and a
timestamp value. It returns a timestamp that applies the delta value to the
specified part of the original timestamp:

Timestamp dateadd( datepart Varchar, delta Integer, value
Timestamp )

The DateAddMapper element is used to customize the mappings for the date
parts listed in Table 10-12. The table also shows the default template for each date
part.

Table 10-12 Default templates for mapping date parts with the DATEADD
function

Date part Default template
yyyy (year) {EN TIMESTAMPADD (SQL_TSI_ MONTH, $P0*12, $P1)}
q (quarter) {EN TIMESTAMPADD (SQL_TSI_ MONTH, $P0*3, $P1)}
m (month) {FN TIMESTAMPADD (SQL_TSI_MONTH, $P0, $P1)}
d (day) {EN TIMESTAMPADD (SQL_TSI_DAY, $P0, $P1)}
h (hour) {EN TIMESTAMPADD (SQL_TSI_HOUR, $P0, $P1)}

{

{

{

{

FN TIMESTAMPADD (SQL_TSI_MINUTE, $P0, $P1)}
FN TIMESTAMPADD (SQL_TSI_SECOND, $P0, $P1)}
FN TIMESTAMPADD (SQL_TSI_DAY, $P0, $P1)}
FN TIMESTAMPADD (SQL_TSI_DAY, $P0, $P1)}

n (minute)

s (second)

w (day of week)
y (day of year)
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Example: Mapping the DATEADD functions

Your database has a different syntax for the DATEADD functions. You define
each part using a mapping:

<DateAddMapper>
<FunctionMappings>
<FunctionMapping FunctionName="DATEADD"
DatePart="yyyy">
(SP1 + S$PO YEARS)
</FunctionMapping>

<FunctionMapping FunctionName="DATEADD"
DatePart="y">
(SP1 + $PO DAYS)
</FunctionMapping>
</FunctionMappings>
</DateAddMapper>

Mapping date serialization functions:
DateSerialMapper element

DATESERIAL has two forms. The first form takes three arguments: a year value,
a month value, and a day value. It returns a timestamp for the date corresponding
to the specified year, month, and day with the time set to 00:00:00.0:

Timestamp dateserial ( year Integer, month Integer,
day Integer )

The second form of dateserial takes six arguments: values for the year, month,
day, hour, minute, and second. It returns the timestamp for the specified values:

Timestamp dateserial ( year Integer, month Integer, day Integer,
hour Integer, minute Integer, second Integer )

The DateSerialMapper element is used for customizing the mappings of the
DATESERIAL functions. The default templates are generated by the Integration
service. In most cases, it is not necessary to override them.

Example: Disabling the DATESERIAL functions

The DATESERIAL templates generated by the Integration service do not work, so
you disable the mappings for both versions of DATESERIAL:

<DateSerialMappers>
<FunctionMappings>
<FunctionMapping FunctionName="DATESERIAL"
Disabled="true" />
</FunctionMappings>
</DateSerialMapper>
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Mapping NULL functions: NullFuncMapper element

The NullFuncMapper element is used for customizing the mappings of the NULL
functions listed in Table 10-13. The table also shows the default template for each

function.
Table 10-13 Default templates for mapping NULL functions

Operand data Default
NULL function types FunctionName template
ISNULL <INTEGER> Use IS_NULL as FunctionName for IS $P0 IS NULL

<DECIMAL>  NULL.

<DOUBLE>

<VARCHAR>

<TIMESTAMP>
CAST (NULL AS Use CAST_NULL_AS INTEGER as Generated by
INTEGER) FunctionName. the Integration
CAST (NULL AS Use CAST_NULL_AS_DECIMAL as ~ S€tVice:
DECIMAL) FunctionName.
CAST (NULL AS Use CAST_NULL_AS_DOUBLE as
DOUBLE) FunctionName.
CAST (NULL AS Use CAST_NULL_AS_VARCHAR as
VARCHAR) FunctionName.
CAST (NULL AS Use CAST_NULL_AS_TIMESTAMP
TIMESTAMP) as FunctionName.

Example: Disabling the CAST (NULL AS .. .) functions

Your database does not support the NULL literal, so the CAST (NULL AS . . .)
functions must be disabled:

<NullFuncMapper>
<FunctionMappings>
<FunctionMapping FunctionName="CAST NULL_AS INTEGER"
Disabled="true" />
<FunctionMapping FunctionName="CAST NULL AS DECIMAL"
Disabled="true" />
<FunctionMapping FunctionName="CAST NULL_AS DOUBLE"
Disabled="true" />
<FunctionMapping FunctionName="CAST NULL_AS VARCHAR"
Disabled="true" />
<FunctionMapping FunctionName="CAST NULL AS TIMESTAMP"
Disabled="true" />
</FunctionMappings>
</NullFuncMappers>
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Mapping conditional functions: CondFuncMapper
element

The CondFuncMapper element has attributes that you use to customize CASE
statements. These attributes are listed in Table 10-14.

Table 10-14 Attributes of the CondFuncMapper element

Attribute name Description Required?

CaseWhenString String to use instead of CASE  No. Default is CASE
WHEN. WHEN.

WhenString String to use instead of No. Default is WHEN.
WHEN.

ThenString String to use instead of No. Default is THEN.
THEN.

ElseString String to use instead of ELSE. No. Default is ELSE.

EndString String to use instead of END. No. Default is END.

Example: Mapping the CASE statement

Your database uses a SWITCH statement instead of a CASE statement. SWITCH
is not standard SQL. The Actuate SQL CASE prototype is as follows:

CASE [<ValueExpressions]
{<WhenClause>} [..n]
[ELSE <ValueExpressions>]
END

The mapping for SWITCH is as follows:

<CondFuncMapper CaseWhenString="SWITCH ("

WhenString=",6"
ThenString=","
ElseString=", TRUE,"
EndString=")" />
This mapping produces a SWITCH statement such as:
SWITCH (
Country IN ('Canada', 'Mexico', 'USA'), 'North America',
Country IN ('Argentina', 'Brazil',6 'Venezuela'), 'South
America',
Country IS NULL, ' (Not Known)',

TRUE, 'Rest of the world')
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Mapping aggregate functions: AggrFuncMapper
element

The AggrFuncMapper element is used for customizing the mappings of the
aggregate functions listed in Table 10-15. The table also shows the default
template for each function.

Table 10-15 Default templates for mapping aggregate functions

Aggregate  Operand data

function types Default template Remarks
SUM <INTEGER> SUM ($P0)
AVG <DECIMAL> AVG ($P0)
<DOUBLE> AVG (DISTINCT $P0)
MAX <INTEGER> MAX ($P0)
MIN <DECIMAL> MIN ($P0)
COUNT <DOUBLE> COUNT ($P0)
<VARCHAR>
<TIMESTAMP>
COUNT (*) COUNT (*) Use

COUNT_ROWS as
the FunctionName
for COUNT (*).

Example: Mapping the AVG function

The default template for the AVG function does not return the correct result for
DECIMAL data types, so you use the following mapping:

<AggrFuncMapper>
<FunctionMappings>
<FunctionMapping FunctionName="AVG"
OperandTypes="DECIMAL" >
CAST (AVG( $PO ) AS SR)
</FunctionMapping>
</FunctionMappings>
</AggrFuncMapper >

Mapping multi-row Boolean operators:
MultiRowBoolFuncMapper element

The MultiRowBoolFuncMapper element is used for customizing the mappings of
the multi-row Boolean operators listed in Table 10-16. The table also shows the
default template for each operator.
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The = ANY and <> ANY operators are implemented using the IN and NOT IN
operators. The = ALL operators are implemented using the = ANY operators.

Table 10-16 Default templates for mapping multi-row Boolean operators
Multi-row
Boolean
operator ~ Operand data types Default template Remarks
EXISTS <TABLE> EXISTS $PO
IN <INTEGER>, <TABLE>  $P0IN $P1
NOT IN <DECIMAL>, <TABLE> $P0ONOTIN $P1  Use NOT_IN as FunctionName
<DOUBLE>, <TABLE> for NOT IN.
< ANY <VARCHAR>, <TABLE> $P0 < ANY $P1 Use LT_ANY as FunctionName
<TIMESTAMP>, for < ANY.
> ANY <TABLE> $P0 > ANY $P1 Use GT_ANY as FunctionName
for > ANY.
<= ANY $P0 <= ANY $P1  Use LE_ANY as FunctionName
for <= ANY.
>= ANY $P0 >= ANY $P1  Use GE_ANY as FunctionName
for >= ANY.
Mapping cast functions: CastFuncMapper element
The CastFuncMapper element is used for customizing the mappings of the cast
functions listed in Table 10-17. The Integration service generates the default
templates for the cast functions.
Table 10-17 Operand data types for the cast functions
Cast function Operand data types Remarks
CAST (AS INTEGER) <DECIMAL> Use CAST_AS_INTEGER as
<DOUBLE> FunctionName.
<VARCHAR>
CAST (AS DECIMAL) <INTEGER>, Use CAST_AS_DECIMAL as
<INTEGER>, FunctionName.
<INTEGER> The second and third operands are the
<DECIMAL>, decimal precision and scale, for example 20
<INTEGER>, and 8 in CAST (AS DECIMAL (20, 8)).
<INTEGER> Specify the default precision and scale
<DOUBLE>, using the iServer configuration variables
<INTEGER>, DefaultDecimalPrecision and
<INTEGER> DefaultDecimalScale.
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Table 10-17 Operand data types for the cast functions

Cast function

Operand data types Remarks

CAST (AS DECIMAL)
(continued)

CAST (AS DOUBLE)

CAST (AS VARCHAR)

CAST (AS TIMESTAMP)

<VARCHAR>,
<INTEGER>,
<INTEGER>

<INTEGER>
<DECIMAL>
<VARCHAR>

<INTEGER>,
<INTEGER>

<DECIMAL>,
<INTEGER>

<DOUBLE>,
<INTEGER>

<VARCHAR>,
<INTEGER>

<TIMESTAMP>,
<INTEGER>

<VARCHAR>

Use CAST_AS DOUBLE as FunctionName.

Use CAST_AS_VARCHAR as
FunctionName.

The second operand is the string length, for
example 50 in CAST(AS VARCHAR (50)).
Specify the default string length using the
iServer configuration variable
DefaultStringLength.

Use CAST_AS_TIMESTAMP as
FunctionName.

Example: Mapping the CAST functions

The default templates generated by the Integration service are not compatible
with your database, so you change the mappings to use the CONVERT function.

$R represents the return data type:

<CastFuncMapper>

<FunctionMappings>
<FunctionMapping FunctionName="CAST AS INTEGER">
CONVERT (SR, $PO)
</FunctionMapping>
<FunctionMapping FunctionName="CAST AS DECIMAL">
CONVERT ($R, $PO)
</FunctionMapping>
<FunctionMapping FunctionName="CAST AS DOUBLE">
CONVERT (SR, $PO)
</FunctionMapping>
<FunctionMapping FunctionName="CAST AS VARCHAR">
CONVERT ($R, $PO)
</FunctionMapping>
<FunctionMapping FunctionName="CAST AS TIMESTAMP">
CONVERT (SR, $PO)
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</FunctionMapping>
</FunctionMappings>
</CastFuncMapper>

Using operators in a mapping

When including operators in a mapping, use the following guidelines.

Symbolic operators require parentheses

To avoid problems with operator precedence on a database, all symbolic
operators must be enclosed in parentheses. For example, use parentheses around
an arithmetic expression, such as ($P0 + $P1). Do not use $P0 + $P1. The only
exception to this rule is operators that return Boolean values such as =, <, and >.

The operators NOT, AND, and OR should also be enclosed in parentheses. For
example, use ($P0 IS NULL AND $P1 IS NOT NULL), not $P0 IS NULL AND $P1
ISNOT NULL.

You also need parentheses in function mappings that use such operators,
regardless of whether you are mapping an Actuate SQL function or operator.

You do not need parentheses if the template already contains the equivalent of
parentheses, for example the parentheses of a function or the commas that
separate operands.

Negative sign must be followed by a space

When a mapping contains a negative sign (-) followed by an operand, place a
space after the negative sign. Two negative signs indicate a comment in SQL, so
-$P0 in a template would cause a problem when $P0 is a negative number such as
-1. This would translate to --1, and would be interpreted as a comment.

Less than (<) and greater than (>) symbols must be
escaped
When you create a function template that uses a less than (<) or greater than (>)

symbol, you must use CDATA to escape the symbol. For example, the default
mapping for the not-equal-to operator is the following:

<FunctionMapping FunctionName="NE">
<! [CDATA[ SPO0 <> S$P1 11>
</FunctionMapping>

Alternatively, you can use &lt; and &gt; to represent the less than and greater than
symbols.
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If you use a less than or greater than symbol without escaping it, the Integration
service returns an error because it cannot parse the mappings.xml file correctly.

Example: Mapping the not-equal-to operator

The mapping for the not-equal-to operator returns a Boolean and does not
contain NOT, AND, or OR, so no parentheses are required:

<FunctionMapping FunctionName="NE">
SPO != SP1
</FunctionMapping>

The mapping for the not-equal-to operator uses the function NEQ, which
contains parentheses. No additional parentheses are required:

<FunctionMapping FunctionName="NE">
NEQ (CASE WHEN $SPO IS NULL THEN ' ' ELSE $PO END,
CASE WHEN $P1 IS NULL THEN ' ' ELSE $P1 END)
</FunctionMapping>

The mapping for the not-equal-to operator uses the AND operator. You must
enclose it in parentheses:

<FunctionMapping FunctionName="NE">
($P0 IS NOT NULL AND $P1 IS NOT NULL AND $PO <> $P1)
</FunctionMapping>

Example: Mapping the CONCAT function

The mapping for the CONCAT function uses symbols and returns a string, not a
Boolean. You must enclose it in parentheses:

<FunctionMapping FunctionName="CONCAT">
($PO + $P1)
</FunctionMapping>

Example: Mapping the DATEDIFF function

The mapping for the DATEDIFF function uses symbols and does not return
Boolean values. Parentheses are required:

<FunctionMapping FunctionName="DATEDIFF" DatePart="yyyy">
(YEAR ($P2) - YEAR (S$SP1))
</FunctionMapping>

Example: Mapping the CHAR_LENGTH function

In the following mapping, you do not need to place additional parentheses
around the argument of the LEN function:
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<FunctionMapping FunctionName="CHAR LENGTH">

(LEN ($PO + ' ') - 1)

<!-- Note: No need for (LEN (($PO + '_')) - 1) -->
</FunctionMapping>

Example: Mapping the negative sign (-)

You must place a space after the negative sign to map the subtraction and
negation operators:

<FunctionMapping FunctionName="SUB">
($PO - $P1)
<!-- Note: Not ($SP0-$P1) -->
</FunctionMapping>

<FunctionMapping FunctionName="NEG">
- SPO
<!-- Note: Not -$PO -->
</FunctionMapping>

Using initialization statements

Initialization statements are SQL statements that are sent to the database before
executing an Integration service query. Initialization statements are defined by
the database and are usually of the form SET <variable > = <value> or

SET <variable> <value>. Initialization statements force the database to behave in
a way that is compatible with Actuate SQL. Initialization statements take effect
only for the session in which the query is executed, so they do not affect queries
that are not sent by the Integration service. The Integration service does not send
initialization statements when executing SQL stored procedures on the database.

Example: Specifying the behavior of concatenation
with NULL

By default, when a string is concatenated with a NULL string, your database
returns the original string. Actuate SQL, however, returns a NULL. You check
your database documentation and find that there is an initialization statement
that changes this behavior. You add the following code to your data source

mapping:
<Initializerss>

<Initializer>SET CONCAT_NULL_ YIELDS NULL ON</Initializers>
</Initializerss>
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Mapping literals and
clauses

This chapter contains the following topics:
m  Mapping literals: LiteralMapper element
m  Mapping clauses
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Mapping literals: LiteralMapper element

Literals in Actuate SQL are converted to expressions on the database. For
example, the Actuate SQL literal 'Hello' is translated into the expression N'Hello'
on the database if the database uses the N-syntax for string literals. You can
customize the literal mapping for each Actuate SQL data type using the
LiteralMapping element in mappings.xml.

Template format for VARCHAR literals

By default, Actuate SQL string literals are enclosed in single quotes and passed to
the database without modification. The template variable $V represents the string
and the single quotes. The default template for string literals is $V.

Template format for TIMESTAMP literals

TIMESTAMP $V represents an Actuate SQL timestamp literal, for example
TIMESTAMP '2001-02-03 12:11:10". $V is the value of the timestamp, including the
single quotes. The default template for timestamp literals uses the ODBC escape
syntax {ts $V}.

Example: Mapping VARCHAR and TIMESTAMP literals

Your database uses the N-syntax for Unicode string literals. Also, your JDBC
driver does not support the ODBC escape syntax for timestamp literals. As in the
FunctionMapping element, $R represents the return data type of the expression:

<LiteralMappers>
<LiteralMappings>
<LiteralMapping DataTypeName="VARCHAR">
<Template>NsSV</Template>
</LiteralMapping>
<LiteralMapping DataTypeName="TIMESTAMP" >
<Template>CAST ($V AS SR)</Templates
</LiteralMapping>
</LiteralMappings>
</LiteralMapper>

Mapping clauses
You can customize the mappings for the ORDER BY and GROUP BY clauses.

260 Designing BIRT Information Objects



Mapping the ORDER BY clause:
OrderByClauseMapper element
To map the ORDER BY clause, use the OrderByClauseMapper element in

mappings.xml. The OrderByClauseMapper element has two attributes,
UseSelectltemIndexes and PushComplexExprs.

UseSelectlitemiIndexes attribute

Most databases support expressions in the ORDER BY clause of a query, for
example:

SELECT contact_last
FROM CUSTOMERS
ORDER BY city, contact last || ', ' || contact first

Some databases, however, do not. The SELECT clause must contain the
expression and the ORDER BY clause must reference the expression by index, for
example:

SELECT city, contact last || ', ' || contact first
FROM CUSTOMERS
ORDER BY 1, 2

If your database does not support expressions in the ORDER BY clause, set the
UseSelectItemIndexes attribute to true, for example:

<OrderByClauseMapper UseSelectItemIndexes="true" />

PushComplexExprs attribute

Some databases do not support ORDER BY expressions other than column
references. For such databases, an ORDER BY expression that is not a column
reference should not be sent to the database. For example, ORDER BY
contact_last should be sent to the database, but ORDER BY contact_last | | ', ' | |
contact_first should not.

If your database does not support ORDER BY expressions other than column
references, set the PushComplexExprs attribute to false, for example:

<OrderByClauseMapper PushComplexExprs="false" />

Mapping the GROUP BY clause:
GroupByClauseMapper element

To map the GROUP BY clause, use the GroupByClauseMapper element in
mappings.xml. The GroupByClauseMapper element has two attributes,
UseSelectItemIndexes and PushComplexExprs.
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UseSelectlitemindexes attribute

Most databases support expressions in the GROUP BY clause of a query, for
example:

SELECT contact_ last
FROM CUSTOMERS
GROUP BY city, contact last || ', ' || contact first

Some databases, however, do not. The SELECT clause must contain the
expression and the GROUP BY clause must reference the expression by index, for
example:

SELECT city, contact last || ', ' || contact first
FROM CUSTOMERS
GROUP BY 1, 2

If your database does not support expressions in the GROUP BY clause, set the
UseSelectItemIndexes attribute to true, for example:

<GroupByClauseMapper UseSelectItemIndexes="true" />

PushComplexExprs attribute

Some databases do not support GROUP BY expressions other than column
references. For such databases, a GROUP BY expression that is not a column
reference should not be sent to the database. For example, GROUP BY
contact_last should be sent to the database, but GROUP BY contact_last | | ,' | |
contact_first should not.

If your database does not support GROUP BY expressions other than column
references, set the PushComplexExprs attribute to false, for example:

<GroupByClauseMapper PushComplexExprs="false" />
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Working with collations
and byte-based strings

This chapter contains the following topics:
m  Working with collations

m  Working with byte-based strings
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Working with collations

A collation is an algorithm for ordering strings. When an Actuate SQL query is
executed, the collation determines the result of sort and comparison operations,
including:

m The order of string items produced by the ORDER BY clause

m The grouping of string items produced by the GROUP BY clause

m The strings returned by SELECT DISTINCT

m The result of string comparison operations, for example 'abc' > 'ABC’

m  The result returned by the MAX and MIN functions when used with strings

m The result of the LIKE and POSITION operators

m  The result returned by the COUNT (DISTINCT) function when used with
strings

Databases support one or more collations. The database collation is usually
determined by the database locale. The Integration service, however, supports
only the Unicode and ASCII code-point collations, which order strings based on
the Unicode or ASCII numbers corresponding to each character. Together, the
database collation and the Integration service collation determine which
operations are sent to the database and which operations must be performed by
the Integration service.

About Integration service collations

The Integration service supports two collations: Unicode binary and ASCII
case-insensitive. The default collation is Unicode binary. The Integration service
collations are explained in Table 12-1.

Table 12-1 Integration service collations
Integration
service
collation Description Examples
Unicode_BIN  Unicode code point order 'E' <'e', since E = U+0045 and e
(binary order). All = U+0065.
characters are different '0' <'O' (O with an umlaut),
from one another and are since 0 = U+006F and O =
sorted by their Unicode U+00D6.
values. 'E' <[, since E = U+0045 and [ =
U+005D.
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Table 12-1 Integration service collations

Integration
service
collation Description Examples
ASCII_CI ASCII code point order, 'E' = 'e' since case is not
with uppercase characters  considered.
given the same value as Cannot sort O, since it is outside
lowercase characters. the ASCII range (U+00D6).
ASCII range is between U+0000
and U+007F.
'E'> [, since E = U+0065 and
[ = U+005D.

Choose Unicode_BIN if either of the following statements is true:
m Your databases contain characters outside the ASCII range.
m Strings must be compared case-sensitively.

Choose ASCII_CI if your databases contain only ASCII characters and
case-insensitive sorting is required.

When the Integration service collation matches the database collation, all string
comparison and sort operations are sent to the database. When the Integration
service collation does not match the database collation, some or all string
comparison and sort operations must be performed by the Integration service.
For this reason, performance is optimized when the Integration service collation
matches the collation on as many of your databases as possible. For example, you
have five different databases, all of which contain only ASCII data, and either
case-insensitive or case-sensitive sorting is acceptable. You can choose either
ASCII_CI or UNICODE_BIN as the Integration service collation. However, if four
of the databases sort case-insensitively, while the fifth database sorts
case-sensitively, you should choose ASCII_CI so that performance suffers only
when the Integration service must compare and sort strings from the fifth
database.

About database collations

A database collation falls into one of the categories listed in Table 12-2. Refer to
your database documentation to determine the appropriate category for your
database collation.
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Table 12-2 Database collations

Database

collation Description

unicode_bin Same as Integration service collation UNICODE_BIN.
ascii_ci Same as Integration service collation ASCII_CIL.

null_sensitive ~ Does not correspond to either Integration service collation.
No two characters have the same value.

null Does not correspond to either Integration service collation.
More than one character can have the same value, for
example 'E' ="e".

About collation implementations

Together, the Integration service collation and the database collation determine
which operations are sent to the database and which operations must be
performed by the Integration service, as shown in Table 12-3. If the database
would not perform an operation in the same way as the Integration service, the
operation must be performed by the Integration service.

Table 12-3 Collation implementations

Integration

service Database

collation collation Collation implementation

UNICODE_BIN unicode_bin

UNICODE_BIN null_sensitive

UNICODE_BIN null
ASCII_CI ascii_ci

ASCII_CI null

All sort and comparison operations are sent
to the database.

GROUP BY and SELECT DISTINCT
operations, DISTINCT aggregations, LIKE,
POSITION, and string equality (=)
comparisons are sent to the database.
ORDER BY on strings, string comparisons
other than equality, MAX, MIN, etc. must be
performed by the Integration service.

All operations must be performed by the
Integration service.

All sort and comparison operations are sent
to the database.

All operations must be performed by the
Integration service.
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Specifying the Integration service and database
collations

You specify the Integration service and database collations using the
Configuration Console.

How to specify the Integration service and database collations

1 Choose Servers—Properties—Advanced—Integration Service—General Data
Source Information.

m  In Default collation of ASQL strings, select the Integration service collation,
as shown in Figure 12-1.

m In Default collation of target database strings, select the database collation,

then choose OK.
Integration service collation
Database collation
& JActuste > Server propertiey ‘MicySoft ItemetEwplorer  -lod
Servers = cdl02755  Propedies = Ategration Service = General Data Source Information =
General Data Sourcy/infory/Zation
Default collation of ASCZ strings: JUNICODE_BIN i ke
Diefault collation of target datahase strings: |unicode_bin j 1=
Default ASQL decimal precision: |20 Digits 1 7] 173
Default ASGL decimal scale: |8 Digits 1 [] £73
Default ASGL string length: |50 Characters | [F] 3
Maximurm decimal precision across all databases: |38 Digits | ] 53
Waximum length of strings across all databases: |64DDD Characters |7 {5
Maxirnum tirmeout in seconds for a JOBC driver connection.: IED Digits | [
B2 These fields reguire server restart to take effect
(I These fields will take default value if left blank
%I Cancel j

Figure 12-1 Specifying the Integration service and database collations

2 Restart the Integration service.

Working with byte-based strings

ASCII and Latin 1 characters, for example the letter A, consist of one byte.
Chinese, Japanese, and Korean characters consist of two or more bytes. The
Integration service processes strings by character, not by byte. Some databases,
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however, process strings by byte, not by character. If the database processes
strings by byte and contains multibyte characters, the following string operations
should not be sent to the database:

m SUBSTRING, LEFT, and RIGHT functions
m POSITION function

m CAST functions from VARCHAR to VARCHAR where the length is specified,
for example CAST (CUSTOMERS.CUSTOMNAME AS VARCHAR (50))

m  Actuate SQL parameters specified using syntax such as
CAST (? AS VARCHAR (30))

For example, SUBSTRING (CUSTOMERS.CUSTOMNAME, 1, 7) should return
the first seven characters of the customer name, not the first seven bytes. If the
database processes strings by byte, the SUBSTRING operation should not be sent
to the database.

To indicate that string operations should not be sent to the database, set the
UseCharStringImplByDefault attribute to true for the database type in
mappings.xml, for example:

<DataSourceMapper Name="MyDatabaseTypeMapper"
UseCharStringImplByDefault="true">

</DataSourceMapper>
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Symbols

_ (underscore) character 102, 182, 245
, (comma) character 86
: (colon) character 107
!= operator 257
? (question mark) character 55, 246
. (period) character 101, 115
' (single quotation mark) character 100, 115,
164
" (double quotation mark) character
cache databases and 145
column aliases and 74
Oracle string comparisons and 208
parameter names and 115
QBE expressions and 87
SQL identifiers and 164, 170
XML files and 214
() (parentheses) characters 106, 192, 256
[ ] (brackets) characters 220, 246
{} (curly brace) characters 232
@ (at-sign) character 245
* (asterisk) character 246
* operator 177,241
/ (forward slash) character 124, 170
/ operator 177,241
\ (backslash) character 182, 246
\ (backslash) characters 102
&gt; character code 214
&lt; character code 214
&quot; character code 214
% (percent) character 102, 182, 220, 245
+ operator 177,241
< (less than) character 214, 256
< ANY operator 254
< operator 97, 240
<= ANY operator 254
<= operator 97, 240
<> operator 97, 100, 240
= operator 89, 90, 97, 240
> (greater than) character 214, 256
> ANY operator 254
> operator 97, 240

>= ANY operator 254

>= operator 97, 240

| (pipe sign) character 86

| | operator 181

—operator 177,241, 258

— (hyphen) character 175, 195
$ (dollar sign) character 245
$% symbol 237

$Pn symbol 237

$R symbol 237

$V variable 260

A

absolute paths 124, 170, 218
accessing
information objects 73
maps 73
Prompt editor 117
SQL editor 123
acserverprofile.xml 12
Actuate Basic reports 44
Actuate Query 4, 158
Actuate SQL 158, 163, 235
See also SQL statements
Actuate SQL compiler 92, 127
Actuate SQL data types 173,174, 227
See also SQL data types
Actuate SQL expressions. See SQL
expressions
Actuate SQL functions 176, 234, 235
See also SQL functions
Actuate SQL grammar 163, 164
Actuate SQL identifiers 163, 169, 170
Actuate SQL keywords 168
Actuate SQL parameters 114-115
ad hoc parameters 86, 87
ADD operator 241
adding
aggregate functions 188
cache databases 142
column aliases 74
columns to queries 74,170
configuration keys 17, 19, 20, 44
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adding (continued) ANSI SQL 158, 159

connection definitions 16, 19 applyIndexing pragma 197
connection properties 44 arguments. See parameters
database types 212, 222 arithmetic expressions 256
DDL statements 148 arithmetic operators 177, 241, 256
filter conditions 96, 98, 99, 104 ArithOpMapper element 241
functions to expressions 72 ASCII case-insensitive collation 264, 265, 266
functions to queries 159 ASCII characters 265, 267
iServer profiles 10, 12 ASCII_CI collation 265
parameters to joins 130 ascii_ci collation 266
parameters to queries 115, 130, 159, 171, asterisk (*) character 246
174 at-sign (@) character 245
predefined filters 86 Augment operator 129
projects 10 automatic cache replacement 149
tables to queries 91, 159, 173 automatic grouping 111
addition operator 177, 241 averages 189
AdditionalSpecialChars attribute 245 AVG function 188, 189, 253
AdditiveExpression declaration (SQL) 165
AdHocParameter declaration (SQL) 165 B
aggregate columqs 98,109,113 backslash (\) character 102, 182, 246
aggregate expressions 165 balloon help 80
aggregate functions 78, 159, 162, 188, 193, 253 BasicStringFuncMapper element 243
Aggregate Type property 78 BETWEEN operator 97, 176
aggregation 109, 142 BIGINT data type 227

AggrExpression declaration (SQL) 165

bi llation 264
AggrFuncMapper element 253 Inary collation

binary types 204

Alias element 229 BIRT Designer Professional 4,5
aliases BIRT documents 19, 21

column names and 74, 80 BIRT Studio 4, 12, 78, 127

data types and 229 BIT data type 227

referenceg to 162 blank values 85, 100

_SQL queries and 123, 170 Boolean operators 239, 240, 253
Aliases element 229 Boolean values 180, 256

alignment 80 See also conditional expressions

Allow this Source to be used in Cartesian BooleanOpMapper element 239
Joins property 95 Box operator 129
allProceduresAreCallable method 218 brackets ([ ]) characters 220, 246
allTablesAreSelectable method 218 !
alternate names. See aliases
Analysis Type property 74

build error messages 152
Build Project command 152
Business Intelligence and Report Tools. See

AND operator BIRT
Boolean values 180, 239 buttons 79
flljcer con(.h.hons 104, 105 byte-based strings 267
join conditions 89
not-equal-to operator and 257 C
operator precedence and 256
And%xpress}i)on declaration (SQL) 165 cache connection definition files 142
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cache connection definitions 142, 146, 153
cache database 142, 143, 145
Cache Object command 146
cache object files 143
cache objects 142, 143, 146, 153
Cache Sources folder 10, 142
cache tables 142, 143, 144, 147
caching
data 130
information objects 142, 144, 145, 146
maps 146
Caching service 142, 144
calculated columns. See computed fields
calculations
date values and 103
DB2 data type mappings and 205
decimal values and 228
limitations for 174
queries and 177
string values and 228
CallExecutionUnit operator 130
cardinality (joins) 93, 94, 194
CARDINALITY keyword 91
Cardinality property 94, 95
CardinalityType declaration (SQL) 165
Cartesian joins 95
case conversions 180, 206
case sensitivity
Actuate SQL keywords 169
cache connection definition file names 142
cache object file names 143
connection definition file names 16
connection properties 47, 49
information object file names 70
map file names 49
map filters 50, 60
string comparisons 175
CASE statements 165, 206, 252
CaseExpression declaration (SQL) 165
case-insensitive collation 264
case-insensitive comparisons 175
CaseWhenString attribute 252
cast expressions 174
CAST function 55, 174, 251, 254, 268
CAST statements 165
CAST_AS_DECIMAL function 254
CAST_AS_DOUBLE function 255

CAST_AS_INTEGER function 254
CAST_AS_TIMESTAMP function 255
CAST_AS_VARCHAR function 255
CastExpression declaration (SQL) 165
CastFuncMapper element 254
casting rules 174, 175
CatalogFilter element 221
catalogs (maps) 50, 221
categories. See column categories
category names 75
Category Path property 78
CDATA keyword 214, 256
CEILING function 178, 205, 242
changing

column aliases 74

column names 15, 51, 52

configuration files 204, 214, 232, 235

data types 52

development locations 13

filter conditions 107

folder names 14

locales 140

maps 54

output column properties 84

parameter names 15, 57, 63, 67

parameter properties 121

project directories 10

resources 152

SQL statements 123

tables 52

translation keys 139

translation strings 139

views 52
CHAR data type 55, 227
CHAR_LENGTH function 181, 243, 257
CHAR_LITERAL token (SQL) 164
character conversions 180, 206
character data types 94
character encoding 27, 30
character patterns 87,101, 181, 246
character sets 22, 26, 27, 267
character strings. See strings
characters

blank values 100

column aliases and 74

database collation and 264

filter conditions and 99
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characters (continued)
LIKE operator and 244, 246
literal text and 164
MATCH operator and 246
ODBC escape sequences and 232
parameter names and 115
parameter values and 159
relative paths and 124
resource names and 4
SQL identifiers and 163
SQL statements and 86
string operations and 268
XML files and 214
Charset property 22,26
Choose a Cache DCD dialog box 146
CLIENT_LOCALE variable 30
code pages 27, 30
code points 175, 264, 265
code-point collations 264
collation 209, 264-267
Collection property 21
colon (:) character 107
column aliases 74, 80, 123, 170
column categories
creating maps and 49, 51
defining output columns and 75-76
displaying 77
Column Categories page 75,76
column descriptions 78
column headings 79
column name duplication 15
column names
See also column aliases; column headings
changing 15, 51, 52
converting to expressions 90
creating cache tables and 145
creating information objects and 51, 74, 80
displaying 79
entering in SQL statements 170
updating 52
ColumnAlias declaration (SQL) 165
columns
See also computed fields; output columns
adding to queries 74,170
caching information objects and 144, 147
changing order of 110, 111
comparing values between 102
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defining joins and 89, 90, 94, 95
deleting 15, 111, 113
filtering blank values in 101
filtering null values in 101
filtering on 51, 75, 86, 98, 100
grouping on 109, 110, 111
localizing information objects and 136,
137,139
locating 75
mapping to database 53, 226
prompting for values and 116, 117
propagating values for 152
referencing 159
renaming 15, 51, 52
retrieving type information for 226, 227,
229
returning subsets of 129
updating cache tables and 144, 148
viewing blank values in 101
viewing null values in 101
Columns page (graphical information object
editor) 73
Columns page (SQL editor) 124
comma (,) character 86
comments 169, 256
comparison operators 100, 176, 177, 240, 256
ComparisonOpMapper element 240
comparisons
collation and 264
date-and-time values 101
filter conditions 98
numeric values 101
range of values 100
string values 101, 175, 176, 208
values in expressions 176
values in multiple columns 99, 102
Compile 10 and dependents command 134
Compile IO button 78, 122
compiler 92,127,217
compiler errors 51, 74
compiling 135, 152
computed columns 15, 109
See also computed fields
computed fields 79, 111, 191
CONCAT function 207, 243, 257
concatenation 164, 181, 207, 258
concatenation operator 181



Conceal Value property 78,119
CondExpr declaration (SQL) 165
CondFuncMapper element 252
conditional expressions 165, 168

See also Boolean values
ConditionalPrimary declaration (SQL) 165
configurable database types 212-214
Configuration Console 267
configuration files

accessing 45

changing 204, 214, 232, 235

connection properties in 17, 19, 44

connection types in 204, 212, 216, 218

database function mappings in 232, 234,

236

database types in 204, 212,213,214

externalized connections in 44, 45,47, 48

JDBC drivers and 219

passthrough security and 44

SQL statement mappings in 261

string operations and 268
Configuration key property 17, 19
configuration keys 17, 19, 20, 44
conjunction 180
connection definition files 16
connection definitions

See also connections

caching information objects and 142, 146

creating 15-31

database schemas and 31

moving projects and 43

publishing projects and 153

viewing information about 68
connection parameter types 222
connection parameters 47, 202, 216, 221
connection properties

See also connection definitions

cache database 142

data source configurations 15,17, 44

DB2 databases 45

Encyclopedia volumes 10

externalizing 43-49

iServer profiles 12

ODA data sources 19, 20, 48

ODBC databases 16

preconfigured connection types 21
connection strings 202, 216, 220

connection types
configuring 204, 212, 213, 216, 218
displaying 221
externalizing properties for 45, 47
listed 21
naming 218
overview 202
setting parameters for 202, 221
ConnectionParam element 221
ConnectionParams element 43, 46, 47, 218,
221
ConnectionProperties element 220
connections
accessing Encyclopedia and 10
accessing ODA data sources and 19
creating data source 19, 43, 44
creating database 16, 218
iServer 12
locating configuration files for 45
retrieving properties for 17, 19
setting character encodings for 27
setting parameters for. See connection
parameters
setting properties for. See connection
properties
setting run time 44
specifying port numbers for 12,17
testing 18, 21
ConnectionString element 220
ConnectionType attribute 223
ConnectionType element 46, 47, 213, 218
ConnectionTypes element 218, 219
ConnectOptions element 44, 46, 47, 48
Context path property 13
control strings (units of time) 185
control type constants 119
control types
changing 121
defining local parameters and 120
defining output columns and 79
entering display names for 117
filtering data and 88
prompting for input and 87, 117, 119
CONVERT function 255
copying projects 152
cost-based optimization (joins) 195-197, 198
COUNT function 188, 193, 253
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COUNT_ROWS function 253
counting non-null values 188
country codes 137
Create SQL map option 18
creating
cache database 142, 143
cache objects 142, 143, 146
cache tables 142, 144, 147
column aliases 74
column categories 75
connection definitions 15-31
custom filters 79
data filters 86, 96, 104
database types 222
function templates 237
information objects 4, 70-71
iServer profiles 10, 12
joins 89-90, 95
list of values 86, 87, 116, 117
maps 49-68
parameterized queries 159, 174
projects 10-11
SQL queries. See queries
subqueries 172
textual queries 70, 123-124
Credentials property 17
cube profiles 44
curly brace ({ }) characters 232
CURRENT_DATE function 185
CURRENT_TIMESTAMP function 185
CURRENT_USER function 189
Custom Data Source Properties dialog box 20
custom data sources. See ODA data sources
Custom driver class property 26
customizing
aggregate functions 253
cast functions 254
data filters 79
null functions 251
numeric functions 242
query mappings 260-262
SQL operators 253
string functions 243
substring functions 244
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dashboard reports 31
data
See also values
aggregating. See aggregation
aligning 80
caching 130
creating joins and 89, 92,94, 95, 195
filtering. See data filters; filtering data
grouping 108-113, 162
previewing 6,126
retrieving from
databases 96
information objects 4, 116, 133
multiple data sources 4, 129
simulating 132
Data Analyzer 81
Data Connection Definition command 16, 19
data connection definition files 16
Data Connection Definition page 16, 19
data connection definitions
caching information objects and 142, 146
creating 15-31
database schemas and 31
moving projects and 43
publishing projects and 153
viewing information about 68
data cube profiles 44
Data Definition Language statements 144,
148
See also cache objects; cache tables
data filters
See also filtering data
adding to queries 86
building maps and 50, 57, 60, 62, 66
comparing date-and-time values and 101
comparing numeric values and 101
comparing string patterns and 101
comparing values in multiple columns
and 102
creating 86, 96, 104
customizing 79
defining output columns and 51, 75, 79
disabling 79
excluding null or blank values and 100
excluding sets of values and 100, 105



prompting for 107
removing columns and 15
setting at run time 162
setting conditions for. See filter conditions
setting control type for 79
setting default values for 78, 88
setting evaluation order for 105
specifying parameters as 98
Data Integration (EII) Option 4
Data Preview view 6, 126
data rows. See rows
data sets
See also result sets
filtering 96, 100, 105
mapping to ODA data sources and 65, 67
Data source connection properties page
JDBC connections and 202, 216
ODA connections and 20, 65
ODBC connections and 17, 202, 216
Data Source page (New Maps) 49, 56, 59
data sources
See also specific type
accessing multiple 4
connecting to 16, 19, 43, 44
defining joins and 89, 92, 94, 95, 195
externalizing connection properties
for 43-49
locating configuration files for 45
querying remote 176, 177
retrieving data from 129
retrieving distinct values from 74
setting connection properties for 15,17, 21
testing connections for 21
viewing queries for 127, 133
Data Sources folder 10, 14
Data Type property 78, 119
data types
accessing non-native 228
assigning to parameters 115, 119, 222
casting 159, 174, 254
changing 52
creating SQL queries and 158, 173
displaying 53, 81, 124, 126
filtering null values and 100
mapping 204, 226, 227, 229
mapping queries and 55, 57
mapping stored procedures and 60, 62, 63

mapping to
DB2 databases and 205
Informix databases and 206
ODA data sources and 64
Oracle databases and 207
SQL databases and 210
Sybase databases and 211
redefining aliases for 229
returning from function calls 237
setting join column properties and 94
supported 227
database collation 209, 264-267
database connection types. See connection
types
database drivers. See drivers
Database property 21, 22, 23, 24, 25, 26
database schemas 31, 50, 60, 143
database servers. See servers
database types
See also specific type
adding 212
applying default mappings and 212, 213
configuring 204, 212, 213, 214, 268
creating 222
defining connection types for 216, 218
mapping functions for 234, 235
overview 202
running queries and 232
databases
See also data sources; specific type
caching data and 142, 143, 145
connecting to 16, 218, 222
creating queries for 162,172,173, 203
disabling function mappings for 234
externalizing connections for 45, 47
mapping literal strings for 260
mapping to data in 49-52, 204, 226
mapping to functions in 232, 235, 236
mapping to result sets from 55, 59
ordering strings in 264, 265, 266, 267
retrieving data from 96
running queries from 203, 235
setting character encodings for 27
testing connections for 18
undefined mappings and 228
DatabaseType element 213, 222
DatabaseTypes element 218, 222
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DataSourceMapping attribute 214, 223
datasources.xml 47,213, 214, 218
DataType declaration (SQL) 165
DataType element 228
DataTypeMapper element 227, 237
DataTypes element 228
DATE data type 227
date functions 247, 248, 249, 250
date stamps 185, 247, 248, 249, 250
date values 101, 103, 209, 238
DATEADD function 186, 236, 249, 250
DateAdd function 209
DateAddMapper element 249
DATEDIFF function 103, 186, 236, 248
DateDiff function 209
DATEDIFF function mappings 238, 248, 257
DateDiffMapper element 239, 248
DatePart attribute 236
DATEPART function 187, 236, 247
DatePart function 209
DatePartMapper element 247
DATESERIAL function 187, 250
DateSerialMapper element 250
DB_LOCALE variable 30
DB2 data types 205
DB2 databases
caching information objects and 142, 145
connecting to 21, 22, 204
creating queries for 203
externalizing connections for 45, 46
mapping to 205
renaming stored procedures for 59
setting character encodings for 27
.dcd files 16, 142
See also connection definitions
DDL statements 144, 145, 148
See also cache objects; cache tables
DECIMAL data type 173,174, 227,228
See also decimal values
decimal precision 174, 228
decimal separators 101, 115
decimal values
aggregating data and 188
calculating data and 177
converting 205
creating SQL queries and 173,174
mapping to data types and 211, 228
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rounding 179
setting precision for 228
DECIMAL_LITERAL token (SQL) 164
Default Analytics button 82
Default collation of ASQL strings option 267
Default collation of target database strings
option 267
default directories. See directories
default function templates 232, 255
default mappings file 212
default names 57, 63
Default Value property 78, 119
default values
connection parameters 222
data filters 78, 88
output parameters 64
overriding 15
run-time parameters 117, 119
SQL parameters 115
DefaultDecimalPrecision configuration
variable 254
DefaultDecimalScale configuration
variable 254
DefaultStringLength configuration
variable 255
DefaultValue attribute 222
deleting
column categories 76
columns 15, 111, 113
filter conditions 107
join conditions 91
output columns 75
parameters 15, 115
query execution plans 135
DELIMIDENT variable 30
dependent joins 92, 130, 160
DependentJoin operator 130
derived tables 173
Describe Query button 124, 126
Description Key property 79, 119
Description property 78, 85,119, 136
designs
building information objects and 4
creating queries and 162, 170
filtering data and 86, 164
retrieving data for 4
developers 4



development locations 10, 13
directory paths

column categories 78

connection type configurations 204, 212,

218
database type mappings 213, 223
externalized connection properties 45, 47,
48

information objects 86, 170

JDBC drivers 218, 220

project folders 11, 14

SQL function mappings 170, 232, 234

SQL queries 124

WSDL files 26

XML data sources 27
Disabled attribute 236, 244, 245
Disabled value 79
disjunction 180
Display attribute 221
Display Control Type property 79, 119
Display Format property 79, 119
Display Length property 79, 119
Display Name Key property 79, 119
Display Name property 79, 85, 119, 136
display names

connection types 221

control types 87, 117

output columns 79

parameter prompts 119
displaying

column categories 77

column names 79

data types 53, 81, 124, 126

error messages 6, 152

information objects 68, 72

maps 68, 72

output columns 51, 56, 66, 124

parameters 126

SQL queries 127,133

SQL statements 6, 128
DisplayName attribute 223
DISTINCT keyword 74, 81, 162
Distinct Values Count property 94
Distinct values only option 74
DIV operator 241
division 177,178
DNS servers 22

Do Not Prompt property 79, 119
Do not show this message again setting 6
documentation ix
documents 21
See also reports
dollar sign ($) character 245
DOUBLE data type 173,174, 205, 227
See also double values
double quotation mark (") character
cache databases and 145
column aliases and 74
Oracle string comparisons and 208
parameter names and 115
QBE expressions and 87
SQL identifiers and 164, 170
XML files and 214
double values 173,174, 176,177, 205
DOUBLE_LITERAL token (SQL) 164
Driver class path property 27
DriverName attribute 219
drivers
configuring JDBC 219
connecting to data sources and 16, 19
connecting to databases and 22,212,217,
219
creating map files and 60, 226, 227, 229
customizing 26
installing JDBC 217, 218
installing non-Unicode characters and 27
naming 219
running platform-independent queries
and 232
specifying paths to 218, 220
drop-down lists 79, 88, 117
Dup operator 130
duplicate rows 74
dynamic filters 79, 86, 88, 162
Dynamic list of values option 88, 117

E

e.Analysis 81

e.Report Designer Professional 4
e.Spreadsheet Designer 4
Eclipse 31

Eclipse IDE 4

Eclipse plug-ins 48
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Edit in SQL text editor option 70, 123
Edit SQL button 123
ELSE keyword 252
ElseString attribute 252
empty strings 208
empty values 100
Enable cost based optimization variable 197
EnableCBO pragma 195, 196
encoding 22,27, 30
Encoding for XML source and schema
property 27
encryption extension point plug-in 31
EncryptionProviderID.exsd 32
Encyclopedia volumes
accessing information objects in 170
adding projects to 10
defining connection properties for 10
publishing to 153, 154
specifying iServer profiles for 10, 12
END keyword 252
EndString attribute 252
environments 43
.epr files
ODA data sources and 64, 66
stored procedures and 58, 63
EQ operator 240
Equal to operator 97
equality comparisons 176
equality operator 89, 90, 240
equijoins 93, 130
error messages 6, 152
erTors
column aliases and 74
column names and 51
data type mappings and 209, 211, 229
escape sequences and 246
SQL operators and 257
SQL queries 174
unknown escape sequences and 232
unsupported functions and 234
escape characters 159, 168, 182, 246
ESCAPE clause 244
ESCAPE keyword 182
escape sequences 212, 214, 228, 232
EscapeTemplate attribute 245
EXISTS operator 254
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ExplicitinnerOuterType declaration
(SQL) 165
ExplicitjoinType declaration (SQL) 165
exponentiation 179
Expression Builder 71-72, 74
Expression property 79
ExpressionList declaration (SQL) 165
expressions
adding column names to 90
adding functions to 72
adding SQL operators to 256
changing column names and 15, 52
comparing values in 176
creating computed fields and 79
creating joins and 89, 90, 93
creating queries and 71, 86, 173,176
defining output columns and 74
filtering data and. See filter expressions
grouping data and 162
mapping literal strings and 260
matching character patterns and 181
setting default values and 57
external procedure object files
ODA data sources and 64, 66
stored procedures and 58, 63
external procedures 5, 153
externalizing connection properties 43-49

F

facets (defined) 173
FakeData operator 132
FakeFileData operator 132
false values. See Boolean values
file names 16, 49, 70, 142, 143
filter conditions
adding 96, 98, 99, 104
aggregating data and 113, 114
changing 107
creating expressions for 103
defining multiple 104, 106
deleting 107
grouping 105, 106
including parameters in 108
prompting for 162
selecting multiple values for 99
Filter Conditions dialog box 96, 98, 107



filter expressions
changing column names in 15
comparison operators in 100, 101
empty or blank values in 100, 101
filter conditions and 96, 98, 103, 104
functions in 103
grouping conditions in 106
literal characters in 102
logical operators in 105
multiple values in 99, 103
Filter property 75,79, 86, 87
filter specification. See filter expressions
FilterClause declaration (SQL) 164, 165
filtering data
at run time 107
in tables and views 50
information objects and 86, 87, 96, 104, 113
filters
adding to queries 86
building maps and 50, 57, 60, 62, 66
comparing date-and-time values and 101
comparing numeric values and 101
comparing string patterns and 101
comparing values in multiple columns
and 102
creating 86, 96, 104
customizing 79
defining output columns and 51,75, 79
disabling 79
excluding null or blank values and 100
excluding sets of values and 100, 105
prompting for 107
removing columns and 15
setting at run time 162
setting conditions for. See filter conditions
setting control type for 79
setting default values for 78, 88
setting evaluation order for 105
specifying parameters as 98
Filters page (graphical information object
editor) 98,99, 103, 104, 107
FILTERS statements 158, 162, 164, 165
See also SQL statements
fixed point numbers 173
flat file data sources 19, 22, 65, 132
flatjoins 130, 131
Flatfile style property 22

FLOAT data type 227
floating point numbers 173, 176, 177, 227
FLOOR function 178, 205, 233, 242
Folder property 22
folders
connecting to flat file data sources and 22
localizing information objects and 136
moving 14
renaming 14
saving projects and 10, 11
storing cache object files and 143
storing connection definitions and 15, 142
storing map files and 49, 58, 64
foreign keys 81
formats
join column properties 94
output columns 79, 80
forward slash (/) character 124, 170
fractional numbers 211
FROM clause 165
See also SQL statements
FromClause declaration (SQL) 165
FromTableName declaration (SQL) 165
FromTableReference declaration (SQL) 165
function mapping examples 237
function templates 232, 234, 235, 237, 255
FunctionCallOrColumnRef declaration
(SQL) 165
FunctionMapping element 236, 260
FunctionMappings element 239
FunctionName attribute 236
functions
aggregation and 109, 188, 193, 253
compatibility with 234
DB2 databases and 205
disabling default mappings for 234, 239
filtering data and 103
mapping 232, 234,236
null values and 251
numeric data types and 178, 242
Oracle databases and 207
overloading 236
SQL databases and 209
SQL queries and 55, 72, 159, 174
string data types and 180, 243
substrings and 182, 184, 244
Sybase databases and 211
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functions (continued)
system information and 189
testing driver version and 217
timestamp values and 184
type casting and 254

G

GE operator 240
GE_ANY function 254
Generate Query button 88
Generic SQL type codes 212
Generic_ODBC mappings file 234, 236
GenericSQLType attribute 228
get]DBCMajorVersion method 217
getProcedures method 218
getTables method 217
graphical information object editor
accessing 71
categorizing output columns and 75
changing filter conditions with 107
creating joins and 89, 90
creating queries and 71,72, 123
defining output columns and 73
defining parameters with 115, 121
editing queries and 123
filtering data with 87, 98,99, 102, 104, 105
grouping data with 111, 113
retrieving aggregate columns and 114
synchronizing parameters with 122
viewing column categories and 77
graphical queries 71, 158
See also queries
Greater Than operator 97
Greater Than or Equal to operator 97
GreedyMatchChar attribute 245
GROUP BY clause
See also SQL statements
adding expressions to 162, 166
creating 108-113
deleting 112
filtering aggregate data and 113
mapping 261
removing columns from 111, 113
Group By page 111, 113
GroupByClause declaration (SQL) 166
GroupByClauseMapper element 261
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grouping data 108-113, 162

grouping filter conditions 105, 106

groups
changing column order for 110, 111
disabling automatic grouping and 111
nesting rows and 131
returning distinct values for 74
returning from queries 162
viewing available columns for 111

&gt; character code 214

GT operator 240

GT_ANY function 254

H

Has Null property 79
HAVING clause 113, 162, 166

See also SQL statements
Having page 114
HavingClause declaration (SQL) 166
Heading Key property 80, 120
Heading property 79, 85, 120, 136
Help Text Key property 80, 120
Help Text property 80, 85, 120, 136
Hidden Messages list 6
hidden parameters 119
hidden strings 222
hiding specific values 119
hints 189
home folders 11
Horizontal Alignment property 80, 120
Host property 22
HTML text format 80
hyphen (-) character 175, 195

IANAAppCodePage property 21, 22, 26, 27,

220
IBM DB2 databases. See DB2 databases
Jdcd files 143

See also cache objects

IDENTIFIER token (SQL) 163
identifiers (SQL) 163, 169, 170
IEncryptionProvider interface 32, 34
illegal characters 170
IN operator 97,99, 108, 177, 254
incremental cache updates 149



indexed columns 81
Indexed property 80
indexes (cache tables) 148
indexes (SQL queries) 197, 198
Information Console port property 12
Information Console server property 12
Information Object command 70
information object data sources 133, 136
Information Object Designer
building projects and 152
caching information objects and 142, 146
copying projects with 152
creating queries and 162
duplicating column names and 15
filtering data and 104, 105, 163
grouping data and 110
overriding default values for 15
overview 4
previewing data and 126
prompting for input and 117
publishing projects with 154
saving passwords for 12
viewing column categories and 77
viewing queries and 127, 129, 133
information object files 70
Information object project page 10, 12
Information Object Project wizard. See New
Project wizard
Information Object Query Builder 78, 86, 190
information objects
accessing multiple data sources and 129
building from information objects 74, 84,
120
building from map files 49, 51, 55, 58, 64
building queries for 71, 72, 95,123, 158
caching 142, 144, 145, 146
changing items in 15
creating 4, 70-71
defining computed fields and 191
defining joins for 89-90, 92, 94, 95, 195
defining optional tables for 190-194
defining output columns for 73-75
defining parameters for 114-122
deleting joins for 91
deleting query plans for 135
disabling indexing for 197
displaying information about 68

displaying list of 68
displaying output for 6, 126
displaying queries for 6
filtering data for 86, 87,96, 104, 113
grouping data for 108-113
inheriting properties and 84-86, 152
localizing 136-140
naming 70
opening 73
overview 4
referencing 14, 86, 170
renaming 84
retrieving data from 4, 116, 133
saving query plans for 133, 134
selecting 72
testing 12,127,132
viewing 72
Information Objects folder 10, 14, 70
Informix data types 207
Informix databases
connecting to 22, 30, 204
externalizing connections for 45
mapping to 206-207
renaming stored procedures for 59
setting character encodings for 27
inheriting properties 84-86, 120, 152
initialization statements 258
inner joins 90, 161
input 86, 87,107, 117
input parameters 58, 60, 64, 120
See also stored procedures
installation
character sets 26
JDBC drivers 217,218
INTEGER data type 173, 174, 227
INTEGER_LITERAL token (SQL) 164
integers 164, 173, 174,177,227
Integration service
calculating data and 177
comparing values and 175, 176
configuring database types and 213
connecting to Informix databases and 30
creating projects and 10
data type mappings and 226, 228, 229
database drivers and 217
defining joins and 93
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Integration service (continued)

mapping SQL functions and 232, 235, 237,
255

ordering strings and 264, 265, 266, 267
running queries and 162, 202, 228, 233
setting collation for 267

intersection operations 158

intsrvrsources.xml 45, 47, 204

IO Design perspective 5

.ob files 70

IP addresses 12,21, 26

IS NOT NULL operator 97,101, 180, 257

IS NULL function 251

IS NULL operator 97, 101, 180

iServer
accessing Informix databases and 30
connecting to 12
creating profiles for. See iServer profiles
installing drivers for 218
running on UNIX platforms 27
viewing error messages from 6

iServer Explorer view 6

iServer profiles 6,10, 12

iServer property 12

iServer volumes. See Encyclopedia volumes

IteratorAsLeaf operator 132

iterators 130, 131, 132

J

Java Runtime Environment 217

JDBC connection strings 202, 216

JDBC data sources 219, 220

JDBC drivers
See also drivers
connecting to databases and 16, 212, 217,

219

creating map files and 60, 226, 227, 229
creating SQL statements and 232
installing 217, 218

jdbcCompliant function 217

JDBCDriver element 218, 219, 220

join algorithms 92, 94, 160, 197

join control syntax 160

join operators 130, 131

join types 90

JoinCondition declaration (SQL) 166
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JoinElement declaration (SQL) 166
JoinExpression declaration (SQL) 166
joins
accessing multiple data sources and 92,
195
building subqueries and 172
creating 89-90, 95
defining algorithms for 92, 94, 160
defining cardinality of 93, 94, 194
defining dependent 92,130, 160
disabling cost-based optimization for 195,
196
optimizing 91, 92, 94
removing conditions for 91
setting column properties for 94, 95
setting conditions for 89, 90, 93
specifying optional tables for 190
testing 129
Joins page 90, 94
JoinSpec declaration (SQL) 166
JRE compatibility 217

K

keywords (Actuate SQL) 168

L

language code 137
LE operator 240
LE_ANY function 254
leaf operators (queries) 132
LEFT function 182,244, 268
LEFT OPTIONAL keywords 193
LEN function 257
Length declaration (SQL) 166
length function 181
Less Than operator 97
Less Than or Equal to operator 97
LibraryPath element 220
LIKE expressions 246
LIKE operator
changing escape character for 246
customizing 244
disabling 245, 246
displaying blank values and 101
mapping to 244-246
matching characters and 97, 101, 246



SQL queries and 87,159, 181

LikeOpMapper element 244

lists
displaying at run time 86, 87, 116, 117
selecting values from 88, 100, 117

literal characters 87, 102, 164, 167, 182

literal integers 164, 166, 167

literal strings 159, 164, 260

LiteralMapper element 260

LiteralMapping element 260

local directory options 10, 70

local parameters 120, 121

locale code 137

locales
See also localizing information objects
byte-based strings and 267
changing 140
character encoding and 27, 30
column properties and 79
database collation and 264
date-and-time filters and 101
numeric comparisons and 101
selecting 137

Localization button 137

Localization dialog box 138, 139, 140

Localization folder 136

localizing information objects 136-140

Location element 220

logical operators 105, 180

logical values 180

login IDs 22,26

LONG VARCHAR data type 227

LOWER function 180, 243

&lt; character code 214

LT operator 240

LT_ANY function 254

LTRIM function 183, 243

M

Management Console
caching information objects and 142, 149
enabling passthrough security and 44
locating configuration files and 45
setting iServer profile properties for 12
Map command 49

map files
See also maps
configuring database types and 204, 212,
214
converting SQL functions and 232
naming 49, 56
setting default directories for 223
storing 49, 58, 64
Map page 56
Map stored procedures option 18
Map tables button 18, 21
mapping
data types 204, 226, 227, 229
database functions 232, 234, 236
database tables and views 49-52, 204, 226
literal strings 260
ODA result sets 21, 64-68
SQL functions 232, 234, 235
SQL operators 234, 235, 236, 256
SQL queries 55-58
stored procedures 58-64, 226
mapping examples (SQL functions) 237
mapping examples (SQL operators) 257-258
mappings.xml 204, 214, 232
maps
accessing databases and 226
adding to projects 49, 55, 59
caching 146
changing 54
changing names in 15, 51
creating 49-68
defining joins for 90, 92, 94, 95, 195
displaying 68, 72
inheriting property values and 84, 85
opening 73
publishing projects and 153
referencing 86, 170
removing items from 15
renaming 84
retrieving data from 89, 116
retrieving type information for 226, 227,
229
running queries and 203
selecting 72
unsupported functions and 234
updating 52, 53, 54
viewing information about 68
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maps (continued)
viewing output for 6
Maps page 50, 59, 61, 65
masked property 33
masks 222
MATCH operator 246
matching character patterns 87, 101, 181, 246
Materialize operator 130
mathematical operators 177
MAX function 188, 253
Max memory per query parameter 93
Max Value property 94
maximum values 188
MaxSize attribute 228
memory 93, 197
merge joins 93, 161
MergeJoin operator 130
Message Distribution Service 12
messages 6
metadata 58, 64,217
Microsoft SQL databases. See SQL Server
databases
Microsoft Windows. See Windows systems
MIN function 188, 253
Min Value property 94
minimum values 188
MinRowsForIndexing pragma 198
missing values 101
MOD function 178, 242
Move operator 131
moving
column categories 76
output columns 51, 75,76
project files 43
project folders 14
MULT operator 241
MultiAugment operator 131
multibyte characters 268
multiline comments (SQL) 169
multiplication 177
MultiplicativeExpression declaration
(SQL) 166
MultiRowBoolFuncMapper element 253
MySQL Enterprise database type 212
MySQL Enterprise databases 23, 45, 204
MySQL Enterprise login accounts 23
MySQL Enterprise named instances 23
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N

Name attribute
ConnectionParam element 221
ConnectionType element 218
DatabaseType element 223
DataType element 228

Name property 80, 84, 120

named parameters 55

named servers 23, 26

NamedParameter declaration (SQL) 166

names
as SQL identifiers 170
changing 15
parameters and 57, 63
stored procedures and 59

naming
cache connection definition files 142
cache objects 143, 147
cache tables 147
connection types 218, 223
data connection definition files 16
database schemas 31
database types 223
external procedure object files 58, 64
information objects 70
iServer profiles 12
JDBC drivers 219
map files 49, 56
output columns 74
parameters 115, 120
project folders 14
projects 10
queries 65
resources 4
result sets 61

naming restrictions 4
See also case sensitivity

native SQL data types 57, 64

Navigator view 5

NCHAR data type 55, 206

NE operator 240

NEG operator 241

negation 180, 256, 258

negation operator 241, 258

negative (-) signs 256, 258

NEQ function 257



Nest operator 131
nested loop joins 93, 131, 160
NestedLoop]Join operator 131
nesting joins 130, 131
New Data Connection Definition wizard 16,
19
New Information Object wizard 70
New iServer Profile wizard 12
new line characters 168
New Maps wizard 49, 56, 59
New Project wizard 10
node operators (queries) 129
non-native data types 228
NoOp operator 132
NOT BETWEEN operator 97, 100
Not Equal to operator 97
NOT IN operator 97, 254
NOT LIKE operator 97,100, 101
NOT operator 105, 180, 239, 240, 256
NOT_IN function 254
not-equal-to operator 257
null collation 266
NULL functions 251
NULL keyword 258
null test operators 180
null values
assigning to parameters 115
concatenating strings and 258
defining output columns and 79
filtering 100
mapping 207, 251
testing for 180
null_sensitive collation 266
NullFuncMapper element 251
numbers
assigning to parameters 115, 122
calculating 177
comparing 101, 176
entering in SQL queries 164, 173
ordering 264
rounding 179
setting decimal precision for 228
setting default values for 115
NUMERIC data type 227,228
numeric data types 174, 176, 205
numeric functions 178, 242
NumericFuncMapper element 237, 242

NVARCHAR data type 206, 228
NVARCHAR? data type 207

o)

ODA connection types 48
ODA data source query builder 65
ODA data source types 19
ODA data sources
connecting to 19
creating queries for 65, 67
enabling passthrough security and 44
externalizing connections for 48
mapping result sets for 64-68
retrieving parameters from 120
ODA drivers 19
ODA nodes (Query Profiler) 129
ODA operator 132
ODBC connection strings 202, 216
ODBC databases 16, 232
ODBC drivers 16,212, 232
ODBC escape sequences 212, 228, 232
odbc.ini 27
online documentation ix
open data sources. See ODA data sources
open database connectivity. See ODBC
opening
Expression Builder 74
graphical information object editor 71
information objects 73
maps 73
SQL editor 123
operands 236, 256
OperandTypes attribute 236, 237
operator mapping examples 257-258
operators
customizing 239, 240, 241, 244, 253
filter conditions 97,98, 100, 105
join conditions 89, 90
mapping 234, 235, 236, 256
ODBC data sources 236
SQL queries 129,159, 176
optimizing
joins 91,92, 94
queries 91,93, 172, 189, 195
OPTION clause 172
See also SQL statements
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Optional attribute 222 output parameters 58, 60, 64, 120

optional data filters 79 See also stored procedures

OPTIONAL keyword overloaded functions 236
aggregate functions and 193 overloaded stored procedures 59
computed fields and 191 overriding default values 15
joins and 91, 190, 192

optional parameters 222 P

Optional value 79 Parameter Mode property 120

OR keyword 123 parameter passing conventions 160

OR operator 105, 180, 239, 256 Parameter Values dialog box 126,127, 133
Oracle data types 208 ParameterDeclaration declaration (SQL) 166

Oracle databases . :
N . . parameterized queries
caching information objects and 142, 145 See also stored procedures

connecting to 23, 204 creating 159, 174
creating queries for 203, 207 defining parameters for 114, 159
externalizing connections for 45 filtering data with 162

mapping to 55, 207
ORDER BY clause 55,124, 161, 166, 261
See also SQL statements
OrderByClause declaration (SQL) 166
OrderByClauseMapper element 261 adding to joins 130

OS/400 operating systems 21 assigning data types to 115, 119
OSGi extensions framework 31 assénmg values ko 116, 119, 122, 126, 170
outer joins 89, 90, 161 caching information objects and 142
output 6, 80, 126 changing properties for 121

See also result sets defining connection 221
output COl}.ll"IlI‘lS defining local 120

categorizing 75-76 defining source 120-122

joining tables with 161

mapping to 55, 58, 64

renaming parameters for 57, 67
parameters

changing order of 51, 75,76 deleting 15, 115

changing properties for 84 displaying 126

defining 73-75 filtering data and 86, 98, 107
deleting 75 , hiding 119

displaying categories 77

localizing inf tion objects and 136,
displaying data types for 124 ()1C§71211§9g formation objects an

displaying multi-line text in 80
excluding from map files 51

filtering 51,75, 79

formatting values in 79, 80

grouping data and 111

inheriting property values and 84, 85
naming 74

renaming 51, 56, 62, 65

setting display lengths for 79

mapping stored procedures and 58, 60, 63
mapping to ODA data sources and 64, 67
mapping to SQL databases and 209
mapping to SQL queries and 55, 57
naming 115, 120

optimizing queries and 93

prompting for 115, 116, 117

propagating values for 152

querying information objects and 114, 115,

setting properties for 51, 75, 78, 124 130, 159, 171, 174
truncating textin 80 renar’ning, 15 ,57 63, 67
viewing 51, 56, 66, 124 setting default values for 115, 119

Output Columns page 50, 51, 62, 65
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setting properties for 115, 119
specifying as required 120
synchronizing 122
viewing data types for 126
Parameters For Stored Procedure dialog
box 59, 60
Parameters page
defining parameters and 115, 121
defining prompts and 117
deleting parameters and 115
updating information on 122
Parameters page (SQL editor) 57, 63, 67, 126
ParamPlaceholder declaration (SQL) 166
parentheses ( ) characters 106, 192, 256
passthrough security 43
Passthrough value 17
Password property
database connections 21, 22, 23, 24, 25, 26
iServer profiles 12
passwords
database connections and 17, 21, 23, 26
iServer profiles and 12
MySQL Enterprise login accounts and 23
PostgreSQL login accounts and 24
run-time connections and 44
saving 12
SQL Server login accounts and 25
paths. See directory paths
pattern characters 182
pattern-matching operator 159
percent (%) character 102, 182, 220, 245
performance 96, 142, 203, 235, 265
period (.) character 101, 115
perspectives 5
pick lists. See drop-down lists
pipe sign (| ) character 86
plain text format 80
platform-independent queries 232
plugin.xml 48
plug-ins 48
POJO data sources 19, 24
Port number property 12
Port property
DB2 data connections 21
Informix data connections 22
MySQL Enterprise connections 23
ODBC data connections 17

Oracle data connections 23
PostgreSQL connections 24
SQL Server connections 25
Sybase data connections 26
ports 12
POSITION function 184, 234, 239, 244, 268
PostgreSQL databases 24, 31, 45, 204
PostgreSQL login accounts 24
PostgreSQL named instances 25
POWER function 179, 205, 237, 242
power function 211
Pragma declaration (SQL) 164, 166
pragmas 161, 195
precedence 256
precision 173,174,228
Precision declaration (SQL) 166
preconfigured connection types 21, 45
preconfigured database types 16, 202, 204,
235
preconfigured ODA data source types 19
predefined filters 78, 86
Predefined value 79, 86
previewing data 6, 126
previewing output 6
primary keys 81, 147
PrimaryExpression declaration (SQL) 166
Problems view 6, 152
production databases 31, 142
Profile name property 12
profiles 6,10, 12, 44
programmers 4
Project command 10
Project operator 131
projects
adding map files to 49, 55, 59
changing locations for 13
compiling resources for 152
copying 152
creating 10-11
moving 43
naming 10
publishing 152, 153-155
saving 10
testing 153
updating 152
viewing contents 5
viewing information about 68

Index
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Prompt editor 85, 86, 87, 116, 117
Prompt editor button 117
prompt properties 115, 116, 117
prompting for input 86, 87, 107, 117
Propagate Property Values command 152
propagation settings 15
properties
connection types 21
data source connections 15,17, 21, 44
displaying 5
externalized connections 43-49
information object parameters 119
inheriting 84-86, 120, 152
iServer profiles 12
joins and 94, 95
ODA data sets 67
ODA data sources 19, 20, 48
ODBC databases 16
output columns 51, 75,78, 84, 124
parameters 115,117, 119
propagating values for 152
resetting 85, 121
translated strings 136, 139
Properties command 13, 153
Properties dialog box 140
properties file 136
Properties view 5
Proxy value 17
Publish Files button 154
Publish Information Objects command 154

Publish Information Objects dialog box 154

Publish Location property 153
publish locations 11, 153, 154
Publishing dialog box 154

publishing projects 152, 153-155
publishing resources 153
PushComplexExprs attribute 261, 262

Q

QBE expressions 86

queries
See also SQL statements; subqueries
adding comments to 169
aggregating data and 109, 193
building expressions for 71, 86,173,176
building for
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information objects 71, 72, 95, 123, 158
ODA data sources 65, 67
Oracle databases 207
remote data sources 176, 177
SQL Server databases 209
Sybase databases 211
building function templates for 237
comparing strings and 175, 208
configuring database types and 212
converting case and 180, 206
converting functions for 232, 233, 236
creating 5,70, 123, 158, 232
customizing mappings for 260-262
disabling cost-based optimization for 195,
196
filtering data with 86, 88, 96, 113, 162
generating 88
grouping data with 108-113, 162
initializing 258
limitations for 158, 162,172
mapping data types for 204, 226, 227, 229
mapping literal strings for 260
mapping to 21, 55-58, 64
naming 65
not returning values 114
optimizing 91, 93, 172, 189, 195, 235
ordering strings for 264, 265, 266, 267
prompting for input and 116, 117, 120
restricting data returned by 86
retrieving data with 86
returning distinct values and 74
returning duplicate rows and 74
running 202, 217, 228, 233
saving 123
selecting information objects for 72
selecting maps for 72
sorting data with 161
specifying database collation for 264, 267
updating map files and 53
viewing execution plan for 6
viewing information about 127, 133
viewing parameters in 126
Query By Example. See QBE expressions
query definition view 5
query execution plans 129, 133, 134, 135
query extensions 159
query operators. See operators



Query Profiler view 6, 127,129, 133

QueryParameterDeclaration declaration
(SQL) 166

question mark (?) character 55, 246

&quot; character code 214

R

radio buttons 79
range of values 100, 176
range test operator 176
REAL data type 227
records. See rows
references
aliases and 162
database views and 159
information objects and 14, 86, 170
pattern-matching operator and 159
SQL queries and 159
table names and 159
relational databases 232
See also databases
RelationalOperator declaration (SQL) 166
relative paths 86, 124, 170
remainders 178
Remember Password option 12
remote data sources 176, 177
removing. See deleting
renaming
column categories 76
columns 15, 51, 52
information objects 84
maps 84
parameters 15,57, 63, 67
project folders 14
stored procedures 59
report designs
building information objects and 4
creating queries and 162, 170
filtering data and 86, 164
retrieving data for 4
Report document path property 21
report documents 21
reports 44,136
Required property 80, 120
reserved words (Actuate SQL) 168
resource names 4

resources 68,152,153
Result Set Name dialog box 61
result sets
categorizing columns in 75-76
changing column order in 75, 76
changing output columns names 56, 62, 65
defining output columns for 73-75
displaying multi-line text in 80
filtering data for 51,75,79
formatting text in 80
mapping to 21, 58, 59, 64, 65
naming 61
removing output columns in 75
returning distinct values for 74
returning from information objects 95, 160
truncating text in 80
viewing output columns in 51, 56, 66
RIGHT function 182,244, 268
RIGHT OPTIONAL keywords 192, 194
ROUND function 179, 205, 242
TOws
adding to cache tables 144
adding to joins 90
copying iterators for 131
excluding duplicate 74, 108
filtering blank values in 101
filtering null values in 101
grouping 131
resetting iterators for 130
restricting number returned 96, 105, 107,
113
retrieving from
information objects 142
queries 108, 129, 130, 131, 132
specifying threshold values for 198
viewing blank values in 101
viewing null values in 101
RPAD function 55
RTF text format 80
RTRIM function 183, 243
running queries 202, 217, 228, 233
run-time connections 17, 19, 44
Runtime element 44
run-time filters 162
run-time queries 159
run-time values 88, 116, 117
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S

saving
connection definition files 15, 142
passwords 12
projects 10
queries 123
query execution plans 133, 134
resources 152
scalar subqueries 160
scalar values 160, 173, 177
ScalarDataType declaration (SQL) 167
Scale declaration (SQL) 167
Schema (optional) property 31
Schema name prefix option 50, 60
schemas 27, 31, 50, 60, 143
search function 184
security 12,17,43
Select a wizard page 10
SELECT clause 109, 111
Select operator 131
SELECT statements 158, 159, 161, 162
See also SQL statements
selection lists. See drop-down lists
Selectltem declaration (SQL) 167
SelectList declaration (SQL) 167
SelectStatement declaration (SQL) 167
SelectWithoutFrom declaration (SQL) 167
SelectWithoutOrder declaration (SQL) 167
separators (numbers) 101
serial values 187, 250
Server name property 23, 24, 25, 26
server profiles. See iServer profiles
Server property 21,22
servers 17,21
connecting to database 22, 26
See also iServer
Service property 22
set difference operations 158
SetClause declaration (SQL) 167
Show Categories icon 6
Show categories in graphical editor option 77
Show Dependents command 68
Show Detail command 68
Show map properties button 95
Show Sources command 68
SID property 24
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SignedLiteral declaration (SQL) 167
SimpleCondition declaration (SQL) 167
SINGLE EXEC keywords 172
single quotation mark (') character 100, 115,
164
SingleMatchChar attribute 244, 245
Size property 120
.sma files 49
See also map files
SMALLINT data type 227
SOAP end point property 26
sort keys 132
sort operations 264
Sort operator 132
SortedOuterUnion operator 132
source columns 53
source parameters 58, 64, 120-122
space characters. See white space characters
special characters. See characters
SQL compiler 92, 127
SQL conventions (Actuate) 163
SQL data types
casting rules for 174
DB2 databases and 205
Informix databases and 206
listed 173,227
mapping to 204, 226, 227, 229
Oracle databases and 207
SQL databases and 210
Sybase databases and 211
SQL editor 123,126
SQL editor icon 123
SQL expressions 71, 173,176
SQL functions
See also functions
aggregation 188, 193, 253
compatibility with 234
converting 232, 233
custom mappings for 236, 242, 243, 244,
254
DB2 databases and 205
disabling default mappings for 234, 239
mapping 232, 234, 235, 237
null values and 251
numeric data types and 178
Oracle databases and 207
SQL databases and 209



string data types and 180
substrings and 182, 184
Sybase databases and 211
system information and 189
timestamp values and 184
SQL identifiers 163,169, 170
SQL keywords 168
SQL nodes (Query Profiler) 129
SQL operator 133
SQL operator mapping examples 257-258
SQL operators 176
See also operators
SQL parameters 114-115
SQL Preview page 123
SQL Preview view 6, 158
SQL Server databases
caching information objects and 142
connecting to 25, 204
creating queries for 209
externalizing connections for 45
mapping to 209-210
SQL Server login accounts 25
SQL Server named instances 25
SQL statements
See also queries
adding
column names to 170
escape sequences to 232
functions to 72, 159
parameters to 115,130, 159, 171, 174
table names to 170
displaying 6, 128
editing 123
entering at run time 159
mapping GROUP BY clause for 261, 262
mapping ORDER BY clause for 261
referencing
aliases in 162
information objects in 170
parameters in 159
tables or views in 159
removing columns from 111-113
selecting columns for 74,170
selecting tables for 91, 159, 173, 190
setting dynamic filters in 162
setting filter conditions in 96, 99, 103

setting join conditions in 89, 90, 94, 160,
195
unassigned parameters and 114
SQL text editor. See SQL editor
SQL type codes 212
SQL-92 keywords 169, 170
SQL-92 specifications 234
square brackets ([ ]) characters. See brackets
characters
Start Auto suggest option 88, 117
Stored procedure name prefix option 60
stored procedures
changing map files for 63
changing parameter names for 63
filtering 60
mapping to 58-64, 226
renaming 59
retrieving list of 218
retrieving parameters from 120
string data types 173
string functions 180, 182, 183, 184, 243
string operators 180
strings
assigning to parameters 115,122, 174
casting rules for 174
comparing 101, 175, 176, 208
concatenating 164, 181, 207, 258
converting case 180, 206
entering in SQL statements 173
filtering blank values in 100, 101
filtering data and 86
filtering tables and views and 50
getting length of 181
localizing information objects and 136,
138, 139
mapping literal 260
mapping to data types and 228
mapping to queries and 55
masking 222
matching characters in 87, 101, 181, 246
maximum size for 228
missing values in 101
ordering 264, 267
padding 206
parsing 182
returning substrings in 182, 184
setting maximum length for 173

Index 291



strings (continued)
trimming white space in 183
XML parsers and 214
SUB operator 241
subcategories (output columns) 75, 76
subqueries
creating 159, 172
grouping data and 162
matching character patterns and 159
optimizing 172
returning scalar values and 160
SubQuery declaration (SQL) 168
subroutines 130
SUBSTR function 235
SUBSTRING function 182, 235, 244, 268
substring functions 182, 244
SubStringFuncMapper element 244
substrings 182, 184, 244
subtraction operator 177, 241, 258
SUM function 188, 189, 193, 253
summary tables 78
summary values 188
See also aggregation
SWITCH statements 252
Sybase data types 211
Sybase databases
connecting to 26, 204
creating queries for 211
externalizing connections for 45
mapping to 59, 211
setting character encodings for 27
Sybase named servers 26
symbolic operators 256
synchronizing source parameters 122
syntax (SQL) 163, 164
synthesized data 132
system information 189

T

tab characters 168

tab-delimited formats 132

table aliases 123

table names 170

Table/View name prefix option 50
TableParameter declaration (SQL) 168
TableParameters declaration (SQL) 168
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tables
adding to queries 91, 159, 173
cache database and. See cache tables
changing 52
filtering 50
getting 217
joining 161
mapping to database 49-52, 65, 204, 226
specifying as optional 91, 190-194
templates (SQL functions) 232, 234, 235, 237,
255
testing
connections 18, 21
for null values 180
for range of values 176
for set of values 177
information objects 12, 127, 132
joins 129
localized information objects 139
projects 153
text 80, 164, 182
text boxes 79
text file data sources 132
Text Format property 80
text strings. See strings
textual queries
building expressions for 71
creating 70, 123-124
displaying output columns for 124
displaying parameters for 126
saving 123
textual query editor 56, 71
See also SQL editor
THEN keyword 252
ThenString attribute 252
thousands separator 101
threshold values (SQL indexes) 198
time stamps
as literal strings 260
assigning to parameters 122
comparing 176
mapping 247, 248, 249, 250
returning current 185
specifying default 115
SQL conventions for 164, 173, 174
time values 101, 185
TIMESTAMP data type 173, 174, 227



timestamp functions 184
TIMESTAMP keyword 260
TIMESTAMP_STRING token (SQL) 164
TINYINT data type 227
TNS names file property 24
TNS server name property 24
Toggle categories view icon 77
tokens (SQL grammar) 163
totals 113, 189
trailing spaces 102
Transact-SQL data types 210
Transact-SQL functions 209
translation keys 136, 138, 139
translation strings 136, 138, 139
translations 136
TRIM function 183
true values. See Boolean values
truncation 80, 174, 228
Type attribute 44, 222
type casting 159, 174, 254
type declarations 165, 167

See also data types

U

UnaryExpression declaration (SQL) 168
UnaryLogicalExpression declaration
(SQL) 168

unassigned parameters 114
UNC paths 22
underscore (_) character 102, 182, 245
Unicode binary collation 209, 264, 265, 266
Unicode characters 264
Unicode data 26
Unicode strings 164, 173, 260
Unicode_BIN collation 264

See also Unicode binary collation
unicode_bin collation 266
UNION keyword 123
Union operator 132
UNION statements 158, 167
unique values 74, 94

See also DISTINCT keyword
UNIX systems 22,27, 30
unknown data types 78
unnamed parameters 55, 159
UnsignedLiteral declaration (SQL) 168

update columns 144, 148
Update Map command 53
Update Maps command 54
updating
cache tables 144, 148
maps 52,53, 54
projects 152
UPPER function 180, 243
URL of the XML schema property 27
URL of the XML source property 27
URLs
BIRT Studio 12
localized information objects and 137
WSDL files 26
XML data streams 27
Use Precompiled Query Plan at runtime
property 134
UseCharStringImplByDefault attribute 268
User name property 12, 22,23, 24, 25, 26
user names
database connections and 17, 22, 26
iServer profiles and 12
MySQL Enterprise login accounts and 23
PostgreSQL login accounts and 25
returning 189
SQL Server login accounts and 25
UseSelectltemIndexes attribute 261, 262

V'

ValueExpression declaration (SQL) 168
ValuelsCaseSensitive attribute 222
values

See also data

aggregating. See aggregation

assigning to parameters 115, 116, 122, 126,

170

comparing. See comparisons

counting non-null 188

creating list of 86, 87, 116, 117

filtering empty or blank 100, 101

filtering on multiple 99

filtering range of 100

hiding 119

inheritance and blank 85

mapping data types and 207, 211, 228

returning largest 178

Index 293



values (continued)
returning smallest 178
rounding 179
selecting at run time 88, 116, 117
setting default 115, 117, 119
testing for null 180
testing range of 176
testing sets of 177
ValueSelectItem declaration (SQL) 168
ValueSelectList declaration (SQL) 168
VARCHAR data type
as generic type 227
as literal strings 260
assigning to parameters 119, 120
casting numeric types to 205
declaring 228
defining output columns and 80
SQL queries and 173, 174
VARCHAR? data type 207
variables 114
variant strings 174, 260
variant types 207
See also NVARCHAR; VARCHAR data
types
viewing
column categories 77
column names 79
data types 53, 81, 124, 126
error messages 6, 152
information objects 68, 72
maps 68, 72
output columns 51, 56, 66, 124
parameters 126
SQL queries 127,133
SQL statements 6, 128
views
changing 52
filtering 50
mapping to database 49-52, 204, 226
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virtual tables 173
Volume property 12
volumes. See Encyclopedia volumes

W

web services data sources 19, 26, 27

Web Services Description Language file 26

WHEN clause 168
WHEN keyword 252
WhenClause declaration (SQL) 168
WhenString attribute 252
WHERE clause 94, 96, 162, 168, 211
See also SQL statements
WhereClause declaration (SQL) 168
white space characters
in queries 164, 168, 170
in strings 183
wildcard characters 102, 246
Windows systems 22, 30
WITH clause 86, 114, 159, 166
See also SQL statements
Word Wrap property 80
word wrapping 80
WSDL descriptor property 26

X

XML connection types 48

XML data source connections 19, 27, 48

XML data streams 27
XML elements 214
XML files 27,214
See also configuration files
XML parsers 214
XML schemas 27

y4

z/OS operating systems 21
zero-length variants 207
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